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Intellectual Property Statement
SHENZHEN MINDRAY BIO-MEDICAL ELECTRONICS CO., LTD. (hereinafter called Mindray) owns the intellectual 
property rights to this Mindray product and this manual. This manual may refer to information protected by 
copyright or patents and does not convey any license under the patent rights or copyright of Mindray, or of 
others. 

Mindray intends to maintain the contents of this manual as confidential information. Disclosure of the 
information in this manual in any manner whatsoever without the written permission of Mindray is strictly 
forbidden. 

Release, amendment, reproduction, distribution, rental, adaptation, translation or any other derivative work of 
this manual in any manner whatsoever without the written permission of Mindray is strictly forbidden.

 is the trademark, registered or otherwise, of Mindray in China and other countries. All other 
trademarks that appear in this manual are used only for informational or editorial purposes. They are the 
property of their respective owners.

This posting serves as notice under 35 U.S.C.§287(a) for Mindray patents: http://www.mindrayna.com/patents.

Manufacturer’s Responsibility
Contents of this manual are subject to changes without prior notice.

Mindray is responsible for the effects on safety, reliability and performance of this product, only if:

■ all installation operations, expansions, changes, modifications and repairs of this product are conducted by 
Mindray authorized personnel;

■ the electrical installation of the relevant room complies with the applicable national and local 
requirements;

■ the product is used in accordance with the instructions for use.

WARNING

• Only skilled/trained clinical professionals should operate this equipment. 

• It is important for the hospital or organization that uses this equipment to perform a recommended 
service/maintenance plan. Neglect of this may result in machine breakdown or personal injury.

Service
Mindray maintains a network of service representatives and factory-trained distributors. Prior to requesting 
service, perform a complete operational check of the instrument to verify proper control settings. If operational 
problems continue to exist, contact Mindray service.

In North America contact the Service Department at (800) 288-2121, ext: 8116 for Technical Support or (201) 
995-8000 for assistance in determining the nearest field service location.

Please include the instrument model number, the serial number, and a description of the problem with all 
requests for service.

Any questions regarding the warranty should be directed to the local sales or service representative.
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Preface
Manual Purpose

This manual contains the instructions necessary to operate the product safely and in accordance with its 
function and intended use. Observance of this manual is a prerequisite for proper product performance and 
correct operation and ensures patient and operator safety. 

This manual is based on the maximum configuration and therefore some contents may not apply to the product. 
If you have any question, please contact Mindray.

This manual is an integral part of the product. It should always be kept close to the equipment so that it can be 
obtained conveniently when needed.

Intended Audience
This manual is geared for clinical professionals who are expected to have a working knowledge of medical 
procedures, practices and terminology as required for monitoring of patients.

Illustrations
All illustrations in this manual serve as examples only. They may not necessarily reflect the setup or data 
displayed on the patient monitor.

Conventions
■ Italic text is used in this manual to quote the referenced manuals, chapters, sections and formulas.

■ Bold text is used to indicate the screen texts and names of hard keys.

■ → is used to indicate operational procedures.
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1 Safety

1.1 Safety Information

WARNING

• Indicates a potential hazard or unsafe practice that, if not avoided, could result in death or serious 
injury.

CAUTION

• Indicates a potential hazard or unsafe practice that, if not avoided, could result in minor personal 
injury or product/property damage.

NOTE
• Provides application tips or other useful information that does not involve patient or user risk.

1.1.1 Warnings

WARNING

• Patient with a pacemaker – on ventricular paced patients, episodes of Ventricular Tachycardia may 
not always be detected. Do not rely entirely upon the system’s automated arrhythmia detection 
algorithm.  Keep pacemaker patients under close surveillance.

• This equipment is used for a single patient at a time.

• To avoid explosion hazards, do not use the equipment in the presence of oxygen-rich atmospheres, 
flammable anesthetics, or other flammable agents.

• Do not touch the equipment’s metal parts or connectors when in contact with the patient; otherwise 
patient injury may result.

• Never mix patient electrode types or brands. Dissimilar metals or other incompatibilities may cause 
considerable baseline drift and may increase trace recovery time after defibrillation.

• To reduce the hazard of burns during high-frequency surgical procedure, ensure that the monitor’s 
cables and transducers never come into contact with the electro-surgery unit (ESU).

• The neutral electrode of the electro-surgery unit (ESU) shall properly contact the patient. Otherwise, 
burns may result.

• MR unsafe: the N1 monitor is not intended to be used within the Magnetic Resonance (MR) 
environment.

• Before connecting the equipment to the mains power, ensure that the voltage and frequency ratings 
of the power line are the same as those indicated on the equipment’s label or in this manual.

• Before putting the system into operation, the operator must verify that the equipment, connecting 
cables, and accessories are in correct working order and operating condition. 

• To avoid risk of electric shock, the equipment must only be connected to mains power with 
protective earth, or operated on battery power. 

• Do not touch the patient and live parts simultaneously. Otherwise patient injury may result.

• Do not touch the patient or metal parts in contact with the patient during defibrillation. Otherwise 
serious injury or death could result. 

• Do not open the equipment housings. All servicing and future upgrades must be carried out by 
trained and authorized personnel.
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• Do not rely exclusively on the audible alarm system for patient monitoring. Turning the alarm 
volume to a low level or off may result in a hazard to the patient. Always keep the patient under 
close surveillance.

• Alarm settings should be customized according to patient situations. 

• Do not place the equipment or accessories in any position that might cause it to fall on the patient.

• Do not start or operate the equipment unless the setup was verified to be correct.

• To avoid inadvertent disconnection, route all cables in a way to prevent a stumbling hazard. Wrap 
and secure excess cabling to reduce risk of entanglement by patients or personnel. 

• The physiological data and alarm messages displayed on the equipment are for reference only and 
cannot be directly used for diagnostic interpretation. The equipment should not be used as the sole 
basis for medical decisions. It must be used in conjunction with clinical signs and symptom. If any 
measurement seems questionable, first check the patient’s vital signs by alternate means and then 
check the equipment for proper functioning.

1.1.2 Cautions

CAUTION

• Use only parts and accessories specified in this manual. 

• Disposable accessories are not designed to be reused. Reuse may cause a risk of contamination and 
affect the measurement accuracy.

• Ensure that the equipment is supplied with continuous electric power during operation from the 
mains power or batteries. Sudden power failure may cause data loss.

• When no battery is installed, ensure that the monitor is supplied with continuous electric power 
during operation. Sudden power failure may lead to data loss.

• Store and use the equipment in specified environmental condition. The monitor and accessories 
may not meet the performance specification due to aging, stored or used outside the specified 
temperature and humidity range.

• Magnetic and electrical fields are capable of interfering with the proper performance of the 
equipment. For this reason make sure that all external devices operated in the vicinity of the 
equipment comply with the relevant EMC requirements. Mobile phones, X-ray equipment, and MRI 
devices are possible sources of interference as they may emit higher levels of electromagnetic 
radiation. 

• Always install or carry the equipment properly to avoid damage caused by drops, impacts, strong 
vibrations or other mechanical forces.

• Dry the equipment immediately in case of rain or water spray. 

• Some settings are password protected and can only be changed by authorized personnel. Contact 
your department manager or biomedical engineering department for the passwords used at your 
facility.

• Do not loop the patient cabling into a tight coil or wrap around the device, as this can damage the 
patient cabling.

• Dispose of the package material as per the applicable waste control regulations. Keep it out of 
children’s reach.

• At the end of its service life, the equipment, as well as its accessories, must be disposed of in 
compliance with the guidelines regulating the disposal of such products. If you have any questions 
concerning disposal of the equipment, please contact Mindray.

1.1.3 Notes

NOTE

• The equipment software copyright is solely owned by Mindray. No organization or individual shall 
resort to modifying, copying, or exchanging it or to any other infringement on it in any form or by 
any means without due permission.

• Put the equipment in a location where it can be easily viewed and operated. 
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• The equipment uses a mains plug as isolation means to the mains power. Do not locate the 
equipment in a place difficult to access the mains plug.

• During normal use, the operator is expected to face the front of the equipment.

• Remove the battery before shipping the monitor or if it will not be used for an extended period of 
time.

• Remove the battery before transporting the equipment or if the equipment will not be used for a 
long time.

• The software was developed in compliance with IEC62304, to minimize the possibility of hazards 
arising from software errors.

• This manual is based on the maximum configuration and therefore some contents may not apply to 
the product. If you have any question, please contact Mindray.

• Observance of this manual is a prerequisite for proper product performance and correct operation 
and ensures patient and operator safety.

• Keep this manual in the vicinity of the equipment so that it can be referenced when needed.

1.2 Equipment Symbols

Symbol Description Symbol Description

General warning sign Refer to instruction manual/booklet

Serial number Catalogue number

Date of manufacture Manufacturer

USB connector Protected against vertically falling water 
drops per IEC 60529

IP44: protected against ingress of foreign 
objects no less than 1.0 mm, and against 
access to hazardous parts with wire; 
protect against harmful effects of 
splashing water

IP22: protected against ingress of foreign 
objects no less than 12.5 mm and 
against access to hazardous parts with 
finger; protected against harmful effects 
of vertically falling water drops with the 
device tilted at any angle up to 15°

Battery indicator Computer network

Direct current Lock; tighten

Equipotentiality Alternating current

Defibrillation-proof type CF applied part Defibrillation-proof type BF applied part
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Direction and angle off rotation Polarity of d.c. power connector  

Input/output IBP zero key

Locking Unlocking

NIBP start/stop Calibration

Start Stop

Stand-by Menu

Gas outlet Gas inlet

Video output Non-ionizing electromagnetic radiation

Dispose of in accordance to local 
requirements

Plastic identification symbol

Pushing prohibited (wheels locked, no 
pushing)

Conforms to ANSI Std. ES60601-1, IEC Std. 
60601-1-8, IEC Std. 60601-2-25, IEC Std. 
60601-2-26, IEC Std. 60601-2-27, IEC Std. 
80601-2-30, IEC Std. 60601-2-34, IEC Std. 
60601-2-49, ISO Std. 0601-2-55, ISO Std. 
80601-2-56,

and ISO Std. 80601-2-61

Certified to CAN/CSA Std. C22.2 No. 60601-1, 
No. 60601-1-6, No. 60601-1-8, No. 60601-2-25, 
No. 60601-2-26, No. 60601-2-27, No. 80601-2-
30, No. 60601-2-34, No. 60601-2-49, No. 
80601-2-55, No. 80601-2-56, and No.

80601-2-61

Symbol Description Symbol Description
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2 Equipment Introduction

2.1 Indications for Use
The BeneVision N1 Patient Monitor is intended for monitoring, displaying, reviewing, storing , alarming, and 
transferring of multiple physiological parameters including ECG (3-lead, 5-lead, 6-lead or 12-lead selectable, 
Arrhythmia Detection, ST Segment Analysis, QT Analysis, and Heart Rate (HR)), Respiration (Resp), Temperature 
(Temp), Pulse Oxygen Saturation (SpO2), Pulse Rate (PR), Non-invasive Blood Pressure (NIBP), Invasive Blood 
Pressure (IBP), Pulmonary Artery Wedge Pressure (PAWP), Carbon Dioxide (CO2) and Oxygen (O2). The system 
also provides an interpretation of resting 12-lead ECG. 

All the parameters can be monitored on single adult, pediatric, and neonatal patients except for the following: 

■ The arrhythmia detection and PAWP is intended for adult and pediatric patients only 

The BeneVision N1 monitor is to be used in healthcare facilities. It can also be used during patient transport 
inside and outside of the hospital environment. It should be used by clinical professionals or under their 
guidance. It should only be used by persons who have received adequate training in its use. It is not intended for 
home use.

NOTE

• This manual is based on the maximum configuration and therefore some contents may not apply to 
the product. If you have any question, please contact Mindray.

2.2 Equipment Features
The monitor is intended to be used in a hospital environment including, but not limited to, ICU, CCU, PICU, 
Neonatology, RICU, emergency room, operating room, postoperative observation ward, etc. 

The monitor can be used in two ways:

■ As a stand-alone patient monitor, or

■ As a multi-parameter module (MPM) for the Mindray BeneVision N22, BeneVision N19, BeneVision N17, 
BeneVision N15, or BeneVision N12 patient monitor, hereafter referred to as “the host monitor”.

In this manual, the N1 is generally referred to as “the monitor” except in the situation describing its use with a 
host monitor, where it is referred to as “the N1” to distinguish it from the host monitor.

2.3 Applied Parts 
The applied parts of the monitor are:

■ ECG electrode and leadwire

■ SpO2 sensor

■ Temp probe

■ NIBP cuff

■ IBP transducer

■ CO2 sampling line/nasal sampling cannula, water trap, and mask
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2.4 Main Unit

2.4.1 Front View

 

BeneVision N1

(5)
(4)

(3)

(2)(1)

(1) Alarm lamp:

When a physiological alarm or technical alarm occurs, this lamp lights and flashes corresponding with the alarm 
priority:

• High priority alarms: the lamp quickly flashes red.

• Medium priority alarms: the lamp slowly flashes yellow.

• Low priority alarms: the lamp lights in cyan without flashing.

(2) Ambient light sensor

When screen brightness is set to auto, the system automatically adjusts screen brightens according to the 
strength of ambient light.

(3) Display

(4) Battery LED:

• Yellow: the battery is being charged.

• Green: the battery is fully charged.

• Flashing green: the monitor runs on battery power.

• Flashing yellow: the battery is malfunctioning.

• Off: no battery is installed, or the monitor is powered off and no external power is connected.

(5) External power supply indicator:

• On: when external power supply is connected.

• Off: when external power supply is not connected. 
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2.4.2 Left View

NOTE
• To ensure good contact, clean the contacts regularly, as dust and dirt may collect on them. When 

cleaning the contacts, wipe them with cotton, dampened with alcohol. Using forceps is 
recommended.

•  In the case of water spray, dry the Multi-pin connector of the N1 before connecting the N1 to the 
Modular Rack or Dock. 

(1) Communication interface: used for communication between the 
N1 and host monitor (BeneVision N series monitor).

(2) Infrared filter: used for communication between the N1 and N 
series monitor if the communication interface does not work.

(3) Contact: used for receiving power supply from the host monitor 
(BeneVision N series monitor).

(4) Multi-pin connector: connects the N1 to the Modular Rack or Dock.

(5) External DC power input connector: connects the N1 to the AC 
adapter

(4)

(5)

(3)(3)

(2)

(1)
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2.4.3 Right View

2.4.4 Bottom View

2.5 Modular Rack
The Modular Rack is used to connect an N1 and an external parameter module as well as providing bed rail 
mounting capability. It can also be connected to the Dock. 

(1) (2) (3)

(4)

(5)

(6)

(7)

(8)

(9)

(1) Power switch (2) Sample line connector for 
sidestream CO2

(3) Gas outlet

(4) ECG cable connector (5) SpO2 sensor connector (6) NIBP cuff connector

(7) Multifunctional connector: outputs analog ECG, IBP and defib synchronization 
signals.

(8) IBP cable connector 

(9) Temperature probe connector 

(1)

(2)

(1)

(1) Clip: fastens the N1 when N1 is in use with the host monitor, Dock or Modular Rack.

(2) Latch: locks the N1 when the N1 is in use with the host monitor, Dock or Modular Rack. Pressing here releases 
the N1 so that the N1 can be removed from the host monitor, Dock or Modular Rack. 
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2.5.1 Left View

2.5.2 Right View

(1)

(2)

(1) Release button: pressing this button releases the Modular Rack from the Dock.

(2) Multi-pin connector: connects the Modular Rack and Dock.

(3)

(2)(1)

(4)

(1) Multi-pin connector: connects the Modular Rack and N1.

(2) Pogo pin: used for communication between the Modular Rack and external parameter module. 

(3) Infrared filter: used for communication between the Modular Rack and external parameter module. 

(4) Contact: power input connector of the external parameter module.
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2.6 Dock
The Dock is used to connect the N1 or Modular Rack to provide power, charge the installed battery, and support 
connection to an external display, USB drive, network cables, and the BeneVision N series patient monitors.

2.6.1 Left View

2.6.2 Right View

(1)

(2)

(1) Symbol: indicates the direction and angle that Dock can rotate when Dock is fixed onto a transverse or a 
vertical rod.

(2) Pole mount seat: used to fix the pole mount to the Dock and then to a transverse or a vertical rod.

(1)

(2)

(3)

(1) Multi-pin connector: power input and communication connector of the N1.

(2) Connection status indicator: it is on when the N1 is properly connected to the Dock.

(3) External power supply indicator: it is on when the external AC power supply is connected.
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2.6.3 Rear View

2.7 External Parameter Modules
The monitor can connect the following external parameter modules through the Modular Rack.

(1) (2) (3) (4) (5) (6)

(1) AC Power input connector

(2) Equipotential grounding terminal: when using the monitor together with other devices, connect their 
equipotential grounding terminals together to eliminate the potential difference between them.

(3) VGA connector: connects the external display

(4) Host monitor connector: connects the N1 to the host monitor through a cable.

(5) USB connector: connects USB devices.

(6) Network connector: a standard RJ45 connector which connects the monitor to the CMS. It can also be used to 
transfer data..

Sidestream CO2 module Microstream CO2 module IBP module
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2.8 Installation

2.8.1 Installing the N1 or External Parameter Module into the Modular Rack
Install the N1, and an external parameter module if needed, to the Modular Rack as indicated below:

Firmly push the N1 or the external module until an audible click is heard indicating that the clip (refer to 
2.4.4 Bottom View) engaged the Modular Rack. To ensure that the N1 or the external module is properly 
connected, try to pull the N1 or the external module outward. The N1 or the external module has properly 
engaged the Modular Rack if it cannot be pulled out. 

NOTE

• To prevent the N1 or the external module from falling out of the Modular Rack, after inserting the N1 
or the external module into the Modular Rack, always check that the N1 or the external module 
properly engaged the Modular Rack.

• When the external module is properly installed, it should be further fasten to the Modular Rack with 
the lock at the bottom of the module to ensure the engagement. 

2.8.2 Removing the N1 or External Parameter Module from the Modular Rack
To remove the N1 or external parameter module, follow this procedure:

1. Press and hold the latch at the bottom of the N1 or parameter module. If the external module is locked to 
the Modular Rack, unlock it first.

2. Pull the N1 or parameter module out as indicated.

1

2

1

2
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2.8.3 Installing the Modular Rack to the Dock
The Modular Rack can be installed to the Dock as indicated below:

A click is heard when the Modular Rack is pushed into place. 

2.8.4 Removing the Modular Rack from the Dock
To remove the Modular Rack from the Dock, follow this procedure:

1. Press and hold down the release button at the top of the Modular Rack.

2. Pull the Modular Rack out as indicated.
.

CAUTION

• To prevent the Dock from falling off, do not press the release button while transporting the N1 with 
the Modular Rack and Dock.

2.8.5 Installing the N1 to the Dock
The N1can also be installed directly to the Dock as shown below:

1

2
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Firmly push the N1 until an audible click is heard indicating that the clip (refer to 2.4.4 Bottom View) engaged the 
Dock. To ensure that the N1 is properly connected, try to pull the N1 outward. The N1 has properly engaged the 
Dock if it cannot be pulled out.

2.8.6 Removing the N1 from the Dock
To remove the N1 from the Dock, follow this procedure:

1. Press and hold the latch at the bottom of the N1.

2. Pull the N1 out as indicated.

2.9 N1 in Use with a Host Monitor
When the N1 is connected to the BeneVision N series monitor, the N1 works as the parameter module while 
BeneVision N series monitor works as the host monitor. For more information, see section 3.7.2 Module Mode.

The N1 can be connected to the host monitor through the following parts:

■ The module rack of the host monitor

■ The Satellite Module Rack (SMR) 

■ The Dock

2.9.1 Connecting the N1 to the Host Monitor through the Module Rack
To connect the N1 to the module rack of the host monitor, follow this procedure:

1. Insert the N1 to the host monitor’s module rack. Firmly push the N1 until an audible click is heard indicating 
that the clip (refer to 2.4.4 Bottom View) engaged the module rack. 

1

2
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2. To ensure that N1 is properly connected, try to pull N1 outward. The N1 has properly engaged the module 
rack if it cannot be pulled out. 

To remove the N1 from the module rack of the host monitor, lift the latch (refer to 2.4.4 Bottom View) at the 
bottom of the N1 and pull the N1 out.

CAUTION

• To prevent the N1 from falling out, after inserting the N1 into the module rack, always check that the 
N1 properly engaged the module rack.

• To prevent the N1 from falling, catch it with another hand while pulling it out from the module rack.

NOTE

• There is no module rack for the BeneVision N22 or BeneVision N19 monitors. The N1 can be 
connected to the BeneVision N22 or BeneVision N19 monitor through the SMR or Dock.

2.9.2 Connecting the N1 to the Host Monitor through the Satellite Module Rack 
(SMR)
To connect the N1 to the host monitor through the SMR, follow this procedure:

1. Connect the SMR to the host monitor.

2. Insert the N1 to the SMR. Firmly push the N1 until an audible click is heard indicating that the clip (refer to 
2.4.4 Bottom View ) engaged the SMR. 

3. To ensure that the N1 is properly connected, try to pull the N1 outward. The N1 has properly engaged the 
module rack if it cannot be pulled out. 

To remove the N1 from the SMR, lift the latch (refer to 2.4.4 Bottom View) at the bottom of the N1 and pull the N1 
out.

CAUTION

• To prevent N1 from falling out, after inserting the N1 into the SMR, always check that the N1 
properly engaged the SMR.

• To prevent the N1 from falling, catch it with another hand while pulling it out from the SMR.

2.9.3 Connecting the N1 to the Host Monitor through the Dock
To connect the N1 to the host monitor through the Dock, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the host monitor connector of the Dock with the SMR connector of the host monitor using the 
dock data cable.
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2.10 N1 in Use with the Transport Dock
The N1can be used with the Transport Dock to transport a patient via ambulance, airplane fuselage or helicopter 
fuselage. For the installation instructions of the N1 and Transport Dock, refer to the Transport Dock Indication for 
Use (PN: H-046-011365-00).

WARNING

• The monitor must only be connected to mains power with protective earth, and the connection 
should be performed by qualified service personnel. 

• Ensure that the external power system has secure protective earth when the monitor is used 
together with the Transport Dock.

• Verify that the connection of protective earth and the external power system is securely connected 
when installing the Transport Dock.

2.11 Input Devices
The monitor allows data entry through touchscreen, keyboard, mouse, and barcode reader. 

2.12 Printing Devices
Use only Mindray specified printers to output patient information and data.

(1) DC power input (2) Power supply indicator

(3) Upper cover (4) Slide block for unlocking the N1

(4)

(1)

(2)

(3)
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3 Getting Started

3.1 Equipment Preparation Safety Information

WARNING

• Use only installation accessories specified by Mindray.

• Connect only approved devices to this equipment. Devices connected to the equipment must meet 
the requirements of the applicable IEC standards (e.g. IEC 60950 safety standards for information 
technology equipment and IEC 60601-1 safety standards for medical electrical equipment). The 
system configuration must meet the requirements of the IEC 60601-1 medical electrical systems 
standard. Any personnel who connect devices to the equipment’s signal input/output port are 
responsible for providing evidence that the safety certification of the devices has been performed in 
accordance to the IEC 60601-1. If you have any questions, please contact Mindray. 

• The monitor and parameter monitoring accessories are suitable for use within the patient 
environment. For other equipment and accessories connected to the monitor, consult 
corresponding manufacturers for the suitability within the patient environment.

• If it is not evident from the equipment specifications whether a particular combination with other 
devices is hazardous, for example, due to summation of leakage currents, please consult the 
manufacturer or an expert in the field. A determination must be made that the proposed 
combination will not negatively affect the devices themselves or the patient's safety.

CAUTION

• The equipment should be installed by Mindray authorized personnel. 

• When disposing of the packaging material, be sure to observe the applicable waste control 
regulations and keep it out of children’s reach.

• Before use, verify whether the packages are intact, especially the packages of single use accessories. 
In case of any damage, do not apply it to the patient.

• Make sure that the equipment operating environment meets the specific requirements. Otherwise 
unexpected consequences, e.g. damage to the equipment, could result. 

• Avoid rough handling during transport.

NOTE

• This manual is based on the maximum configuration and therefore some contents may not apply to 
the product. If you have any question, please contact Mindray.

• Put the equipment in a location where it can be easily viewed and operated.

• Keep this manual in the vicinity of the equipment so that it can be referenced when needed.

• Save the packing case and packaging material as they can be used if the equipment must be 
reshipped.

• Many settings in the patient monitor are password protected. It is recommended to change the 
default passwords and keep the passwords safe. Passwords should only be changed by authorized 
personnel. Contact the department manager or biomedical engineering department for the 
passwords used at the facility.

3.2 Monitor Installation

3.2.1 Unpacking and Checking
Before unpacking, examine the packaging carefully for signs of damage. If any damage is detected, contact the 
carrier, distributor, or Mindray.
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If the packing case is intact, open the package and remove the equipment and accessories carefully. Check all 
materials against the packing list and check for any mechanical damage. Contact Mindray in case of any 
problems.

NOTE

• If the N1 purchased contains the internal CO2 module, connect the CO2 adapter to the CO2 receptacle 
soon after unpacking the monitor to avoid losing the CO2 adapter.

3.2.2 Environmental Requirements
The operating environment of the equipment must meet the requirements specified in this manual.

The environment where the equipment is used shall be reasonably free from noises, vibration, dust, corrosive, 
flammable and explosive substances. Moreover, to maintain good ventilation, the equipment shall be at least 2 
inches (5cm) away from around the cabinet.

When the equipment is moved from one place to another, condensation may occur as a result of temperature or 
humidity difference. In this case, never start the system before the condensation evaporates.

CAUTION

• Make sure that the equipment operating environment meets the specific requirements. Otherwise 
unexpected consequences, e.g. damage to the equipment, could result.

3.3 Setting Up the Equipment
Observance of this manual is a prerequisite for proper product performance and correct operation. It ensures 
patient and operator safety. 

3.3.1 Connecting the AC Mains
The monitor can be powered by AC power supply when it is connected to the AC adapter or Dock. Before 
connecting the equipment to the AC mains, check that the voltage and frequency ratings of the power line are 
the same as those indicated on the AC adapter or Dock. 

3.3.1.1 Connecting the AC Mains through the AC Adapter

 To connect the N1 to the AC power source through the AC adapter, follow this procedure:

1. Connect the N1 to the AC adapter.

2. Connect the female end of the power cord to the AC adapter, and the male end of the power cord to a wall 
AC outlet. 

3. Check that the external power supply indicator is on.

The external power supply indicator lies in the lower right corner of the display. When the AC mains is not 
connected, the external power supply indicator is off. When AC mains is connected, the external power supply 
indicator is illuminated in green.

3.3.1.2 Connecting the AC Mains through the Dock

 To connect the N1 to the AC power source through the Dock, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the female end of the power cord to the AC power input of the Dock, and the male end of the 
power cord to a wall AC outlet. 

3. Check that the external power supply indicator of the N1 and Dock are on.
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WARNING

• Operate the equipment on battery power if the integrity of the protective earth conductor or the 
protective earthing system in the installation is in doubt.

CAUTION

• Always use the accompanying power cord delivered with the monitor.

• Always use the AC adapter specified by Mindray.

• Before connecting the equipment to the AC mains, check that the voltage and frequency ratings of 
the power line are the same as those indicated on the AC adapter and Dock.

NOTE

• Use the cable retainer to secure the power cord to prevent it from falling off.

• Use AC power source when the N1 is in use with the Dock.

3.3.2 Connecting the Input Devices
Connect the mouse, keyboard, and/or barcode reader to the USB ports on the rear of the Dock if necessary.

3.3.3 Installing the External Parameter Module
If an external parameter module is needed, refer to section 2.8.1 Installing the N1 or External Parameter Module 
into the Modular Rack for installation. 

3.4 Turning on the Monitor
Before beginning measurements, turn on the monitor, perform the following inspections: 

1. Check the monitor for any mechanical damage. Make sure that all external cables, plug-ins and accessories 
are properly connected. 

2. Connect the monitor to the AC power source using AC adapter or Dock. Make sure the battery power is 
sufficient if the monitor is powered by the battery.

3. Press the power switch to turn on the monitor.

When the monitor is turned on, the alarms are paused for two minutes. Then the alarm system is activated.

CAUTION

• Check that visual and auditory alarm signals are presented correctly when the equipment is 
powered on.

• Do not use the monitor for any monitoring procedure on a patient if you suspect it is not working 
properly, or if it is mechanically damaged. Contact the service personnel or Mindray. 

NOTE
• For first use, connect the monitor to the AC power source and then turn on the monitor to activate 

the battery.

• The time for the monitor to warm up from the minimum storage temperature between uses until the 
monitor is ready for its intended use is 10 minutes when the ambient temperature is 20 °C.

• The time for the monitor to cool down from the maximum storage temperature between uses until 
the monitor is ready for its intended use is 10 minutes when the ambient temperature is 20 °C.
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3.5 Operation and Navigation
Everything needed to operate the monitor is on its screen. Almost every element on the screen is interactive. 
Screen elements include parameter values, waveforms, quick keys, information fields, alarms fields, dialogs, and 
menus. Often you can access the same element in different ways. For example, you can access a parameter 
dialog by selecting the corresponding numeric area or waveform area, or by selecting the Main Menu quick key 
→ from the Parameters column select Setup.

3.5.1 Using the Touchscreen 
You can use the touchscreen to select a screen element by pressing directly on the monitor’s screen. 

3.5.1.1 Tapping or Swiping across the Screen
■ Tapping the screen 

◆ To select an item from menus or lists or select a quick key, tap on it with your finger.

◆ To enter a parameter menu, tap the corresponding numeric area or waveform area. For example, 
select the ECG numeric area or waveform area to enter the ECG menu.

■ Swiping the screen with a single finger

◆ To scroll through a list or a menu, swipe up or down.

◆ If an external display is connected, to show or expand the Minitrends screen or the EWS screen on the 
external display, swipe right across the corresponding screen.

◆ If an external display is connected, to contract or hide the Minitrends screen or the EWS screen on the 
external display, swipe left across the corresponding screen. 

■ Swiping across the screen with two fingers

◆ If an external display is connected, to switch to another screen, swipe left or right across the screen. 
For example, on the Normal screen, swipe with two fingers from left to right to switch to the 
Minitrends screen.

◆ To discharge a patient, swipe from top to bottom.

3.5.1.2 Locking the Touchscreen

To avoid accidental use, the touchscreen is locked in the following situations:

■ The touchscreen is not used in 60 seconds when the N1 runs on battery and is not connected to an external 
display.

■ Select the Unlock quick key , and swipe the slider up as instructed.

When the touchscreen is locked, the quick key changes to . To unlock the touchscreen, touch anywhere 
on the touchscreen and swipe the slider up as instructed.

NOTE

• Wipe off any water on the touchscreen in case of rain or water spray.

3.5.2 Using the On-Screen Keyboard
The on-screen keyboard enables information entry: 

■ Enter the information by selecting one character after another. 

■ Select the Backspace key  to delete single characters or select  to delete the entire entry. 

■ Select the Caps Lock key  to access uppercase letters. 

■ Select the Enter key  to confirm the entry and close the on-screen keyboard. 

If a conventional keyboard is connected to the monitor, you can use it instead of, or in combination with, the on-
screen keyboard.
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3.5.3 Using the Barcode Reader
The monitor supports both a linear (1D) barcode reader and two-dimensional (2D) barcode reader. The barcode 
reader is connected to the monitor through the USB connector on the rear of the Dock.

NOTE

• Use the Mindray custom barcode reader to obtain all the available patient information from both 
the 2D and 1D barcodes. Using other barcode readers can only output the patient’s medical record 
number (MRN) and visit number.

3.5.3.1 Clearing Old Data Formats (for the Mindray Custom 2D Barcode Reader)

If you are using the Mindray custom 2D barcode reader (Model HS-1R or HS-1M), before using the it for the first 
time, clear old data formats and configure the barcode reader. To do so, follow this procedure:

1. Scan the engineering barcode to clear the previous data format. 

2. Scan the 2D engineering barcode which contains the hospital’s data format. 

NOTE
• Contact the scanner manufacturer or Mindray to obtain the barcodes for clearing data formats and 

programming the hospital’s data format. 

3.6 Screen Display
The following figure shows the normal screen:

(1) (3)

(7)

(5)

(9)

(10)

(6)(2) (4)

(8)

(1) Patient information area: displays patient category and gender. The displayed patient information is 
configurable. Selecting this area enters the Patient Management dialog. For more information, see 5.2.2 Editing 
Patient Information.

(2) Patient information area: displays patient information, including department, room number, bed number, and 
so on. The displayed patient information is configurable. Selecting this area enters the Patient Management 
dialog. For more information, see 5.2.2 Editing Patient Information.

(3) Technical alarm information area: displays technical alarm message or prompt message.

(4) The current configuration: displays the name of the configuration that can be loaded from the main menu.

(5) Physiological alarm information area: displays physiological alarm message.

(6) System status information area: displays alarm symbol, battery status, network status, currently connected CMS, 
and system time. For more information, see 3.6.1 On-screen Symbols.
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3.6.1 On-screen Symbols

The following table lists the on-screen symbols displayed on the system status information area:

(7) Quick key area: displays quick keys.

(8) Parameter numerics area: displays parameter values, alarm limits, and alarm status. This area can also display the 
parameter list. For more information, see  3.9.3 Displaying the Parameter List. Selecting a parameter numeric 
block enters the corresponding parameter dialog. Selecting the parameter list enters Tabular Trends review.

(9) Parameter waveform/numerics area: unique area of the screen that can be configured to display either 
parameter numerics or parameter waveforms. Depending on the configuration, the tiles take on the 
characteristics of either area (8) or area (10).

(10) Parameter waveform area: displays parameter waveforms, measurement ranges, and magnification. Selecting a 
waveform enters the corresponding parameter dialog. 

Symbol Description Symbol Description

Adult, male Adult, female

Pediatric, male Pediatric, female

Neonate, male Neonate, female

Wireless network is connected. The solid part 
indicates network signal strength.

Wireless network is not connected.

Wired network is connected. Wired network is not connected.

All the alarms are paused. Individual physiological alarms are turned off 
or the monitor is in the alarm off status. 

Audible alarm tones are paused. Audible alarm tones are turned off.

The alarm system is reset.  The battery is working correctly. The green 
portion represents the remaining charge.

The battery has low power and needs to be 
charged.

 The battery has critically low charge and 
needs to be charged immediately. Otherwise, 
the monitor will automatically shut down 
soon.

 The battery is being charged. No battery is installed.

Battery fault, battery communication fault, or battery charging fault. Contact service personnel for help.
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3.6.2 Dialogs
All dialogs have similar style and structure, see the figure below: 

 

3.6.3 Quick Keys of N1
The monitor provides quick keys for you to quickly access some functions. The quick key area is located at the 
right of the screen. The quick key area displays 5 quick keys. You can also swipe down on the quick key area for 
more quick keys.The following table shows available quick keys.

The following table shows available quick keys.

(1) Dialog heading 

(2) subdialog tabs 

(3) Operation buttons

(4) Exit button: closes the current dialog.

(5) Main body area: includes dialog items and options.

(6)  Switch: 

◆ Green: the switch is on.

◆ Gray: the switch is off.

(1)

(2)

(2)

(3)

(4)

(5)
(6)

Symbol Label Function Symbol Label Function 

Main Menu Enters the main menu. Alarm Reset Resets the alarm system.

Alarm Pause Pauses the physiological 
alarm system (Availability 
depends on configuration 
of Pause in Maintenance 
→ Alarm → Pause/Reset 
dialog).

Audio Pause Pauses alarm tone 
(Availability depends on 
configuration of Pause in 
Maintenance → Alarm → 
Pause/Reset dialog). 

Screen Setup Enters the Screen Setup 
dialog.

Standby Enters the standby mode.
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3.7 Operating Modes
The monitor provides different operating modes. This section describes the different monitoring modes and 
standby modes.

3.7.1 Monitoring Mode
The monitoring mode is the most frequently used clinical mode for patient monitoring. When the monitor is 
turned on, it automatically enters the monitoring mode.

3.7.2 Module Mode
When the N1 is connected to the host monitor, the N1 enters the module mode. For connection of the N1 and 
the host monitor, see section 2.9 N1 in Use with a Host Monitor. The N1 monitor has the following features when it 
enters the module mode:

■ The patient information, parameter setup, and alarm setup of the N1 and the host monitor will be 
synchronized. For data transfer strategy, see the operator’s manual of the host monitor.

■ The N1 can still store the parameter data and the alarm events. 

■ The N1 receives and stores the parameter trends data from the host monitor.

■ All audible sounds of the N1 are off.

■ Wired and wireless network of the N1 are not available.

■ The alarm indications of the battery related alarms of the N1 are given by the host monitor.

■ Turning on or off the host monitor simultaneously powers on or off the N1. 

■ The main screen of the N1is off when it is connected to the host monitor through the SMR or the module 
rack of the host monitor.

The N1 resumes to monitor mode when it is disconnected from the host monitor.

3.7.3 Privacy Mode
The privacy mode is a special clinical monitoring mode. In the privacy mode, the monitor does not display 
patient information and monitoring data. This provides controlled access to patient data and ensures 
confidentiality.

The privacy mode is only available when the patient admitted by the monitor is also monitored by the CMS. The 
monitor continues monitoring the patient, but patient data is only visible at the CMS.

3.7.3.1 Entering the Privacy Mode

To enter the privacy mode, select the Main Menu quick key → from the Display column select Privacy Mode 
→ select Ok.

The monitor has the following features after entering the privacy mode:

■ The screen turns blank. 

■ Except for the low battery alarm, the monitor inactivates alarm tones and alarm lights for all other alarms.

Manual Event Manually saves an event 
into the Events list.

Print Starts printing a real-time 
report.

NIBP Start/
Stop

Starts an NIBP 
measurement or stops the 
current NIBP 
measurement.

NIBP Measure Opens the NIBP Measure 
interval options.

Lock Selects and operates as 
instructed to unlock the 
touchscreen

Unlock Selects and operates as 
instructed to lock the 
touchscreen

Symbol Label Function Symbol Label Function 
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■ The monitor suppresses all system sounds, including heart beat tone, pulse tone, and prompt tone. 

WARNING
. 

• In the privacy mode, all audible alarms are suppressed and the alarm light is deactivated at the 
monitor. Alarms are presented only at the CMS. Pay attention to potential risk.

NOTE

• The privacy mode is not available if the Department is set to OR.

• You cannot enter the privacy mode if a low battery alarm is active.

3.7.3.2 Exiting the Privacy Mode

The monitor automatically exit the privacy mode in any of the following situations:

■ The monitor disconnects from the CMS. 

■ The low battery alarm occurs.

You can also operate the touchscreen, mouse, or keyboard to manually exit the privacy mode.

3.7.4 Night Mode 
The night mode is a special clinical monitoring mode. The night mode reduces screen brightness, sound 
volumes, and pauses NIBP measurements. To avoid disturbing the patient, you can use the night mode.

3.7.4.1 Entering the Night Mode

To enter the night mode, follow this procedure:

1. Select the Main Menu quick key → from the Display column select Night Mode.

2. Change the night mode settings if necessary.

3. Select Enter Night Mode. 

The night mode settings are as follows by default:

■ Brightness: 1

■ Alarm Volume: 2 

■ QRS Volume: 1

■ Key Volume: 0

■ NIBP End Tone: Off

■ Stop NIBP: Off

CAUTION

• Verify the night mode settings before entering the night mode. Pay attention to the potential risk if 
the setting value is low.

3.7.4.2 Exiting the Night Mode

To cancel the night mode, follow this procedure:

1. Select the Main Menu quick key → from the Display column select Exit Night Mode.

2. Select Ok.

NOTE

• If the monitor is connected to the CMS, it automatically exits the night mode if disconnected from 
the CMS.
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• The monitor resumes the previous settings after exiting the night mode.

3.7.5 Standby Mode
You can temperately stops patient monitoring without switching off the monitor by entering the standby mode.

3.7.5.1 Entering the Standby Mode
1. Select the Standby quick key, or select the Main Menu quick key → from the Patient Management 

column select Standby. 

2. Define where the patient is by selecting a location in the drop down list when the monitor enters the 
standby mode.

3. Select Ok.

The monitor behaves as follows after entering the standby mode:

■ Stops all parameter measurements.

■ Disables all the alarms and prompt messages, except for the battery low alarm. 

■ Turns screen brightness to the dimmest after entering the standby mode for 30 seconds. 

WARNING

• Pay attention to the potential risk of placing the monitor to standby. In the standby mode, the 
monitor stops all parameter measurements and disable all the alarm indications, except for the 
battery low alarm.

3.7.5.2 Changing the Patient Location at Standby

To change the patient’s location, select patient location from the Standby screen.

3.7.5.3 Exiting the Standby Mode

To exit the standby mode, choose any of the following ways:

■ Select Resume Monitor to exit the standby mode and resume monitoring the current patient. 

■ Select Discharge Patient to discharge the current patient. 

If the monitor automatically enters the standby mode after a patient is discharged, choose any of the following 
ways to exit the standby mode:

■ Select Monitor to exit the standby mode and admit a new patient.

■ Select Patient Management to enter the patient information for preparing to admit a new patient.

When the monitor exits Standby mode and resumes monitoring, the alarms are paused for two minutes, after 
which the alarm system is activated.

3.7.6 Outdoor Mode
The outdoor mode is intended for transferring patients outdoors. The monitor behaves as follows after entering 
the outdoor mode:

■ The parameter color is white and unchangeable.

■ The screen brightness is automatically changed to 10.

3.7.6.1 Entering the Outdoor Mode

To enter the outdoor mode, select the Main quick key → from the Display column select Enter Outdoor Mode.

NOTE
• The monitor enters the outdoor mode automatically if the strength of ambient light is greater than 

the threshold.
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3.7.6.2 Exiting the Outdoor Mode

When Enter Outdoor Mode is set to Manual, select the Main Menu quick key → from the Display column 
select Exit Outdoor Mode.

The monitor automatically exits the outdoor mode in the following situation:

■ The monitor is connected to a host monitor.

■ The strength of ambient light is lower than the threshold when Enter Outdoor Mode is set to Auto.

3.7.7 Discharge Mode
The discharge mode is a special standby mode after a patient is discharged.

3.8 Configuring the Monitor
Configure the monitor before putting it in use.

3.8.1 Setting the Date and Time
To set the system time, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Time.

2. Set Date and Time.

3. Set Date Format.

4. If you want to use the 12-hour mode, switch off 24 Hour Time.

5. If you want to use daylight saving time, switch on Daylight Saving Time. You can manually switch on or off 
the daylight saving time only when the auto daylight saving time function is disabled. For more 
information, see 21.8.2 Enabling Auto Daylight Savings Time for details.

If the monitor is connected to a central monitoring system (CMS) or hospital clinical system (HIS), the date and 
time are automatically taken from the CMS. In this case, you cannot change the date and time on the monitor.

CAUTION

• Changing the date and time affects the storage of trends and events and may result in loss of data.

3.8.2 Adjusting the Screen Brightness
To adjust the screen brightness, follow this procedure: 

1. Access Display in either of the following ways:

◆ Select the Screen Setup quick key → select the Display tab.

◆  Select the Main Menu quick key → from the Display column select Display.

2. Set Brightness. If Brightness is set to Auto, the monitor automatically adjust the screen brightness 
according to the ambient light.

3.8.3 Adjusting the Key Volume
To adjust the key volume, follow this procedure: 

1.  Select the Main Menu quick key → from the Display column select Display.

2. Set the Key Volume.

3.9 General Operation
This section describes the operations that are generally used when monitoring a patient.
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3.9.1 Switching On or Off a Parameter
You can manually switch on or off a parameter when its module is connected. If setting parameter switches is 
not password protected, follow this procedure to set parameter switches:

1. Access Parameters On/Off in either of the following ways:

◆ Select the Screen Setup quick key → select the Parameters On/Off tab.

◆  Select the Main Menu quick key → from the Parameters column select Parameters On/Off.

2. Switch on or off desired parameters.

When a parameter is switched off, the monitor stops data acquisition and alarming for this measurement. 

NOTE

• When a parameter is manually switched off even, you cannot monitor this parameter if related 
accessories of this parameter are connected.

3.9.2 Displaying Parameter Numerics and Waveforms 
You can configure the parameter numerics, waveforms, and their sequence displayed on the normal screen. To 
do so, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select a parameter numeric area or waveform area, and then from the popup list select an element you 
want to display in this area. The parameters and waveforms you did not select will not displayed.

3.9.3 Displaying the Parameter List
You can display the trends of HR, SpO2, RR, and NIBP/IBP in the parameter numerics area. To do so, follow this 
procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter numerics area where you want to display the parameter list, and then from the popup 
list select Parameter List.

3.9.4 Accessing Parameter Setup Dialogs
Each parameter has a setup dialog in which you can adjust the alarm and parameter settings. You can enter a 
parameter setup dialog by using any of the following methods:

■ Select the parameter numeric area or waveform area.

■ Press the setup hard key  on the module front of the CO2 module.

■ Select the Parameters Setup quick key, and then select the desired parameter.

■ Select the Main Menu quick key → from the Parameters column select Setup → select the desired 
parameter.

NOTE

• In this manual, we always use the first method to enter the setup dialog. But you can use any method 
you prefer.

3.9.5 Changing Measurement Colors
You can set the color of measurement values and waveforms for each parameter. To do so, follow this procedure:

1. Select Main Menu quick key → from the Parameters column select Parameter Color. 
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2. Select the Current tab and set the colors of the currently monitoring measurement values and waveforms. 

3. Select the All tab and set the colors of measurement values and waveforms for all parameters.

3.9.6 Choosing a Screen
The monitor enters the normal screen after it is powered on. The normal screen is most frequently used for 
patient monitoring. You can also select other screens. To do so, follow this procedure:

1. Access Choose Screen in either of the following ways:

◆ Select the Screen Setup quick key.

◆  Select the Main Menu quick key → from the Display column select Choose Screen.

2. Select the desired screen.

3.9.7 Selecting the Big Numerics Screen 
The big numerics screen displays parameter numerics in big font size. You can configure the parameters and 
their layout on the big numeric screen. Quickly switch between the normal screen and the big numeric screen 
by swiping left or right on the touchscreen with two fingers. You can also select the big numeric screen by 
proceeding as follows:

1. Access Choose Screen in either of the following ways:

◆ Select the Screen Setup quick key.

◆  Select the Main Menu quick key → from the Display column select Choose Screen.

2. Select Big Numerics.

3. Select Big Numerics tab.

4. Select a parameter numeric area or waveform area, and then from the popup list select an element to 
display in this area. 

3.10 Connecting the CMS
You can connect the monitor to the BeneVision CMS through wired LAN or wireless LAN. When connected to the 
CMS, the system provides the following function.

■ The monitor can transmit parameter values, waveforms, alarms, and events to the CMS. From the CMS, you 
can check the patient’s monitoring data and alarms.

■ The monitor can transmit parameter values and alarms from the connected external devices to the CMS. 
From the CMS you can check the patient’s monitoring data and alarms obtained from the connected 
external devices.

■ Patient information, alarm settings, and alarm status can be synchronized between the monitor and the 
CMS.

■ You can start or stop NIBP measurements from the CMS.

■ In case of network disconnection, the monitor can transmit the offline data to the CMS when the network is 
reconnected. 

For more information on the CMS, see the operator’s manual of corresponding central monitoring system.

To select a CMS, select the system status information area at the top right corner of the main screen. Select the 
desired CMS from the popup CMS list.

NOTE

• You can select CMS only when the Select CMS switch is on. For more information, see 
21.12.4 Enabling Selecting a CMS.

3.11 Connecting the eGateway
You can connect the monitor to the eGateway through wired LAN or wireless LAN to implement interaction 
between the monitor and external devices. When connected to the eGateway, the system provides the following 
functions:
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■ The monitor can transmit parameter values, waveforms, alarm settings, and events to the eGateway.

■ The monitor can transmit parameter values and alarm settings received from the BeneLink-connected 
external devices to the eGateway. 

■ Clock can be synchronized between the monitor and the eGateway.

3.12 Connecting the Wireless Network
You can add up to five wireless networks for the monitor. For more information, see 21.12.2 Setting the Wireless 
Network.

If connecting the current wireless network fails, the monitor automatically connects other wireless networks in 
the order when they were added.

To manually switch the wireless network, from the system status information area on the top right conner of the 
screen select , and select the desired wireless network.

3.13 Disconnecting the Wireless Network
To disconnect the wireless network manually, follow this procedure:

1. Swipe the screen from top down with a single finger.

2. Select .

To reconnect the wireless network after it is disconnected manually, follow this procedure:

1. Swipe the screen from top down with a single finger.

2. Select .

3.14 Turning Off the Monitor
Before turning off the monitor, perform the following check: 

1. Ensure that monitoring of the patient has been completed. 

2. Disconnect the cables and sensors from the patient.

3. Save or clear the patient data as required.

To turn off the monitor, press and hold the power switch for 3 seconds. 

CAUTION

• Press and hold the power switch for no less than 10 seconds to forcibly shut down the monitor if it 
could not be shut down normally. This may cause loss of patient data.

NOTE

• Turning off the monitor does not disconnect the monitor from the AC mains. To completely 
disconnect the power supply, unplug the power cord.

• In case of a temporary power failure, if the power is restored within 30 minutes, monitoring will 
resume with all active settings unchanged. If the monitor is without power for more than 30 
minutes, it behaves the same as if it were normally turned off.
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4 Using the External Display

4.1 Using the External Display
The N1 can be connected to an external display through the VGA connector of the Dock. When the external 
display is connected, you can monitor a patient’s condition either through the N1 or through the external 
display. 

The external display can be configured as independent display enabling it to be configured to show different 
information than  the N1. For the configuration of the independent external display, see section 21.14.4 Setting 
the External Display.

The following screens or functions can be viewed and operated only on the independent external display:

■ Minitrends Screen

■ OxyCRG Screen

■ Remote View Screen

■ ECG Half-Screen

■ PAWP Screen

■ Calculations

■ EWS

■ GCS

■ ST Graphic

■ Targeted Goal

■ SepsisSight

NOTE

• The external display can share the mouse or keyboard with the monitor. If the mouse or keyboard 
are needed, connect them to the USB connector of the Dock.

4.1.1 Connecting the N1 to the External Display
To connect the external display, follow this procedure:

1. Connect the Dock and the external display using the VGA cable. 

2. Connect the Dock and the external display using the USB cable accompanying the external display.

3. Connect the external display to the AC mains and turn on the display.

4. Connect the N1 to the Dock.

4.1.2 External Display Troubleshooting

Problem Corrective Actions

 Image offset Adjust the external display by using the auto adjust function or adjust the 
external display manually.

No image or the image displays abnormally • Check that the external display is properly connected to the AC mains 
and is powered on. 

• Check that the VGA cable is properly connected. 

• Remove the N1 from the Dock and reconnect it.

Touchscreen failure Check that both ends of the USB cable accompanying the external display 
are connected properly to the Dock and the external display.
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CAUTION

• Use only the specified display. Using unspecified displays may result in unexpected problems. 

4.1.3 Quick keys of the independent external display
The following table displays the quick keys that are available for the independent external display.

Symbol Label Function Symbol Label Function 

Main Menu Enters the main menu. Alarm Reset Resets the alarm system.

Alarm Pause Pauses the physiological 
alarm system (Availability 
depends on configuration 
of Pause in Maintenance 
→ Alarm → Pause/Reset 
dialog).

Audio Pause Pauses alarm tone 
(Availability depends on 
configuration of Pause in 
Maintenance → Alarm → 
Pause/Reset dialog). 

Screen Setup Enters the Screen Setup 
dialog.

Standby Enters the standby mode.

Manual Event Manually saves an event 
into the Events list.

Print Starts printing a real-time 
report.

NIBP Start/
Stop

Starts an NIBP 
measurement or stops the 
current NIBP 
measurement.

NIBP Measure Opens the NIBP Measure 
interval options.

NIBP STAT Starts a five-minute 
continuous NIBP 
measurement.

NIBP Stop All Stops all NIBP 
measurements.

Alarm Setup Enters the Alarm dialog. More Shows more quick keys.

Zero IBP Enters the Zero IBP dialog. PAWP Opens the PAWP screen.

Parameters 
Setup

Enters the Parameters 
Setup dialog.

Remote View Opens the Remote View 
screen to view other 
patients.

Review Enters the Review dialog 
to review historical data.

Minitrends Opens the Minitrends 
screen.

OxyCRG Opens the OxyCRG screen. ECG Full- 
Screen

Opens the ECG full screen.

Privacy Mode Enters the privacy mode. Night Mode Enters the night mode.
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4.1.4 Configuring the Displayed Quick Keys (only available when the N1 is used with 
the independent external display)
To select the quick keys you want to display, follow this procedure:

1. Access Quick Keys in either of the following ways:

◆ Select the Screen Setup quick key → Select the Quick Keys tab.

◆ Select the Main Menu quick key → from the Display column select Quick Keys.

2. Select the Current tab to configure the quick keys you want to display on the screen: From the top of this 
page, select a block where you want to show a certain quick key, and then select the quick key from the 
quick key list. For example, if you want to show the Screen Setup quick key at the first block, select the first 
block, and then select Screen Setup from the list.

3. Select the More tab to configure the quick keys you want to display when the More quick key is selected.

4.2 Minitrends Screen
The Minitrends screen shows the recent graphic trends of parameters. 

4.2.1 Entering the Minitrends Screen
Choose one of the following methods to enter the Minitrends screen:

■ Swipe left or right on the touchscreen with two fingers to switch among the Minitrends screen, normal 
screen, and the big numerics screen. 

CPB Mode Enters the CPB mode. Intubation 
Mode

Enters the intubation 
mode.

Volume Enters the Volume dialog. Freeze Freezes waveforms.

Calculations Enters the Calculations 
dialog.

Load Config Enters the Load Config 
dialog.

Patient 
Management

Enters the Patient 
Management dialog.

ECG Lead/
Gain

Enters the ECG Lead/Gain 
dialog.

Venipuncture Inflates the NIBP cuff to 
help venous puncture.

EWS Opens the EWS screen.

GCS Enters the GCS dialog. SepsisSight Enters the SepsisSight 
dialog.

Discharge 
Patient

Enters the Discharge 
Patient dialog to 
discharge the patient and 
restore pre-configured 
default settings.

Discharged 
Patients

Enters the Discharged 
Patients dialog and 
displays previously 
discharged patients.

Targeted Goal Opens the Targeted Goal 
screen.

End Case 
Report

Prints the selected end 
case reports

Symbol Label Function Symbol Label Function 
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■ Select the Minitrends quick key. 

■ Select the Screen Setup quick key → Select the Choose Screen tab→ select Minitrends.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select Minitrends.

For adult and pediatric patients, when the Minitrends screen is hidden as , you can also choose one of the 
following methods to quickly enter the Minitrends screen.

■ Swipe left or right across the touchscreen with two fingers until you switch to the Minitrends screen.

■ Swipe right across the touchscreen with a single finger. 

■ Select the  button.

4.2.2 The Display of Minitrends Screen
 The following figure shows the minitrends screen. Your display may be configured to look slightly different.

4.2.3 Viewing the Long Trends
To expand the Minitrends screen to view the long trends, choose either of the following ways:

■ Select the  button.

■ Swipe right across the Minitrends screen with a finger.

 (1) Scale

(2) Routine Vital button. If the department is set to OR, then the Baseline button is displayed. 

(3) Routine Vital/Baseline

(4) Select this button to view the long trends, or contract the long trends screen to the Minitrends screen.

(5) Time line

(6) Alarm statistic area

(2)

(4)

(3)

(5)

(1)

(6)
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4.2.4 Setting Minitrends Parameters
To set parameters, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Set parameters. If you want to use the default parameters, select Default Parameter.

4.2.5 Setting the Minitrend Length
To set the Minitrend length, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Set the Minitrend Length.

4.2.6 Setting the Alarm Statistics Switch
The Minitrends screen can be configured to display the statistic number of physiological alarms in its lower half 
screen. To set the alarm statistics switch, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Switch on or off the Alarm Statistics switch.

4.2.7 Setting the Alarm Statistics Duration
The time length within which the alarms statistics are made is configurable. To set the alarm statistics length, 
follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Set Alarm Statistics Duration.

4.2.8 Routine Vital/Baseline
The Routine vital/Baseline function is used for marking the parameter measurements of certain moment for later 
reference.  If the department is set to OR, then the Baseline button is available. For other departments, the 
Routine Vital button is available.

4.2.8.1 Manually Marking the Routine Vital/Baseline

To manually mark the Routine Vital/Baseline, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Routine Vital button or Baseline button.

NOTE

• If you do not see the Baseline button or Routine Vital button in the Minitrends screen, you can select 
the Setup button and switch on the Baseline switch, or set the Routine Vital to Manual or Auto.

4.2.8.2 Configuring Automatic Routine Vital Settings

The monitor can automatically mark the routine vital sign values. To enable this function, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Select Auto from the dropdown list of Routine Vital.

4. Select Time to set the time for marking the first routine vital sign values.
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5. Select Interval to set the interval for marking the routine vital sign values.

4.3 The OxyCRG Screen
The monitor displays the OxyCRG screen by default when the neonatology department is selected. The OxyCRG 
screen is available in any department setting, but only when the patient size is set to Neo. This screen displays 6-
minute HR, SpO2 trends, CO2/Resp compressed waveform, ABD parameters, and the latest ABD events.

The OxyCRG function is intended for neonatal patents only.

4.3.1 Entering the OxyCRG Screen
To enter the OxyCRG screen, choose any of the following ways:

■ Swipe left or right on the touchscreen with two fingers to switch to the OxyCRG screen.

■ Select the OxyCRG quick key.

■ Select the Screen Setup quick key → select the Choose Screen tab → select OxyCRG.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select OxyCRG.

4.3.2 The Display of the OxyCRG Screen
The following figure shows the OxyCRG screen. Your display may be configured to look slightly different.

4.3.3 OxyCRG Events
The following table lists the ABD events and their criteria:

 (1) HR, SpO2 trend

(2) Resp/CO2 compressed waveform

(3) Event time

(4) Event type

(5) Parameter values of ABD events

(6) ABD event list: displays the latest red ABD events. Selecting the ABD event list area enters the OxyCRG review 
page.

(7) Mark button: opens the Mark dialog to edit the events.

(8) ABD event prompt area: displays parameter values of currently active OxyCRG events.

(1)

(2)

(3) (4) (5)

(6)

(7)(8)

Event type Description Remarks

A Apnea event: the apnea duration exceeds the threshold.

• A20: the apnea duration is greater or equal to 20 seconds.

• A15: the apnea duration is between 15 to 20 seconds (excluding 20 seconds).

• A10: the apnea duration is between 10 to 15 seconds (excluding 15 seconds).

A20 is a red event
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NOTE

• The monitor records all ABD events for OxyCRG review, but only red events displays in the ABD list of 
the OxyCRG screen.

4.3.4 The Display of the ABD Event Area
The ABD event area displays parameter values of currently active OxyCRG events and lists the latest red ABD 
events.

4.3.5 Setting OxyCRG Parameters
Select parameter trends or compressed waveform to set parameters and the compressed waveform you want to 
display. The selected parameters will be used for ABD event calculation.

4.3.6 Setting the Threshold of ABD Events
Select any parameter trend or the compressed waveform to perform the following setup:

■ Set the threshold of ABD events.

■ Set Event Storage Format:

◆ 1 min+3 min: stores data one minute before and three minutes after the event.

◆ 3 min+1 min: stores data three minutes before and one minute after the event.

◆ 2 min+2 min: stores data two minutes before and two minutes after the event.

The stored data includes the trends of the OxyCRG parameters, compressed waveform, alarm thresholds, NIBP, 
and Temp measurements.

4.3.7 Editing ABD Events
To edit ABD events, follow this procedure:

1. Select the Mark button to enter the Mark dialog box.

2. Drag the event list upwards and downwards to select the desired event.

3. Select the patient’s status when the event happened.

4. Select Save.

4.4 The Targeted Goal Screen
If you are concerned with specific parameters and their trends, you can use the Targeted Goal screen. The 
Targeted Goal screen focuses on the target parameter and displays parameter measurements in big numerics. 
You can easily identify whether parameter target is reached via a dashboard and review the statistics of the 
target parameter by sections.

The Targeted Goal screen displays parameter measurements and waveforms of ECG, SpO2, IBP, PI, PR, CO2, Resp, 
NIBP, and Temp. You can define the target parameter and secondary parameters. The measurements of these 
parameters displays in big numerics.

B Low Heart Rate event: the duration of low heart rate exceeds the threshold. /

D Low SpO2 event: the duration of SpO2 Desat exceeds the threshold. /

BD Low Heart Rate and low SpO2 happen at the same time. /

AB Apnea and Low Heart Rate happens at the same time. Red event

AD Apnea and low SpO2 happen at the same time. Red event

ABD Apnea, Low Heart Rate, and low SpO2 happen at the same time. Red event

Event type Description Remarks
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4.4.1 Entering the Targeted Goal Screen
To enter the Targeted Goal screen, choose any of the following ways:

■ Select the Screen Setup quick key → select the Choose Screen tab → select Targeted Goal screen.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select Targeted 
Goal Screen.

■ If the Patient Category is set to Neo, swipe left or right on the touchscreen with two fingers to switch to 
the Targeted Goal screen.

4.4.2 The Display of the Targeted Goal Screen
 The following figure shows the Targeted Goal screen. Your display may be configured to look slightly different.

4.4.3 Configuring the Targeted Goal Screen Layout
To configure the parameter numerics, waveforms, and their sequence displayed on the Targeted Goal screen, 
follow this procedure:

1. Access the Targeted Goal screen in either of the following ways:

◆ Select the Screen Setup quick key → select the Choose Screen tab → select Targeted Goal screen.

◆ Select the Main Menu quick key → from the Display column select Choose Screen → select 
Targeted Goal Screen.

2. Select a parameter numeric area or waveform area, and then from the popup list select an element to 
display in this area. The parameters and waveforms not selected will not displayed.

(5)

(6)

(1)

(2)

(3)

(4)

(1) Parameter trends area: displays trends of the target parameter and secondary parameters. If the target 
parameter is Art, this area only lists the trend of arterial pressure.

(2) Target parameter statistics area: displays the statistics of the target parameter by sections.

(3) Other parameter area: displays parameter measurements and alarm limits of parameters other than the target 
parameter and secondary parameters.

(4) Target parameter area: displays the measurement of the target parameter in big numerics, as well as its target 
range, and alarm limits.

• If the target parameter is Resp or PR, parameter source is also displayed.

• The dashboard shows the target range in green. 

• The △ pointer below the dashboard indicates the current measurement value.

(5) Secondary parameters area: displays parameter measurement of secondary parameters in big numerics, as well 
as waveforms and alarm limits. If secondary parameters are Resp and PR, parameter sources are also displayed.

(6) Target parameter waveform area: displays the waveform of the target parameter.

• If the target parameter is Resp or PR, the waveform of the source parameter is displayed.

• If the target parameter is ECG, the fist ECG waveform is displayed by default.
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4.4.4 Operating the Targeted Goal Screen
You can access parameter setup and trends review from the Targeted Goal screen. To do so, follow this 
procedure:

■ Select the parameter trends area to enter the Tabular Trends review page.

■ Select the target parameter statistics area to enter the parameter statistics setup dialog. Set the range of 
each section and the target section.

■ Select the desired waveform area, parameter numeric area, or dashboard to enter corresponding 
parameter setup dialog.

4.5 Remote View
The patient alarm and real time physiological data of the N1 can be viewed by other networked monitors. When 
the external display is connected, you can also observe alarm conditions and view real time physiological data 
from patients on other networked monitoring devices. 

A device from a remote site is called a remote device or bed. You can simultaneously watch up to 12 remote 
devices. You can also view waveforms of one remote device on the external display.

You can watch the remote devices in the Remote View screen, or the alarm watch tiles on the main screen.

In the Remote View screen, you can view real time parameters and waveforms from one specific device, and 
watch the alarms of other monitored devices at the same time.

NOTE
• A particular monitor (for example Monitor #1) can be viewed by at most 32 remote devices at the 

same time, of which eight of those remote devices can watch Monitor #1’s waveforms.

4.5.1 Entering the Remote View Screen
To enter the Remote View screen, choose one of the following ways:

■ Select the Remote View quick key.

■ Select the bed at the alarm watch tile on the main screen. For more information, see 4.5.10.2 Displaying the 
Alarm Watch Tile on the Main Screen.

■ Select the Screen Setup quick key → select the Choose Screen tab → select Remote View.

4.5.2 About the Remote View
The following figure shows the Remote View screen.
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WARNING

• The data presented in the Remote View screen has a delay. Do not rely on this screen for real time 
data.

4.5.3 Adding a Bed
After adding the desired remote devices, then the alarms from these devices can be viewed on the monitor. To 
add a remote device, follow this procedure:

1. Enter the Select Bed dialog. To do so, choose either of the following ways:

◆ In the Remote View screen, select Select Bed. For more information, see 4.5.1 Entering the Remote 
View Screen.

◆ Select the  icon at the alarm watch tile if the tile is configured to display on the main screen.

2. In the Select Bed dialog, select a desired department. All the beds under this department will be listed.

3. Select a desired tile at the A-W1 or A-W2 areas and then select a bed from the bed list. The selected bed will 
appear in the tile. 

(3)

(1)

(2)

(1) Alarm watch area

Displays all the monitored remote beds. Each bed displays the room number, bed number, connection 
status and alarm status. The background color indicates the alarm status on the corresponding bed.

Background Color Description

Green No alarm is occurring at the bed.

Red The remote device is disconnected or a high priority alarm is currently the highest alarm 
level on the bed. If the remote device is disconnected, the  icon is displayed.

Yellow The medium priority alarm is currently the highest alarm level on the bed.

Cyan The low priority alarm is currently the highest alarm level on the bed.

Grey The bed is in the standby mode.

(2) Main area

Displays the patient’s information, alarm status and messages, waveforms, measurements, etc. of the selected bed. 
This bed is called main bed.

(3) Remote View setup button: select it to enters the Remote View setup menu.
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NOTE

• The added bed is indicated by a check mark (√) at the left of the bed list.

4.5.4 Removing a Bed
To remove a remote device from remote monitoring, follow this procedure:

1. Enter the Select Bed dialog. Choose either of the following ways:

◆ In the Remote View screen, select Select Bed. For more information, see 4.5.1 Entering the Remote 
View Screen.

◆ Select the  icon in the alarm watch tile if the tile is configured to display on the main screen.

2. In the Select Bed dialog, select a bed at the A-W1, A-W2 or A-W3 areas, and then select Clear Bed. If you 
want remove all beds, select Clear All Beds.

4.5.5  Displaying the Main Bed
In the Remote View screen, you can select a bed in the alarm watch area, then the main body of the Remote 
View screen will display the real time monitoring screen of the device. 

4.5.6 Saving a Manual Event
You can initiate a manual event on the remote monitor by selecting Manual Event in the Remote View screen. 

4.5.7 Managing Alarms from Remote Devices
You can view and manage the alarms coming from remote devices.

If the monitor and remote devices have alarms at the same time, the monitor presents alarms according to the 
following rules:

■ If the alarm tone pattern for the monitor is same as that for the remote devices, the monitor prioritizes all 
the alarms and sounds the highest alarm tone.

■ If the alarm tone pattern for the monitor is different from that for the remote devices, the monitor sounds 
the alarms in their corresponding tone. 

The monitor provides the same alarm tone pattern for the remote device alarms as those for the monitor alarms 
by default. You can change the alarm tone pattern of the remote monitor; see 21.3.5.5 Setting the Tone Pattern for 
Alarms from Remote Devices.

4.5.8 Resetting Alarms for Remote Devices
You can reset the alarms on the remote devices by selecting Alarm Reset in the Remote View screen. This 
function needs to be enabled. For more information, see 21.3.5.1 Resetting Alarms for Remote Devices.

4.5.9 Selecting Beds By Care Group
If configured, the monitor automatically selects beds in the same care group during the shift of care groups in 
the CMS. To enable this function, follow this procedure:

1. Enter the Select Bed window. Choose either of the following ways:

◆ In the Remote View window, select Select Bed. For more information, see 4.5.1 Entering the Remote 
View Screen for entering the Remote View window.

◆ Select the  icon in the alarm watch tile if the tile is configured to display on the main screen.

2. In lower left corner of the Select Bed window, select Select Beds By Care Group.

4.5.10 Alarm Watch 
The alarm watch function provides the alarm notification by color and sound. 

■ The monitor sounds the highest priority alarm tone from all the monitored remote devices.
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■ The monitor displays the highest priority alarm in corresponding background color for each bed at the 
following areas:

◆ At the top of the Remote View. For more information, see 4.5.2 About the Remote View for details.

◆ On the main screen. For more information, see 4.5.10.1 About Alarm Watch Tile for details.

4.5.10.1 About Alarm Watch Tile

The main screen can display two alarm watch tiles, namely A-W1 and A-W2. Each tile can accommodate up to six 
beds. 

The following figure shows the alarm watch tiles.

The alarm watch tile is similar to alarm watch area in the Remote View. For more information, see 4.5.2 About the 
Remote View.

4.5.10.2 Displaying the Alarm Watch Tile on the Main Screen

To configure the alarm watch tile to be displayed on the monitor’s main screen, follow this procedure:

1. Select the Main Menu quick key → from the Display column select Choose Screen to enter the Screen 
Setup dialog.

2. Select the Tile Layout tab.

3. Select the numeric area where you want to display the alarm watch tile, and then in the drop-down list, 
select Alarm Watch → A-W1 or A-W2.

4.5.11 Auto Displaying the Alarm Bed
The monitor provides the function of automatically displaying the remote alarm bed. If this function is enabled, 
when a remote bed issues an alarm, the monitor automatically displays the monitoring information from this 
remote bed.

If multiple remote beds issue alarms, the monitor cyclically displays the alarm beds as per the preset interval and 
in the order of alarm time. 

The auto displaying alarm bed function is disabled by default. To enable this function, follow this procedure:

1.  From the Remote View screen, select  to enter the Remote View setup menu.

2. Switch on Rollup Alarm Beds.

3. Set Rollup Interval:

(1)

(5) (4)(3)

(2)(1)

(3)

(1) Alarm watch tile label

(2) Disconnection icon: when the remote device is disconnected, this icon displays at the tile, and the tile 
background color is red.

(3) Select bed icon: select it to enter the Select Bed dialog.

(4) More than one bed tile: when more than one bed is assigned to a tile, the tile displays the alarm status, 
connection status, etc.

(5) One bed tile: when only one bed is assigned to a tile, the tile displays the parameter value and alarm 
message from this bed, etc.
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◆ Off: do not cyclically display the remote alarm beds. Once a new alarm is issued, the monitor 
automatically switches to the new alarm bed.

◆ 10 sec, 20 sec, or 30 sec: If multiple remote beds issue alarms, the monitor cyclically displays the 
alarm beds as per the preset interval and alarm priority in the order of alarm time. 

4. Set Alarm Priority:

◆ High Only: Only when a high priority alarm is issued, the monitor automatically switches to the alarm 
bed.

◆ High & Med: If Rollup Interval is set to Off and when a high priority alarm or medium priority alarm is 
issued, the monitor automatically switches to the alarm bed. If Rollup Interval is set to 10 sec, 20 sec, 
or 30 sec and multiple remote beds issue alarms, the monitor cyclically displays the alarm beds with 
higher priority in the order of alarm time. For example, if both high priority alarms or medium priority 
alarm are issued, only beds with high priority alarms are cyclically displayed. 

4.6 Freezing Waveforms
During patient monitoring, the freeze feature allows you to freeze the currently displayed waveforms on the 
screen so that you can have a close examination of the patient’s status. Additionally, you can select any frozen 
waveform for recording.

4.6.1 Freezing Waveforms
To freeze waveforms, select the Freeze quick key. Except waveforms of the following screens, all displayed 
waveforms stop refreshing and scrolling after you select the Freeze quick key:

■ Minitrends screen

■ oxyCRG screen

■ Remote View screen

■ EWS screen

4.6.2  Viewing Frozen Waveforms
To view the frozen waveforms, follow this procedure:

■ Select the   or  button in the Freeze dialog.

■ Slide the frozen waveform leftward or rightward. 

At the lower right corner of the bottom most waveform displays the freeze time. The initial frozen time is 0 s. 
With the waveforms scrolling, the freeze time changes at an interval of 1 second. For example, -2 s means the 
two seconds before the frozen time. This change will be applied for all waveforms on the screen.

NOTE

• You can view the frozen waveforms of up to 120 seconds.

4.6.3 Unfreezing Waveforms
To unfreeze the frozen waveforms, select the  button upper right corner of the Freeze dialog.

4.6.4 Printing Frozen Waveforms
To print the frozen waveforms, select the  button at the upper left corner of the Freeze dialog.
BeneVision N1 Patient Monitor Operator’s Manual 4 - 13



This page intentionally left blank.
4 - 14  BeneVision N1 Patient Monitor Operator’s Manual



5 Managing Patients

5.1 Starting Monitoring a Patient
After turning on the monitor, follow this procedure to monitor a patient:

1. Admit the patient.

2. Check patient settings. Make sure that alarm limits, patient category and paced status, and so on, are 
appropriate for the patient. Change them if necessary.

3. Perform desired measurements. For more information, see corresponding measurement chapters.

5.2 Admitting a Patient
The monitor admits a new patient in the following situations:

■ After a patient is manually discharged, the monitor automatically admits a new patient.

■ After being switched off for the selected time period, the monitor automatically discharges the previous 
patient and admits a new patient at startup.

■ If the monitor has not detected certain patient vital signs (ECG, SpO2, PR, RR, NIBP) for 30 minutes, it will 
prompt whether to start monitoring a new patient if any of the above vital signs are detected again. 

Always input patient information as soon as the patient is admitted. For more information, see 5.2.2 Editing 
Patient Information for details.

WARNING

• The default Patient Category setting is Adult, and Paced setting is Unspecified. Set Paced and check 
if the Patient Category setting is correct for the patient.

• For paced patients, set Paced to Yes. If it is incorrectly set to No, the monitor could mistake a pace 
pulse for a QRS and fail to alarm when the ECG signal is too weak.

• For non-paced patients, set Paced to No. 

5.2.1 Entering the Patient Management Dialog
Use any of the following methods to enter the Patient Management dialog:

■ Select the patient information area at the top left corner of the screen.

■ Select the Patient Management quick key (only available when the N1is used with the independent 
external display).

■ Select the Main Menu quick key → from the Patient Management column select Patient Management.

5.2.2 Editing Patient Information
Edit patient information after a patient has been admitted, or when patient information is incomplete, or when it 
is necessary to change patient information:

To edit patient information, follow this procedure:

1. Enter the Patient Management dialog. For more information, see5.2.1 Entering the Patient Management 
Dialog.

2. Edit patient information as required.

If a barcode reader is connected to the monitor, scanning the patient’s barcode will enter the patient’s 
information.
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NOTE

• The monitor will reload the configuration if you change the patient category.

5.2.3 Loading Patient Information from the CMS
If the monitor is connected to the central monitoring system (CMS). You can load patient information from the 
CMS to the monitor. To do so, follow this procedure:

1. Enter the Find Patient dialog in either of the following ways:

◆ Select the Main Menu quick key → from the Patient Management column select Find Patient.

◆ From the Patient Management dialog select Find Patient.

2. Input query criteria.

3. Select Search. Then a list pops up, including all the patients that meet the query criteria.

4. Select a patient from the patient list, and then select Admit. Corresponding patient information in the 
monitor will be updated.

NOTE

• If ADT Query is switched on, input query criteria from the Discharged Patients page.

5.2.4 Loading Patient Information from the ADT Server
If the monitor is connected with the Admit-Discharge-Transfer (ADT) server through the eGateway. You can load 
patient information from ADT server to the monitor. 

To do so, follow this procedure:

1. Enter the Find Patient dialog in either of the following ways:

◆ Select the Main Menu quick key → from the Patient Management column select Find Patient.

◆ Select Find Patient from the Patient Management dialog.

2. Input query criteria.

3. Select Search. Then a list pops up, including all the patients that meet the query criteria.

4. Select a patient from the patient list, and then select Admit. Corresponding patient information in the 
monitor will be updated.

NOTE

• You can load patient information from the ADT server only when ADT Query is enabled. For more 
information, see 21.12.9 Using the ADT Gateway.

• The monitor can automatically upload the patient information from the ADT server when:

◆  The configured keywords of the monitor and the eGateway are the same.

◆ The IP address of the monitor is added to the eGateway configuration dialog.

• Loading patient information from the ADT server updates only patient information in the monitor. 
The patient’s monitoring data is not changed and the patient is not discharged.
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5.3 Transferring Patient
Patient settings and data can be transferred from an N1 into a host monitor. The patient settings and data 
includes patient information, trend data, alarm events, and parameter alarm limits. The N1 also allows transfer of 
full disclosure data.

For detailed information about patient data transfer, refer to the user manual of the host monitor. For the 
connection of N1 and the host monitor, refer to section 2.9 N1 in Use with a Host Monitor.

WARNING

• Do not discharge a patient on the bedside monitor before patient information is completely 
transferred. Discharging the patient during transfer will result in incomplete patient information.

NOTE

• The system automatically switches on the HR/PR (high, low) alarms and lethal arrhythmia alarms 
after transferring the patient data.

5.4 Exporting Patient Data
To export the data of the current patient and discharged patients, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the USB drive to the Dock’s USB connector. 

3. Access the Discharged Patients dialog box by selecting the Main Menu quick key → from the Patient 
Management column select Discharged Patients.

4. From the patient list select desired patients.

5. Select Export Patient Data.

5.5 Deleting Patient Data
To delete the data of discharged patients, follow this procedure:

1. Access the Discharged Patients dialog box by selecting the Main Menu quick key → from the Patient 
Management column select Discharged Patients.

2. From the patient list select desired patients.

3. Select Delete.

5.6 Stopping a Parameter Measurement
To stop monitoring a parameter, follow this procedure:

1. Remove corresponding sensor from the patient.

2. Disconnect the sensor from the patient cable.

3. Disconnect the patient cable from the parameter module.

5.7 Discharging a Patient
Before monitoring a new patient, discharge the previous patient. The technical alarms are reset, and monitor 
settings return to their defaults. For more information, see 20.3 Setting Default Patient Category. 

After a patient is discharged, the monitor automatically admits a new patient.

WARNING

• Always discharge the previous patient before starting to monitor a new patient. Failure to do so can 
lead to data being associated with the wrong patient.
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 To manually discharge a patient, use any of the following methods to access the Discharge Patient dialog:

■ Swipe down the touchscreen with two fingers.

■ Select the Discharge Patient quick key (only available when the N1is used with the independent external 
display).

■ Select the patient information area at the top left corner of the screen→ Discharge Patient.

■ Select the Patient Management quick key → Discharge Patient (only available when the N1is used with 
the independent external display).

■ Select the Main Menu quick key → from the Patient Management column select Discharge.

Select a button in the Discharge Patient  dialog:

■ Print End Case Report: prints the end case report when the patient is discharged.

■ Discharge: clears the waveform data of the current patient. The monitor loads the default configuration 
and goes to the standby mode. The current patient becomes a discharged patient.

■ Clear Patient Data: discharges the current patient and clears the waveform data. The monitor still uses the 
current configuration and does not go to the standby mode. The current patient becomes a discharged 
patient.
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6 Alarms

6.1 Alarm Introduction
This chapter describes alarm functions and alarm settings.

6.2 Alarm Safety Information

WARNING

• A potential hazard can exist if different alarm presets and default configuration settings are used for 
the same or similar equipment in the same care area, for example an intensive care unit or cardiac 
operating room.

• If the monitor is connected to the central monitoring system (CMS) or other monitors, alarms can be 
presented and controlled remotely. Remote suspension, inhibition, or reset of monitor alarms via 
the CMS or other monitors may cause a potential hazard. For more information, see the operator’s 
manuals for the CMS and the other monitors. 

• The monitors in the care area may each have different alarm settings to suit different patients. 
Always check that the alarm settings are appropriate for the patient before starting the monitoring. 
Always make sure that necessary alarm limits are active and set according to the patient's clinical 
condition.

• Setting alarm limits to extreme values may cause the alarm system to become ineffective. For 
example, setting the SpO2 high alarm limit to 100%, is equivalent to switching the alarm off. 

• When the alarm sound is switched off, the monitor gives no alarm tones even if a new alarm occurs. 
Be careful when considering to switch off the alarm sound. When the alarms are off or while alarm 
audio is paused either temporarily or indefinitely, observe the patient frequently.

• When monitoring patients that are not continuously attended by a clinical operator, properly 
configure the alarm system and adjust alarm settings as per the patient's condition. 

• Do not rely exclusively on the audible alarm system for monitoring. Adjustment of alarm volume to a 
low level may result in a hazard to the patient. 

6.3 Understanding the Alarms

6.3.1 Alarm Categories 
The monitor has two different types of alarms: physiological alarms and technical alarms. 

■ Physiological alarms are triggered by patient measurement exceeding the parameter limits, or by an 
abnormal patient conditions.

■ Technical alarms are triggered by an electrical, mechanical, connectivity, or other monitor abnormal 
operation, or by failure of a sensor or component. Technical alarm conditions may also be caused when an 
algorithm cannot classify or interpret the available data.

Apart from the physiological and technical alarms, the monitor can also prompt with some messages describing 
the system status or patient status. 

6.3.2 Alarm Priorities
By severity, the alarms are classified into the following priority levels:

■ High priority alarms: indicate a life threatening situation or a severe device malfunction. High priority 
alarms require an immediate response.

■ Medium priority alarms: indicate abnormal vital signs or a device malfunction. Medium priority alarms 
require a timely response.
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■ Low priority alarms: indicate a discomfort condition, a device malfunction, or an improper operation. Low 
priority alarms require you to be aware of this condition.

■ Messages: provides additional information on the patient or the equipment.

6.3.3 Alarm Indicators
When an alarm occurs, the monitor indicates it through visual or audible alarm indications. For more 
information, see the following table.

NOTE

• When multiple alarms of different priority levels occur simultaneously, the monitor selects the 
highest priority alarm to light the alarm lamp and issue the alarm tone.

• When multiple alarms of different priority levels occur simultaneously and should be displayed in 
the same area, the monitor only displays the messages from the highest priority alarm.

• When multiple alarms of the same priority levels occur simultaneously alarm messages are 
displayed cyclically.

• Some physiological alarms, such as Asystole, are exclusive. They have identical alarm tones and 
alarm lights with normal high level physiological alarms, but their alarm messages are displayed 
exclusively. That is, when an exclusive physiological alarm and a normal high level physiological 
alarm are triggered simultaneously, only exclusive physiological alarm message will be displayed.

Alarm Indicator High Priority 
Alarm

Medium 
Priority Alarm

Low Priority 
Alarm

Message Comments

Alarm lamp Red

Flashing 
frequency: 1.4 - 
2.8 Hz

Duty cycle: 20 - 
60% on

Yellow

Flashing 
frequency: 0.4 - 
0.8 Hz

Duty cycle: 20 - 
60% on

Cyan

No flashing

Duty cycle: 
100% on

None None

Audible 
tone 
pattern

ISO Repeat pattern 
of triple + 
double + triple 
+ double beeps 

Repeat pattern 
of triple beeps 

Single beep None None

Mode 1 Repeat pattern 
of high-pitched 
single beep 

Repeat pattern 
of double beeps

Low-pitched 
single beep

None

Mode 2 Repeat pattern 
of high-pitched 
triple beeps 

Repeat pattern 
of double beeps

Low-pitched 
single beep

None

Alarm message White text 
inside a red box

Black text inside 
a yellow box

Black text inside 
a cyan box

White 
text

Alarm messages are 
displayed in the alarm 
information area at the 
top of the screen. You 
can select the alarm 
messages to show the 
alarm list.

Alarm priority 
indicator

*** ** * None The indicator appears in 
front of the 
corresponding alarm 
message.

Parameter value White text 
inside a flashing 
red box

Black text inside 
a flashing 
yellow box

Black text 
inside a flashing 
cyan box 

None None
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6.3.4 Alarm Status Symbols 
Apart from the alarm indicators as described in 6.3.3 Alarm Indicators, the monitor uses the following symbols 
to indicate the alarm status: 

6.4 Accessing On-screen Help for Technical Alarms (AlarmSight)
In the technical alarm list, alarm messages followed by Detail include help messages or pictures to help you 
identify the problem. This function is called AlarmSight. To access AlarmSight, follow this procedure:

1. Select an alarm displaying in the technical alarm information area to enter the Alarms dialog.

2. From the alarm list select the desired alarm. 

NOTE

•  If there are no displayed alarms, then selecting the technical alarm area will not open any dialogs.

6.5 Checking the Physiological Alarms List
If the patient monitor has more than one physiological alarm, you can see the physiological alarm list by 
selecting the physiological alarm information area to enter the Alarms dialog. If there is only one physiological 
alarm, selecting the physiological alarm information area enters the Review dialog for the event created by this 
alarm.

6.6 Changing Alarm Settings
Alarms settings can be changed by selecting Main Menu and choosing from the list in the Alarm column.

6.6.1 Setting Parameter Alarm Properties
To set parameter alarm properties, follow this procedure:

Alarm pause: indicates that all the alarms are paused.

Alarm off: indicates that individual measurement alarms are turned off or the system is in the 
alarm off status. 

Audio pause: indicates that audible alarm tones are paused.

Audio off: indicates that audible alarm tones are turned off.

 Alarm reset: indicates that the alarm system is reset.
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1. Select the Main Menu quick key → from the Alarm column select Limits.

2. Enter the password if required.

3. Select a parameter tab and set alarm properties as desired.

You can also change the alarm properties of individual parameter from the corresponding parameter dialog.

NOTE

• The monitor can be configured to require an password or login to change alarm settings. For more 
information, refer to 21.13.3 Selecting Password for User Authentication.

6.6.2 Changing the Alarm Volume

To change the alarm volume, follow this procedure:

1. Select the Main Menu quick key → from the Alarm column select Setup.

2. Set Alarm Volume. The alarm volume can be set from X to 10, in which X is the minimum volume allowed 
by your department, and 10 is the maximum volume.

3. Select High Alarm Volume to set the volume of the high priority alarm.

4. Select Reminder Volume to set the volume of the reminder tone. 

NOTE

• When the alarm volume is set to 0, the alarm sound is turned off and the audio off symbol appears 
on the screen.

• You cannot set the volume of high priority alarms if Alarm Volume is set to 0. 

• You can set the Alarm Volume to 0 only when your monitor is connected to the CMS. If your monitor 
is not connected to the CMS, the lowest setting of Alarm Volume is 1.

• When the monitor is connected to the CMS and Alarm Volume is set to 0, Alarm Volume 
automatically changes to 2 if the CMS is disconnected.

6.6.3 Setting the Auto Limits for New Patient Switch
If the Auto Limits for New Patient function is enabled, a dialog box can pop up to ask you whether to set alarm 
limits based on the latest parameter measurements for a newly admitted patient. To set the Auto Limits for 
New Patient switch, follow this procedure:

1. Enter the alarm setup page in any of the following ways:

◆ Select the Alarm Setup quick key → select the Setup tab.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

2. Set the Auto Limits for New Patient switch. 
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When Auto Limits for New Patient is switched on, the confirmation dialog box pops up if all of the following 
requirements are met: 

■ Within 10 minutes after the patient is admitted.

■ Continuous measurements are stable.

■ An NIBP measurement has been taken.

■ HR alarm switch is on.

■ No lethal alarms are triggered.

■ The patient is not in poor perfusion condition.

■ Alarm limits of no parameters were manually changed. 

■ The monitor is not in intubation mode, private mode, or CPB mode. 

NOTE

• The Auto Limits for New Patient function is intended for newly admitted patients only.

• The automatically set alarm limits take effect only after being confirmed.

6.6.4 Initiating Auto Alarm Limits
The monitor provides the auto alarm limits function to automatically adjust alarm limits according to the 
patient’s vital signs. When auto limits are selected, the monitor calculates safe auto limits based on the latest 
measured values. To get accurate auto alarm limits, collect a set of measured vital signs as a baseline. 

To initiate auto alarm limits, follow this procedure:

1. Select the Main Menu quick key → from the Alarm column select Limits.

2. From the Limits page, select Auto Limits at the left bottom.

3. Select Ok from the popup dialog box.

Then the monitor will automatically calculate alarm limits based on the latest measured values. Before applying 
these automatically created alarm limits, confirm if they are appropriate for the patient from the Limits dialog. If 
not, you can adjust them manually. These alarm limits will remain unchanged until you select auto limits again or 
adjust them manually.

The monitor calculates auto limits based on the following rules:

Module Parameter Lower Limit Upper Limit Auto Limit Range

Adult/
pediatric

Neonate Adult/
pediatric

Neonate

ECG HR/PR 
(bpm)

HR × 0.8 or 40 
(whichever is 
greater)

(HR - 30) or 90 
(whichever is 
greater)

HR × 1.25 or 
240 
(whichever is 
smaller)

(HR + 40) or 
200 
(whichever is 
smaller)

Adult/pediatric: 35 to 240

Neonate: 55 to 225

Resp RR (rpm) RR × 0.5 or 6 
(whichever is 
greater)

(RR - 10) or 30 
(whichever is 
greater)

(RR × 1.5) or 
30 (whichever 
is smaller)

(RR + 25) or 
85 (whichever 
is smaller)

Adult/pediatric: 6 to 55

Neonate: 10 to 90

SpO2 SpO2 (%) Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range
BeneVision N1 Patient Monitor Operator’s Manual 6 - 5



NIBP NIBP-S 
(mmHg)

(SYS × 0.68 + 
10) 

(SYS - 15) or 
45 (whichever 
is greater)

(SYS × 0.86 + 
38) 

(SYS + 15) or 
105 
(whichever is 
smaller)

Adult: 45 to 270

Pediatric: 45 to 185

Neonate: 35 to 115

NIBP-D 
(mmHg)

(Dia × 0.68 + 
6) 

(Dia - 15) or 
20 (whichever 
is greater)

(Dia × 0.86 + 
32) 

(Dia + 15) or 
80 (whichever 
is smaller)

Adult: 25 to 225

Pediatric: 25 to 150

Neonate: 20 to 90

NIBP-M 
(mmHg)

(Mean × 0.68 
+ 8) 

(Mean - 15) or 
35 (whichever 
is greater)

(Mean × 0.86 
+ 35) 

(Mean + 15 or 
95) 
(whichever is 
smaller)

Adult: 30 to 245

Pediatric: 30 to 180

Neonate: 25 to105

Temp

(xx refers 
to 
temperat
ure site)

Txx (°C) (Txx - 0.5) (Txx - 0.5) (Txx + 0.5) (Txx + 0.5) 1 to 49 

ΔT (°C) Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

IBP: ART/
Ao/UAP/
BAP/FAP/
LV/P1-P4 
(Arterial 
pressure)

IBP-S 
(mmHg)

SYS × 0.68 + 
10

(SYS - 15) or 
45 (whichever 
is greater)

SYS × 0.86 + 
38 

(SYS + 15) or 
105 
(whichever is 
smaller)

Adult: 45 to 270

Pediatric: 45 to 185

Neonate: 35 to 115

IBP-D 
(mmHg

(Dia × 0.68 + 
6)

(Dia - 15) or 
20 (whichever 
is greater)

(Dia × 0.86 + 
32)

(Dia + 15) or 
80 (whichever 
is smaller)

Adult: 25 to 225

Pediatric: 25 to 150

Neonate: 20 to 90

IBP-M 
(mmHg)

Mean × 0.68 + 
8 

(Mean - 15) or 
35 
(whichever is 
greater)

Mean × 0.86 + 
35

(Mean + 15) 
or 95 
(whichever is 
smaller)

Adult: 30 to 245

Pediatric: 30 to180

Neonate: 25 to 105

IBP: PA IBP-S 
(mmHg)

SYS × 0.75 SYS × 0.75 SYS × 1.25 SYS × 1.25 3 to 120

IBP-D 
(mmHg

Dia × 0.75 Dia × 0.75 Dia × 1.25 Dia × 1.25 3 to 120

IBP-M 
(mmHg)

Mean × 0.75 Mean × 0.75 Mean × 1.25 Mean × 1.25 3 to 120

IBP: CPP CPP 
(mmHg)

CPP × 0.68 + 8 (CPP-15) or 
35, 
(whichever is 
greater)

CPP × 0.86 + 
35

(CPP+15) or 
95, 
(whichever is 
smaller)

Adult: 20 to 235

Pediatric: 25 to175

Neonate: 25 to 100

IBP: CVP/
LAP/
RAP/
UVP/P1-
P4 
(Venous 
pressure)

IBP-M 
(mmHg)

Mean × 0.75 Mean × 0.75 Mean × 1.25 Mean × 1.25 3 to 40

Module Parameter Lower Limit Upper Limit Auto Limit Range

Adult/
pediatric

Neonate Adult/
pediatric

Neonate
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6.6.5 Setting the Apnea Delay Time
To set the apnea delay time, follow this procedure:

1. Select the Main Menu quick key → from the Alarm column select Setup.

2. Select Apnea Delay to set the apnea delay time.

6.6.6 Switching On or Off V-Tach Latching
When V-Tach Latching Lock is switched on, you can switch on or off V-Tach Latching. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the Alarm column select Setup.

2. Switching on or off V-Tach Latching.

For information on the V-Tach Latching function, see 21.3.4 Latching Physiological Alarms.

6.6.7 Restoring the Default Alarm Settings
To reset all alarm settings to the defaults, follow this procedure:

1. Select the Main Menu quick key → from the Alarm column select Limits.

2. On the Limits page, select Defaults at the bottom.

6.6.8 Setting the Length of Printed Waveforms
You can define the length of printed waveforms when an alarm is triggered. To do so, follow this procedure:

1. Select the Main Menu quick key → from the Alarm column select Setup.

2. Set Printing Duration On Alarm.

CO2 EtCO2 
(mmHg)

0 to 32: 
remains the 
same

0 to 32: 
remains the 
same

0 to 32: 
remains the 
same

0 to 32: 
remains the 
same

Same as the 
measurement range

33 to 35: 29 33 to 35: 29 33 to 35: 41 33 to 35: 41 Same as the 
measurement range

36 to 45: 
(etCO2 - 6)

36 to 45: 
(etCO2 - 6)

36 to 45: 
(etCO2 + 6)

36 to 45: 
(etCO2 + 6)

Same as the 
measurement range

46 to 48: 39 46 to 48: 39 46 to 48: 51 46 to 48: 51 Same as the 
measurement range

>48: remains 
the same

>48: remains 
the same

>48: remains 
the same

>48: remains 
the same

Same as the 
measurement range

FiCO2 None None Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

awRR 
(rpm)

awRR × 0.5 or 
6 (whichever 
is greater)

(awRR - 10) or 
30 (whichever 
is greater)

awRR × 1.5 or 
30 (whichever 
is smaller)

(awRR+25) or 
85 rpm 
(whichever is 
smaller)

Adult/pediatric: 6 to 55

Neonate: 10 to 90

Module Parameter Lower Limit Upper Limit Auto Limit Range

Adult/
pediatric

Neonate Adult/
pediatric

Neonate
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6.7 Pausing Alarms/Pausing Alarm Tones 
You can either pause alarms or pause alarm tones. This depends on the pause setting. To set the pause function, 
refer to 21.3.3 Defining the Pause Function.

6.7.1 Pausing Alarms
If the Pause function is configured to alarm pause, pressing the Alarm Pause quick key can temporarily disable 
alarm indicators. For the configuration of the pause function, see 21.3.3 Defining the Pause Function. When alarms 
are paused, the following rules are followed:

■ No physiological alarm will be presented.

■ For technical alarms, alarm sounds are paused, but alarm lamps and alarm messages continue to be 
presented.

■ The remaining alarm pause time is displayed in the physiological alarm information area.

■ The alarm pause symbol is displayed in the system information area.

When the alarm pause time expires, the alarm paused state is automatically deactivated. You can also cancel the 
alarm paused state by pressing the Alarm Pause quick key again. 

6.7.1.1 Prolonging the Alarm Pause Time

If enabled, you can temporarily prolong the alarm pause time after the monitor enters the alarm paused state. 
This capability is disabled by default. To prolong the alarm pause time, follow this procedure:

1. In the physiological alarm information area, select the alarm pause countdown.

2. Select Pause 5 min, Pause 10 min, or Pause 15 min.

NOTE
• Prolonging alarm pause time does not affect the setting of alarm pause time.

6.7.1.2 Switching Off All Alarms

If Pause Time is set to Permanent (see section 21.3.3.1 Setting the Alarm Pause Time/Alarm Tone Pause Time), 
pressing the Alarm Pause quick key permanently switches off all alarms. The alarm off state has the following 
features:

■ Physiological alarms are switched off. The alarm lamp does not flash and alarm sound is not issued.

■ Alarm sound of technical alarms is switched off, but alarm lamp flashes and alarm messages are presented.

■ The message Alarm Off with red background is displayed in the physiological alarm information area.

■ The alarm off symbol is displayed in the system status information area.

To exit the alarm off state, press the Alarm Pause quick key again. 

WARNING

• Pausing or switching off alarms may result in a hazard to the patient. 

6.7.2 Pausing Alarm Sound
If the Pause function is configured to Audio Pause, pressing the Audio Pause quick key pauses alarm tone and 
sets the quick key to be highlighted. For the configuration of the pause function, see section 21.3.3 Defining the 
Pause Function. When alarm tones are paused, the following rules are followed:

■ The sound of all physiological alarms and technical alarms are switched off. 

■ The remaining audio pause time is displayed in the physiological alarm information area. 

■ The audio pause symbol is displayed in the system information area.

When the audio pause time expires, the audio paused state is automatically deactivated. You can also cancel the 
audio paused state by pressing the highlighted Audio Pause quick key again. 
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6.7.2.1 Prolonging the Alarm Tone Pause Time

If enabled, you can temporarily prolong the alarm tone pause time after the monitor enters the alarm tone 
paused state. This capability is disable by default. To prolong the audio pause time, follow this procedure:

1. In the physiological alarm information area, select the alarm pause countdown.

2. Select the alarm tone pause time. Options may include Pause 5 min, Pause 10 min, or Pause 15 min.

NOTE

• Prolonging alarm pause time does not affect the setting of alarm tone pause time. 

6.7.2.2 Switching Off Alarm Sound 

If Pause Time is set to Permanent (see section 21.3.3.1 Setting the Alarm Pause Time/Alarm Tone Pause Time), 
pressing the Audio Pause quick key permanently switches off all alarm sound. The audio off state has the 
following features:

■ Alarm sound of both physiological alarms and technical alarms is switched off.

■ The audio off symbol is displayed in the system information area.

To exit the audio off state, press the Audio Pause quick key again. 

WARNING

• Pausing or switching off alarm sound may result in a hazard to the patient. 

6.8 Resetting Alarms
Press the Alarm Reset quick key to reset the alarm system. When the alarm system is reset, the alarm reset 
symbol displays in the system status information area for alarm symbols.

NOTE
• If a new alarm is triggered after the alarm system is reset, the alarm reset icon will disappear and the 

alarm light and alarm tone will be reactivated. 

6.8.1 Resetting Physiological Alarms
For physiological alarms, when the alarm system is reset, the following occur:

■ The alarm sound is silenced.

■ A √ appears before the alarm message.

■ The color of the parameter numeric background corresponds with the alarm priority, but the parameter 
numeric does not flash.

6.8.2 Resetting Technical Alarms
For technical alarms, when the alarm system is reset, the following occur:

■ Some technical alarms are cleared. The monitor gives no alarm indications.

■ Some technical alarms are changed to prompt messages.

■ For some technical alarms, the alarm is silenced and a √ appears before the alarm message. 

For details about the indications of technical alarms when the alarm system is reset, see D.2 Technical Alarm 
Messages.

6.9 Latching Alarms
The latching setting for physiological alarms defines how alarm indicators behave if you do not reset the alarms. 

■ If you do not “latch” physiological alarms, their alarm indications disappear when the alarm condition ends. 
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■ If you “latch” physiological alarms, all visual and audible alarm indications remain (if configured) until the 
alarms are reset. For latched alarms the time when the alarm is last triggered is displayed behind the alarm 
message. 

The monitor can be set to separately latch visual indications or simultaneously latch the visual and the audible 
indications. 

■ When visual indications are latched, visual indications, including alarm lamp, alarm message and its 
background remain when the alarm condition ends and the time when the alarm last triggered is displayed 
behind the alarm message.

■ When audible indications are latched, the monitor continues to issues alarm sounds when the alarm 
condition ends.

To set how you want to latch the physiological alarms, see section 21.3.4 Latching Physiological Alarms.

NOTE

• Changing alarm priority may affect the latching status of the corresponding alarm. Determine if you 
need to adjust the latching status for the specific alarm when you have changed its alarm priority.

• When the alarm system is reset, latched physiological alarms are cleared.

6.10 CPB Mode 
The CPB (Cardiopulmonary Bypass) mode is activated only if you set the department to OR. 

In the CPB mode, all the physiological alarms and technical alarms are switched off. So when performing CPB, you 
can put the monitor in the CPB mode to inactivate unnecessary alarms. 

6.10.1 Entering the CPB Mode
To enter the CPB mode, select the Main Menu quick key → from the Alarm column select CPB Mode.

In the CPB mode, CPB Mode is displayed in the physiological alarm area with a red background color.

NOTE

• When the CPB mode is entered, the monitor stops all NIBP measurements. You can restart NIBP 
measurements after entering the CPB mode. 

6.10.2 Exiting the CPB Mode
To exit the CPB mode, select the Main Menu quick key → from the Alarm column select Exit CPB Mode.

6.11 Intubation Mode
Intubation mode is available for Resp and CO2 monitoring. When performing intubation during general 
anesthesia, you can put the monitor in the intubation mode in order to inactivate unnecessary alarms.

In the intubation mode, Resp and CO2 related physiological alarms are switched off. 

6.11.1 Entering the Intubation Mode
To enter the intubation mode, choose either of the following ways: 

■ From the bottom of the Resp or CO2 dialog, select Intubation Mode. 

■ Select the Main Menu quick key → from the Alarm column select Intubation Mode.

6.11.2 Exiting the Intubation Mode
To exit the intubation mode, choose either of the following ways: 

■ From the bottom of the Resp or CO2 dialog, select Exit Intubation Mode. 

■ Select the Main Menu quick key from the Alarm column → select Exit Intubation Mode.
6 - 10  BeneVision N1 Patient Monitor Operator’s Manual



6.12 Testing Alarms
The monitor automatically performs a selftest at startup. Check that an alarm tone is heard, the alarm lamp 
illuminates, one after the other, in red, yellow, and cyan. This indicates that the visible and audible alarm 
indicators function correctly.

To further test individual measurement alarms, perform measurements on yourself or using a simulator. Adjust 
alarm limits and check that appropriate alarm behavior is observed.
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7 Monitoring ECG, Arrhythmia, ST and QT

7.1 ECG Introduction
The electrocardiogram (ECG) measures the electrical activity of the heart and displays it on the monitor as 
waveforms and numerics. ECG monitoring provides 3-, 5-, 6-, and 12-lead ECG monitoring, ST-segment analysis, 
arrhythmia analysis, QT/QTc measurements, and optional 12-lead resting analysis via the Glasgow algorithm.

The N1 monitor incorporating ST analysis has the ST label. 

The N1 monitor incorporating 12-lead has the 12-lead label. 

7.2 ECG Safety Information

WARNING

• This equipment is not intended for direct cardiac application.

• Ensure that the conductive parts of ECG electrodes and associated connectors, including the neutral 
electrode, do not come into contact with any other conductive parts including earth.

• Always use defibrillation-proof ECG cables during defibrillation.

• Do not touch the patient, or metal devices connected to the patient, during defibrillation.

• To minimize the hazard of burns during high-frequency surgical procedures, ensure that the 
monitor’s cables and transducers never come into contact with the electrosurgery unit (ESU).

• To minimize the hazard of burns during use of high-frequency surgical unit (ESU), the ECG 
electrodes should not be located between the surgical site and the ESU return electrode. 

CAUTION

• Only use parts and accessories specified in this manual. Follow the instructions for use and adhere to 
all warnings and cautions.

• Periodically inspect the electrode application sites to ensure skin integrity. If the skin quality 
changes, replace the electrodes or change the application site.

(1) 12-lead label (2) ST label (3) Glasgow label

(1)

(3)

(2)
BeneVision N1 Patient Monitor Operator’s Manual 7 - 1



• Interference from an ungrounded instrument near the patient or electrosurgery usage can induce 
noise and artifact into the waveforms.

7.3 ECG Display
The following figures show the ECG waveform and numeric areas. The display may be configured to look slightly 
different.

 

7.4 Preparing for ECG Monitoring

7.4.1 Preparing the Patient Skin
Proper skin preparation is necessary to ensure good signal quality at the electrode sites, as the skin is a poor 
conductor of electricity. To properly prepare the skin, choose flat areas and then follow this procedure:

1. Shave hair from skin at chosen electrode sites. 

2. Gently rub skin surface at sites to remove dead skin cells. 

3. Thoroughly cleanse the site with a mild soap and water solution. We do not recommend using ether or 
pure alcohol, because this dries the skin and increases the resistance. 

4. Dry the skin completely before applying electrodes. 

7.4.2 Applying Electrodes and Connecting the Patient
To connect ECG cables, follow this procedure:

(1) ECG lead label of the displayed waveform (2) ECG waveform gain

(3) ECG filter mode (4) Notch filter status

(5) Paced status: If Paced is set to Yes,  is displayed. If Paced is set to No,  is displayed.

(6) HR/PR alarm message

(7) Pace pulse marker: If Paced is set to Yes, pace pulse markers “|” are displayed corresponding to detected 
pacer for each beat.

(1) Parameter label (2) HR measurement unit

(3) HR alarm limits (4) HR value

(1)                                 (2)                             (3)                                  (4)                                 (5)                                (6)

(7)

(1)
(2)

(3)

(4)
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1. Check that electrode packages are intact and the electrodes are not past the expiry date. Ensure the 
electrode gel is moist. If you are using snap electrodes, attach the snaps to the electrodes before placing 
electrodes on the patient.

2. Place the electrodes on the prepared sites. Ensure that all electrodes have good skin contact.

3. Connect the leadwires to the patient cable if not already connected.

4. Plug the patient cable into the ECG connector.

CAUTION

• Never mix patient electrode types or brands. This may lead to impedance mismatches issues.

NOTE

• When applying the electrodes, avoid bony area, obvious layers of fat, and major muscles. Muscle 
movement can result in electrical interference. Applying electrodes on major muscles, for example 
on muscles of the thorax, may lead to erroneous arrhythmia alarms due to excessive muscle 
movement. 

7.4.3 Lead Wire Color Code
The following table lists the color coding of leadwires for AHA standards:

7.4.4 ECG Electrode Placements
In this section, electrode placement is illustrated using the AHA naming convention.

7.4.4.1 3-leadwire Electrode Placement

The following is the electrode configuration when a 3-leadwire cable is 
used:

■ RA placement: directly below the clavicle and near the right 
shoulder.

■ LA placement: directly below the clavicle and near the left 
shoulder.

■ LL placement: on the left lower abdomen.

Lead Label Color

Right arm RA White

Left arm LA Black

Right leg (neutral) RL Green

Left leg LL Red

Chest 1 V1 Brown/Red

Chest 2 V2 Brown/Yellow

Chest 3 V3 Brown/Green

Chest 4 V4 Brown/Blue

Chest 5 V5 Brown/Orange

Chest 6 V6 Brown/Violet

RA LA

LL
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7.4.4.2 5-leadwire and 6-leadwire Electrode Placement

The following is the electrode configuration for a 5-leadwires cables:

■ RA placement: directly below the clavicle and near the right 
shoulder.

■ LA placement: directly below the clavicle and near the left 
shoulder.

■ RL placement: on the right lower abdomen.

■ LL placement: on the left lower abdomen.

■ V placement: on the chest in any of the V1 to V6 positions.

For 6-leadwire placement, you can use the position for the 5 -
leadwire placement but with two chest leads. The two chest leads (Va 
and Vb) can be positioned at any two of the V1 to V6 positions. For 
more information, see 7.4.4.3 Chest Electrode Placement. The Va and 
Vb lead positions are configurable. For more information, see 
7.5.3.3 Changing Va and Vb Labels.

7.4.4.3 Chest Electrode Placement

The chest electrode can be placed at the following positions:

■ V1 placement: on the fourth intercostal space to the right of 
the sternum.

■ V2 placement: on the fourth intercostal space to the left  of 
the sternum.

■ V3 placement: midway between the V2 and V4 electrode 
positions.

■ V4 placement: on the fifth intercostal space at the left 
midclavicular line.

■ V5 placement: on the left anterior axillary line, horizontal with 
the V4 electrode position.

■ V6 placement: on the left midaxillary line, horizontal with the V4 electrode position.

■ V3R-V6R placement: on the right side of the chest in positions corresponding to those on the left.

NOTE

• For the 5-leadwire and 6-leadwire placement, place the precordial electrode according to the 
physician's preference.

RA

V

RL

LA

LL

V1

V6

V5

V4

V2 V3VE
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7.4.4.4 10-leadwire Electrode Placement

12-lead ECG uses 10 electrodes, which are placed on the patient’s four limbs 
and chest. The limb electrodes should be placed on the limb extremities and 
the chest electrodes placed according to the physician’s preference. The figure 
at right illustrates the conventional 10-leadwire electrode placement.

7.4.4.5 Lead Placement for Pacemaker Patients

The recommended lead placement for monitoring a pacemaker patient is as follows.

A pacemaker patient usually requires a different electrode patch placement configuration than a non-
pacemaker patient.

Do not place an ECG electrode directly over the pacemaker generator. Place the electrode patches 2 to 3 inches 
away from the pacemaker generator area. For example, if the pacemaker generator is located in the left 
subclavian area, relocate the Left Arm electrode closer in towards the center of the chest.

7.4.4.6 Lead Placement for Surgical Patients

The surgical site should be taken into consideration when placing electrodes on a surgical patient. For example, 
for open-chest surgery, the chest electrodes can be placed on the lateral chest or back. To reduce artifacts and 
interference from electrosurgical units, you can place the limb electrodes close to the shoulders and lower 
abdomen and the chest electrodes on the left side of the mid-chest. Do not place the electrodes on the upper 
arm. Otherwise, the ECG waveform will be very small.

WARNING

• To reduce the hazard of burns during use of electrosurgical units (ESU), the ECG electrodes should 
not be located between the surgical site and the ESU return electrode. 

• Never entangle the ESU cable and the ECG cable together.

3-leadwire Electrode Placement 5-leadwire Electrode Placement

RA LA

LL

Pacemaker

RA LA

LL
RL

Pacemaker

V1
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• When using ESU, never place ECG electrodes near the grounding plate of the ESU, as this can cause a 
lot of interference on the ECG signal.

• When using ESU, ensure proper contact of the ESU return electrode to the patient to avoid burns at 
monitor measurement sites. Also ensure that the ESU return electrode is near the operating area.

7.4.5 Choosing the ECG Lead Type 
To choose ECG lead type, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Lead Set according to the lead type you are going to use. The default lead type is Auto. In this case, the 
monitor automatically detects the lead type. 

7.4.6 Checking Paced Status
It is important to correctly set the patient’s paced status before you start monitoring ECG. The paced symbol  
is displayed when Paced is set to Yes. Pace pulse markers “|” are displayed on each ECG waveform whenever  a 
pacer signal is detected. If Paced is set to No or unspecified, the symbol  will be shown in the ECG waveform 
area.

To change the paced status, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Pacer tab.

3. Set Paced to Yes or No. 

You can also change the patient’s paced status from the Patient Management dialog. For more information, see 
5.2.1 Entering the Patient Management Dialog.

If you did not set the paced status, the monitor issues a prompt tone when pace pulse is detected. At the same 
time, the paced symbol  flashes and the message Please check if the patient has a pacemaker? appears in 
the ECG waveform area. Check and set the patient’s paced status.

WARNING

• For paced patients, you must set Paced to Yes. If it is incorrectly set to No, the monitor could mistake 
a pace pulse for a QRS complex and fail to alarm when the ECG signal is too weak. On ventricular 
paced patients, episodes of ventricular tachycardia may not always be detected. Do not rely entirely 
upon the system’s automated arrhythmia detection algorithm.

• False low heart rate or false asystole alarms may result with certain pacemakers because of 
pacemaker artifacts, such as electrical overshoot of the pacemaker overlapping the true QRS 
complexes.

• Do not rely entirely on rate meter alarms when monitoring patients with pacemakers. Always keep 
these patients under close surveillance.

• The auto pacer recognition function is not applicable to pediatric patients and neonatal patients.

7.4.7 Enabling Pacer Rejection
To eliminate the pacing pulse from the ECG waveform of paced patients, it is recommended to enable the pace 
pulse rejection function. The pace pulse rejection function is disabled by default. To enable this function, follow 
this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Pacer tab.

3. Switch on Pacer Reject. 
7 - 6  BeneVision N1 Patient Monitor Operator’s Manual



NOTE

• When pace pulses are detected, the pace pulse markers “|” are shown on the ECG waveforms. Pacer 
Rejection setting has no impact on the display of pace pulse markers “|”.

• You can switch on pacer rejection only when Paced is set to Yes. If Paced is set to no, the Pacer Reject 
function is disabled. 

7.5 Changing ECG Settings

7.5.1 Choosing an ECG Screen
When monitoring ECG, several display options are available.

■ For 3-lead ECG monitoring, only normal screen is available.

■ For 5-lead ECG monitoring, besides the normal screen, you can also choose Full-screen (7-lead). 

■ For 6-lead ECG monitoring, besides the normal screen, you can also choose Full-screen (8-lead).

■ For 12-lead ECG monitoring, besides the normal screen, you can also choose Full-screen (7-lead), or 12-
Lead (12-lead analysis). 

To choose the desired screen configuration, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select Full-Screen or 12-Lead. 

To return to the normal screen, press the highlighted button to unselect that screen.

Alternately you can choose the desired screen configuration as follows:

1. Select the Screen Setup quick key → Choose Screen or select the Main Menu quick key → from the 
Display column select Choose Screen.

2. Select ECG Full-Screen or ECG 12-Lead.

7.5.2 Setting ECG Alarm Properties
To select the desired ECG alarm options, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Alarm tab.

3. Select the desired alarm options.

7.5.3 Changing ECG Wave Settings

7.5.3.1 Selecting the Leads of Displayed ECG Waveforms 

To select the desired ECG waveforms to be displayed, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Select ECG to set the lead of each displayed ECG waveform. 

4. If more than three ECG waveforms are to be displayed, select the More Leads tab, and then select ECG to 
set leads of other ECG waveforms. 

For optimal ECG analysis, select leads with the following characteristics:

■ The QRS complex should be either completely above or below the baseline and it should not be biphasic.

■ The QRS complex should be tall and narrow.

■ The P waves and T waves should be less than 0.2mV. 
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CAUTION

• Ensure that you have selected the optimal leads with the best waveform amplitude and the highest 
signal-to-noise ratio. Selecting the optimal leads is important for detecting beats, classifying beats, 
and detecting ventricular fibrillation. 

7.5.3.2 Changing ECG Waveform Size

If the ECG waveform is too small or clipped, you can change its size by selecting the appropriate Gain setting. To 
do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Select ECG Gain to set the size of each ECG waveform. 

4. If more than three ECG waveforms are displayed, select the More Leads tab, and then select ECG Gain to 
change the sizes of other ECG waveforms. If you select Auto, the monitor automatically adjusts the size of 
the ECG waveforms for all the leads. 

7.5.3.3 Changing Va and Vb Labels

When monitoring ECG with 6-leadwire. You can change the labels of Va and Vb leads. To do so, follow this 
procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Va and Vb according to the locations of the Va and Vb electrode sites. Default settings are Va and Vb. 

7.5.3.4 Changing ECG Waveform Speed

To change ECG waveform speed, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set the desired Speed. 

7.5.3.5 Setting the ECG Filter 

To set the appropriate ECG waveform filter mode, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Filter. 

◆ Diagnostic: use when diagnostic quality ECG is required. The unfiltered ECG waveform is displayed so 
that changes such as R-wave notching or discrete elevation or depression of the ST segment are 
visible.

◆ Monitor: use under normal monitoring conditions.

◆ Surgery: use when the signal is distorted by high frequency or low frequency interference. High 
frequency interference usually results in large amplitude spikes making the ECG signal look irregular. 
Low frequency interference usually leads to wandering or rough baseline. The surgery filter reduces 
artifacts and interference from electrosurgical units. Under normal measurement conditions, 
selecting Surgery may suppress certain features or details of the QRS complexes.

◆ ST: recommended for ST monitoring.

7.5.3.6 Switching On or Off the Notch Filter

The notch filter removes the line frequency interference. To switch on or off the notch filter, follow this 
procedure:
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1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Switch on or off Notch Filter.

NOTE

• The notch filter can only be switched on or off when ECG Filter is set to Diagnostic. In other filter 
modes, the notch filter is always on.

7.5.4 Disabling the Smart Lead Off Function
The monitor provides the smart lead off function. When the lead corresponding to the first ECG wave gets 
detached but another lead is available, the monitor automatically switches to the available lead to recalculate 
heart rate, and to analyze and detect arrhythmias. When you reconnect the detached leads, the monitor 
automatically switches back to the original lead. 

The smart lead off function is enabled by default. To disable this function, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Switch off Smart Lead.

7.5.5 Adjusting the QRS Volume
To adjust the QRS volume, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set QRS Volume.

When valid SpO2 measurements are available, the monitor adjusts the pitch of QRS tone based on the SpO2 
value.

7.5.6 Adjusting the Minimum QRS Detection Threshold 
To avoid false asystole alarm due to low R wave amplitude, and to avoid tall T waves and P waves being mistaken 
for QRS complexes, the monitor provides a means to manually adjust the minimum QRS detection threshold. 

To adjust the minimum QRS detection threshold, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab and set Filter to Monitor.

3. Select the QRS Threshold tab.

4. Select up or down arrow buttons to adjust the minimum threshold for QRS detection. Selecting Default 
resets the QRS threshold to the default value (0.16 mV).

CAUTION

• The setting of the QRS detection threshold can affect the sensitivity for arrhythmia, ST, QT/QTc 
detection, and heart rate calculation.

• If the QRS amplitude is low, the monitor might not be able to detect the beats and false asystole calls 
may occur.

NOTE

• The minimum QRS detection threshold can only be adjusted when the ECG filter is set to Monitor.
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7.6 Monitoring Arrhythmia 
Arrhythmia monitoring is intended for adult and pediatric patients.

7.6.1 Arrhythmia Safety Information

WARNING

• Heart rate reading may be affected by cardiac arrhythmias. Do not rely entirely on heart rate alarms 
when monitoring patients with arrhythmias. Always keep these patients under close surveillance.

• The arrhythmia analysis program may incorrectly identify the presence or absence of an arrhythmia. 
Therefore, a physician must analyze the arrhythmia information with other clinical findings.

• Atrial fibrillation (Afib) detection function is not intended for pediatric and neonatal patients.

CAUTION

• Since the arrhythmia detection algorithm sensitivity and specificity are less than 100%, it is possible 
for false arrhythmias to be detected and true arrhythmia events to not be detected. The possibility 
increases when the signal is noisy.

• The ECG size and minimum QRS detection threshold settings affect arrhythmia detection and heart 
rate calculation sensitivity.

• If QRS amplitude is low, the monitor might be unable to calculate heart rate and thus create false 
asystole calls. During the learning phase of the algorithm, arrhythmia detection may not be 
available. It is recommended to closely monitor patient condition during, and for several minutes 
after, the learning phase to allow the algorithm to reach optimal detection performance.

7.6.2 Arrhythmia Events
This section lists all arrhythmia events and their criteria.

7.6.2.1 Lethal Arrhythmia Events

7.6.2.2 Nonlethal Arrhythmia Events

Arrhythmia message Description

Asystole No QRS complex detected within the set time interval in the absence of ventricular 
fibrillation or chaotic signal.

V-Fib/V-Tach A fibrillatory wave for 6 consecutive seconds.

A dominant rhythm of adjacent PVCs and the ventricular rate is greater than the V-tach rate 
limit.

V-Tach The number of consecutive PVCs is greater than or equal to the V-Tach PVCs limit, and the 
ventricular rate is greater than or equal to the V-Tach rate limit.

Arrhythmia message Description

Vent Brady The number of consecutive PVCs is greater than or equal to V brady PVC limit and the 
ventricular rate is less than the V-Brady Rate limit.

Extreme Tachy The heart rate is greater than the extreme tachycardia limit. 

Extreme Brady The heart rate is less than the extreme bradycardia limit.

R on T R on T PVC is detected.

Run PVCs More than two consecutive PVCs, but lower than the V-Brady PVCs limit, and the ventricular 
rate is lower than the V-Tach rate limit.

Couplet A Pair of PVCs detected in between normal beats.
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*N: normal beat; V: ventricular beat

7.6.3 Displaying Arrhythmia Information
You can display the arrhythmia information in the numeric area. To do so, follow this procedure: 

1. Access Tile Layout using either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select Main Menu quick key → from the Display column select Tile Layout.

2. Click the numeric area where you want to display the arrhythmia information, and then select ECG → 
Arrhythmia. 

7.6.4 Changing Arrhythmia Settings 

7.6.4.1 Changing Arrhythmia Alarm Settings

To set the arrhythmia alarm properties, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Arrhythmia tab→ Alarm tab.

3. Set alarm properties as desired.

Multiform PVC Multiform PVCs detected in Multif. PVC's Window (which is adjustable).

PVC One PVC detected in between normal beats.

Bigeminy A dominant rhythm of N, V, N, V, N, V*.

Trigeminy A dominant rhythm of N, N, V,N, N, V, N, N, V*.

Tachy The heart rate is greater than the tachycardia limit. 

Brady The heart rate is lower than the bradycardia limit. 

Pacer Not Capture No QRS complex detected for 300 ms following a pace pulse (for paced patients only).

Pacer Not Pacing No pace pulse detected for 1.75 x average R-to-R intervals following a QRS complex (for 
paced patients only).

Missed Beat At least 3 consecutive Ns*, and

The current RR interval is greater than 1.5 x previous RR interval, and

The next RR interval is lower than 1.5 x average RR interval, and

HR lower than 100 and the current RR interval is greater than 1.75 x average RR interval , or 
HR is greater than or equal to 100 and the current RR interval is greater than 1000 ms.

Nonsus V-Tach The number of consecutive PVCs is lower than the V-Tach PVCs limit but greater than 2, and 
the ventricular rate is greater than or equal to the V-Tach Rate limit. 

Vent Rhythm The number of consecutive PVCs is greater than or equal to the V-Brady PVCs limit, and 
ventricular rate is greater than or equal to the V-Brady Rate limit but lower than V-Tach Rate 
limit. 

Pause No QRS complex is detected within the set pause time threshold.

Irr Rhythm Consistently irregular rhythm (N*, irregular RR interval change is greater than 12.5%)

A-Fib (for adult only) P wave is absent and normal beat RR intervals are irregular.

PVCs/min PVCs/min exceeds high limit.

Pauses/min Pauses/min exceeds high limit.

Irr Rhythm End Irregular rhythm no longer detected for the irregular rhythm end delay time.

A-Fib End (for adult only) Atrial fibrillation no longer detected for the A-Fib end delay time.

Arrhythmia message Description
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NOTE

• You can switch off lethal arrhythmia alarms only when the monitor is set to enableLethal Arrh 
Alarms Off. For more information, see 21.3.9.1 Setting the Lethal Arrhythmia Alarms Switch.

• The priority of lethal arrhythmia alarms is always high. It cannot be altered.

7.6.4.2 Changing Arrhythmia Alarm Threshold Settings

You can change threshold settings for certain arrhythmia alarms. When an arrhythmia exceeds its threshold, an 
alarm will be triggered. To do so, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Arrhythmia tab → select the Threshold tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication. 

4. Set the threshold for the desired arrhythmia alarms.

NOTE

• The asystole delay time relates to ECG relearning. When heart rate is less than 30 bpm, it is 
recommended to set Asystole Delay to 10 sec. 

7.6.4.3 Arrhythmia Threshold Range

7.6.4.4 Setting Thresholds for PVC-Related Alarms

PVC-related alarms are detected on the basis of the current PVC rate and the number of consecutive PVCs. 

To set the required thresholds for PVC-related alarms, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Arrhythmia tab → select the More Threshold tab.

Arrhythmia Threshold Range

Asystole Delay 3 sec to 10 sec

Tachy (HR High) 60 bpm to 295 bpm

Brady (HR Low) 16 bpm to 120 bpm

Extreme Tachy 65 bpm to 300 bpm

Extreme Brady 15 bpm to 115 bpm

Multif PVCs Window 3 beats to 31 beats

V-Tach Rate 100 bpm to 200 bpm

V-Brady Rate 15 bpm to 60 bpm

V-Tach PVCs 3 beats to 99 beats

V-Brady PVCs 3 beats to 99 beats

PVCs/min 1 to 100

Pauses/min 1 to 15

Pause Threshold 1.5 sec, 2.0 sec, 2.5 sec, 3.0 sec

AF/Irr Rhy End Time 0 min, 1 min, 2 min, 3 min, 4 min, 5 min, 10 min, 15 min, 30 
min
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3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

Adjust V-Tach PVCs, V-Tach Rate, V-Brady PVCs, and V-Brady Rate as necessary to set the thresholds for the 
desired PVC-related alarms.

The following figure illustrates the conditions under which PVC alarms will be generated if V-Tach PVCs is set to 
6, V-Tach Rate is set to 130, V-Brady PVCs is set to 5, and V-Brady Rate is set to 40.

■ If the number of consecutive PVCs is greater than or equal to the V-Tach PVCs limit (6), and the ventricular 
rate (Vent Rate) is greater than or equal to the V-Tach Rate limit (130), a V-Tach alarm is generated.

■ If the number of consecutive PVCs is lower than the V-Tach PVCs limit (6) but greater than 2, and the 
ventricular rate is greater than or equal to the V-Tach Rate limit (130), a Nonsus V-Tach alarm is generated.

■ If the number of consecutive PVCs is greater than or equal to the V-Brady PVCs limit (5), and the ventricular 
rate is lower than the V-Tach Rate limit (130) but greater than or equal to the V Brady Rate limit (40), a Vent 
Rhythm alarm is generated.

■ If the number of consecutive PVCs is lower than the V-Brady PVCs limit (5) but greater than 2, and the 
ventricular rate is lower than the V-Tach Rate limit (130), a Run PVCs alarm is generated.

■ If the number of consecutive PVCs is greater than or equal to the V-Brady PVCs limit (5), and the ventricular 
rate is lower than the V Brady Rate limit (40), a Vent Brady alarm is generated.

7.6.5 Intelligent Arrhythmia Alarm
Normally, an arrhythmia alarm is presented when an alarm condition is detected. However, there are certain 
situations that can inhibit audible and visible alarm indications even though an alarm condition was detected. 
For more information, see 7.6.5.1 Arrhythmia Alarm Chains and 7.6.5.2 Arrhythmia Alarm Shielding Rules.
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7.6.5.1 Arrhythmia Alarm Chains

If multiple alarms overlap, announcing all of the detected alarm conditions would be confusing, and a more 
serious condition might be overlooked. So arrhythmia alarms are prioritized by alarm "chains".

7.6.5.2 Arrhythmia Alarm Shielding Rules

The following table explains how audible and visual alarms are indicated during arrhythmia alarm shielding 
period.

Asystole

V Fib/V Tach

V Tach / Vent Brady

Extreme Tachy/
Extreme Brady

Pause

Nonsus V Tach / 
Vent Rhythm

Tachy/Brady

Run PVCs

Couplet

R on T

Bigeminy

Trigeminy

Multiform PVC

PVC

Pacer not Capture / 
Pacer not Pacing / 

Missed Beat

HR High / 
HR Low

Pauses/min
A Fib/

A Fib End

Irr. Rhythm/
Irr.Rhythm End

PVCs/min

PVC Alarm Chain
Beat Detection 

Alarm Chain
Rate Alarm Chain A Fib Alarm Chain

H
igh  Priority

M
edium

Priority

Previous alarm Current alarm Alarm indication

Alarm in high priority 
chain

Alarm in high priority chain Alarm light and alarm tone

Alarm in medium priority chain During the shielding period, alarm light and alarm 
tone are disabled. When the shielding period is 
reached, alarm light and alarm tone are 
reactivated.

Alarm in medium 
priority chain 

Alarm in high priority chain Alarm light and alarm tone

Alarm in the same medium priority 
chain, but with higher priority 

Alarm light and alarm tone

The same alarm reoccurs During the shielding period, alarm light and alarm 
tone are disabled. When the shielding period is 
reached, alarm light and alarm tone are 
reactivated. 

Alarm in the same medium priority 
chain, but with lower priority

During the shielding period, alarm light and alarm 
tone are disabled. When the shielding period is 
reached, alarm light and alarm tone are 
reactivated.

Alarm in other medium priority chain Alarm light and alarm tone
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7.6.5.3 Arrhythmia Alarm Refractory Period

For the following eight alarms in medium priority chain, there is a 30-second refractory period. That is to say, if 
the same alarm is not presented within 30 seconds after the previous alarm disappears.

■ Couplet

■ R on T

■ PVCs/min High

■ Multiform PVCs

■ PVC

■ Missed Beat

■ Pacer not Capture

■ Pacer not Pacing

7.7 ST Segment Monitoring
ST segment analysis is intended for adult, pediatric and neonatal patients. To use this feature, the N1 must be 
labeled to support ST analysis, see 7.1 ECG Introduction.  

7.7.1 ST Safety Information

WARNING

• ST segment deviation values may be affected by such factors as certain drugs or metabolic and 
conduction disturbances.

• ST deviation is often calculated at a fixed offset from the J point. Changes in heart rate may affect ST.

•  The significance of ST segment changes needs to be determined by a physician.

• This monitor provides information regarding changes in ST deviation levels. The clinical significance 
of the ST level change information should be determined by a physician.

7.7.2 Enabling ST Monitoring
The ST monitoring function is disabled by default. Before you start ST monitoring, enable the ST function. To do 
so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ select the Setup tab.

3. Switch on ST Analysis.

Reliable ST monitoring cannot be ensured under the following situations:

■ You are unable to get a lead that is not noisy.

■ Arrhythmias, such as atrial fibrillation or atrial flutter, which may cause an irregular baseline.

■ The patient is continuously ventricularly paced.

■ The patient has left bundle branch block.

In these cases, you may consider switching off ST monitoring.

7.7.3 Displaying ST Deviation Numerics
To display ST numerics, follow this procedure:

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select Main Menu quick key → from the Display column select Tile Layout.

2. Click the numeric area where you want to display the ST numerics, and then select ECG → ST. 
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The ST parameter display area is configured differently according to the ECG cable used: 

■ When you are using the 3-lead ECG leadwires, a separate ST numeric area does not appear on the display. 
The ST deviation value displays in the ECG numeric area.

■ When you are using the 5-lead ECG leadwires, the ST numeric area displays 7 ST deviation values: ST-I, ST-II, 
ST-III, ST-aVR, ST-aVL, ST-aVF, ST-V.

■ When you are using the 6-lead ECG leadwires, the ST numeric area displays 8 ST deviation values: ST-I, ST-II, 
ST-III, ST-aVR, ST-aVL, ST-aVF, ST-Va, ST-Vb.

■ When you are using the 12-lead ECG leadwires, the ST numeric area displays12 ST deviation values: ST-I, ST-
II, ST-III, ST-aVR, ST-aVL, ST-aVF, ST-V1, ST-V2, ST-V3, ST-V4, ST-V5, ST-V6.

This example shows the ST numeric area when 5-lead ECG cable is used. The monitor screen may look slightly 
different:

7.7.4 Displaying ST Segments in the Waveform Area 
You can display ST segments in the waveform area. To do so, follow this procedure: 

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select Main Menu quick key → from the Display column select Tile Layout.

2. Select the waveform area where you want to display the ST segments, and then select ECG → ST.

(1) Parameter label (2) ST measurement unit 

(3) ST alarm off symbol (4) Lead labels

(5) ST numerics: a positive value indicates ST segment elevation, and a negative value indicates ST 
segment depression.

(4)               (5)  

(1)
(2)

(3)
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ST segment shows a QRS complex segment for each measured ST lead. The current ST segment is drawn in the 
same color as the ECG wave, usually green, superimposed over the stored reference segment, drawn in a 
different color. The information is updated once every ten seconds. 

7.7.5 Entering the ST View 
In ST View mode a complete QRS segment for each ST lead is displayed. The color of the current ST segments 
and ST deviation values is consistent with the color of the ECG waveforms, normally green. The color of the 
baseline ST segments and ST deviation values is white. 

To enter the ST View, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab.

3. From the bottom of the dialog, select ST View.

7.7.6 Saving the Current ST Deviation and Segment as Baseline 
ST deviation is typically monitored as a relative change from a baseline value. Set an ST baseline when ST 
deviation values become stable. If you did not set the ST baseline, the monitor automatically saves the baseline 
when valid ST deviation values appear for 5 minutes. To set the ST baseline, follow this procedure:

1. From the ST View, select Set Baseline.

2. From the pop-up dialog box, select Ok to set the current ST segments and values as the baseline.

From the ST View, you can also perform the following operations:

■ Display or hide ST baseline by selecting Display Baseline or Hide Baseline.

■ Display or hide the position of ISO point, J point and ST point by selecting Display Marker or Hide Marker.

CAUTION

• Updating ST baseline affects ST alarms.

(1) ST lead (2) Current ST deviation value

(3) Baseline ST deviation value (4) 1 mV scale

(5) Current ST segment (green) and baseline ST segment (white) 

(1)                                (2)  

(3)

(4)                            (5)     
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7.7.7 Entering the ST Graphic (only available when the N1 is used with the 
independent external display)
To display ST Graphic, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab.

3. Select ST Graphic.

The following figure shows the ST Graphic when ST Alarm Mode is set to Absolute. The height of the bar 
indicates the ST deviation value of corresponding ST lead. The color of the bar indicates ST alarm status: green 
indicates that corresponding ST deviation value is within alarm limits; cyan, yellow and red indicate that the ST 
deviation value exceeds the alarm limits. The color matches ST alarm priority.

The following figure shows the ST Graphic when ST Alarm Mode is set to Relative. The height of grey bar 
indicates the baseline ST deviation value and the green bar (cyan, yellow or red if an alarm occurs) indicates 
relative ST from that baseline. 

7.7.8 Changing ST Settings

7.7.8.1 Setting ST Alarm Properties

To set ST alarm properties, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ Alarm tab.

3. Set ST Alarm Mode to Absolute or Relative.

◆ Absolute: you can separately set the alarm properties for each ST alarm for each lead.

◆ Relative: you can set the alarm properties for ST Single and ST Dual alarms.

4. Set ST alarm properties.
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7.7.8.2 Changing Leads for ST Display

The monitor automatically selects the three most deviated leads for ST display. You can also manually select the 
leads. To do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab → select the Setup tab.

3. Set ST Segment. You can select up to 3 leads. 

7.7.8.3 Showing ISO Point, J Point, and ST Point Markers 

In the waveform area, the ISO point, J point, and ST point marker do not display on the ST segments by default. 
To display these markers, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ select the Setup tab.

3. Switch on Show Markers. 

7.7.9 Adjusting ST Measurement Points

7.7.9.1 About ST Point, ISO Point, and J Point

The ST deviation value for each beat is the potential difference between the isoelectric (ISO) point and the ST 
point. The ISO point provides the baseline. The ST point is located between the J point and the start of the T-
wave. The J point is the end of the QRS complex. As the ST point is at a fixed distance away from the J point (40, 
60, 80 etc msec), manually adjusting the J point helps you correctly position the ST point.

7.7.9.2 Setting ST Point, ISO Point, and J Point

CAUTION

• If Auto Adjust is Off, or if the patient's heart rate or ECG morphology changes significantly, the ISO 
and ST points need to be occasionally adjusted because this may affect the QT interval and thus the 
location of the ST point. False ST segment depression or elevation may occur if the isoelectric point 
or the ST point is incorrectly set.

• Always ensure that the locations of ST points are appropriate for the patient.

To set the ST point, ISO point, and J point, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ select the Adjust tab.

3. Set ST Point.

The setting for Auto Adjust defines the method of adjusting the ISO and J point locations. Auto Adjust is 
enabled by default. In this case, the locations of the ISO point and J point are automatically determined by the 

(1) ISO point                                (2) J point (3) ST point (4) ST deviation   

P

R

Q

S

T(1) (2) (3) (4)
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algorithm. When Auto Adjust is disabled, you need to manually adjust the position of the ISO point and J point 
using the arrows at the right sides of ISO and J. 

■ The ISO point (isoelectric) location shown is relative to the R-wave peak. Position the ISO point in the 
middle of the flattest part of the waveform (between the P and Q waves).

■ The J point location is indicated relative to the R-wave peak. Position the J point at the end of the QRS 
complex and the beginning of the ST segment.

■ The ST point is positioned a fixed distance from the J point. Position the ST point relative to the J point at 
J+60/80ms, J+40ms, J+60ms or J+80ms. When J+60/80ms is selected, the ST point will be positioned 80 
ms (heart rate 120 bpm or less) or 60 ms (heart rate more than 120 bpm) from the J point.

7.8 QT/QTc Interval Monitoring 
The QT interval is the time between the beginning of the Q-wave and the end of the T-wave. It represents the 
total duration of the depolarization (QRS duration) and repolarization (ST-T) phases of the ventricles. QT interval 
monitoring can assist in the detection of long QT syndrome.

The QT interval has an inverse relationship to heart rate. Faster heart rates shorten QT interval and slower heart 
rates prolong QT interval. Therefore, several formulas are commonly used to correct the QT interval for heart 
rate. The heart rate corrected QT interval is abbreviated as QTc. 

QT/QTc interval monitoring is intended for adult, pediatric, and neonatal patients.

7.8.1 QT/QTc Monitoring Limitations
Some conditions may make it difficult to achieve reliable QT/QTc monitoring, for example:

■ R-wave amplitudes are too low

■ The presence of frequent ventricular ectopic beats

■ RR intervals are unstable

■ P-waves tending to encroach on the end of the previous T-wave at high heart rates

■ The T-wave is very flat or T-wave are not well defined

■ The end of the T-wave is difficult to delineate because of the presence of U-waves

■ QTc measurements are not stable

■ In the presence of noise, asystole, ventricular fibrillation, atrial fibrillation, or ECG lead off

For reliable QT/QTc monitoring, choose lead with good T-wave amplitude and no visible flutter activity, and 
without a predominant U-wave or P-wave.

Some conditions such as left or right bundle branch block or ventricular hypertrophy can lead to a widened QRS 
complex. If a long QTc is observed you should verify it to ensure that it is not caused by QRS widening.

Because normal beats followed by ventricular beats are not included in the analysis, no QT measurement will be 
generated in the presence of a bigeminy rhythm.

If the heart rate is extremely high (over 150 bpm for adults and over 180 bpm for pediatrics and neonates), QT 
will not be measured. When the heart rate changes, it can take several minutes for the QT interval to stabilize. For 
reliable QTc calculation it is important to avoid measurements when the heart rate is changing.

7.8.2 Enabling QT/QTc Monitoring
The QT monitoring function is disabled by default. Before you start QT monitoring, enable the QT function. To do 
so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab→ select the Setup tab.

3. Switch on QT Analysis.
7 - 20  BeneVision N1 Patient Monitor Operator’s Manual



7.8.3 Displaying QT Numerics and Segments
To display QT numerics and Segments, follow this procedure:

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆ Select Main Menu quick key → from the Display column select Tile Layout.

2. Click the parameter numeric area where you want to display the QT numerics, and then select ECG → QT/
QTc. 

NOTE

• QTc values are calculated based on the QT-HR, not the ECG HR. To view the QT-HR, open the QT View. 
For more information, see 7.8.4 Entering the QT View.

The following picture shows the QT numeric area. The monitor screen may look slightly different:

7.8.4 Entering the QT View
QT View shows the current and baseline QT parameter values and waveforms. To enter QT View, follow this 
procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab.

3. Select QT View.

The following picture shows a typical QT view. 

■ The current waveform is shown in the upper half in green. 

■ The baseline waveform is shown below in white. 

(1) QTc alarm limit (if QTc alarm is off, the alarm off symbol is displayed) 

(2) Parameter label (3) QTc value

(4) ΔQTc value (the difference between the current and baseline QTc values) 

(5) QT value (6) QT-HR value

(4)

(2)

(1)

(6)

(3)

(5)
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■ The waveform of selected lead is highlighted, while the waveforms of other leads are in light green or light 
gray.

■ The start of the QRS complex and the end of the T wave are marked with a vertical line.

■ In some conditions, no QT measurement can be made. Then the cause of failed QT measurement is shown 
at the bottom of the QT numerics area and the message “Cannot Analyze QT” is shown in the technical 
alarm area. 

Select the left or right arrow to switch leads, and the corresponding waveform will be highlighted.

7.8.5 Saving the Current QTc as Baseline 
In order to quantify changes in the QTc value, you can set a QTc baseline. If no baseline has been set for this 
patient within the first five minutes after getting valid QT values, the monitor will automatically set a baseline. To 
set the current values as baseline, follow this procedure:

1. From the QT View, select Set Baseline.

2. From the pop-up dialog box, select Ok. This baseline will then be used to calculate ΔQTc.

If you set a new baseline the previous baseline is discarded. 

From the QT View, you can also perform the following operations:

■ Select the left or right arrow to select a lead label to highlight corresponding waveform. 

■ Select Display Baseline or Hide Baseline to display or hide the baseline waveform.

CAUTION

• Updating QTc baseline affects the ΔQTc value and alarm.

7.8.6 Changing QT Settings

7.8.6.1 Setting QT Alarm Properties

To set QT alarm properties, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab→ select the Alarm tab.

3. Set QTc and ΔQTc alarm properties.

7.8.6.2 Selecting Leads for QT Calculation

You can select one lead or all leads for QT calculation. To do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab→ select the Setup tab.

3. Set QT Leads. All is selected by default. This means all leads are used for QT calculation.

7.9 ECG Relearning
Changes in ECG beat morphology could result in incorrect arrhythmia alarms and/or inaccurate heart rate. ECG 
relearning allows the monitor to learn the new dominant beat morphology and thus reduce false arrhythmia 
alarms and inaccurate HR values. Once learning is complete, the dominant QRS complex is stored as a reference 
template. The reference template is used as the normal morphology of that patient and it is compared with 
incoming beats to identify possible arrhythmias. 

7.9.1 Auto ECG Relearning
Auto arrhythmia relearning happens in the following situation: 

■ The ECG lead type or lead label is changed. 
7 - 22  BeneVision N1 Patient Monitor Operator’s Manual



■ ECG leads are off and are not reconnected within 60 seconds.

■ The patient‘s paced status is changed. 

7.9.2 Initiating an ECG Relearning Manually
If you suspect that false arrhythmia alarms are presented, you may need to manually initiate an ECG relearn. To 
do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select Relearn.

CAUTION

• Initiate ECG relearning only during periods of predominantly normal rhythm and when the ECG 
signal is relatively noise-free. If ECG learning takes place during arrhythmias, the ectopic beats may 
be incorrectly learned as normal QRS complexes. This may result in missed detection of subsequent 
arrhythmia events. 

7.10 Defibrillation Synchronization Pulse Output 
The 12-lead N1 monitor provides an analog out connector to output synchronization pulses for defibrillators. If a 
defibrillator is connected, it receives a synchronization pulse (100 ms, +5 V) through the multifunction 
connector each time an R-wave is detected. The 3/5/6 lead N1 monitor does not offer this output. 

WARNING

• According to IEC 60601-2-4: 2010, the peak of the synchronized defibrillator discharge should be 
delivered within 60 ms of the peak of the R wave. The signal at the ECG output (sync pulse) on the 
monitor is delayed by maximum of 30 ms. the biomedical engineer should verify that the ECG/
Defibrillator combination does not exceed recommended maximum delay of 60 ms.

• Before defibrillation, ensure that both defibrillator and monitor have passed the system test and 
can be safely used together.

7.11 ECG Troubleshooting
This section lists some of the problems that might be encountered during ECG monitoring. If you encounter 
problems when using the monitor or accessories, check the table below before requesting for services. If the 
problem persists after you have taken corrective actions, contact the service personnel.

NOTE

• For the physiological and technical alarm messages, see D Alarm Messages.

Problem Corrective Actions

Noisy ECG traces 1. Check that the electrodes are not detached or dry. Replace with fresh and 
moist electrodes if necessary. 
2. Check that leadwires are not defective. Replace leadwires if necessary.
3. Check that the patient cable or leadwires are not routed too close to other 
electrical devices. Move the patient cable or leadwires away from electrical 
devices and their cables if necessary. 

Excessive electrosurgical Interference Use ESU-proof ECG cables. For more information, see 25.1 ECG Accessories. 

Muscle Noise Inadequate skin preparation, tremors, tense subject, and/or poor electrode 
placement. 
1. Perform skin preparation again and re-place the electrodes. For more 
information, see 7.4.1 Preparing the Patient Skin and 7.4.2 Applying Electrodes 
and Connecting the Patient.
2. Apply fresh, moist electrodes. Avoid muscular areas. 
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Intermittent Signal 1. Check that cables are properly connected. 
2. Check that electrodes are not detached or dry. Perform skin preparation 
again as described in 7.4.1 Preparing the Patient Skin and apply fresh and 
moist electrodes. 
3. Check that the patient cable or leadwires are not damaged. Change them 
if necessary. 

Excessive alarms: heart rate, lead fault 1.  Check that electrodes are not dry. Perform skin preparation again and 
re-place the electrodes. For more information, see 7.4.1 Preparing the 
Patient Skin and 7.4.2 Applying Electrodes and Connecting the Patient. 

2. Check for excessive patient movement or muscle tremor. Reposition the 
electrodes. Replace with fresh and moist electrodes if necessary. 

Low Amplitude ECG Signal 1. Check that the ECG gain is not set too low. Adjust the gain as required. 
For more information, see 7.5.3.2 Changing ECG Waveform Size.

2. Perform skin preparation again and re-place the electrodes. For more 
information, see 7.4.1 Preparing the Patient Skin and 7.4.2 Applying 
Electrodes and Connecting the Patient.

3. Check electrode application sites. Avoid bone or muscular area. 
4. Check that electrodes are not dry or used for a prolonged time. Replace 

with fresh and moist electrodes if necessary. 

No ECG Waveform 1. Check that the ECG gain is not set too low. Adjust the gain as required. 
For more information, see 7.5.3 Changing ECG Wave Settings. 

2. Check that the leadwires and patient cables are properly connected. 
3. Change cable and lead wires if necessary. 
4. Check that the patient cable or leadwires are not damaged. Change them 

if necessary. 

Base Line Wander 1. Check for excessive patient movement or muscle tremor. Secure 
leadwires and cable. 

2. Check that electrodes are not detached or dry and replace with fresh and 
moist electrodes if necessary. For more information, see 7.4.1 Preparing 
the Patient Skin and 7.4.2 Applying Electrodes and Connecting the Patient. 

3. Check for ECG filter setting. Set ECG Filter mode to Monitor to reduce 
baseline wander on the display.

Problem Corrective Actions
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8 Resting 12-Lead ECG Analysis

8.1 Resting 12-Lead ECG Analysis Introduction
The monitor can be configured with the Glasgow 12-lead resting ECG analysis algorithm. The monitor 
incorporating the Glasgow algorithm is labeled with the logo of Glasgow as shown in 7.1 ECG Introduction.

The Glasgow algorithm is intended for adult, pediatric, and neonatal patients. 

8.2 Entering the 12-Lead Screen
To enter the 12-Lead screen, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. From the bottom of the ECG dialog, select 12-Lead.

You can also enter the 12-Lead screen by following this procedure:

■ Select the Screen Setup quick key → select the Choose Screen tab → select ECG 12-Lead.

■  Select Main Menu quick key → from the Display column select Choose Screen → select ECG 12-Lead.

NOTE
• The ECG 12-Lead screen is available only when the Glasgow algorithm is configured (associated 

module has the Glasgow label) and Lead Set is set to Auto or 12-Lead.

8.3 Initiating Resting 12-Lead ECG Analysis
Before initiating 12-lead ECG analysis, check that all electrodes are correctly connected to the lead wires and the 
ECG trunk cable is properly connected. Check that patient information is correct. Keep the patient still.

To initiate 12-Lead ECG analysis, select Analyze from the bottom left of the 12-Lead screen. 

8.4 Changing 12-Lead ECG Analysis Settings
On the ECG 12-Lead screen, you can set the high frequency filter, baseline drift removal (BDR) filter, and the 
waveform layout.

8.4.1 Setting the High Frequency Filter
The high frequency filter attenuates muscle artifact by restricting the included frequencies.  The setting of the 
high frequency filter is 35 Hz by default. To change the setting, follow this procedure: 

1. On the ECG 12-Lead screen, select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set High-Freq Cut-off.

The high frequency filter is a low-pass filter. That is to say, signal frequencies higher than the set frequency are 
filtered out. For example, if you set High-freq Cutoff to 35 Hz, then signal below 35 Hz is kept in the signal and 
signal exceeding 35 Hz is attenuated.

8.4.2 Setting the Baseline Drift Removal Filter
The baseline drift removal (BDR) filter suppresses most baseline drift interference and also is able to preserve the 
fidelity of the ST-segment level. BDR is switched on by default. To set the BDR, follow this procedure:

1. On the ECG 12-Lead screen, select the ECG numeric area or waveform area to enter the ECG dialog.
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2. Select the Setup tab.

3. Switch on or off Baseline Drift Removal as desired. If BDR is switched off, the 0.05 Hz high pass filter is 
used. 

NOTE

• BDR introduces around 1-second delay. Using BDR is recommended except when the delay is 
unacceptable.

8.4.3 Setting the 12-Lead Waveform Layout 
To set the 12-lead waveform layout, follow this procedure:

1. On the ECG 12-Lead screen, select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Waveform Layout.

◆ Standard: the waveform sequence is I, II, III, aVR, aVL, aVF, V1, V2, V3, V4, V5, V6.

◆ Cabrera: the waveform sequence is aVL, I, -aVR, II, aVF, III, V1, V2, V3, V4, V5, V6.  

For the Glasgow algorithm, the sequence of the chest leads depends on the setting of V3 Placement. If V3 
placement is set to V4R, the sequence of chest leads is V4R, V1, V2, V4, V5, V6.

8.4.4 Editing Patient Information
Some patient information may directly affect ECG analysis. Complete and correct patient information is helpful 
for accurate diagnosis and treatment of the patient. Enter patient information before starting a resting ECG 
analysis.

To enter patient information, follow this procedure:

1. On the ECG 12-Lead screen, select Setup to enter the 12-Lead Setup dialog.

2. On the Patient Demographics page, input or edit patient information.

NOTE

• Saving information will also save the information as though it was entered in the Patient 
Management dialog.

• Changes are not saved until you press Save. So changing to another tab without saving and then 
pressing the exit button “X” will lose any changes.

• Check that patient information is correct before starting a resting 12-lead analysis. 

• Using pediatric lead placement V4R, V1, V2, V4 - V6 is recommended if the patient is under 16 years 
of age. Please record V4R using the V3 electrode. Also set V3 Electrode to V4R. This is a normal 
practice for a patient of this age. 

8.4.5 Setting Tachycardia and Bradycardia Thresholds 
To set tachycardia and bradycardia thresholds, follow this procedure:

1. On the ECG 12-Lead screen, select Setup to enter the 12-Lead Setup dialog.

2. Select the Setup tab.

3. Set Tachy and Brady.

NOTE

• The tachycardia threshold only applies to patients whose age exceeds 180 days.

• The bradycardia threshold only applies to patients whose age exceeds 2191 days (6 years).
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8.4.6  Setting the 12-Lead Interpretation Report
To set the 12-lead interpretation report, follow this procedure:

1. On the ECG 12-Lead screen, select Setup to enter the 12-Lead Setup dialog.

2. Select the Report tab.

3. Set the format and items included in the 12-lead interpretation report.

8.5 Saving the 12-Lead Interpretation Report
At the completion of 12-lead ECG interpretation, select Save to save the report. You can review the saved 12-
lead interpretation reports. For more information, see 15.2.10 12-Lead ECG Review Page.

8.6 Printing the 12-Lead Interpretation Report
At the completion of 12-lead ECG interpretation, select Print to output the report via the printer. 

8.7 Exiting the ECG 12-Lead Screen
To exit the ECG 12-Lead screen, select Exit on the ECG 12-Lead screen.
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9 Monitoring Impedance Respiration (Resp)

9.1 Resp Introduction
Impedance respiration is measured across the thorax. When the patient is breathing or ventilated, the volume of 
air changes in the lungs, resulting in impedance changes between the electrodes. Impedance respiration rate 
(RR) is calculated from the signal representing these impedance changes, and a respiration waveform is 
displayed on the patient monitor screen.

Impedance respiration monitoring is intended for adult, pediatric and neonatal patients. 

Respiration may also be measured using a CO2 module. Refer to 14 Monitoring Carbon Dioxide (CO2) for 
respiration information specific to the CO2 module.

9.2 Impedance Resp Safety Information

WARNING

• When monitoring the patient’s impedance respiration, do not use ESU-proof ECG cables. The 
monitor cannot measure impedance respiration with ESU-proof ECG cables.

• If you do not set the detection level for the respiration correctly in manual detection mode, it may 
not be possible for the monitor to detect apnea. If you set the detection level too low, the monitor is 
more likely to detect cardiac activity, and to falsely interpret cardiac activity as respiratory activity 
in case of apnea. 

• The respiration measurement does not recognize the cause of apnea. It only indicates an alarm if a 
pre-adjusted time has elapsed without a breath being detected since the last detected breath. 
Therefore, it cannot be used for diagnostic purpose.

• If operating under conditions according to the EMC Standard IEC 60601-1-2 (Radiated Immunity 3V/
m), field strengths above 3V/m may cause erroneous measurements at various frequencies. 
Therefore, it is recommended to avoid the use of electrically radiating equipment in close proximity 
to the impedance respiration measurement unit.

• The current used to measure impedance respiration may cause rate changes in Minute Ventilation 
Rate Responsive Pacemakers. If you suspect the patient monitor is affecting the pacemaker rate 
then replace the ECG cable with an ECG cable that contains ESU filters.

CAUTION

• Only use parts and accessories specified in this manual. 

• Impedance respiration monitoring is not for use on patients while they are active, as this can cause 
false alarms.
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9.3 Resp Display

NOTE
• If ESU-proof ECG cables are used, the Resp waveform area will display the message “Check Leads”. 

Replace the ECG cable if necessary.

9.4 Preparing for Impedance Resp Monitoring 

9.4.1 Preparing the Patient
Follow this procedure to prepare the patient:

1. Shave hair from skin at chosen sites. 

2. Gently rub skin surface at sites to remove dead skin cells. 

3. Thoroughly cleanse the site with a mild soap and water solution. 

4. Dry the skin completely before applying the electrodes.

CAUTION

• Proper skin preparation is necessary for good signal quality at the electrode site, as the skin is a poor 
conductor of electricity.

(1) Resp waveform gain (2) Resp lead label (3) Alarm limits

(4) Respiration rate (RR) (5) RR source

(1) (5)(4)(3)(2)
9 - 2  BeneVision N1 Patient Monitor Operator’s Manual



9.4.2 Placing the Electrodes
Impedance respiration is acquired using standard ECG electrodes and cables. Either lead I (RA-LA) or lead II (RA-
LL) can be used.

For more information, see 7.4.4 ECG Electrode Placements.

CAUTION

• Correct electrode placement can help to reduce interference from cardiac related impedance 
changes: avoid including the liver area and the ventricles of the heart between the respiratory 
electrodes. This is particularly important for neonates. 

• Some patients with restricted movements breathe mainly abdominally. In these cases, you may 
need to place the left leg electrode on the left abdomen at the point of maximum abdominal 
expansion to optimize the respiratory waveform. 

• Some patients (especially neonates) expand their chests laterally, causing a negative intrathoracic 
pressure. In these cases, it is better to place the two respiration electrodes in the right midaxillary 
and the left lateral chest areas at the patient’s maximum point of the breathing movement to 
optimize the impedance respiration waveform. 

• To optimize the impedance respiration waveform, place the RA and LA electrodes horizontally when 
monitoring respiration with ECG Lead I; place the RA and LL electrodes diagonally when monitoring 
respiration with ECG Lead II. 

• Periodically inspect electrode application sites to ensure skin integrity. If the skin quality changes, 
replace the electrodes or change the application site. 

NOTE

• Store the electrodes at room temperature. Open the electrode package immediately prior to use. 

• Check that the electrode packages are intact and that the electrodes are not past the expiration 
date. Ensure the electrode gel is moist.

                                           (1) Lead I                                                                 (2) Lead II

(1) (2)
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9.5 Changing Resp Settings

9.5.1 Setting the Resp Alarm Properties
To set the Resp alarm properties, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User Authentica-
tion.

4. Set alarm properties as desired.

9.5.2  Setting the RR Source
To set RR source, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Choose RR Source from the dropdown list.

When you select Auto, the monitor automatically selects the RR source following order of priority: first CO2, and 
then ECG. When the manually selected RR source is not available, the monitor automatically switches the RR 
Source to Auto. 

9.5.3 Choosing the Respiration Lead
To set the respiration lead, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Set Resp Lead.

If you cannot get an acceptable impedance Resp waveform or you suspect the veracity of the Resp value after 
choosing the Resp lead, you may need to adjust the electrode placement.

9.5.4 Setting the Resp Waveform Size
To set the Resp waveform size, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Set Gain.

9.5.5 Setting the Resp Waveform Speed
To set the Resp waveform speed, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Set Speed.
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9.5.6 Setting the Auto Detection Switch
To set the auto detection switch, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Switch on or off Auto Threshold Detection.

◆ If Auto Threshold Detection is switched on,  the monitor automatically adjusts the Resp waveform 
detection level, or threshold. 

◆  If Auto Threshold Detection is switched off, you have to manually adjust the Resp waveform 
threshold. For more information, see 9.5.7 Adjusting the Resp Waveform Detection Threshold.

In the auto threshold detection mode, if you are monitoring Resp and the ECG parameter is switched off, the 
monitor cannot compare the heart rate and Resp rates to detect cardiovascular artifact. The respiration 
detection level is automatically set higher to prevent the detection of cardiovascular artifact as respiration.

In the manual detection mode (where auto threshold detection is off ), cardiovascular artifact can, in certain 
situations, trigger the respiration rate counter. This may lead to a false indication of a high respiration or an 
undetected apnea condition. If you suspect that cardiovascular artifact is being registered as respiratory activity, 
raise the detection level above the zone of cardiovascular artifact. If the Resp wave is so small that raising the 
detection level is not possible, you may need to optimize the electrode placement.

9.5.7 Adjusting the Resp Waveform Detection Threshold
Use the manual detection mode (where auto threshold detection is off ) in the following situations:

■ The respiration rate and the heart rate are close.

■ Patients have intermittent mandatory ventilation.

■ Respiration is weak. Try repositioning the electrodes to improve the signal.

To set the Resp waveform threshold to the desired level, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Threshold tab.

3. Select the up and down arrows below Upper Line and Lower Line to define the Resp waveform threshold.

Once set, the detection level will not adapt automatically to different respiration depths. It is important to 
remember that if the depth of breathing changes, you may need to change the detection level.
BeneVision N1 Patient Monitor Operator’s Manual 9 - 5



This page intentionally left blank.
9 - 6  BeneVision N1 Patient Monitor Operator’s Manual



10 Monitoring Pulse Oxygen Saturation (SpO2)

10.1 SpO2 Introduction

Pulse Oxygen Saturation (SpO2) monitoring is a non-invasive technique used to measure the amount of 
oxygenated hemoglobin and pulse rate by measuring the absorption of selected wavelengths of light. The light 
generated in the emitter side of the probe is partly absorbed when it passes through the monitored tissue. The 
amount of transmitted light is detected in the detector side of the probe. When the pulsative part of the light 
signal is examined, the amount of light absorbed by the hemoglobin is measured and the pulse oxygen 
saturation can be calculated. This device is calibrated to display functional oxygen saturation.

SpO2 monitoring is intended for adult, pediatric and neonatal patients.

The monitor can be configured with Masimo SpO2 or Nellcor SpO2:

■ Masimo SpO2: the connector is purple and the logo of Masimo SET is on the monitor.

■ Nellcor SpO2: the connector is grey and the logo of Nellcor is on the monitor.

NOTE
• The SpO2 extension cable used must be compatible with the SpO2 sensor connectors used. For 

example, only the Masimo SpO2 extension cable can be connected to the Masimo SpO2 sensor 
connectors.

• Measurement accuracy verification: The SpO2 accuracy has been verified in human experiments by 
comparing with arterial blood sample reference measured with a CO-oximeter. Pulse oximeter 
measurement are statistically distributed and about two-thirds of the measurements are expected 
to come within the specified accuracy range compared to CO-oximeter measurements.

• A functional tester or SpO2 simulator can be used to determine the pulse rate accuracy.

• A functional tester or SpO2 simulator cannot be used to assess the SpO2 accuracy.
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10.2 SpO2 Safety Information

WARNING

• When a trend toward patient deoxygenation is indicated, analyze the blood samples with a 
laboratory co-oximeter to completely understand the patient’s condition.

• Do not use SpO2 sensors during magnetic resonance imaging (MRI). Induced current could 
potentially causes burns. The sensor may affect the MRI image, and the MRI unit may affect the 
accuracy of the oximetry measurements. 

• Prolonged continuous monitoring may increase the risk of undesirable changes in skin 
characteristics, such as irritation, reddening, blistering or burns. Inspect the sensor site every two 
hours and move the sensor if the skin quality changes. Change the application site every four hours. 
For neonates, or patients with poor peripheral blood circulation or sensitive skin, inspect the sensor 
site more frequently.

• If the sensor is too tight because the application site is too large or becomes too large due to edema, 
excessive pressure for prolonged periods may result in venous congestion distal from the 
application site, leading to interstitial edema and tissue ischemia. 

• When patients are undergoing photodynamic therapy they may be sensitive to light sources. Pulse 
oximetry may be used only under careful clinical supervision for short time periods to minimize 
interference with photodynamic therapy. 

• Setting alarm limits to extreme values may cause the alarm system to become ineffective. For 
example, high oxygen levels may predispose a premature infant to retrolental fibroplasia. If this is a 
consideration, do not set the high alarm limit to 100%, which is equivalent to switching off the 
alarm. 

• SpO2 is empirically calibrated in healthy adult volunteers with normal levels of carboxyhemoglobin 
(COHb) and methemoglobin (MetHb). 

• To protect from electric shock, always remove the sensor before bathing the patient. 

• The pulse oximetry function of the bedside monitor should not be used for apnea monitoring. 

•  The pulse oximetry function of the bedside monitor should not be used for arrhythmia analysis.

CAUTION

• Change the application site or replace the sensor and/or patient cable when a persistent SpO2 Low 
Signal Quality message is displayed on the equipment. These messages may indicate that patient 
monitoring time is exhausted on the patient cable or sensor.

• Replace the cable or sensor when a “SpO2 Sensor Off”, “SpO2 No Sensor”, or “SpO2 Low Signal 
Quality” message is consistently displayed while monitoring consecutive patients after completing 
troubleshooting steps listed in this manual. 

• Variation in measurements may be profound and may be affected by sampling technique as well as 
the patient's physiological conditions. Any results exhibiting inconsistency with the patient’s clinical 
status should be repeated and/or supplemented with additional test data. Blood samples should be 
analyzed by laboratory instruments prior to clinical decision making to completely understand the 
patient’s condition.

• Use only SpO2 sensors specified in this manual. Follow the SpO2 sensor’s instructions for use and 
adhere to all warnings and cautions.

• Do not place the patient monitor where the controls can be changed by the patient. 

• If using pulse oximetry during full body irradiation, keep the sensor out of the radiation field. If the 
sensor is exposed to the radiation, the reading might be inaccurate or the device might read zero for 
the duration of the active irradiation period. 

NOTE

• Additional information specific to the Masimo sensors compatible with the equipment, including 
information about parameter/measurement performance during motion and low perfusion, may be 
found in the sensor's directions for use (DFU).
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• Masimo cables and sensors are provided with X-Cal™ technology to minimize the risk of inaccurate 
readings and unanticipated loss of patient monitoring. Refer to the Cable or Sensor DFU for the 
specified duration of the patient monitoring time.

10.3 SpO2 Measurement Limitations

The following factors may influence the accuracy of SpO2 measurement:

■ Patient physiological characteristics:

◆ Cardiac arrest 

◆ Hypotension 

◆ Darkly pigmented skin

◆ Shock

◆ Severe vasoconstriction

◆ Hypothermia

◆ Severe anemia

◆ Ventricular septal defects (VSDs)

◆ Venous pulsations

◆ Poor perfusion

◆ Dysfunctional hemoglobin, such as carboxyhemoglobin (COHb) and methemoglobin (MetHb)

◆ Elevated levels of bilirubin

◆ Vasospastic disease, such as Raynaud’s, and peripheral vascular disease

◆ Hemoglobinopathies and synthesis disorders such as thalassemias, Hb s, Hb c, sickle cell, etc.

◆ Hypocapnic or hypercapnic conditions

◆ Birthmark(s), tattoos, skin discolorations, moisture on skin, deformed or abnormal fingers. etc.

■ Interfering substances:

◆ Intravascular dyes (such as indocyanine green, methylene blue, indigo carmine, etc.)

◆ Dyes in the measure site, such as nail polish

■ Environmental conditions:

◆ Excessive ambient light

◆ Electrosurgery equipment

◆ Defibrillation (may cause inaccurate reading for a short amount of time)

◆ Excessive patient/sensor motion

◆ Electromagnetic field

◆ Arterial catheters and intra-aortic balloon

■ Others

◆ Inappropriate positioning of the SpO2 sensor, or use of incorrect SpO2 sensor

◆ Cuff or arterial blood pressure measurement device on the same limb as the SpO2 sensor 

10.4 SpO2 Display

(1)                                                                                                                         (2)                  (3)

(5)                                                               

(4)                                                               
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NOTE

• PI is displayed for Masimo SpO2.

10.5 Preparing for SpO2 Monitoring 

To prepare to monitor SpO2, follow this procedure:

1. Select an appropriate sensor according to the module type, patient category and weight.

2. Clean the contact surface of the reusable sensor.

3. Remove colored nail polish from the application site.

4. Apply the sensor to the patient according to the instruction for use of the sensor.

5. Select an appropriate extension cable according to the connector type and plug the cable into the SpO2 
connector.

6. Connect the sensor to the extension cable.

CAUTION

• Do not apply sensor too tightly as this results in venous pulsation which may severely obstruct 
circulation and lead to inaccurate measurements. 

• At elevated ambient temperatures, be careful with measurement sites that are not well perfused, 
because this can cause burns after prolonged application.

• Avoid placing the sensor on extremities with an arterial catheter, an NIBP cuff or an intravascular 
venous infusion line. 

• For neonatal patients, make sure that all sensor connectors and adapter cable connectors are 
outside the incubator. The humid atmosphere inside can cause inaccurate measurements. 

10.6 Changing the SpO2 Settings

NOTE

• The settings of in the SpO2 module and SpO2b module are linked.

10.6.1 Changing the SpO2 Alarm Settings

To change the SpO2 alarm settings, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

(1) Pleth waveform (Pleth): visual indication of patient’s pulse. The waveform is not normalized.

(2) Oxygen saturation of arterial blood (SpO2): percentage of oxygenated hemoglobin in relation to the sum of 
oxyhemoglobin and deoxyhemoglobin.

(3) Perfusion indicator: the pulsatile portion of the measured signal caused by arterial pulsation.

(4) Perfusion index (PI): gives the numerical value for the pulsatile portion of the measured signal caused by arterial 
pulsation. PI is an indicator of the pulsatile strength. You can also use it to assess the SpO2 signal strength. 

(5) Pulse rate (derived from the pleth wave): detected pulsations per minute.
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NOTE
• The desat alarm is a high level alarm notifying you of potentially life threatening drops in oxygen 

saturation. When the SpO2 value is below the desat alarm limit and desat alarm switch is set on, the 
message “SpO2 Desat” is displayed.

• You can switch off the SpO2 Desat alarm only when the SpO2 Desat Alarm Off is enabled. For more 
information, see section 21.3.6.6 Setting the Switch of the SpO2 Desat Alarm Off.

10.6.2 Nellcor SatSecondsTM Alarm Management
With traditional alarm management, high and low alarm limits are set for monitoring oxygen saturation. During 
monitoring, once an alarm limit is violated, an audible alarm immediately sounds. When the patient SpO2 
fluctuates near an alarm limit, the alarm sounds each time the limit is violated. Such frequent alarms can be 
distracting. Nellcor’s SatSeconds alarm management technique is used to reduce these nuisance alarms.

The SatSeconds feature is available with the Nellcor SpO2 to decrease the likelihood of false alarms caused by 
motion artifacts. With SatSeconds alarm management, high and low alarm limits are set in the same way as 
those with traditional alarm management. A SatSeconds limit is also set. The SatSeconds limit controls the 
amount of time that SpO2 saturation may be outside the set limits before an alarm sounds. 

The method of calculation is as follows: the percentage points of the SpO2 saturation falling outside the alarm 
limit is multiplied by the number of seconds remaining outside the limit. This can be stated as the equation:

SatSeconds = Points × Seconds

Only when the SatSeconds limit is reached, the monitor gives a SatSeconds alarm. For example, the figure below 
demonstrates the alarm response time with a SatSeconds limit set at 50 and a low SpO2 limit set at 90%. In this 
example, the patient SpO2 drops to 88% (2 points) and remains there for 2 seconds. Then it drops to 86% (4 
points) for 3 seconds, and then to 84% (6 points) for 6 seconds. The resulting SatSeconds are:

After approximately 11 seconds, a Sat-Second alarm would sound, because the limit of 50 SatSeconds would 
have been exceeded.

% SpO2 Seconds SatSeconds

2× 2= 4

4× 3= 12

6× 6= 36

Total SatSeconds= 52

%SpO2                                                               

Seconds                                                         
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Saturation levels may fluctuate rather than remaining steady for a period of several seconds. Often, the patient 
SpO2 may fluctuate above and below an alarm limit, re-entering the non-alarm range several times. During such 
fluctuation, the monitor integrates the number of SpO2 points, both positive and negative, until either the 
SatSeconds limit is reached, or the patient SpO2 re-enters the non-alarm range and remains there. 

NOTE

• The SpO2 Too Low or SpO2 Too High alarm is presented in the case that SpO2 value violates the alarm 
limits 3 times within one minute even if the setting of SatSeconds is not reached. 

To set the SatSeconds, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Alarm tab.

3. Set Sat-Seconds.

10.6.3 Setting SpO2 Sensitivity (for Masimo SpO2)

For Masimo SpO2, selects the Sensitivity as per signal quality and patient motion.

Normal sensitivity is the recommended for patients who are experiencing some compromise in blood flow or 
perfusion. It is advisable for care areas where patients are observed frequently, such as the intensive care unit 
(ICU). 

Adaptive Probe Off Detection (APOD) sensitivity is the recommended sensitivity mode where there is a high 
probability of the sensor becoming detached. It is also the suggested mode for care areas where patients are not 
visually monitored continuously. This mode delivers enhanced protection against erroneous pulse rate and 
arterial oxygen saturation readings when a sensor becomes inadvertently detached from a patient due to 
excessive movement.

Maximum sensitivity is recommended for use on patients with weak signals (e.g. high ambient noise and/or 
patients with very low perfusion) and for use during procedures or when clinician and patient contact is 
continuous such as in higher acuity settings.

To set SpO2 sensitivity, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Setup tab.

3. Set Sensitivity to Maximum, Normal, or APOD.

CAUTION

• When using the Maximum Sensitivity setting, performance of "Sensor Off" detection may be 
compromised. If the equipment and the sensor becomes detached from the patient, the potential 
for false readings may occur due to environmental noise such as light, and vibration.

• Configuring the monitor to “Load Latest Configuration” as the default configuration may result in 
Masimo SpO2 being set to Maximum sensitivity mode on power up or after admitting a new patient. 
Maximum sensitivity is recommended for use during procedures or when clinician and patient 
contact is continuous, such as in higher acuity settings. Maximum sensitivity is not recommended 
for care areas where patients are not monitored visually as “Sensor Off” detection may be 
compromised. Refer to Section 20.4 Setting Default Configuration for managing configuration.

10.6.4 Enabling FastSAT (for Masimo SpO2)

FastSAT enables rapid tracking of arterial oxygen saturation changes as may be required in urgent situations. 
When FastSAT is switched on, the averaging algorithm evaluates all the SpO2 values and provides an averaged 
SpO2 value that is a better representation of the patient’s current oxygen saturation status. 

The reliability of FastSAT is dependent on the setting for the averaging time and the input signal. FastSAT is 
disabled by default. To enable FastSAT, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 menu.

2. Select the Setup tab.

3. Switch on FastSAT.
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10.6.5 Displaying SIQ (for Masimo SpO2)

The signal quality indicator (SIQ) displays below the Pleth waveform. The SIQ is conveyed by vertical bars. The 
height of the bar provides an assessment of the confidence in the displayed SpO2 value. The SpO2 SIQ can also 
be used to identify the occurrence of a patient ‘s pulse.

The following picture shows the SpO2 SIQ:

 To show SpO2 SIQ, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 menu.

2. Select the Setup tab.

3. Switch on Display SIQ.

10.6.6 Changing Averaging Time (for Masimo SpO2)

The SpO2 value displayed on the monitor screen is the average of data collected within a specific time. The 
shorter the averaging time is, the quicker the monitor responds to changes in the patient’s oxygen saturation 
level. Contrarily, the longer the averaging time is, the slower the monitor responds to changes in the patient’s 
oxygen saturation level, but the SpO2 measurement is more stable. For critically ill patients, selecting a shorter 
averaging time will help with understanding the patient’s state. 

To set the averaging time, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Setup tab.

3. Set Averaging.

10.6.7 Monitoring SpO2 and NIBP Simultaneously

When monitoring SpO2 and NIBP on the same limb simultaneously, you can switch on NIBP Simul to lock the 
SpO2 alarm status until the NIBP measurement ends. If you switch off NIBP Simul, low perfusion caused by NIBP 
measurement may lead to inaccurate SpO2 readings and therefore cause false physiological alarms. 

To set the NIBP Simul, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Alarm tab.

3. Set NIBP Simul.

10.6.8 Changing the Sweep Speed of the Pleth Waveform
To set the sweep speed of Pleth waveform, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Setup tab.

3. Set Speed.

10.7 Changing the PR Settings

10.7.1 Changing the PR Alarm Settings
To change the PR alarm settings, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the PR tab.

(1) Signal quality indicator (SIQ)

(1)                                                               
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3. Enter the password if required. For more information refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

10.7.2 Changing the QRS Volume
If the Alarm Source is set to PR, the QRS tone is derived from PR measurements. To set the QRS volume, follow 
this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the PR tab.

3. Select the Setup tab.

4. Set QRS Volume.

If the SpO2 value is valid, the monitor also adjusts the QRS tone (pitch tone) according to the SpO2 value. For 
information, see 21.15.3 Setting the SpO2 Tone Mode.

NOTE

• Changing the QRS volume settings in the PR Setup page also changes the QRS volume settings in the 
Setup page of the ECG dialog.

10.7.3 Setting the PR Source
Current pulse source is displayed in the PR numeric area if current PR source is not SpO2. The PR from current 
pulse source has the following characteristics: 

■ PR is stored in the monitor’s database and can be reviewed in the graphic and tabular trends.In  graphic 
trends, as the PR curve has the same color as that of current PR source.

■ PR is sent via the network to the CMS, if available. 

To set which parameter is used as a PR source, follow this procedure: 

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the PR tab.

3. Select the Setup tab.

4. Set PR Source.

The dropdown list of the PR Source displays the currently available PR sources from top to bottom by priority. 
When you select Auto, the system will automatically select the first option as the PR source. If the current PR 
source is unavailable, the system will automatically switch PR Source to Auto. When you select IBP, the system 
will automatically select the first pressure label as the PR source. 

10.7.4 Showing/Hiding PR

You can set whether to display the PR value in the SpO2 parameter area. To do so, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 menu.

2. Select the PR tab.

3. Select the Setup tab.

4. Switch on or off Display PR.

10.8 Displaying SpO2 Statistics

You can show SpO2 statistics for a defined period of time. To do so, follow this procedure:

1. Access the Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.
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2. Select the parameter numeric area where you want to display SpO2 statistics, and then from the popup list 
select SpO2 → SpO2 Statistics.

The following figure shows the SpO2 statistics area.

10.8.1 Selecting the Range of each SpO2 Section and the Target Section

To define the SpO2 range of each section, follow this procedure:

1. Select the SpO2 statistics area.

2. In the To column set the SpO2 value at which each section ends. Changing the value in the To column 
automatically changes the value in the From column of the next section.

3. In the Target column select the section to be used as the target section. The target section is highlighted in 
green in the SpO2 statistics area. 

10.8.2 Selecting the SpO2 Statistics Length

The time period over which the SpO2 statistics are calculated is configurable. From the SpO2 statistics area, select 
a new duration from the popup menu.

10.9 SpO2 Troubleshooting

This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

(1) Duration of SpO2 statistics

(2) Results of SpO2 statistics

(3) Sections for statistics: The section in green indicates the target range.

(1)

(2)
(3)

Problem Solution

Do not see SpO2 numeric area or waveform area 
on the main screen

1.   Check that the SpO2 is set to display in the Screen Setup → → 
Tile Layout page. For more information, see 3.9.2 Displaying 
Parameter Numerics and Waveforms.
2. Check that the SpO2 parameter switch is enabled. If not, enable the 
SpO2 measurement.For more information, see 3.9.1 Switching On or 
Off a Parameter.
3. Check that the cable connections of the SpO2 sensor and the 
extension cable are tight. Replace the SpO2 sensor or the extension 
cable if needed.
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10.10  Nellcor Information
 

Nellcor Patents

This posting serves as notice under 35 U.S.C.§287(a) for Covidien patents: http://www.covidien.com/patents.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized replacement parts which would, alone, or in combination with this device, fall within the scope of 
one or more of the patents relating to this device.

10.11 Masimo Information
 

Masimo Patents

This posting serves as notice under 35 U.S.C.§287(a) for Masimo patents: http://www.masimo.com/patents.htm.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized sensors or cables which would, alone, or in combination with this device, fall within the scope of 
one or more of the patents relating to this device. 

10.12 Masimo End-User License Agreement
THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN YOU (“PURCHASER”) AND SHENZHEN MINDRAY. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE ENTIRE PACKAGE, INCLUDING ALL 
ACCESSORIES, IN THEIR ORIGINAL PACKAGE, WITH YOUR SALES RECEIPT TO SHENZHEN MINDRAY FOR A FULL 
REFUND.

1. Grant of License. In consideration of payment of the license fee, which is part of the price paid for this 
product, Shenzhen Mindray grants to Purchaser a nonexclusive, nontransferable license, without right to 
sublicense, to use the copy of the incorporated software/firmware, and documentation in connection with 
Purchaser's use of the Masimo Products for their labeled purpose. Shenzhen Mindray reserves all rights not 
expressly granted to Purchaser.

Dashes “- -” display in place of numerics 1. Check that the cable connections of SpO2 sensor and the 
extension cable are tight. Replace the SpO2 sensor or the extension 
cable if needed.
2. Reconnect the SpO2 sensor if the alarm SpO2 Sensor Off appears. 
3. Check the PI value. If the PI value is too low, adjust the SpO2 sensor, 
or apply the sensor to a site with better perfusion.
4. Move the sensor to a place with weaker ambient light, or cover the 
sensor to minimize the ambient light if the alarm SpO2 Too Much 
Light appears.

Low amplitude SpO2 signal 1. The SpO2 sensor and NIBP cuff are placed on the same limb. 
Change the monitoring site if necessary.
2. Check the PI value. If the PI value is too low. Adjust the SpO2 sensor, 
or apply the sensor to a site with better perfusion.

SpO2 value is inaccurate 1. Check the patient’s vital signs.
2. Check for conditions that may cause inaccurate SpO2 readings. For 
more information, see 10.3 SpO2 Measurement Limitations.
3. Check the monitor, the SpO2 module or the MPM for proper 
functioning.

Problem Solution
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2. Ownership of Software/Firmware. Title to, ownership of, and all rights and interests in, any Masimo 
software and/or firmware and the documentation, and all copies thereof, remain at all times vested in 
Masimo Corporation, licensor to Shenzhen Mindray, and they do not pass to Purchaser.

3. Assignment. Purchaser shall not assign or transfer this License, in whole or in part, by operation of law or 
otherwise, without Shenzhen Mindray's prior written consent; any attempt without such consent, to assign 
any rights, duties or obligations arising hereunder shall be void.

4. Copy Restrictions. The software/firmware, mask works, circuit board layouts, and accompanying written 
materials are copyrighted. Unauthorized copying of the software, including software that has been 
modified, merged, or included with other software, or other written materials is expressly forbidden. You 
may be held legally responsible for any copyright infringement that is cause or incurred by your failure to 
abide by the terms of this license. Nothing in this license provides any rights beyond those provided by 17 
U.S.C. §117.

5. Use Restriction. As the Purchaser, you may physically transfer the products from one location to another 
provided that the software/firmware is not copied. You may not electronically transfer the software/
firmware from the products to any other device. You may not disclose, publish, translate, release distribute 
copies of, modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works 
based on the Masimo Product, the software/firmware, or the written materials without the prior written 
consent of Masimo. Masimo Sensors that are designated for single use are licensed under Masimo patents 
for use on a single patient only, and are not sold. There is no license, implied or otherwise, that would allow 
use of single use Masimo Sensors beyond their intended single use. After use of single use Masimo Sensors, 
there is no further license granted by Masimo to use the sensors and they must be discarded.

6. Transfer Restrictions. The software/firmware is licensed to the Purchaser, and may not be transferred to 
anyone, except other end-users, without the prior written consent of Shenzhen Mindray. In no event may 
you transfer, assign, rent, lease, sell, or otherwise dispose of the software/firmware or the products on a 
temporary basis.

7. Beneficiary. Masimo Corporation is a Beneficiary of this Agreement and has the right to enforce its 
provisions.

U.S. Government Rights: If you are acquiring software (including the related documentation) on behalf of any 
part of the United States Government, the following provisions apply: the software is deemed to be “commercial 
software” and “commercial computer software documentation,” respectively pursuant to DFAR Section 227.7202 
FAR 12.212, as applicable. Any use, modification, reproduction, release, performance, display or disclosure of the 
software (including the related documentation) by the U.S. Government or any of its agencies shall be governed 
solely by the terms of this Agreement and shall be prohibited except to the extent expressly permitted by the 
terms of this agreement.
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11 Monitoring Temperature (Temp)

11.1 Temperature Introduction
The monitor can continuously monitor the patient’s skin temperature and core temperature. Thermally sensitive 
resistors (thermistors) are used, and are based on the principle that electrical resistance of the thermistor 
changes as temperature changes. The resistance change of the thermistors is used to calculate the temperature. 

Up to two temperature sites can be monitored simultaneously and the difference between two measured sites is 
calculated.

Temperature monitoring is intended for adult, pediatric and neonatal patients.

11.2 .Temperature Safety Information

CAUTION

• Verify that the probe detection program works correctly before monitoring. Remove the 
temperature probe cable from the temperature probe connector, and check that the monitor can 
display the alarm messages and give alarm tones correctly.

11.3 Temperature Display 
The following figure shows the Temp numeric area for temperature monitoring with the monitor. Your display 
may be configured to look different.

11.4 Preparing for Temperature Monitoring
To prepare temperature monitoring, follow this procedure:

1. Select an appropriate probe for your patient according to patient category and measured site.

2. Plug the probe or temperature cable to the temperature connector. If using a disposable probe, connect 
the probe to the temperature cable.

3. Follow the probe manufacturer’s instructions to connect the probe to the patient.

(1) Temperature site (2) Temperature alarm limits             (3) Temperature value

(4) Temperature difference (∆T): Difference between two temperature sites. It displays only when ∆T is 
switched on.

(3)

(1)

(3)

(4)(2)

(1)

(2)
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11.5 Changing Temperature Settings

11.5.1 Setting the Temperature Alarm Properties 
To set the temperature alarm properties, follow this procedure:

1. Select the temperature numeric area to enter the Temp dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

11.5.2 Selecting the Temperature Label 
Select the temperature label according to the measurement site. To do so, follow this procedure:

1. Select the temperature numeric area to enter the Temp dialog.

2. Select the Setup tab.

3. Set the temperature label. 

11.5.3 Displaying the Temperature Difference 
To display the temperature difference between two measurement sites monitored by the same temperature 
module, switch on ∆T. To do so, follow this procedure:

1. Select the temperature numeric area to enter the Temp dialog.

2. Select the Setup tab.

3. Switch on ∆T.

11.6 Temperature Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

Label Description Label Description

T1 Temperature of application site 1 T amb Ambient temperature

T2 Temperature of application site 2 T airw Airway temperature

T skin Skin temperature T vesic Vesical temperature

T core Core temperature T blood Blood temperature

T axil Axillary temperature T myo Myocardial temperature

T naso Nasopharyngeal temperature T tymp Tympanic temperature

T eso Esophageal temperature T cereb Cerebral temperature

T rect Rectal temperature
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Problem Solution

Do not see Temp numeric area on the main 
screen

1.  Check that if the Temp parameter switch is enabled. If not, enable 
the Temp measurement. For more information, see 3.9.1 Switching 
On or Off a Parameter.

2. Check that the connections of the temperature probe and the 
temperature cable are tight.

Measurement fails/’--’ is displayed in the Temp 
numeric area

1. If using a disposable probe, check the connection between the 
probe and the temperature cable.

2. Try using a known good probe in case the sensor is damaged.
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12 Monitoring Noninvasive Blood Pressure (NIBP)

12.1 NIBP Introduction
The monitor uses the oscillometric method for measuring Non-Invasive Blood Pressure (NIBP). NIBP 
measurement is based on the principle that pulsatile blood flow through an artery creates oscillations of the 
arterial wall. The oscillometric device uses a blood pressure cuff to sense these oscillations that appear as tiny 
pulsations in cuff pressure. The oscillometric devices measure the amplitude of pressure changes in the 
occluding cuff as the cuff deflates from above systolic pressure. The amplitude suddenly increases as the pulse 
breaks through the occlusion in the artery. As the cuff pressure decreases further, the pulsations increase in 
amplitude, reach a maximum (which approximates to the mean pressure), and then diminish. The oscillometric 
method measures the mean pressure and determines the systolic and diastolic pressures.

NIBP monitoring is intended for adult, pediatric, and neonatal patients.

NOTE

• Blood pressure measurements determined with this device are equivalent to those obtained by a 
trained observer using the cuff/stethoscope auscultatory method or an intra-arterial blood pressure 
measurement device, within the limits prescribed by the American National Standard: manual, 
electronic, or automated sphygmomanometers. 

• NIBP measurement can be performed during electro-surgery and discharge of a defibrillator.

12.2 NIBP Safety Information

WARNING

• Be sure to select the correct patient category setting for your patient before NIBP measurement. Do 
not apply the higher adult settings for pediatric or neonatal patients. Otherwise, it may present a 
safety hazard.

• Do not measure NIBP on patients with sickle-cell disease or on the limb where skin damage has 
occurred or is expected.

• Use clinical judgment to determine whether to perform frequent unattended blood pressure 
measurements on patients with severe blood clotting disorders because of the risk of hematoma in 
the limb fitted with the cuff.

• Do not use the NIBP cuff on a limb with an intravenous infusion or arterial catheter in place. This 
could cause tissue damage around the catheter when the infusion is slowed or blocked during cuff 
inflation.

• Do not apply cuff on the arm on the side of a mastectomy or lymph node clearance.

• Continuous cuff pressure due to connection tubing kinking may cause blood flow interference and 
result in harmful injury to the patient.

• NIBP reading can be affected by the measurement site, the position of the patient, exercise, or the 
patient's physiologic condition. If you doubt the NIBP measurements, determine the patient’s vital 
signs by alternative means, and then verify that the monitor is working correctly.

• Devices that exert pressure on tissue have been associated with purpura, ischemia, and neuropathy. 
Inspect the application site regularly to ensure skin quality and inspect the extremity of the cuffed 
limb for normal color, warmth and sensitivity. If the skin quality changes, or if the extremity 
circulation is being affected, move the cuff to another site or stop the blood pressure measurements 
immediately. Check more frequently when making automatic or STAT measurements. Auto NIBP 
measurements with one and two minute intervals are not recommended for extended periods of 
time.

• Do not modify or replace connectors of the NIBP air hose except with mindray-approved connectors. 
Use neonatal and infant cuffs with CM1901 hoses only. Use pediatric/adult cuffs with CM1903 hoses 
only.
BeneVision N1 Patient Monitor Operator’s Manual 12 - 1



• Never connect intra-arterial or intra-venous lines, or any other incompatible connectors to the NIBP 
hose. This can cause serious injury or death.

• NIBP diagnostic significance must be decided by the hospital’s clinician staff.

CAUTION
 

• Measuring NIBP on patients connected to an Intra Aortic Balloon Pump (IABP) machine may result in 
the NIBP measurement, including PR, to be inaccurate or fail.

• Only use parts and accessories specified in this manual. Follow the instructions for use and adhere to 
all warnings and cautions.

• Using IABP may cause NIBP, including PR, measurements inaccurate or failed.

• Accuracy of NIBP measurement depends on using a cuff of proper size. It is essential to measure limb 
circumference and choose a cuff with proper size.

12.3 NIBP Measurement Limitations
Measurements are impossible with heart rate extremes of less than 30 bpm or greater than 300 bpm, or if the 
patient is on a heart-lung machine. The measurement may be inaccurate or impossible in the following 
situations:

■ Regular arterial pressure pulses are hard to detect

■ Excessive and continuous patient movement such as shivering or convulsions

■ Cardiac arrhythmias

■ Rapid blood pressure changes

■ Severe shock or hypothermia that reduces blood flow to the peripheries

■ On an edematous extremity

■ Obesity, where a thick layer of fat surrounding a limb dampens the oscillations coming from the artery

NOTE

• The effectiveness of this sphygmomanometer has not been established in pregnant women, 
including pre-eclamptic patients.

12.4 Measurement Modes
The monitor provides the following NIBP measurement modes:

■ Manual: measurement on demand.

■ Auto: repeated measurements at set interval.

■ STAT: continual rapid series of measurements over a five-minute period.

■ Sequence: continually automatic measurement at set durations and intervals. 
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12.5 NIBP Display
The NIBP display shows only numerics. 

NOTE

• If NIBP measurement fails, “XX” is displayed; if NIBP measurement is not taken or NIBP 
measurement exceeds its measurement ranges, “--” is displayed.

• NIBP numerics in black color with a light outline indicate that the measurement is old and exceeds 
the configured NIBP Measurement Timeout time (see section 21.5.7 Setting Parameter Measurement 
Timeout). These NIBP values are not recommended for reference.

12.6 Preparing for NIBP Measurements

12.6.1 Preparing the Patient for NIBP Measurements
In normal use, perform NIBP measurement on a patient who is in the following position:

■ Comfortably seated

■ Legs uncrossed

■ Feet flat on the floor

■ Back, arm and feet supported 

NOTE
• It is recommended that the patient remains calm and relaxes as much as possible before performing 

the measurement and that the patient does not talk during the measurement.

  (3)                       (4)                                                                 (5)      

  (10)                              (9)

  (2) 

  (1) 

(6)

(7)

(8)

(11)

(1) Systolic pressure alarm limits

(2) NIBP unit: mmHg or kPa

(3) The last NIBP measurement time

(4) Time to the next measurement (for Auto mode and Sequence mode)

(5) Measurement mode: for Auto NIBP, interval is displayed; for Sequence mode, the current phase and interval are displayed

(6) Diastolic pressure

(7) Diastolic pressure alarm limits

(8) Mean pressure alarm limits

(9) Mean pressure (displayed after measurement completed) or cuff pressure (displayed during the measurement)

(10) Systolic pressure

(11) Pulse Rate
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• Other factors that have been shown to result in an overestimation of blood pressure are labored 
breathing, full bladder, pain etc.

12.6.2 Placing the NIBP Cuff
To place the NIBP cuff, follow this procedure:

1. Verify that the patient category setting is correct. 

2. Connect the air tubing to the NIBP connector. 

3. Select an appropriately sized cuff for the patient, and then wrap it around the limb directly over the 
patient’s skin as follows:

a Determine the patient’s limb circumference.

b Select an appropriate cuff by referring to the limb circumference marked on the cuff. The width of the 
cuff should be 40% (50% for neonates) of the limb circumference, or 2/3 of the length of the upper 
arm or the thigh. The inflatable part of the cuff should be long enough to encircle to overlap at least 
50% to 80% of the limb. 

c Apply the cuff to the patient’s upper arm or leg and make sure the Φ marking on the cuff matches the 
artery location. The cuff should fit snugly, but with enough room for two fingers to be placed 
between the cuff and the patient’s arm (on adults), and loosely on neonates with little or no air 
present within the cuff. Otherwise it may cause discoloration and ischemia of the extremities. Make 
sure that the cuff index line falls within the range markings on the cuff. If it does not, use a cuff that fits 
better.

d Middle of the cuff should be at the level of the right atrium of the heart. If it is not, use the 
measurement correction formula to correct the measurement. For more information, see 
12.8.7 Setting the NIBP Display Format.

4. Connect the cuff to the air tubing. Avoid compression or restriction of pressure tubes. Air must pass 
unrestricted through the tubing.

CAUTION

• Do not touch or apply external pressure against the cuff and air tubing during NIBP measurement. 
This may cause inaccurate blood pressure values. 

• Use care when placing the cuff on an extremity used for monitoring other patient parameters.

12.7 Starting and Stopping NIBP Measurements
Start and stop NIBP measurement by selecting the NIBP quick keys or from the NIBP dialog.

Task By Quick Key From NIBP dialog

Start a manual measurement NIBP Start/Stop quick key Start NIBP button

Start auto NIBP series NIBP Start/Stop quick key Setup tab → set Interval → Start NIBP 
button

NIBP Measure quick key →select 
Interval

Start NIBP sequence 
measurement

NIBP Measure quick key  → 

Sequence
Sequence tab → set NIBP sequence 
→Start NIBP button

Start STAT measurement NIBP Measure quick key  → STAT STAT button

Stop the current NIBP 
measurements

NIBP Start/Stop quick key Stop NIBP button

End auto NIBP series or NIBP 
Sequence

/ NIBP Stop All button
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12.8 Changing NIBP Settings

12.8.1 Setting the NIBP Alarm Properties
To set the NIBP alarm properties, follow this procedure: 

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

12.8.2 Setting the Initial Cuff Inflation Pressure
To set initial cuff inflation pressure, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select Initial Pressure, and then select the appropriate setting.

NOTE

•  For known hypertensive patients, you need to set initial cuff pressure to a higher value to reduce the 
measurement time.

12.8.3 Setting the NIBP Interval
For auto NIBP measurement, you need to set the interval between two NIBP measurements. To set the NIBP 
interval, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Set Interval. Selecting Manual switches to manual mode.

NOTE

• NIBP Measure dialog gives quick access to starting and setting the interval. Selecting an option from 
the NIBP Measure dialog will change the NIBP interval to that selection and start the NIBP 
measurement.

12.8.4 Selecting NIBP Start Mode
Start mode defines how future NIBP  measurements are initiated with automatic measurement mode. To set the 
start mode, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select Start Mode. 

◆ Clock: after the first measurement, the monitor automatically synchronizes NIBP automatic 
measurements with the real time clock. For example, if Interval is set to 20 min, and NIBP auto 
measurement is started at 14:03, the next measurement will be taken at 14:20, and then at 14:40, 
15:00, and so on.

◆ Interval: after the first measurement, the monitor automatically repeats measurements at set interval. 
For example, if Interval is set to 20 min, and NIBP auto measurement is started at 14:03, the next 
measurement will be taken at 14:23, and then at 14:43, 15:03, and so on.

Stop STAT measurement and end 
series

NIBP Start/Stop quick key Stop NIBP or NIBP Stop All button

Task By Quick Key From NIBP dialog
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12.8.5 Enabling the NIBP End Tone
The monitor can issue a reminder tone at the completion of NIBP measurement. The NIBP End Tone is off by 
default. To switch on the NIBP end tone, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Switch on NIBP End Tone. 

12.8.6 Setting NIBP Sequence
NIBP sequence measurement can have up to five phases: A, B, C, D, and E. The duration and interval of each phase 
can be set individually. 

To set NIBP sequence, follow this procedure: 

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select the Sequence tab.

3. Set Duration and Interval of each phase. 

12.8.7 Setting the NIBP Display Format
To set the NIBP display format, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP menu.

2. Select the Setup tab.

3. Set Display Format.

12.8.8 Setting the NIBP Alarm Limits Display Switch
To set whether to display the alarm limits of diastolic NIBP and mean NIBP, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP menu.

2. Select the Setup tab.

3. Switch on or off Display Alarm Limits.

12.8.9 Showing/Hiding PR
You can set whether to display the PR value in the NIBP parameter area. To do so, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP menu..

2. Select the Setup tab.

3. Switch on or off Display PR.

12.8.10 Correcting the NIBP Measurements
The middle of the cuff should be at the level of right atrium. If the limb is not at the heart level, the measurement 
should be corrected as follows:

■ Add 0.75 mmHg (0.10 kPa) to the displayed value for each centimetre higher.

■ Deduct 0.75 mmHg (0.10 kPa) to the displayed value for each centimeter lower.

12.9 Assisting Venous Puncture
You can use the NIBP cuff to cause sub-diastolic pressure to block the venous blood vessel and therefore help 
venous puncture. To assist venous puncture, follow this procedure:

1. Select the NIBP numeric area → Setup tab.

2. pSet Venipuncture Pressure.

3. Select Venipuncture at the bottom of the dialog.

4. Puncture vein and draw blood sample.
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5. Select the NIBP Start/Stop quick key to deflate the cuff. If the cuff is not manually deflated, the cuff 
automatically deflates after a fixed period of time (170 seconds for adult and pediatric patient, 85 seconds 
for neonatal patient). 

During venous puncture, pay attention to the cuff pressure and the remaining time displayed in the NIBP 
numerics area. 

12.10 NIBP Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

Problem Solution

Cannot see NIBP numeric area on the main 
screen

1. Check that the NIBP is set to display in the Screen Setup → Tile Layout 
page. For more information, see.3.9.2 Displaying Parameter Numerics and 
Waveforms

2. Check that if the NIBP parameter switch is enabled. If not, enable the NIBP 
measurement. For more information, see 3.9.1 Switching On or Off a 
Parameter.
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13 Monitoring Invasive Blood Pressure (IBP)

13.1 IBP Introduction
This patient monitor can monitor up to four invasive blood pressures and displays the systolic, diastolic and 
mean pressures and a waveform for each pressure.

IBP monitoring is intended for adult, pediatric, and neonatal patients. PAWP monitoring is only intended for 
adult and pediatric patients. 

NOTE

• In order for the N1 to connect to the external IBP module and perform IBP monitoring, the N1system 
software V01.62.00 and above is required.

13.2 IBP Safety Information

WARNING

• Use only pressure transducers specified in this manual. Never reuse disposable pressure 
transducers. See chapter 25 Accessories for specified pressure transducers.

• Make sure that the applied parts never contact other conductive parts.

• To reduce the hazard of burns during high-frequency surgical procedures, ensure that the monitor’s 
cables and transducers never come into contact with the high-frequency surgical units.

• When using accessories, their operating temperature should be taken into consideration. For more 
information, see instructions for use of accessories.

• All invasive procedures involve risks to the patient. Use aseptic technique. Follow catheter 
manufacturer's instructions. 

• Mechanical shock to the invasive blood pressure transducer may cause severe shifts in zero balance 
and calibration, and cause erroneous readings. 

• The neutral electrode of the electro-surgery unit (ESU) shall properly contact the patient. Otherwise, 
burns may result.

(1) IBP cable connector (2) IBP dialog hard key (3) Zero IBP hard key

(1)

(1)

(3)(2)

(1)
BeneVision N1 Patient Monitor Operator’s Manual 13 - 1



CAUTION

• Measuring IBP on patients connected to an Intra Aortic Balloon Pump (IABP) machine may result in 
the IBP measurement, including PR, to be inaccurate or fail.

NOTE

• PAWP monitoring is available only when using an external display.

13.3 Preparing for IBP Monitoring

13.3.1 IBP Equipment to Patient Connection

13.3.2 Measuring an Invasive Blood Pressure
To monitor IBP, follow this procedure:

1. Connect one end of the IBP cable to the IBP cable connector, and the other end to the IBP transducer.

2. Flush the IBP transducer system to exhaust all air from the tubing according to the manufacturer’s 
instructions. Ensure that the system is free of air bubbles.

3. Connect the IBP transducer to the patient, making sure that the transducer is at the same horizontal level as 
the heart.

4. Select the proper pressure label for currently measured pressure. For more information, see 
13.6.2 Changing the Pressure Label.

5. Zero the IBP transducer. For more information, see.13.3.3 Zeroing the IBP transducer. After a successful 
zeroing, turn off the three-way valve to the air and turn on the three-way valve to the patient.

(1) Pressure bag (2) IBP connector

(3) IBP cable (4) IBP transducer

(5) Three-way valve

(1)

(2)

(3)

(4)

(5)

(5)
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CAUTION

• Make sure that all the transducers are zeroed correctly before making IBP measurements.

• Make sure that all air bubbles have been flushed from the IBP transducer system before making IBP 
measurements. 

• If measuring intracranial pressure (ICP) with a sitting patient, level the transducer with the top of the 
patient’s ear. Incorrect leveling may give incorrect values (not applicable if measuring ICP with the 
Codman ICP transducer).

NOTE

• If two invasive blood pressures measurements are needed, use the IBP extension cable with dual-
receptacle (PN: 040-001029-00) instead of the IBP cable.

13.3.3 Zeroing the IBP transducer
To avoid inaccurate pressure readings, the monitor requires a valid zero. Zero the transducer in accordance with 
your hospital policy. The IBP transducer should be zeroed in the following conditions:

■ The IBP transducer or adapter cable is reconnected.

■ The monitor restarts.

■ The readings are in doubt.

■ The monitor displays the prompt message Zero Required.

To zero the transducer, follow this procedure:

1. Connect the IBP transducer, the IBP adapter cable and the monitor.

2. Turn off the three-way valve (the one near the transducer) to the patient, in order to vent the transducer to 
the atmospheric pressure.

3. Select the numeric area (such as the Art numeric area), and then select Zero button.

4. After the zero calibration is completed, close the three-way valve to the air and open the three-way valve to 
the patient.

Zero calibration may fail in case of pressure fluctuation or pressure exceeding the calibration range. If zero 
calibration fails, follow this procedure:

1. Check that the three-way valve (the one near the transducer) is open to the air. 

2. Perform zero calibration again. Do not sway the IBP transducer and tubing during zero calibration.

13.4 Measuring ICP Using the Codman ICP Transducer

13.4.1 Zeroing the Codman ICP transducer
The Codman ICP transducer (Model: 82-6653) must be zeroed before use. To zero the ICP transducer, follow this 
procedure:

1. Connect the ICP transducer, the ICP adapter cable and the monitor.

2. Follow the manufacturer’s instructions to prepare the ICP transducer.

3. Zero the ICP transducer: when the message Zero Reference is displayed in the ICP numeric area, select the 
ICP waveform area or numeric area to enter the ICP dialog → select the Zero tab → select the Zero button.

4. Record the zero reference value on the blank area of the ICP transducer for reference.

If the ICP transducer zero calibration failed or the zero reference value is in doubt, perform the zero calibration 
again.

13.4.2 Measuring ICP
To perform the ICP measurement, follow this procedure:
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1. Zero the Codman ICP transducer. For more information, see section 13.4.1 Zeroing the Codman ICP 
transducer.

2. Disconnect the ICP transducer and ICP adapter cable. Follow the manufacturer’s instructions to apply the 
ICP transducer to the patient.

3. Reconnect the ICP transducer and ICP adapter cable. 

4. Check that the zero reference value displayed on the monitor is consistent with that recorded on the ICP 
transducer. 

◆ Consistent: select Accept.

◆ Inconsistent: input the zero reference value recorded on the ICP transducer, and select Accept.

If the patient being monitored for ICP must be transported, and N1 is not used for transport, check that the 
transport monitor supports the Codman ICP transducer. If the transport monitor does not support the Codman 
ICP transducer, do not use it for ICP monitoring.

If the transport monitor supports the Codman ICP transducer, follow this procedure to transport the patient:

1. Disconnect the ICP adapter cable from the N1.

2. Connect the ICP adapter cable and the transport monitor.

3. Check that the zero reference value displayed on the monitor is consistent with that recorded on the ICP 
transducer. 

◆ Consistent: select Accept.

◆ Inconsistent: input the zero reference value recorded on the ICP transducer, and select Accept.

CAUTION

• If monitors of different brands are used to zero the Codman ICP transducer, the zero reference 
values can be different. Use a Mindray monitor to Zero the Codman ICP transducer if you will take 
ICP measurement using a Mindray monitor. Otherwise the ICP measurement could be inaccurate.

13.5 IBP Display
The IBP measurement is displayed on the monitor as a waveform and numeric pressures. For arterial pressure, 
the IBP numeric area displays systolic pressure, diastolic pressure and mean pressure. For venous pressure, the 
IBP numeric area displays only the mean pressure. The figure below shows the waveform and numerics for the 
Art pressure. 

For some pressures, the parameter window may show the mean pressure only. For different pressures, their 
defaults unit may be different. If the Art and ICP pressures are measured simultaneously, the ICP parameter area 
will display numeric CPP, which is obtained by subtracting ICP from the Art mean.

13.5.1 Overlapping IBP Waveforms
The IBP waveforms can be displayed together. To combine IBP waveforms, follow this procedure:

(1) Pressure label (2) Waveform

(3) Pressure Unit (4) Systolic pressure

(5) Diastolic pressure (6) Mean pressure

(7) PPV measurement

(7)                      (6)

  (1)                          (2)                                                                                                            (3)               (4)              (5)     
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1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆ Select Main Menu quick key → from the Display column select Tile Layout.

2. Select the waveform area where you want to display the overlapped IBP waveforms, and then select the IBP 
waves to be overlapped on the left side of the same line.

3. Repeat step 2 in another waveform area if needed.

4. Select  to save the setting and exit the screen. The main screen will display the overlapped IBP waves.

Selecting the overlapped IBP waveforms on the main screen opens the Overlapping Waveform Setup dialog, 
where you can make the following settings:

■ Scale

◆ Set Left Scale for the arterial pressure.

◆ Set Right Scale for the venous pressure.

◆ Set CVP Scale individually if the CVP waveform is combined and CVP unit is different from IBP unit.

◆ Set ICP Scale individually if the ICP waveform is combined and ICP unit is different from IBP unit.

◆ Set PA Scale individually if the PA waveform is combined.

■ Switch on or off Gridlines to show or hide gridlines in the overlapped waveform area.

■ Set Speed for the overlapped waveforms.

NOTE

• The unit of CVP scale is consistent with the CVP parameter unit.

13.6 Changing IBP Settings

13.6.1 Changing the IBP Alarm Settings
To change the IBP alarm settings, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set the alarm properties of pressure.

13.6.2 Changing the Pressure Label
The pressure label is a unique identifier for each type of pressure. Therefore, it is recommended to select the 
proper pressure label for the source of the pressure being monitored. 

To select the pressure label, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Setup tab.
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3. Set IBP1 Label or IBP2 Label.

NOTE

• The same label cannot be selected for different pressures. When two pressures are detected having 
the same label, the monitor automatically changes one pressure label to a currently unused one.

13.6.3 Setting the Pressure Type for Display
For the non-specific pressure (P1, P2, P3 or P4), the displayed pressure type is configurable. To set the displayed 
pressure type, follow this procedure:

1. Select the numeric area or waveform area of the non-specific pressure to enter the corresponding pressure 
dialog.

2. Select the Setup tab.

3. Set Measure:

◆ If this non-specific pressure is arterial pressure, set the Measure to All. In this case, its corresponding 
numeric area displays systolic pressure, diastolic pressure and mean pressure.

◆ If this non-specific pressure is venous pressure, set the Measure to Mean Only. In this case, its 
corresponding numeric area displays only the mean pressure.

13.6.4 Changing the Sensitivity
The IBP value displayed on the monitor screen is the average of data collected within a specific time. The shorter 
the averaging time is, the quicker the monitor responds to changes in the patient’s blood pressure, and the 
higher the sensitivity. Contrarily, the longer the averaging time is, the slower the monitor responds to changes in 
the patient’s blood pressure, the lower the sensitivity, but the measurement accuracy will be improved. For 
critically ill patients, selecting higher sensitivity will help with understanding the patient’s state. 

To set the sensitivity, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Setup tab.

3. Set Sensitivity.

13.6.5 Setting the IBP Waveform
To set the IBP waveform, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Setup tab.

3. Set the following properties of the IBP waveform:

◆ Speed

◆ Scale: if Auto is selected, the size of the pressure’s waveform will be adjusted automatically.

Label Description Label Description

Art Arterial blood pressure PA Pulmonary artery pressure

Ao Aortic pressure UAP Umbilical arterial pressure

BAP Brachial arterial pressure FAP Femoral arterial pressure 

CVP Central venous pressure LAP Left atrial pressure

RAP Right atrial pressure ICP Intracranial pressure

UVP Umbilical venous pressure LV Left ventricular pressure

P1 to P4 Non-specific pressure label
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13.6.6 Setting the Display Format of Artery Pressure
To set the display format of the artery pressure, follow this procedure:

1. Select the numeric area or waveform area of any arterial pressure to enter the corresponding menu.

2. Select the Setup tab.

3. Set Display Format.

13.6.7 Showing/Hiding the Alarm Limits of Artery Pressure
To set whether to display the alarm limits of the arterial pressure, follow this procedure:

1. Select the numeric area or waveform area of any arterial pressure to enter the corresponding menu.

2. Select the Setup tab.

3. Switch on or off Display Alarm Limits.

13.6.8 Setting the Use PA-D as PAWP Switch (only available when the N1 is used with 
the independent external display)
The PA-D value can be configured to replace the PAWP value for hemodynamic calculation. To do so, follow this 
procedure:

1. Select the PA numeric area or waveform area to enter the PA dialog.

2. Select the Setup tab.

3. Switch on or off Use PA-D as PAWP.

For more information on hemodynamic calculation, see 17.4 Hemodynamic Calculations.

13.6.9 Enabling PPV Measurement
PPV indicates pulse pressure variation. When measuring the arterial pressure (except PA), the PPV measurement 
is available. To enable the PPV measurement, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the PPV Setup tab.

3. Switch on PPV Measure.

You can select PPV source after enabling the PPV measurement. 

WARNING

• This monitor can calculate PPV from beat-to-beat values of any arterial pulsatile pressure. The 
circumstances under which the calculation of a PPV value is clinically meaningful, appropriate and 
reliable must be determined by a physician.

• The clinical value of the derived PPV information must be determined by a physician. According to 
recent scientific literature, the clinical relevance of PPV information is restricted to sedated patients 
receiving controlled mechanical ventilation and mainly free from cardiac arrhythmia.

• PPV calculation may lead to inaccurate values in the following situations:

◆ at respiration rates below 8 rpm

◆ during ventilation with tidal volumes lower than 8 ml/kg

◆ for patients with acute right ventricular dysfunction (cor pulmonale).

• The PPV measurement has been validated only for adult patients.

13.7 PAWP (only available when the N1 is used with the independent 
external display)
Pulmonary Artery Wedge Pressure (PAWP) values, used to assess cardiac function, are affected by fluid status, 
myocardial contractility, and valve and pulmonary circulation integrity.
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Obtain the measurement by introducing a balloon-tipped pulmonary artery flotation catheter into the 
pulmonary artery. When the catheter is in one of the smaller pulmonary arteries, the inflated balloon occludes 
the artery allowing the monitor to record changes in the intrathoracic pressures that occur throughout the 
respiration cycle.

The pulmonary wedge pressure is the left ventricular end diastolic pressure when the airway pressure and valve 
function are normal. The most accurate PAWP values are obtained at the end of the respiration cycle when the 
intrathoracic pressure is fairly constant and the artifact caused by respiration is minimal.

WARNING

• PAWP monitoring is not intended for neonatal patients.

13.7.1 PAWP Equipment to Patient Connection

13.7.2 Preparing to Measure PAWP
To prepare to monitor PAWP, follow this procedure:

1. Connect one end of the IBP cable to the IBP cable connector, and the other end to the IBP transducer. For 
more information, see 13.3.2 Measuring an Invasive Blood Pressure.

2. Follow the manufacturer’s instructions to connect the PA port of the thermodilution catheter and the 
patient end of the IBP transducer.

3. Zero the IBP transducer. For more information, see 13.3.3 Zeroing the IBP transducer.

(1) IBP connector (2) Flush bag

(3) IBP transducer (4) Three-way valve

(5) PA distal port (6) Balloon inflation syringe

(7) Thermodilution catheter (8) Balloon

(1)
(2)

(3)

(4)

(5)

(6)

(7)

(8)
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4. Set the IBP label to PA since the PAWP is measured on PA. For more information, see 13.6.2 Changing the 
Pressure Label. 

13.7.3 Measuring PAWP
To measure the PAWP, follow this procedure:

1. Select the PA numeric area or waveform area to enter the PA dialog, and then select PAWP. 

2. Wedge the flotation catheter into the pulmonary artery by observing the PA waveform changes on the 
screen, referring to the following figure. 

3. Select Start.

4. Inflate the balloon and pay attention to PA waveform changes on the screen when the prompt message 
Ready For Balloon Deflation appears.

5. Deflate the balloon when the prompt message Ready For Balloon Deflation appears. If the PA waveform 
is stable, but the monitor is still not showing the prompt message Ready For Balloon Deflation, select 
Freeze to freeze the waveform, and deflate the balloon.

6. Select Accept to save the PAWP value.

7. If you need to start a new measurement, repeat step 3 to step 6.
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If the measurement fails or you need to adjust the PAWP value, you can use the following buttons to adjust the 
PAWP waveform and measurement. 

■ Select the up or down arrow button to adjust the PAWP value.

■ Select the left or right arrow button to view the frozen waveforms of 40 seconds.

■ Select Accept to save the PAWP value.

WARNING

• Prolonged inflation can cause pulmonary hemorrhage, infarction or both. Inflate the balloon for the 
minimum time necessary to get an accurate measurement.

• If the PAWP is greater than the PA (systolic), deflate the balloon and report the incident in 
accordance with hospital policy. Because the pulmonary artery could be accidentally ruptured, and 
the PAWP value derived will not reflect the patient’s hemodynamic state, but will merely reflect the 
pressure in the catheter or balloon.

• If the flotation/thermodilution catheter drifts into the wedge position without inflation of the 
balloon, the PA waveform assumes a wedged appearance. Take appropriate action, in accordance 
with standard procedures, to correct the situation.

NOTE

• The PA alarm is turned off automatically when the monitor enters the PAWP screen.

13.7.4 Setting the Waveforms of the PAWP Screen
On the PAWP screen, select Setup to enter the PAWP Setup dialog. In the PAWP Setup dialog, you can make 
the following settings:

■ Select Reference Waveform 1 to set an ECG lead wave as the first reference wave.

■ Select Reference Waveform 2 to set a respiration wave as the second reference wave.

■ Select Speed to set a sweep speed for the displayed waveforms on the PAWP screen.

■ Select Scale to set the  size of the PA waveform on the PAWP screen.

13.7.5 Performing Hemodynamic Calculation (only available when the N1 is used with 
the independent external display)
On the PAWP screen, select Hemo Calcs to enter the Calculations dialog. For more information, see 
17.4 Hemodynamic Calculations.

13.8 IBP Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.
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Problem Solution

Cannot see IBP numeric area or waveform 
area on the main screen

1. Check that the IBP is set to display in the Screen Setup dialog. For more 
information, see.3.9.2 Displaying Parameter Numerics and Waveforms.
2. Check that if the IBP parameter switch is enabled. If not, enable the IBP 
measurement. For more information, see 3.9.1 Switching On or Off a 
Parameter.
3. Check the connection of IBP cable, IBP transducer and module.
4. Check that the three-way valve is turned to the correct position.
5. Check that the IBP transducer has been zeroed. For more information, see 
13.3.3 Zeroing the IBP transducer.

Cannot see systolic pressure and diastolic 
pressure for P1/P2/P3/P4

Set Measure to All in the P1/P2/P3/P4 setup page. For more information, see 
13.6.3 Setting the Pressure Type for Display.

IBP readings seem unstable 1. Make sure there are no air bubbles in the transducer systems.
2. Check that the transducer is properly fixed.
3. Zero the transducer again.
4. Replace the transducer.

Zeroing of IBP channel(s) fails. 1. Ensure that the channels are open to air.
2. Perform zero calibration again. Do not sway the IBP transducer and 

tubing during zero calibration. For more information, see 13.3.3 Zeroing 
the IBP transducer.

3. If zero calibration still fails, replace the transducer.
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14 Monitoring Carbon Dioxide (CO2)

14.1 CO2 Introduction

CO2 monitoring is a continuous, non-invasive technique for determining the concentration of CO2 in the 
patient’s airway by measuring the absorption of infrared (IR) light of specific wavelengths. CO2 has its own 
absorption characteristic and the amount of light passing the gas probe depends on the concentration of the 
measured CO2. When a specific band of IR light passes through respiratory gas samples, some of IR light will be 
absorbed by the CO2 molecules. The amount of IR light transmitted after it has been passed through the 
respiratory gas sample is measured with a photodetector. From the amount of IR light measured, the 
concentration of CO2 is calculated.

CO2 measurement is used to monitor the patient’s respiratory status. The sidestream/Microstream CO2 
measurement takes a sample of the respiratory gas with a constant sample flow from the patient's airway and 
analyzes it with a remote CO2 sensor built into the Sidestream or Microstream CO2 module. 

The sidestream CO2 module can be configured with a paramagnetic oxygen sensor to measure O2. The 
paramagnetic oxygen sensor measures oxygen based on its paramagnetic properties. 

The sidestream and microstream CO2 measurement can be used, with specified accessories, with intubated and 
non-intubated adult, pediatric, and neonatal patients. With intubated patients, a sample of the respiratory gas is 
drawn from the patient's breathing circuit through an airway adapter and a gas sampling line. With non-
intubated patients, the gas sample is drawn through a nasal cannula.

Both sidestream and microstream CO2 modules have the function of automatic barometric pressure 
compensation (the system automatically measures the barometric pressure to which the patient monitor is 
exposed). 

CO2 monitoring is intended for adult, pediatric and neonatal patients.

WARNING

• The N1 monitor does not support CO2 measurements when used for transporting patients by rotary 
or fixed-wing ambulance.

• It is not recommended to measure O2 when transporting a patient with the N1 monitor. Shaking the 
CO2 module during O2 measurement may lead to a distorted O2 waveform or inaccurate O2 
measurement.

14.2 Identifying CO2 Modules

To measure CO2, use either the internal CO2 module or the external CO2 module. The external CO2 module is 
connected to the N1 through the Modular Rack. For the connection of the N1 and the external CO2 module, see 
section 2.8.1 Installing the N1 or External Parameter Module into the Modular Rack.

In sequence from left to right, the following are sidestream CO2 external module, microstream CO2 external 
module, and N1 monitor with internal CO2 module.
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14.3 CO2 Safety Information

WARNING

• Route all tubing away from the patient’s throat to avoid strangulation.

CAUTION

• Remove the airway sample line from the patient’s airway while nebulized medications are being 
delivered. Measuring CO2 during nebulization may lead to inaccurate CO2 readings.

• EtCO2 values measured from the CO2 module may differ from those from the blood gas analysis.

• Avoid mechanical shock to the sidestream CO2 module.

• Shaking the CO2 module during O2 measurement may lead to a distorted O2 waveform or 
inaccurate O2 measurement

NOTE

• The CO2 module automatically suppresses physiological alarms until breathing waves have been 
detected. Ensure that the patient is properly connected when using the CO2 module.

14.4 CO2 Measurement Limitations

The following factors may influence the measurement accuracy:

■ Leaks or internal venting of sampled gas

■ Mechanical shock

■ Cyclic pressure up to 10 kPa (100 cmH2O)

■ Other sources of interference, if any

For more information, refer to A.14.8 CO2 Specifications.

CAUTION

• Measurement accuracy of the sidestream CO2 module may be affected by the breath rate and 
inspiration/expiration (I/E) ratio.

• Measurement accuracy of the microstream CO2 module may be affected by the breath rate.

(1) CO2 dialog hard key (2) CO2 Measure/standby hard key

(3) CO2 watertrap seat (4) Gas outlet

(5) Sample line connector (6) Internal CO2 adapter connector 

(1) (2)

(4)

(3)

(1)

(5)

(4)

(2)

(6)
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14.5 CO2 Display

The CO2 numeric and waveform areas provide FiCO2 measurement, EtCO2 measurement, awRR measurement, 
and a CO2 waveform.

If the sidestream CO2 module is configured with the oxygen sensor, O2 waveform and parameters can be 
displayed in an O2 numeric and waveform area as follows:

14.6 Measuring CO2 Using the Sidestream/Microstream CO2 Module

14.6.1 Preparing to Measure CO2 Using the Sidestream CO2 Module

To prepare the CO2 measurement, follow this procedure:

1. Select the appropriate gas sample line and watertrap according to the patient category.

2. Connect one end of the gas sample line to the watertrap or to the CO2 adapter.

◆ If using the sidestream CO2 module, connect the watertrap to the CO2 module, and connect the gas 
sample line to the watertrap.

(1) CO2 waveform (2) Fraction of inspired CO2 (FiCO2)

(3) End tidal CO2 value (EtCO2) (4) Airway respiration rate (awRR)

(1) O2 waveform (2) FiO2 measurement (3) EtO2 measurement

(1) (2) (3) (4)

(3)

(2)

(1)

(1)

(2)
(3)
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◆ If using the N1 monitor for CO2 measurement, connect one end of the gas sample line to the CO2 
adapter. Refer to the CO2 Adapter User Manual (PN: H-046-009994-00) for the connection of the CO2 
adapter and the gas sampling line.

3. Connect the other end of the gas sample line to the patient.

◆ For intubated patients requiring an airway adapter, install the airway adapter between the patient 
circuit and the ventilator Y-piece.

◆ For non-intubated patients, place the nasal cannula onto the patient.

 

4. Connect the gas outlet to the scavenging system using an exhaust tube.

After the CO2 module is connected, it enters measure mode by default and the monitor displays CO2 Starting. 
CO2 can be measured after the start-up sequence is complete.

WARNING

• Do not use the adult or pediatric watertrap with a neonate patient. Otherwise, patient injury could 
result.

(1) Watertrap receptacle (2) DRYLINE II watertrap

(3) Gas sample line

(1) CO2 adapter (2) Gas sample line

(1) Sample line (2) Connection to the ventilator

(3) Airway adapter (4) Connection to the patient

(1)

(2)

(1)

(2)

(3)

(4)
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• Connect the gas outlet to the scavenging system when measuring CO2 using the sidestream CO2 
module.

CAUTION

• Check the compatibility of the CO2 adapter and the sampling line before use. The CO2 adapter is 
intended for connecting the Oridion CO2 sampling line. 

• Leakage in the breathing or sampling system may cause the displayed EtCO2 values to be 
significantly low. Always make sure that all components are securely connected.

• Inspect the airway adapter for a tight connection and proper operation before attaching it to the 
patient.

• Squeezing or bending the sample line during sidestream or microstream CO2 measurement may 
cause inaccurate CO2 readings or no reading.

• To avoid blocking the airway, empty the DRYLINE II watertrap container whenever half full. 
Replacing the DRYLINE II watertrap once a month is recommended. Dispose of accumulated fluids in 
accordance with hospital policy or your local regulations. 

• The DRYLINE II watertrap has a filter preventing bacterium, water and secretions from entering the 
module. Extended use could destroy the filter in watertrap and fail to stop the bacterium, water and 
secretions entering the module, result in damaging the gas module and having infection risk.

NOTE

• It is recommended to replace the CO2 adapter at least once a year.

• To extend the lifetime of the watertrap and module, disconnect the watertrap from the module and 
set the operating mode to Standby mode when CO2 monitoring is not required.

• The sample rates are different when different types of watertraps are used.

• The emptying interval of the DRYLINE II adult/pediatric watertrap is 26 hours @ 120 ml/min, sample 
gas of 37 °C, room temperature of 23 °C, and 100% RH.

• The emptying interval of the DRYLINE II neonatal watertrap is 35 hours @ 90 ml/min, sample gas of 
37 °C, room temperature of 23 °C, and 100% RH.

14.6.2 Preparing to Measure CO2 Using the Microstream CO2 Module

To prepare the CO2 module for measurement, follow this procedure:

1. Connect one end of the sample line to the microstream CO2 module.
 

2. Connect the other end of the sample line to the patient.

(1) Sample line connector (2) Sample line

(2)

(1)
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◆ For intubated patient requiring an airway adapter, install the airway adapter between the patient 
circuit and the ventilator Y-piece.

◆ For non-intubated patient, place the nasal cannula onto the patient.

◆ For patient prone to mouth breathing, place the oral-nasal cannula onto the patient.

3. Connect the gas outlet to the a scavenging system using an exhaust tube.

After the CO2 module is connected, it enters measure mode by default and the monitor displays CO2 Sensor 
Warmup. CO2 can be measured after the start-up sequence is complete.

WARNING

• Connect the gas outlet to the scavenging system when measuring CO2 using the microstream CO2 
module.

NOTE

• Disconnect the sample line from the module when CO2 monitoring is not required.

14.6.3 Zeroing the Sidestream/Microstream CO2 Module

The sidestream and microstream CO2 modules perform a zero calibration automatically when needed. Once the 
zero calibration is started, the CO2 module stops measuring and “Zeroing” is displayed in the CO2 numeric area.

After the zero calibration is completed, the CO2 module reacquires the CO2 readings. During the reacquisition 
period, “Zero Recovering” is displayed in the CO2 numeric area. Valid data will reappear 30 seconds after the 
zero calibration is started. You can hide the display of the “Zero Recovering” message, but values displayed 
during the reacquisition period may not be accurate. See 21.5.6 Hiding the Invalid Display after Zeroing the CO2 

Module for more information.

The automatic zero calibration will not start under the following conditions:

■ Physiological alarms related to CO2 are active.

■ An apnea alarm is active.

■ No breath has been detected for over 30 seconds.

You can also perform the zero calibration manually. For more information, see 21.5.5 Manually Zeroing the CO2 

Module.

14.7 Changing Settings for All CO2 Modules

14.7.1 Changing CO2 Alarm Settings

To change the CO2 alarm settings, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set alarm properties as desired.

14.7.2 Setting the CO2 Waveform

To set the CO2 waveform, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Waveform Type, Speed, Scale, or CO2 Scale of the CO2 waveform.
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14.7.3 Setting the RR Source
To set the respiration rate (RR) source, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set RR Source.

When you select Auto, the system automatically selects the RR source according to the priority. The priority of 
RR source is first CO2, and then ECG. When the current RR source does not have valid measurement, the system 
automatically switches the RR Source to Auto. 

14.7.4 Entering the Standby Mode
Set the CO2 module to one of the following modes according to the module status:

■ Select Measure mode when using the CO2 module for monitoring.

■ Select Standby mode to prolong the CO2 module service life when not using the CO2 module.

The default operating mode is Measure. When not using the CO2 module, proceed as follows to enter the 
Standby mode:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Operating Mode to Standby.

14.7.5 Entering the Intubation Mode
When performing intubation during general anesthesia, enter the intubation mode to reduce unnecessary 
alarms. To enter the intubation mode, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select Intubation Mode.

To exit the intubation mode, choose either of the following ways: 

■ From the bottom of the CO2 dialog, select Exit Intubation Mode. 

■ Select the Main Menu quick key →from the Alarm column select Exit Intubation Mode.

For the details of the intubation mode, see 6.11 Intubation Mode.

NOTE
• When the configured intubation period is over, the monitor automatically exits the intubation mode 

and gives two alert sounds.

14.7.6 Setting the Auto Standby

The monitor enters standby mode automatically if no breath is detected after the configured period of time. To 
set the auto standby, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Auto Standby.

14.7.7 Setting Humidity Compensation
Sidestream and microstream CO2 modules are configured to compensate CO2 readings for either Body 
Temperature and Pressure, Saturated Gas (BTPS), to account for humidity in the patient’s breath, or Ambient 
Temperature and Pressure, Dry Gas (ATPD).

■ ATPD:  PCO2(mmHg)=CO2(vol%) x Pamb/100

■ BTPS (sidestream):  PCO2(mmHg)=CO2(vol%) x (Pamb- 47)/100
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■ BTPS (microstream):  PCO2(mmHg)=CO2(vol%) x (1- 0.03)x Pamb/100

Where, PCO2(mmHg)= partial pressure, vol%=CO2 concentration, Pamb=ambient pressure, and unit is mmHg.

For the sidestream and microstream CO2 module, set the humidity compensation on or off according to the 
actual condition. 

To set the humidity compensation, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set BTPS Compensation. 

◆ Switch on for BTPS.

◆ Switch off for ATPD.

14.8 Changing O2 Settings (For Sidestream CO2 Module Integrating O2)

14.8.1 Changing O2 Alarm Settings

To change the O2 alarm settings, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 21.13.3 Selecting Password for User 
Authentication.

4. Set alarm properties as desired.

14.8.2 Setting the O2 Waveform

To set the O2 waveform, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Speed and O2 Scale of the O2 waveform.

14.9 Setting the Gas Compensation
The presence of interfering gas affects the CO2 measurement. To get the best possible measurement result, it is 
recommended to set the gas compensation. The configured concentration of the interfering gas should be in 
accordance with its actual proportion. 

For the microstream CO2 module, gas compensations are not required.

CAUTION

• Make sure to use the appropriate compensations. Inappropriate compensations may cause 
inaccurate measurement values and result in misdiagnosis.

For the sidestream CO2 module, follow this procedure to set the gas compensation:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set the compensation according to the actual condition.

14.10 Choosing a Time Interval for Peak-Picking
For microstream CO2 modules, select a time interval for picking the highest CO2 as the EtCO2 and the lowest as 
the FiCO2.

To set the time interval, follow this procedure:
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1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Maximum Hold.

4. Toggle between Single Breath, 10 s and 20 s.

◆ Single Breath: EtCO2 and FiCO2 are calculated for every breath.

◆ 10 s and 20 s: EtCO2 and FiCO2 are calculated using 10 or 20 seconds of data.

14.11 Performing the Leakage Test
When measuring CO2 using the internal CO2 module or the external sidestream CO2 module, the leakage test is 
required every time before the CO2 measurement. To perform the CO2 leakage test, follow this procedure: 

1. Connect the measuring accessories as per section 14.6.1 Preparing to Measure CO2 Using the Sidestream CO2 

Module. 

2. Wait until the startup finishes. Completely block the gas inlet on the sidestream CO2 module or on the N1. 
The alarm message “CO2 Airway Occluded” will appear on the screen. 

3. Continue to block the gas inlet for another one minute.

4. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

5. Select the Module tab → CO2 tab.

6. Check that the current flow rate is less than 10ml/min, and the alarm message “CO2 Airway Occluded” 
does not disappear. 

This indicates that the module does not leak. If the alarm message disappears, or the flow rate is equal to 
10ml/min or greater, it indicates that the module leaks. Perform the leakage test again. If the problem 
remains, contact your service personnel for help.

14.12 CO2 Calibration

For sidestream and microstream CO2 modules, a calibration is needed every year or when the measured values 
have a great deviation. 

To calibrate the CO2 module, contact your service personnel.

CAUTION

• Connect the gas outlet to the scavenging system when calibrating the CO2 module.

14.13 Test Method Used to Determine the Respiration Rate Measuring 
Range
To determine the RR measurement range, follow this procedure:

1. Connect the 5% CO2 + N2 (BAL) gas cylinder, reduction valve, rhythm generator and gas sampling path of a 
monitor.

2. Respectively set the rhythm generator to generate a respiration rate of 0 rpm, 6 rpm, 20 rpm, 60 rpm, 
120rpm, and 150 rpm.

3. Verify that it meets the specifications.

NOTE

• The rhythm generator mentioned above is a sensor/sampling site in Figure 201.101 – Test apparatus 
for the TOTAL SYSTEM RESPONE TIME of an RGM of ISO 80601-2-55.
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14.14 CO2 Troubleshooting

This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

14.14.1 Troubleshooting the Sidestream/Microstream CO2 Module

14.15 Oridion Information

Oridion Patents

This posting serves as notice under 35 U.S.C.§287(a) for Covidien patents: http://www.covidien.com/patents.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized CO2 sampling consumables which would, alone, or in combination with this device, fall within the 
scope of one or more of the patents relating to this device and/or CO2 sampling consumable.

Problem Solution

EtCO2 measurements too low 1. Check the patient status.
2. Check the sample line and connectors for leakage.
3. Ventilate the room if the environmental CO2 concentration is too 
high.
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15 Review

15.1 Review Overview
Trends are patient data collected over time and displayed in graphic, tabular, or other forms to give you a picture 
of how the patient's condition is developing. The Review dialog also enables access to review the events, 12-
lead ECG analysis results and waveforms, full disclosure waveforms, and so on.

15.2 Review Dialog
The Review dialog contains tabs to display trend data in tabular, graphic, or other forms. 

15.2.1 Accessing the Review Dialog
To enter the review dialog, select the Main Menu quick key → from the Review column select the desired 
option. 

15.2.2 Example Review Dialog
The review pages have a common structure. The graphic trends review page is taken as an example: 

(5)

(7)

(6)

(1)
(2)

(3)

(4) (8)

(9)

(1) Event type indicator: different color blocks match different types of events:
■ Red: high priority alarm event

■ Yellow: medium priority alarm event

■ Cyan: low priority alarm event

■ Green: manual event

■ White: operation-related event

(2) Current screen time line: indicates the time length of the current screen. 

(3) Waveform area: displays trend curves. The color of trend curves is consistent with the color of parameter labels.

(4) Time line: indicates the entire time length.
■ : indicates the time length of trend data.  can be moved within this time length.

■ : indicates the time length of no trend data.  cannot be moved within this time length.

■ Different color blocks along the time line indicate events of different types. See the color definition for the 
event type indicator.
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15.2.3 Symbols on Review Pages
The following table lists the symbols on review pages.

15.2.4 Common Operations 
This section describes common operations for all review pages.

15.2.4.1 Browsing Trend Data

Browse trend data in one of the following ways:

■ Move the cursor.

■ Move the slider .

■ Slide your finger on the screen.

15.2.4.2 Viewing Events

You can view the following types of events:

■ Manually triggered events

■ Parameter-related operation events and alarm-related events, such as starting NIBP measurement

■ Operation events not related to parameters, such as system time change

View events in either of the following ways:

■ Select  and select the desired event.

■ Select  or  to jump to the previous event or next event. 

Events are displayed in a chronological order. The most recent event is displayed at the top. The number of 
asterisk symbols before an event indicates alarm priority as follows: 

■ ***: high priority alarm

■ **: medium priority alarm

■ *: low priority alarm

(5) Event area: displays the event of the cursor time. Selecting the event accesses the event list. If there is no event at 
the cursor time, the cursor time is displayed.

(6) Cursor: this is adjusted by touching different locations. Adjusting this changes the data displayed in the Event 
area and Numeric area.

(7) Numeric area: displays numeric values at the cursor indicated time. The background color of numeric values 
matches the alarm priority.

(8) Slider: indicates the position of current screen time in the entire time length. Dragging this button left or right 
enables you to locate the trend data at a specific time and also refreshes trend data in current screen 
accordingly.

(9) Button area.

Symbol Description

Slider: indicates the position of current screen time in the entire time length. Dragging 
the slider left or right enables you to locate the trend data at a specific time and also 
refreshes data in current screen accordingly.

 or  Goes to the previous or next event.

 Event list: displays events in a chronological order. The most recent event is displayed 
at the top. The number of asterisk symbols before an event indicates alarm priority.

 Print button: select it to output patient information and data through the printer.
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15.2.5 Tabular Trends Review Page
The tabular trends review page displays trend data in a tabular form. 

15.2.5.1 Entering the Tabular Trends Review Page

To enter the tabular trends review page, select the Main Menu quick key → from the Review column select 
Tabular Trends.

15.2.5.2 Changing the Tabular Trend Group

To change the tabular trend group, follow this procedure:

1. Enter the tabular trends review page.

2. Set Trend Group.

15.2.5.3 Editing the Tabular Trend Group

The setting of the Trend Group defines the contents of displayed trends. It is possible to edit any trend group 
except for the All and Standard trend groups. To do so, follow this procedure:

1. Enter the tabular trends review page:

2. Select Group Setup → select the desired tab.

◆ Rename the trend group (optional): select the  symbol at the upper left corner and input the 
desired name.

◆ Add parameters: select desired parameters from the Choices column, and then select Add. Selecting 
Add All adds all parameters (up to the maximum of 83).

◆ Delete parameters: select desired parameters from the Selected column, and then select Delete. 
Selecting Delete All deletes all parameters except for HR.

◆ Move the position of parameters displayed on the trend page: select desired parameters from the 
Selected column, and then select Move up, Move Down, Move to Top, or Move to Bottom.

◆ Display two parameters side by side: select two parameters from the Selected column, and then 
select Overlap. Then, the symbol  appears at the right of the overlapped parameters. The 
overlapped parameters will be displayed side by side in one numerics area and waveform area.

◆ Unoverlap two parameters: select the overlapped parameters from the Selected column, and then 
select Unoverlap.

Selecting Default will restore the trend group settings to factory defaults. 

NOTE

• Trend groups labeled All or Standard cannot be edited.

• The HR parameter and waveform are always displayed in the first row on the trend page. It cannot be 
deleted or moved.

15.2.5.4 Changing the Resolution of Tabular Trend Data

The interval of tabular trends defines the interval of displaying trend data. A short interval is especially suited for 
neonatal applications, where the clinical situation may change very quickly. In adult monitoring, where the 
patient's status typically changes more gradually, a longer interval may be more informative.

To change the interval of trend data, follow this procedure:

1. Enter the tabular trends review page.

2. Select Interval.

◆ 5 sec or 30 sec: select to view up to 4 hours of tabular trends at an interval of 5 seconds or 30 seconds.

◆ 1 min, 5 min, 10 min, 15 min, 30 min, 1 hr, 2 hrs, or 3 hrs: select to view up to 120 hours of tabular 
trends at selected interval.

◆ Select parameters, such as NIBP, or GCS, to view the tabular trends when these parameter 
measurements are acquired.
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NOTE

• Changing between intervals does not typically change the position of the slider or cursor except to 
round it to the nearest interval, however changing intervals to be 30 seconds or less will move any 
cursor position more than 4 hours ago to the oldest data less than 4 hours ago.

15.2.5.5  Printing a Tabular Trends Report

To print a tabular trends report, follow this procedure:

1. Enter the tabular trends review page.

2. Select  to enter the Print Setup dialog.

3. Set the tabular trends report as described in 18.6.3 Configuring Tabular Trends Reports.

4. Select Print or Print (All).

◆ Print: the trend data before the above set Time, for the above set Period, and at the above set 
Interval will be printed.

◆ Print (All): all the stored trend data will be printed at the review interval.

15.2.6 Graphics Trends Review Page
The graphic trends review page displays trend data in a visual format.

15.2.6.1 Entering the Graphic Trends Review Page

To enter the graphic trends review page, select the Main Menu quick key → from the Review column select 
Graphic Trends.

15.2.6.2 Changing the Graphic Trend Group

To change the graphic trend group, follow this procedure:

1. Enter the graphic trends review page.

2. Select  and set Trend Group.

15.2.6.3 Editing the Graphic Trend Group
1. Enter the graphic trends review page.

2. Select  and select Group Setup. 

For more information, see 15.2.5.3 Editing the Tabular Trend Group for detail on how to edit the group.

15.2.6.4 Changing the Resolution of Trend Data

To change the length of trend data displayed on the current screen, follow this procedure:

1. Enter the graphic trends review page.

2. Select Zoom.

◆ 8 min: the screen displays eight minutes of trend data. You can view the most recent one hour of 
data.

◆ 30 min, 1 hr, 2 hrs, 4 hrs: the screen displays 30 minutes, one hour, two hours, or four hours of trend 
data. You can view the most recent four hours of data.

◆ 8 hrs, 12 hrs, 24 hrs, 48 hrs: the screen displays 8 hours, 12 hours, 24 hours, or 48 hours of trend data. 
You can view the most recent 120 hours of data.

15.2.6.5 Changing the Number of Waveforms

To change the number of waveforms displayed on the trend review page, follow this procedure:

1. Enter the graphic trends review page.

2. Select  and set Trend Group.
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15.2.6.6 Printing a Graphic Trends Report

To print a graphic trends report, follow this procedure:

1. Enter the graphic trends review page.

2. Select  to enter the Print Setup dialog.

3. Set the graphic trends report as described in 18.6.4 Configuring Graphic Trends Reports.

4. Select Print to print the graphic trend data before the above set Time and for the above set Period.

15.2.7 Events Review Page
The monitor stores events in real time, including technical alarm events, physiological alarm events, manual 
events, and operational events. When an event occurs, all the measurement numerics and three event-related 
waveforms 16 seconds before and after the event are stored. 

NOTE

• Alarms are saved as events and will be maintained if the equipment is powered down. The time of 
equipment power down is not recorded as an event and cannot be reviewed.

• Earlier events will be overwritten by later ones if the storage capacity is reached.

• A total loss of power does not affect the events already stored.

15.2.7.1 Entering the Events Review Page

To enter the events review page, select the Main Menu quick key → from the Review column select Events.

The Event page displays the event list.  Events are displayed in descending chronological order, with the most 
recent displayed at the top. The number of asterisk symbols before an event indicate alarm priority as described 
in 6.3.3 Alarm Indicators.

Different color blocks are displayed on the left of each event to indicate different event types.

■ Red: high priority alarm event

■ Yellow: medium priority alarm event

■ Cyan: low priority alarm event

■ Green: manual event

■ White: operation-related event

The number of currently selected events and the total number of events are displayed at the top right corner of 
the event list. For example, 2/4 indicates that the selected event is the second event in the filtered events and the 
total number of filtered events is 4. Total indicates the total number of events. For example: Total: 28 means that 
there are a total of 28 events.

15.2.7.2 Configuring the Filter 

You can filter events to facilitate event review. To configure the filter, follow this procedure:

1. Enter the Events page.

2. Select Filter. From the drop-down list, select the desired filter item.

You can create up to two sets of custom filter. To do so, follow this procedure:

1. From the Filter drop-down list, select Custom 1 or Custom 2 to enter the Filter Setup menu.

2. Select the Name field to edit the name of the custom filter criterion.

3. Select the desired items.

If you want to review events which happened around certain time, select the  button → set the time → 
select Ok. The cursor then jumps to the event happened closest to the time entered.

15.2.7.3 Editing Events

To edit events, follow this procedure:

1. Enter the Events page and tick off the desired events.
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2. Select  to edit the selected events.

◆ Lock: manually lock the event. Locked events cannot be deleted.

◆ Note: enter comments for the event.

◆ Rename: allow renaming an event name. Only manual events and arrhythmia events can be renamed 
if enabled by the hospital’s settings.

15.2.7.4 Viewing Event Details

To view waveforms and parameter values at the event time, follow this procedure:

1. Enter the Events page.

2. Select Detail.

To display beat labels on the first ECG waveform, switch on Beat Anno. The white beat labels indicate heart 
beats classification and may explain suspected, missed, or false arrhythmia calls. Heart beats are classified as 
follows:

■ N = Normal

■ V = Ventricular ectopic

■ S = Supraventricular premature

■ P = Paced

■ L = Learning

■ ? = Insufficient information to classify beat

■ I = Inoperative (for example, Lead Off ) 

■ M = Missed beat

If you switch on Beat Anno on the Events page, beat labels will also be displayed on the Full Disclosure page, 
and vise versa. Beat labels can be printed out.

15.2.7.5 Printing Event Reports

To print event reports via a printer, follow this procedure:

1. Enter the events review page.

2. Select  to enter the Print Setup dialog.

3. Select the desired options.

◆ Print All Event List: print the entire event list.

◆ Print List of Selected Events: print the list of selected events.

◆ Print Detail of Selected Events: print the details of selected events.

◆ Print Displayed Event Detail: print the waveforms and parameters of the currently displayed event. 

4. Select Print.

15.2.8 Full Disclosure Review Page
You can review up to 48 hours of waveform data on the full disclosure review page. You can view both the 
compressed waveforms and numeric values.

15.2.8.1 Entering the Full Disclosure Review Page

To enter the full disclosure review page, select the Main Menu quick key → from the Review column select Full 
Disclosure.

15.2.8.2 Selecting Waveforms

You can select the waveforms to be displayed and stored. Up to 48 hours of waveforms for all parameters can be 
stored. When closing the Select Waveform dialog, a prompt will inform you of the duration of waveforms that 
can be saved if the amount is less than 48 hours. To save and display the desired waveforms, follow this 
procedure:
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1. Enter the full disclosure review page.

2. Select  and select Setup to enter the Select Waveform page.

3. Select the Storage tab and set the desired waveforms to be stored in the monitor. Select the Display 
(Maximum: 3) tab and set the desired waveforms to be displayed on the Full Disclosure page.

NOTE

• Storing more waveforms may shorten the storage time to less than 48 hours. Please adjust the 
waveforms stored with this consideration.

• Parameter labels from external devices are prefixed with the plus sign (+).

In case of alarms, the background of the compressed waveform is highlighted with a colored block during the 
alarm time:

■ Red: high alarm priority

■ Yellow: medium alarm priority

■ Cyan: low alarm priority

15.2.8.3 Setting the Scale and Duration

To set the length and size of displayed compressed waveforms, follow this procedure:

1. Enter the full disclosure review page.

2. Select Overview. If there is no Overview button in the Full disclosure page, skip this step.

3. Set the waveforms scale in either of the following ways:

◆ Select the Scale button. If you do not see Scale, select the  button to show it.

◆ Select the waveform label. 

4. Select Duration to set the length of displayed waveforms.

5. Select the parameter label beside the waveforms to set scale for each parameter.

15.2.8.4 Viewing Details of Compressed Waveforms

To view the full waveforms and numeric values, follow this procedure:

1. Enter the full disclosure review page.

2. Select Detail.

You can perform the following operations on the this page:

■ Switch on Beat Anno. For more information, see 15.2.7.4 Viewing Event Details.

■ Select and set Speed, ECG Gain, or Save As Event.

■ Select Overview to switch to the compressed waveform view.

15.2.8.5 Printing the Full Disclosure Waveform Report

To print a compressed waveform report, follow this procedure:

1. Enter the full disclosure review page.

2. Select  to enter the Print Setup dialog.

3. Select waveform type you want to print:

◆ Print Waveform Overview: compressed waveform of selected period will be printed. This option is 
only available when printing from the Overview or compressed waveform view.

◆ Print Displayed Waveform Detail: parameter values and all stored waveforms around the cursor 
time will be printed. This option is only available when printing from the Detail view.

4. Select Print.
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NOTE

• When a parameter label is prefixed with the plus sign (+) on a printout, it indicates that the data is 
from an external device.

15.2.9 OxyCRG Review Page (available when the N1 is used with the independent 
external display)
You can review up to 48 hours worth of 4 minute trend curves on the OxyCRG review page. The OxyCRG review 
functionality is available for neonatal monitoring only.

NOTE

• OxyCRG Review Page is available only when Patient Category is set to Neo.

15.2.9.1 Entering the OxyCRG Review Page

Choose one of the following methods to enter the OxyCRG review page:

■ From the OxyCRG screen, select the ABD events list area.

■ Select the Main Menu quick key → from the Review column select OxyCRG. 

15.2.9.2 The Display of the OxyCRG Review Page

The following figure shows the OxyCRG screen:

15.2.9.3 Changing the Resolution of Trend Curves

To set the resolution of trend curves, follow this procedure:

1. Enter the OxyCRG review page.

2. Set Zoom.

(3)

(4)

(2)(2)

(1)

(1) Event title area: displays information of the selected event, such as the event type and time.

(2) Event detail area: displays 4 minutes of parameter trends and compressed waveform, and parameter 
values of the selected event.

(3) Event summary area: displays ABD events within the Zoom period. The selected event is enclosed in 
a white frame.

(4) Event statistics area: displays the total number of ABD events and the numbers of each event within 
the Zoom period.
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NOTE

•  If the Zoom is set for a large duration (for example, 8 hrs), the screen may show "No Patient Data" for 
the first several minutes of data collection (for example, 6 minutes), but data will be shown after 
enough data has been collected.

15.2.9.4 Printing an OxyCRG Review Report

To print an OxyCRG review report, follow this procedure:

1. Enter the OxyCRG review page.

2. Select  to enter the Print Setup dialog.

3. Select Print. The report duration corresponds to the duration of data shown on the screen.

15.2.10 12-Lead ECG Review Page
When 12-lead ECG analysis is performed, you can review the most recent 20 events of 12-lead analysis. For more 
information, see 8 Resting 12-Lead ECG Analysis.

15.2.10.1 Entering the 12-Lead Review Page

Choose one of the following methods to enter the 12-lead ECG review page:

■ Upon completion of 12-lead ECG analysis, select Review from the 12-Lead Interpretation page. For more 
information, see 8 Resting 12-Lead ECG Analysis.

■ Select the Main Menu quick key → from the Review column select 12-Lead ECG.

15.2.10.2 Switching to Median Complex (for Glasgow Algorithm Only)

The median complex template displays 12-lead ECG waveforms on one page in 4 columns, with 3 lines in each 
column, and one rhythm lead waveform at the bottom. Additionally, a short vertical bar appears above each 
waveform, marking the start and end positions of the P-wave and the QRS-wave and the end position of T-wave. 

To view Median Complex, follow this procedure:

1. Enter the 12-lead review page.

2. Select Median Complex.

Selecting Waveform can return to the 12-lead ECG waveform page.

15.2.10.3 Setting 12-Lead ECG Waveforms

To set the 12-lead ECG waveforms on the review page, follow this procedure:

1. Enter the 12-lead review page.

2. Set Speed, Gain, and Layout.

15.2.10.4 Printing the 12-Lead ECG Report

To print the 12-Lead ECG report, follow this procedure:

1. Enter the 12-lead review page.

2. Select .

3. Configure the 12-lead ECG report.

4. Select Print.

15.3 Reviewing Discharged Patients
For discharged patients, you can review the trend data in the review page. You can also review the events and 
12-lead ECG analysis results.
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15.3.1 Checking the Data of a Discharged Patient
1. Access the Discharged Patients dialog box by selecting the Main Menu quick key → from the Patient 

Management column select Discharged Patients.

2. From the patient list select the desired patient.

3. Select Detail.

15.3.2 Checking the Information of a Discharged Patient 
1. Access the data of the discharged patient as described in 15.3.1 Checking the Data of a Discharged Patient.

2. Select the  icon to enter the Patient Management dialog box.

3. Select Ok to exit the Patient Management dialog box.
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16 Clinical Assistive Applications (CAA) (available when 

the N1 is used with the independent external 
display)

The Clinical Assistive Applications (CAA) function integrates some commonly used clinical guidelines and tools 
into the monitor. It puts the currently monitoring parameter measurements together and provides 
comprehensive analysis results. 

CAA can improve the clinician’s working efficiency. However, it is not directly used for diagnosis and cannot not 
replace the clinician’s judgement.

16.1 Checking Software Licenses
Licenses are required to run the following CAA functions in the monitor:

■ BoA Dashboard

■ Early Warning Score (EWS)

■ SepsisSight

■ CPR Record

To check the licenses, select the Main Menu quick key → select License → Local.

To install the licenses, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the USB drive to the Dock’s USB connector.

3. Select the Main Menu quick key →select License → select External.

4. Select Install.

16.2 BoA DashboardTM

The Balance of Anesthesia (BoA) Dashboard helps the clinicians to monitor the patient’s status during anesthetic 
induction, maintenance, and postoperative recovery. 

NOTE

• BoA Dashboard is only available when Department is set to OR.

16.2.1 Accessing BoA DashboardTM

Access BoA Dashboard in any of the following ways: 

■ Select the BoA Dashboard quick key.

■ Select the Screen Setup quick key → Select the Choose Screen tab → select BoA Dashboard.

■ Select the Main Menu quick key → from the CAA column select BoA Dashboard.

BoA Dashboard has three pages:

■ Induction

■ Maintenance

■ Recovery
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16.2.2 Induction
Select the Induction tab to enter the Induction page. You can check parameter minitrends and apnea time from 
the Induction page.

Select Induction to start apnea detection, mark the induction event, and start an NIBP STAT measurement. The 
systolic pressure value will be saved as the reference.

The following figure shows the Induction page. Your display may be configured to look slightly different.

 (1) Cursor: indicates the current apnea time.

(2) Apnea indicator: provides apnea time scale.

(3) Timer: displays the time elapsed since the timer was started.

(4) Minitrends area: provides parameter minitrends. You can select the parameters you want to view. 
For more information, see 16.2.5.1 Selecting Parameters for Viewing Trends.

(1)
(2)

(4)

(3)
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16.2.3 Maintenance
You can check the patient’s parameter trends, anesthesia status, and triple low status.

Select Anesthesia Status or Triple Low to choose the indicator.

The anesthesia status indicator presents the patient’s status in terms of pain, consciousness, and neuromuscular 
blockage. 

The triple low indicator presents BIS, MAC and mean pressure. Postoperative mortality and hospital stay are 
increased in patients having low MAC and low blood pressure. With low BIS value, the postoperative mortality 
and hospital stay are further increased. (Sessler et al: Hospital Stay and Mortality Are Increased in Patients Having 
a “Triple Low” of Low bood Pressure, Low Bispectral Index, and Low Minimum Alveolar Concentration of Volatile 
Anesthesia.Anesthesiology 2012; 116: 1195–203)

The following figures show the anesthesia status indicator and triple low indicator:

■ The three arms of the anesthesia status indicator respectively indicate pain (Analgesia), consciousness 
(Sedation), and neuromuscular blockage (Paralysis). You can select parameters for the anesthesia status 
indicator. For more information, see 16.2.5.2 Selecting Parameters for Anesthesia Status Indicator.

■ The three arms of the triple low indicator respectively indicate BIS, MAC, and mean blood pressure.

■ The length of the filling indicates parameter value. 

■ The color of the arms indicates parameter status: green indicates that parameter value is within normal 
range. Red indicates that parameter value is beyond normal range. Gray indicates that parameter value is 
unavailable or invalid.

■ The black lines on the parameter arms indicate the normal range of corresponding parameters.

 (1) Total triple low duration: if BIS, MAC, and Art-M values are lower than the threshold, the patient is in triple low 
status. For information on setting the triple low threshold, see 16.2.5.5 Setting Thresholds for Triple Low Parameters.

(1)
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16.2.4 Recovery
You can view parameter trends from the Recovery page.

Select Aldrete Score to show the latest score and scoring time. To understand the current patient status, select a 
score for each item and then select Confirm to get a new score. 

WARNING

•  The Aldrete score and recommendation is for reference only. Clinicians must make the decision of 
discharging the patient from recovery according to the patient’s actual condition.

16.2.5 Setting the BoA Dashboard
From the BoA Dashboard, you can set the parameters, anesthesia status indicator, and triple low indicator.

16.2.5.1 Selecting Parameters for Viewing Trends

You can view the trends of up to 6 parameters from the Maintenance page and Recovery page.

To select the parameters you want to view, use either of the following ways:

■ Select .

◆ Select the Maintenance tab or Recovery tab to set the parameters you want to view.

◆  Selecting Defaults resumes the default setting.

■ Select a parameter on the trend view, and set which parameter you want to display in this position.

16.2.5.2 Selecting Parameters for Anesthesia Status Indicator

In the anesthesia maintenance stage, you can evaluate the patient’s pain status by heart rate and/or blood 
pressure values. You can evaluate the patient’s consciousness status by BIS or MAC value. The neuromuscular 
blockage status is evaluated by NMT.

To select parameters for the anesthesia status indicator, follow this procedure:

1. Select .

2. Select the Maintenance tab.

3. From the Parameters area, set Analgesia and Sedation.

16.2.5.3 Setting References for Heart Rate and Systolic Blood Pressure

The current heart rate and systolic blood pressure references are displayed as white lines in minitrends area. To 
set the references, follow this procedure:

1. Select Set Reference.

2. Select Ok to set the current HR and BP-S measurements as the reference. You can also input HR and BP-S 
values and then select Ok.

You can also follow this procedure to set HR and BP-S reference:

1. Select .

2. Select the Maintenance tab.

3. From the Reference area, set HR and BP-S.

16.2.5.4 Setting Thresholds for Anesthesia Status Parameters

To set low limits for anesthesia status parameters, follow this procedure:

1. Select .

2. Select the Maintenance tab.

3. From the Threshold area, set threshold for each parameter. 
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16.2.5.5 Setting Thresholds for Triple Low Parameters

To set low limits for triple low parameters, follow this procedure:

1. Select .

2. Select the Maintenance tab → Triple Low tab. 

3. Set low limits for BIS, MAC, and MAP. 

The ranges of the thresholds for triple low parameters are as follows:

16.3 Early Warning Score (EWS)
The Early Warning Scores (EWS) can help you recognize the early sign of deterioration in patients based on vital 
signs and clinical observations. It is based on the “Royal College of Physicians (2015) National Early Warning 
Score (NEWS2): Standardizing the assessment of acute illness severity in the NHS, Report of a Working Party. RCP, 
London. Depending on the score calculated, appropriate recommendations are displayed. 

The monitor supports the following scores: 

■ MEWS (Modified Early Warning Score)

■ NEWS (National Early Warning Score)

■ NEWS2 (National Early Warning Score 2)

■ Custom Score

There are two types of scoring tools:

Total score: A subscore is given for each parameter based on the measured or entered value. When all the 
required parameters are entered or measured, the subscores are added together to calculate the total early 
warning score. Each subscore has a color coding to indicate associated level of risk. When the total score is 
outside of the thresholds, actions are recommended. MEWS, NEWS and NEWS2 can give total scores.

■ IPS (individual parameter score): A color-coded score is given for each parameter based on the measured or 
entered value. Each parameter has upper and lower thresholds. When an individual parameter measured 
or entered is outside of the thresholds, actions are recommended.

Custom Score  is based on user-defined parameters. It can be a total score or an IPS, depending on the 
configuation.

MEWS, NEWS and NEWS2 are intended for adult patients only. The patient category applied to the Custom Score 
is defined by the Mindray Clinical Score Configuration Tool. For more information, see Mindray Clinical Scoring 
Config Tool Instruction for Use (P/N: 046-012986-00).

WARNING

• EWS is not intended for pediatric and neonatal patients.

• The default settings for IPS and Custom Scoring are based on the scoring system used by MEWS and 
NEWS, which have only been clinical validated in the adult population. If you choose to use this 
feature for pediatric patients, you may need to customize the scoring system to reflect any relevant 
differences between adult and pediatric patients.

• The EWS scores and recommended actions are for reference only and cannot be directly used for 
diagnostic interpretation. 

• EWS cannot be used as an prognosis index. It is not a clinical judgement tool. Clinicians must use 
their clinical judgement in conjunction with the EWS tool at all times. 

Parameter Range Default setting

BIS 0 - 100 46

MAC 0 - 3.0 0.6

MAP Adult: 20 -230 mmHg
Pediatric: 20 - 165 mmHg
Neonate: 20 - 110 mmHg

87 mmHg
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• MEWS and NEWS are intended for adult patients only. NEWS is not applicable to pregnant woman 
and COPD (Chronic Obstructive Pulmonary Disease) patients. 

NOTE

• The EWS scores does not trigger any alarms and cannot used for continuous monitoring.

16.3.1 Displaying the EWS Numerics Area
To display the EWS numerics area, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter area where you want to display the EWS score, and then from the popup list select 
EWS.

16.3.2 Accessing the EWS Screen
Access the EWS window in any of the following ways: 

■ Select the EWS parameter area

■ Select the EWS quick key.

■ Select the Screen Setup quick key → select the Choose Screen tab → select EWS.

■ Select the Main Menu quick key → from the CAA column select EWS.

When the EWS screen is hidden as , you can also choose one of the following methods to quickly enter the 
EWS screen.

■ Swipe left or right across the touchscreen with two fingers until you switch to the EWS screen.

■ Swipe right across the touchscreen with a single finger, 

 (1) EWS protocol label

(2) Scoring countdown: time to the next scoring.

(3) Scoring interval

(4) The scoring time

(5) Single parameter whose score reaches 3

(6) Risk level indicator. The level of risk increases from top down. For IPS, this indicator does not display. The current 
level is enclosed by a white square frame.

(7) History total score. The rightmost one is the latest history score.

(8) Total score. The color of the circle indicates the level of risk. For IPS, no score is displayed. Only level of risk is shown: 
white means normal and red indicates alert.

(1)

(8)

(7)

(3)

(5)

(6)

(4)

(2)
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■ Select the  button, 

Take NEWS2 as an example, the EWS screen is shown as follows. Your screen may be slightly different due to the 
configuration. 

16.3.3 Performing EWS Scoring
To perform scoring, follow this procedure:

(1) Total score. The color of the circle indicates the level of risk. For IPS, no numeric score is displayed. Only level of risk 
is shown: white means normal and red indicates alert by default.

(2) Risk level indicator. The level of risk increases from top down. The current level is enclosed by a white frame. For 
IPS, this indicator does not display.

(3) Parameter area: display the subscore and parameter value of each parameter. The keyboard symbol indicates that 
the parameter value is manually entered.

(4) History total scores area: selecting this area or swiping up with one finger can review the trends of total score and 
each subscore

(5) Selecting this button expands the History Total Scores area where your can review the trends of the total score and 
each subscore.

(6) Selecting this button or swiping right across the screen with one finger displays the trends of total score and 
parameter values for scoring.

(7) Clinician ID (displays only when the Clinician ID is enabled): allows inputing the Clinician ID to associate with the 
EWS score. For more information, see 21.4.1 Enabling Inputing the Clinician ID.

(8) Select this button to see the clinical response to the current score

(9) Scoring interval

(10) EWS protocol label

(11) Scoring countdown: time to the next scoring.

(12) The scoring time

(1)

(2)

(3)

(4)

(8)

(7)

(12)   (11)  (10)    (9)      

(6)

(5)
BeneVision N1 Patient Monitor Operator’s Manual 16 - 7



1. Select Reset to clear the previous score and update values of currently monitored parameters and relevant 
subscores.   

2. For NEWS2, set the SpO2 Scale.

◆ Scale 1: for patient without hypercapnic respiratory failure.

◆ Scale 2: for patients with a prescribed oxygen saturation requirement of 88–92% (for example, in 
patients with hypercapnic respiratory failure).

3. Measure or manually enter other required parameters and observations. 

4.  If the clinician ID is enabled, input the clinician information by selecting , and then 
manually entering the information, or by scanning the clinician’s barcode.

5. Select Calculate to get the total score.

6. If Score Confirmation is enabled, select Confirm to save current scoring, or select Cancel to give up 
current scoring. Refer to section 16.3.4.2 Setting the Scoring Confirmation Switch for more information.

CAUTION

• The decision to use Scale 2 of the SpO2 Scale should be made by a competent clinical decision maker 
and should be recorded in the patient’s clinical notes.

NOTE

• Before calculating the score, select Reset to clear the previous score.

• The keyboard symbol at the right of the parameter value indicates that the value is manually 
entered.

• You can get the score only when all required parameters have been measured or entered.

• When a patient is discharged, or the monitor is turned off, the clinician ID is cleared

16.3.4 Changing EWS Settings

16.3.4.1 Changing the Scoring Protocol

The monitor is configured with a default scoring protocol. To change the scoring protocol, follow this procedure:

1. From the EWS page select Setup.

2. Set Score.

16.3.4.2 Setting the Scoring Confirmation Switch

To select if confirmation is required before saving score, follow this procedure:

1. From the EWS page select Setup.

2. Set Score Confirmation switch.

◆ Off: the monitor automatically saves the scoring result after the scoring is completed.

◆ On: you need to confirm that whether the scoring result is saved or not after the scoring is completed.

16.3.4.3 Setting the Manual Data Timeout

The manually input parameter data can be configured to become invalid after a preset time. To set the timeout 
period for the input data, follow this procedure:

1. From the EWS screen select Setup.

2. From the Manual Data Timeout area, select a desired parameter and set its timeout period.

NOTE

• If the data is expired and not updated, the monitor displays the corresponding parameter score in 
outline font, and gives a timeout alarm. 
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16.3.4.4 Setting Auto Scoring

The monitor automatically starts scoring at the preset interval. To set auto scoring, follow this procedure:

1. From the EWS page select Setup.

2.  Set Auto Scoring:

◆ Interval: the monitor automatically starts scoring at the preset interval.

◆ NIBP: the monitor automatically starts scoring at the completion of each NIBP measurement.

◆ Alarm: the monitor automatically starts scoring when an alarm occurs to the parameter for scoring.

◆ If no option is selected, the monitor does not initiate auto scoring.

16.3.4.5 Setting Auto Scoring Interval
1. From the EWS page select Setup.

2. Set Interval:

◆ By Score: the monitor automatically starts scoring as per the interval selected for corresponding total 
score.

◆ 5 min - 24 h: If Auto Scoring is set to Interval, the monitor automatically starts scoring as per the 
selected interval. If Auto Scoring is not set to Interval, the countdown timer of manual scoring is 
selected.

16.3.5 Viewing Historical Scores
From the EWS screen, you can view the total score or subscores of the past 24 hours. To do so, choose either of 
the following ways:

■ Select the history total score area.

■ From the history total score area, swipe up with a finger.

To return to the EWS screen, select  from the top of the historical score screen. Refer to 16.3.2 Accessing the 
EWS Screen for the position of the history total score area.

16.3.6 Viewing Parameter Trends
From the EWS screen, you can view the 24-hour graphic trends of each parameter used for scoring. To do so, 
choose either of the following ways:

■ Select the  button.

■ Swipe right across the EWS screen with a finger.

From the screen of parameter trends, selecting the  button or swiping left across the screen with a finger can 
return to the EWS screen. 

Refer to 16.3.2 Accessing the EWS Screen for the position of the  button.

16.4 Glasgow Coma Scale (GCS)
The Glasgow Coma Scale (GCS) function is based on Teasdale’s Assessment of Coma and Impaired Consciousness-A 
Practical Scale (Lancet, 1974). Three aspects of behavior are independently measured: eye opening, verbal 
response, and motor response. The scores are added together to indicate that patient’s level of consciousness. 

GCS is intended for adults and pediatric patients.

CAUTION

• GCS is intended as an adjunct in patient assessment and must be used in conjunction with 
observation of clinical signs and symptoms.

• GCS is not applied to patients that are sedated, muscularly relaxed, with artificial airway, drunk, 
hypothermia or in status epilepsies.

• Please refer to hospital policy regarding acceptable use of GCS.
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• When applied to children younger than five years old or to the elderly, the GCS score may not reflect 
actual function.

16.4.1 Displaying the GCS Parameter Area
To display the GCS parameter area, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter area where you want to display the GCS score, and then from the popup list select 
GCS.

The following figure shows the GCS parameter area. The display may be configured to look slightly different.

16.4.2 Accessing the GCS Dialog
Enter the GCS dialog in any of the following ways: 

■ Select the GCS parameter area.

■ Select the GCS quick key.

■ Select the Main Menu quick key → from the CAA column select GCS.

 (1) GCS label

(2) Total score and level of consciousness. The color of the circle indicates the level of risk. 

(3) Scoring time

(4) Scoring countdown: time to the next scoring

(5) Scoring interval

(6) Subscores

◆ E: eye opening

◆ V: verbal response

◆ M: motor response

(4)

(5)

(2)

(3)

(6)

(1)
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                                                      (1) Subscore                                     (2) Total score 

16.4.3 Performing GCS Scoring
To perform scoring, follow this procedure:

1. From the Eye Opening area, Verbal Response area, and Motor Response area, respectively select an item 
that represents the patient’s status.    

2. Select Ok to accept the total score. 

The following table lists the default score range and color of relevant consciousness level.

NOTE
• The GCS score range is adjustable. Refer to 21.4.4 Setting GCS Threshold for Each Consciousness Level 

for the method of changing the high limit and low limit of each consciousness level.

16.4.4 Setting GCS Scoring Interval
From the GCS dialog, select Interval to set GCS scoring interval. When the scoring interval is reached and you do 
not perform another scoring, the score will be invalidated and displayed as outline fonts. 

16.4.5 Reviewing GCS Trend Data
From the GCS dialog, select Review to enter the Review dialog and view the GCS trend data from the Tabular 
Trends.

16.5 SepsisSightTM  
The SepsisSightTM function is based on Third International Consensus Definitions for Sepsis and Septic Shock 

(Sepsis-3) and Surviving Sepsis Campaign: International Guidelines for Management of Sepsis and Septic Shock: 
2016 (SSC Guideline 2016). It assists you in recognizing the early signs and symptoms of sepsis by comparing the 
state of the patient to the defined criteria and then guides you through the recommended treatment protocol.

(1)                                                               

(2)                                                               

Level Range Color

Mild damage 13-15 White

Moderate damage 9 - 12 Yellow

Severe damage 3 - 8 Red
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CAUTION

• SepsisSight is not a diagnostic or therapeutic tool and is not intended to replace the competent 
judgment of a clinician.

• SepsisSight should not be used with intravenous immunoglobulins in adult patients with severe 
sepsis or septic shock.

• SepsisSight should not be used with intravenous selenium for the treatment of severe sepsis.

• SepsisSight should not be used with sodium bicarbonate therapy for the purpose of improving 
hemodynamics or reducing vasopressor requirements in patients with hypoperfusion-induced 
lactic acidemia with pH ≥7.15.

NOTE

• SepsisSight is intended to perform routine screening of potentially infected seriously ill patients for 
severe sepsis to allow earlier implementation of therapy.

• SepsisSight is intended to be followed by application of hospital–based performance improvement 
efforts in severe sepsis.

• The Surviving Sepsis Campaign recommends to discuss goals of care and prognosis with patients 
and families.

• The Surviving Sepsis Campaign recommends to incorporate goals of care into treatment and end-of-
life care planning, utilizing palliative care principles where appropriate.

• The SepsisSight goals of care are intended to be applied in a time defined by the SSC guidelines.

• Due to space limitations on the screen, the recommendations cannot always be reproduced in the 
full detail available in the printed and on-line guidelines. 

• SepsisSight is intended for patients suffering from sepsis or suspicion of sepsis.

16.5.1 Accessing the SepsisSight Dialog
Enter the SepsisSight dialog in any of the following ways: 

■ Select the SepsisSight quick key.

■ Select the Main Menu quick key → from the CAA column select SepsisSight.

16.5.2 Screening
As per Sepsis-3, SepsisSight supports quick Sepsis-Related Organ Failure Assessment (qSOFA, or quick SOFA) and 
Sepsis-Related Organ Failure Assessment (SOFA).

16.5.2.1 Performing qSOFA

qSOFA evaluates the patient’s respiration rate, systolic blood pressure and altered mental status. 

RR and BP-S being monitored are automatically obtained. You can also manually enter these values by 
selecting the  symbol. Select whether the patient’s mental status is altered. Then qSOFA score is calculated.

If the qSOFA score is greater than or equal to 2, or sepsis is suspected, select SOFA>> to perform SOFA.

To clear the score, select Reset.

NOTE
• The keyboard symbol  indicates that the parameter value is manually entered.

• The question mark (?) in the score circle indicates that more parameter values are required before a 
score can be calculated.

16.5.2.2 Performing SOFA

SOFA score is used to identify organ function or the rate of sepsis-related organ failure.
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To perform SOFA, enter the value or select a range for each item, SOFA score will be automatically calculated.

To clear the score, select Reset.

If Sepsis criteria is met, make a comprehensive judgement on the clinical features.

16.5.2.3 Changing Screening Settings

From the Screening page select Setup. You can change the following settings:

■ In the Screening area, set RR (rpm) high limit and BP-S (mmHg) low limit for qSOFA scoring.

■ In the Unit area, set the unit of Bilirubin and Creatinine.

16.5.3 Recommendations
As per the SSC Guidelines 2016, SepsisSight provides graded recommendations. Pages Part I and Part II in the 
SepsisSight screen list these recommendations.

16.5.3.1 Viewing Detailed Recommendations

Select the  icon at the right side of each item to view detailed recommendations of SSC Guideline 
2016. The star symbol ★ indicates the grade of recommendation:

■ ★★: strong recommendation

■ ★: weak recommendation

■ No ★ symbol: ungraded strong recommendation

16.5.3.2 Marking Implemented Items

Check off implemented items. Then the time and date are automatically recorded and displayed.

■ You can select the  symbol to change the date and time.

■ Select Reset to clear the current results.

16.5.4 Reviewing SepsisSight Trend Data
Select the Graphic Trends tab to view the trend of parameters of resuscitation. 

When a recommended treatment is checked off on the Part I page and Part II page, relevant event is marked in 
the tabular trend. Vertical lines of different colors indicate the event type:

■ White: inspection performed

■ Blue: medication

■ Green: goal achieved

■ Purple: other treatment

16.6 Resus Mode
You can put the monitor into the Resus mode when rescuing a patient. The Resus mode has the following 
features:

■ Displaying resuscitation-related parameter values and waveforms.

■ Recording drugs and treatments through the CPR Record.

The Resus mode is intended for adult, pediatric, and neonatal patients.

WARNING

• In the Resus mode, all physiological alarms and some of technical alarms are disabled.

• Exit the Resus mode as soon as the resuscitation ends to resume normal patient monitoring.
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16.6.1 Entering the Resus Mode
To enter the Resus mode, choose either of the following ways:

■ Select the Resus Mode quick key → select OK.

■ Select the Main Menu quick key → from the Alarm column select Resus Mode → select OK.

16.6.2 CPR Record
The CPR Record helps you record the process of patient resuscitation. You can record the following items 
through the CPR Record:

■ The time resuscitation starts and ends. 

■ Drug names and doses.

■ Resuscitation treatments.

NOTE

• A license is required for the CPR Record function.

16.6.2.1 Accessing the CPR Record

The CPR Record automatically displays when you enter the Resus mode. If the CPR Record is closed, choose 
either of the following ways to open it:

■ Select the Main Menu quick key → from the CAA column select CPR Record.

■ Select the  button at the left of the screen and swipe right.

The following figure shows the CPR Record. Your display may be configured to look slightly different.

(1) Press this key to output the resuscitation report through the printer.

(2) Press this key to record the resuscitation start time/end time and result. The monitor 
automatically records the resuscitation start time when you enters the Resus mode.

(5)

(3)

(4)

(2)

(3)

(1)

(6)

(7)

(8)

(9)
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16.6.2.2 Customizing Drugs

You can customize drugs frequently used for resuscitation. To do so, follow this procedure:

1. From the CPR Record screen, select the  button to enter the Setup menu.

2. Define the name, unit, dose, and color of each drug as needed.

The CPR Record can list up to six frequently used drugs. The first two drugs  directly shown on the CPR Record 
screen are the most frequently used. The other four drugs are displayed by selecting Other Drugs.

16.6.2.3 Customizing Treatment

Besides Start Compression, Tracheal Intubation, Establish IV Access, Defibrillation, Mechanical 
Ventilation, Place Urinary Catheter, you can customize defibrillation energy and two additional treatments. To 
do so, follow this procedure:

1. From the CPR Record screen, select the  button to enter the Setup menu.

2. Select the Customized Treatment tab to define the defibrillation energy and the names of two additional 
treatments.

16.6.2.4 Recording the Resuscitation Result

After the resuscitation is completed, select End Resus to record the resuscitation end time and result.

16.6.2.5 Outputting the Current Resuscitation Report

The resuscitation report automatically saves. You can output the resuscitation report through the recorder or 
printer. See  The following figure shows the CPR Record. Your display may be configured to look slightly different. for 
details.

You can also export the resuscitation report using a USB drive. To do so, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the USB drive to the Dock’s USB connector.

3. From the top of the CPR Record screen, select the  button to enter the Print Setup menu.

4. Select Print Preview → Export to USB.

16.6.2.6 Closing the CPR Record

The CPR Record automatically closes when you exit the Resus mode. You can select the  button at the right of 
the CPR Record screen and swipe left to close the CPR Record.

16.6.3  Exiting the Resus Mode
To exit the Resus mode, choose either of the following ways:

(3) Event area: lists drugs and treatments. Select any event to add an event, edit or delete this event. 
The resuscitation record saves automatically.

(4) Drug color mark: is used to distinguish the type of drugs.

(5) Press this key to select other doses. If adrenalin is used, you can define the injection interval. If the 
injection time is approaching, the time to the last injection will be highlighted in red, reminding 
that injection is required.

(6) Drug record area: quickly records the names and doses of drugs used for patient resuscitation. 
Select Other Drugs to record other drugs or temporary drugs not included. You can edit these 
drugs later.

(7) Press this key to enter the Setup menu. You can customize drugs and treatments.

(8) Treatment record area: quickly records the treatments. Select Other Treatments to record other 
treatments. If an undefined treatment is selected, you can edit it later.

(9) Press this key to select other defibrillation energy and the type of defibrallation waveform.
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■ Select the Exit Resus Mode quick key.

■ Select the Main Menu quick key → from the Alarm column select Exit Resus Mode.

Exit the Resus mode as soon as resuscitation ends to return to normal patient monitoring.

16.6.4 Reviewing the Resuscitation Events
You can review the details of resuscitation events after exiting the Resus mode. To do so, follow this procedure:

1. Enter the Events page by choosing either of the following ways:

◆ Select the Review quick key → select the Event tab.

◆ Select the Main Menu quick key → from the Review column select the Event tab.

2. From the events list select the desired resuscitation event, and then select Detail.

16.6.4.1 Editing an Resuscitation Event

You can edit the history resuscitation event and result. To do so, follow this procedure.

1. Enter the Events page.

2. From the events list select the desired resuscitation event, and then select Detail.

3. Select any event to add an event, edit or delete this event.

16.6.4.2 Outputting History Resuscitation Record

You can print or export the history resuscitation record through event review. To do so, follow this procedure:

1. Enter the Events page.

2. From the events list select the desired resuscitation event, and then select Detail.

3. Select the  button to enter the Print Setup menu.

4. Print or export the resuscitation report:

◆ Select Print Preview → Print to print this report.

◆ Select Print Preview → Export to USB to export this report.
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17 Calculation (only available when the N1 is used with 

the independent external display)

17.1 Calculation Overview
The monitor provides calculation functions. The calculated values, which are not directly measured, are 
computed based on the values you provide. The calculation function is independent of other monitoring 
functions and can therefore be used for patients being monitored by other monitors. Any operation in a 
calculation dialog does not affect the patient monitored by the current monitor. 

You can perform the following calculations:

■ Drug calculations

■ Hemodynamic calculations

■ Oxygenation calculations

■ Ventilation calculations

■ Renal calculations

17.2 Calculation Safety Information

WARNING

• Decisions on the choice and dosage of drugs administered to patients must always be made by the 
physician in charge. The drug calculations are based on the values input; it does not check the 
plausibility of the calculation performed. 

• Check that the entered values are correct and the calculated values are appropriate. Mindray 
assumes no responsibility for any consequences caused by wrong entries and improper operations.

17.3 Drug Calculations

17.3.1 Performing Drug Calculations
To perform drug calculations, follow this procedure:

1. Access the drug calculator by either of the following ways:

◆ Select the Calculations quick key → select the Drug tab.

◆  Select the Main Menu quick key → from the Calculations column select Drug.

2. Set Drug Name and Patient Category. If the dose of drug is weight dependent, you must input the 
patient’s weight. The dose calculation program has a library of commonly used drugs, while Drug A 
through Drug E are user defined.

3. Enter the known values, for example Drug Amount and Solution Volume.

4. Select Calculate. The calculated values are indicated by red arrows. 

NOTE

• If available, the patient category and weight from the Patient Demographics dialog are 
automatically entered when you first access drug calculation. You can change the patient category 
and weight. This will not change the patient category and weight stored in the patient demographic 
information.
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17.3.2 Checking the Titration Table
The titration table shows information on the currently used drugs. Use the titration table to see what dose of a 
drug your patient will receive at different infusion rates. To access the titration table, follow this procedure:

1. Access drug calculator by either of the following ways:

◆ Select the Calculations quick key.

◆  Select the Main Menu quick key → from the Calculations column select Drug.

2. Select the Titration Table tab.

3. Select Dose Type to set the type of dose unit in the titration table.

4. Select Interval to set the interval between two adjacent titration table items. 

You can select how to display the titration table:

■ Dose: the titration table is listed in the sequence of increased drug dose.

■ Infusion Rate: the titration table is listed in the sequence of increased infusion rate. By default the 
resolution of the infusion rate is one (1). By selecting Exact Rate the resolution of the infusion rate can 
reach 0.01 so that you can display the infusion rate more accurately. 

17.3.3 Drug Calculation Formula

17.3.4 Titration Table Calculation Formula

Description Unit Formula

Dose Dose/hr 
Dose/min

Dose = Infusion Rate × Concentration

Dose (weight based) Dose/kg/hr 

Dose/kg/min

Dose (weight based) = Infusion Rate × 
Concentration/Weight

Drug Amount g series: mcg, mg, g
unit series: Unit, KU, MU 
mEq series: mEq

Drug Amount =Dose × Duration

Drug Amount (weight based) g series: mcg, mg, g
unit series: Unit, KU, MU 
mEq series: mEq

Drug Amount (weight based) = Dose × Duration × 
Weight

Duration hr Duration = Amount/Dose

Duration (weight based) hr Duration (weight based) = Amount/(Dose × Weight)

Concentration mcg/ml, mg/ml, g/ml, Unit/ml, 
KU/ml, MU/ml, mEq/ml

Concentration = Drug Amount/Solution Volume

Solution volume ml Volume = Infusion Rate × Duration

Infusion rate ml/hr Infusion Rate = Dose/Concentration

Infusion rate (weight based) g•ml/hr Infusion Rate = Dose × Weight/Concentration

Description Unit Formula

Infusion Rate ml/hr Infusion Rate = Dose/Concentration

Infusion Rate (weight based) ml/hr Infusion Rate = Weight × Dose/Concentration

Dose Dose/hr 
Dose/min

Dose = Infusion Rate × Concentration

Dose (weight based) Dose/kg/hr 
Dose/kg/min

Dose (weight based) = Infusion Rate × 
Concentration/Weight
17 - 2  BeneVision N1 Patient Monitor Operator’s Manual



17.4 Hemodynamic Calculations
The monitor provides the hemodynamic calculation function and can save the results of up to 10 calculations, 
which are displayed in groups.

17.4.1 Performing Hemodynamic Calculations
To perform hemodynamic calculation, follow this procedure:

1. Access hemodynamic calculation by either of the following ways:

◆ Select the Calculations quick key → Hemodynamics tab.

◆  Select the Main Menu quick key → from the Calculations column select Hemodynamics.

2. Enter the known values. For a patient who is being monitored, the currently measured values are 
automatically entered. 

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value 
lower than the normal lower limit is indicated by a down arrow “↓”.

You can select Range to show the normal range of each parameter.

17.4.2 Input Parameters for Hemodynamic Calculations

NOTE

• If you enable Use PA-D as PAWP, PA-D value will be used to replace PAWP value for hemodynamic 
calculation. For more information, refer to 13.6.8 Setting the Use PA-D as PAWP Switch (only available 
when the N1 is used with the independent external display).

17.4.3 Calculated Parameters and Formulas for Hemodynamic Calculations 

Input Parameter Label Unit

cardiac output C.O. L/min

heart rate HR bpm

pulmonary artery wedge pressure PAWP mmHg

mean arterial pressure MAP mmHg

pulmonary artery mean pressure PA-M mmHg

central venous pressure CVP mmHg

end-diastolic volume EDV ml

height Height cm

weight Weight kg

Calculated Parameters Label Unit Formula

cardiac index C.I. L/min/m2 C.I. (L/min/m2) = C.O. (L/min)/BSA (m2)

body surface area BSA m2 BSA (m2) = Wt0.425 (kg) × Ht 0.725 (cm) × 
0.007184

stroke volume SV ml SV (ml) = 1000× C.O. (L/min)/HR (bpm)

stroke index SVI ml/m2 SVI (ml/m2) = SV (ml)/BSA (m2)

systemic vascular 
resistance

SVR DS/cm5 SVR (DS/cm5) = 79.96 × [APMAP (mmHg) - 
CVP (mmHg)]/C.O. (L/min)
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17.5 Oxygenation Calculations
The monitor provides the oxygenation calculation function and can save the results of up to 10 calculations, 
which are displayed in groups.

17.5.1 Performing Oxygenation Calculations
To perform oxygenation calculations, follow this procedure:

1. Access oxygenation calculation by either of the following ways:

◆ Select the Calculations quick key → Oxygenation tab.

◆  Select the Main Menu quick key → from the Calculations column select Oxygenation.

2. Enter the known values. For a patient who is being monitored, the currently measured values are 
automatically entered. 

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value 
lower than the normal lower limit is indicated by a down arrow “↓”.

In the Oxygenation page, you can also perform the following operations:

■ Select OxyCont Unit, Hb Unit, and Pressure Unit. Then corresponding parameter values will be 
automatically converted and updated accordingly.

■ Select Range to show the normal range of each parameter.

systemic vascular 
resistance index

SVRI DS•m2/cm5 SVRI (DS•m2/cm5) = SVR (DS/cm5) × BSA (m2)

pulmonary vascular 
resistance

PVR DS/cm5 PVR (DS/cm5) = 79.96 × [PAMAP (mmHg) - 
PAWP (mmHg)]/C.O. (L/min)

pulmonary vascular 
resistance index

PVRI DS•m2/cm5 PVRI (DS•m2/cm5) = PVR (DS/cm5) × BSA (m2)

left cardiac work LCW kg•m LCW (kg•m) = 0.0136 × APMAP (mmHg) × C.O. 
(L/min)

left cardiac work index LCWI kg•m/m2 LCWI (kg•m/m2) = LCW (kg•m)/BSA (m2)

left ventricular stroke 
work

LVSW g•m LVSW (g•m) = 0.0136 × APMAP (mmHg) × SV 
(ml)

left ventricular stroke 
work index

LVSWI g•m/m2 LVSWI (g•m/m2) = LVSW (g.m)/BSA (m2)

right cardiac work RCW kg•m R CW (kg•m) = 0.0136 × PAMAP (mmHg) × C.O. 
(L/min)

right cardiac work index RCWI kg•m/m2 R CWI (kg•m/m2) = RCW (kg.m)/BSA (m2)

right ventricular stroke 
work

RVSW g•m R VSW (g•m) = 0.0136 × PAMAP (mmHg) × SV 
(ml)

right ventricular stroke 
work index

RVSWI g•m/m2 R VSWI (g•m/m2) = RVSW (g•m)/BSA (m2)

ejection fraction EF % EF (%) = 100 × SV (ml)/EDV (ml)

end-diastolic volume 
index

EDVI ml/m2 EDVI (ml/m2) = EDV (ml)/BSA (m2)

end-systolic volume ESV ml ESV (ml) = EDV (ml) –SV (ml)

end-systolic volume index ESVI ml/m2 ESVI (ml/m2) = ESV (ml)/BSA (m2)

Calculated Parameters Label Unit Formula
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17.5.2 Input Parameters for Oxygenation Calculations

17.5.3 Calculated Parameters and Formulas for Oxygenation Calculations

Input Parameter Label Unit

cardiac output C.O. L/min

percentage fraction of inspired oxygen FiO2 %

partial pressure of oxygen in the arteries PaO2 mmHg, kPa

partial pressure of carbon dioxide in the arteries PaCO2 mmHg, kPa

arterial oxygen saturation SaO2 %

partial pressure of oxygen in venous blood PvO2 mmHg, kPa

venous oxygen saturation SvO2 %

hemoglobin Hb g/L, g/dl, mmol/L

respiratory quotient RQ None

atmospheric pressure ATMP mmHg, kPa

height Height cm, inch

weight Weight kg, lb

Calculated Parameters Label Unit Formula

body surface area BSA m2 BSA (m2) = Wt0.425 (kg) × Ht 0.725 (cm) × 
0.007184

oxygen consumption VO2 ml/min VO2 (ml/min) = C(a-v)O2 (ml/L)× C.O. (L/min))

arterial oxygen content CaO2 ml/L, ml/dL CaO2 (ml/L) = 10× (0.0134 × Hb (g/dl) × SaO2 
(%)) +0.031× PaO2 (mmHg)

venous oxygen content CvO2 ml/L, ml/dL CvO2 (ml/L) = 10× (0.0134 × Hb (g/dl) × SvO2 
(%)) +0.031 × PvO2 (mmHg)

arteriovenous oxygen 
content difference

C(a-v)O2 ml/L, ml/dl C(a-v)O2 (ml/L) = CaO2 (ml/L) - CvO2 (ml/L)

oxygen extraction ratio O2ER % O2ER (%) = 100×C(a-v)O2 (ml/L)/CaO2 (ml/L)

oxygen transport DO2 ml/min DO2(ml/min) = C.O. (L/min) × CaO2(ml/L)

partial pressure of oxygen 
in the alveoli

PAO2 mmHg, kPa PAO2 (mmHg) = [ATMP (mmHg) - 47 mmHg] × 
FiO2 (%)/100 - PaCO2 (mmHg) × [FiO2 (%)/100  
+ (1 - FiO2 (%)/100)/RQ]

alveolar-arterial oxygen 
difference

AaDO2 mmHg, kPa AaDO2 (mmHg) = PAO2 (mmHg) - PaO2 
(mmHg)

capillary oxygen content CcO2 ml/L, ml/dl CcO2 (ml/L) = Hb (g/L) × 1.34 + 0.031 × PAO2 
(mmHg)

venous admixture QS/QT % QS/QT (%) = 100× [1.34 × Hb (g/L) × (1 - SaO2 
(%)/100)  +  0.031 × (PAO2 (mmHg) - PaO2 
(mmHg))]/[1.34 × Hb (g/L) ×  (1 - SvO2 (%)/
100) + 0.031× (PAO2 (mmHg) -  PvO2 
(mmHg))]

oxygen transport index DO2I ml/min/m2 DO2I (ml/min/m2) = CaO2 (ml/L) × (C.O. (L/
min)/BSA (m2)) 

oxygen consumption VO2I ml/min/m2 VO2I (ml/min/m2) = C (a-v) O2 (ml/L) ×(C.O. (L/
min)/BSA (m2))
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17.6 Ventilation Calculations
The monitor provides the ventilation calculation function and can save the results of up to 10 calculations, which 
are displayed in groups.

17.6.1 Performing Ventilation Calculations
To perform ventilation calculations, follow this procedure:

1. Access ventilation calculation by either of the following ways:

◆ Select the Calculations quick key → Ventilation tab.

◆  Select the Main Menu quick key → from the Calculations column select Ventilation.

2. Enter the known values. For a patient who is being monitored, the currently measured values are 
automatically taken. If the anesthesia machine or ventilator is connected, measured values for ventilation 
calculation are also automatically entered.

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value lower 
than the normal lower limit is indicated by a down arrow “↓”.

On the Ventilation page, you can also perform the following operations:

■ Select Pressure Unit. Then corresponding parameter values will be automatically converted and updated 
accordingly.

■ Select Range to show the normal range of each parameter.

17.6.2 Input Parameters for Ventilation Calculations

17.6.3 Calculated Parameters and Formulas for Ventilation Calculations

Input Parameter Label Unit

percentage fraction of inspired oxygen FiO2 %

respiration rate RR rpm

partial pressure of mixed expiratory CO2 PeCO2 mmHg, kPa

partial pressure of carbon dioxide in the arteries PaCO2 mmHg, kPa

partial pressure of oxygen in the arteries PaO2 mmHg, kPa

tidal volume TV ml

respiratory quotient RQ None

atmospheric pressure ATMP mmHg, kPa

Calculated Parameters Label Unit Formula

partial pressure of oxygen 
in the alveoli

PAO2 mmHg, kPa PAO2 (mmHg) = [ATMP (mmHg) - 47 mmHg] × 
FiO2 (%)/100 - PaCO2 (mmHg) × [FiO2(%)/100  
+ (1 - FiO2 (%)/100)/RQ]

alveolar-arterial oxygen 
difference

AaDO2 mmHg, kPa AaDO2 (mmHg) = PAO2 (mmHg) - PaO2 
(mmHg)

oxygenation ratio Pa/FiO2 mmHg, kPa Pa/FiO2(mmHg) = 100 × PaO2 (mmHg)/FiO2 
(%)

arterial to alveolar oxygen 
ratio

a/AO2
% a/AO2 (%) = 100 × PaO2 (mmHg)/PAO2 

(mmHg)

minute volume MV L/min MV (L/min) = [TV (ml) × RR (rpm)]/1000
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17.7 Renal Calculations
The monitor provides the renal calculation function and can save the results of up to 10 calculations, which are 
displayed in groups.

17.7.1 Performing Renal Calculations
To perform renal calculations, follow this procedure:

1. Access renal calculation by either of the following ways:

◆ Select the Calculations quick key → select the Renal tab.

◆ Select the Main Menu quick key → from the Calculations column select Renal.

2. Enter the known values. 

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value lower 
than the normal lower limit is indicated by a down arrow “↓”.

You can select Range to show the normal range of each parameter.

17.7.2 Calculated Parameters and Formulas for Renal Calculations 

volume of physiological 
dead space

Vd ml Vd (ml) = TV (ml) × [1 - PeCO
2

 (mmHg)/PaCO
2

 (mmHg)]

physiologic dead space in 
percent of tidal volume

Vd/Vt % Vd/Vt (%) = 100 × Vd (ml)/TV (ml)

alveolar volume VA L/min VA (L/min) =[TV (ml) - Vd (ml)] × RR (rpm)/
1000

Calculated Parameters Label Unit Formula

Input Parameter Label Unit

urine potassium URK mmol/L

urinary sodium URNa mmol/L

urine Urine ml/24 hrs

plasm osmolality Posm mOsm/kgH2O

urine osmolality Uosm mOsm/kgH2O

serum sodium SerNa mmol/L

creatinine Cr μmol/L

urine creatinine UCr μmol/L

blood urea nitrogen BUN mmol/L

height Height cm

weight Weight kg
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17.7.3 Calculated Parameters and Formulas for Renal Calculations

*: BUN/Cr is a ratio under the unit of mol.

Calculated Parameters Label Unit Formula

urine sodium excretion URNaEx mmol/24 hrs URNaEx (mmol/24 hrs) = Urine (ml/24 hrs) × 
URNa (mmol/L)/1000

urine potassium excretion URKEx mmol/24 hrs URKEx (mmol/24 hrs) = Urine (ml/24 hrs) × 
URK (mmol/L)/1000

sodium potassium ratio Na/K % Na/K (%) = 100 × URNa (mmol/L)/URK (mmol/
L)

clearance of sodium CNa ml/24 hrs CNa (ml/24 hrs) = URNa (mmol/L) × Urine (ml/
24 hrs)/SerNa (mmol/L)

creatinine clearance rate Clcr ml/min Clcr (ml/min) = Ucr (μmol/L) × Urine (ml/24 
hrs)/[Cr (μmol/L) × (BSA (m2)/1.73) × 1440]

fractional excretion of 
sodium

FENa % FENa (%) = 100 × URNa (mmol/L) × Cr (μmol/
L)/[SerNa (mmol/L) × Ucr (μmol/L)]

osmolar clearance Cosm ml/min Cosm (ml/min) = Uosm (mOsm/kgH2O) × 
Urine (ml/24 hrs)/(Posm (mOsm/kgH2O) × 
1440)

free water clearance CH2O ml/hr CH2O (ml/hr) = Urine (ml/24 hrs) × [1 - Uosm 
(mOsm/kgH2O)/Posm (mOsm/kgH2O)]/24

urine to plasma 
osmolality ratio

U/P osm None U/P osm = Uosm (mOsm/kgH2O)/Posm 
(mOsm/kgH2O)

blood urea nitrogen 
creatinine ratio

BUN/Cr* Mmol/L BUN/Cr = 1000 × BUN (mmol/L)/Cr (μmol/L)

urine-serum creatinine 
ratio

U/Cr None U/Cr (mmol/L) = Ucr (μmol/L)/Cr (μmol/L)
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18 Printing

18.1 Supported Printer
The monitor can output patient reports via a connected network printer. The monitor supports the following 
printers:

■ HP LaserJet Pro M202dw

■ HP LaserJet Pro 400 M401n

■ HP LaserJet P4015n

■ HP LaserJet 600 M602

■ HP LaserJet Enterprise M605

■ HP LaserJet Enterprise M608n 

NOTE

• For more details about the printer, refer to the document accompanying the printer. With product 
upgrades, the monitor may support additional printers without prior notice. If you have any doubts 
about the compatibility of the printer used with this monitor, contact Mindray.

18.2 End Case Reports

18.2.1 Printing the End Case Report
To print the end case report, choose one of the following ways:

■ Select Print from the End Case Report menu.

■ Select Print End Case Report when you discharge a patient.

■ Select the End Case Report quick key (only available when the N1 is used with the independent external 
display).

18.2.2 Setting a Report as An End Case Report
The following reports can be set as end case reports:

■ Tabular Trends Report

■ Graphic Trends Report

■ Event Report

■ 12-lead Interpretation

■ Alarm Limits Report

■ Realtime Report

■ ECG Report

To set a report as an end case report, follow this procedure:

1. Select the Main Menu quick key → from the Report column select End Case Report.

2. From the Select Reports page, select the desired report tab, for example ECG Report.

18.2.3 Configuring the End Case Reports

To configure the end case reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select End Case Report.
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2. From the Report Setup page, set the following end case reports:

◆ Select the Tabular Trends Report, Graphic Trends Report, Realtime Report, and ECG Report tab, 
and set these end case report by referring to section 18.6 Configuring Reports.

◆ Select the Event Report tab, and select the event that needs to be printed.

◆ Select the 12-Lead Interpretation tab, and set the switch of Median Complex, Measurements, 
Interpretation, or Interpretation Summary. For other settings, refer to section 18.6.1 Configuring 
ECG Reports.

18.2.4 Setting the End Case Report Period
To set the end case report print period, follow this procedure:

1. Select the Main Menu quick key → from the Report column select End Case Report.

2. From the Select Reports page, set the Period.

NOTE

• End case report print period is calculated from the patient discharged time to the configured period.

• Period setting is applicable to all of the end case reports.

18.3 Manually Starting a Printing Task
This section describes different methods for manually printing a report.

18.3.1 Printing from the Screen 
The  button will be shown at the top of dialogs that have associated reports. If the button is gray, then there 
is not enough information to begin the report, or the printer has not been set up.

When the icon is white, pressing it opens a Print Setup dialog or starts printing a report. If the Print Setup 
dialog is entered, configure the report and press Print to start printing.

18.3.2 Printing Realtime Reports
Select the Print quick key to print a realtime report. You can also print a realtime report from the Report Setup 
dialog. For more information, see 18.3.3 Printing Most Common Reports.

18.3.3 Printing Most Common Reports
The following most common reports can be printed:

■ ECG Report 

■ Realtime Report

■ Tabular Trends Report

■ Graphic Trend Report.

To print these reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup. 

2. Select the desired report tab.

3. Check the settings.

4. Select Print.

18.4 Automatically Printing Reports
When a parameter alarm switch is set to on and an alarm is triggered for this parameter, you can set the monitor 
to automatically print a Print on Alarm Report.

To do so, follow this procedure:
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1. Access alarm related tabs such as the Alarm tab for a parameter in one of the following ways:

◆ Select the parameter or waveform area of the desired parameter → select the Alarm tab.

◆ Select the Main Menu quick key → from the Parameters column select Setup→ select the desired 
parameter → select the Alarm tab.

2. Switch on Alarm Outputs for desired parameters. 

18.5 Stopping a Printing Task
To stop a printing task, follow this procedure:

1. Select the Main Menu quick key →from the Report column select Print Queue.

2. Select desired printing tasks and then select Delete. Alternately, select Delete All to stop all the printing 
tasks.

18.6 Configuring Reports
This section focuses on how to configure ECG reports, realtime reports, tabular trends reports, and graphic 
trends reports.

18.6.1 Configuring ECG Reports
 To configure ECG reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup.

2. Select the ECG Report tab.

3. Set the desired options. The following table explains some of the less familiar options.

Menu item Function Description

Speed Set the print speed of 
ECG waveforms

25 mm/sec: prints 25 mm of ECG waveform per second.
50 mm/sec: prints 50 mm of ECG waveform per second.

Auto Interval Defines the spacing 
between the ECG 
waveforms on a 
printout

On: automatically adjusts the space between waveforms to 
avoid overlapping.
Off: each waveform area has the same size on a printout.

Note: Auto Interval is only enabled when 12×1 is selected for 12-Lead Format.

12-Lead Format Select the format of 12-
lead ECG waveforms 
on a printout.

12×1: displays 12-lead ECG waveforms on one page in one 
column.
6×2: displays 12-lead ECG waveforms on one page in two 
columns, with 6 lines in each column.
6×2+1: displays 12-lead ECG waveforms on one page in two 
columns, with 6 lines in each column, and one rhythm lead 
waveform at the bottom.
3×4+1: displays 12-lead ECG waveforms on one page in 4 
columns, with 3 lines in each column, and one rhythm lead 
waveform at the bottom.
3×4+3: displays 12-lead ECG waveforms on one page in 4 
columns, with 3 lines in each column, and three rhythm lead 
waveforms at the bottom.

Rhythm Lead 1
Rhythm Lead 2
Rhythm Lead 3

Select the lead that will 
be used as Rhythm 
Lead 1, 2, or 3.

I, II, III, aVR, aVL, aVF, V1, V2, V3, V4, V5, V6

Note: Rhythm Lead setting is only enabled when 6×2+1, 3×4+1, or 3×4+3 is selected for 
12-Lead Format.

Format Sequence Select the recording 
method of ECG report 
generated by auto 
measurement

Sequential: 12-lead ECG data are recorded sequentially and 
displayed in 3 lines and 4 columns with 2.5 seconds of ECG data 
for each column.
Simultaneous: Record simultaneous 12-lead ECG data.
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NOTE

• When ECG Lead Set is set to 3-Lead, the ECG report cannot be printed.

18.6.2 Configuring Realtime Reports
To configure tabular realtime reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup.

1. Select the Realtime Report tab.

2. Set the desired options. The following table explains some of the options.

18.6.3 Configuring Tabular Trends Reports
To configure tabular trends reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup.

2. Select the Tabular Trends Report tab.

3. Set the desired options. 

The following table explains some of the options.

Menu item Function Description

Select Waveform Select the desired 
waveform to print

Current Waveforms: prints the realtime report for the currently 
displayed waveforms and all the currently measured parameter 
values.

Selected Waveforms: prints the realtime report for the waveforms 
configured in the Select Waveform dialog, accessed by clicking the 
Select Waveform button.

Menu Item Function Description

Time Select the time before which a tabular 
trends report will be printed

/

Period Select the period during which a 
tabular trends report will be printed.

Auto: one page of a tabular trends before the current time 
will be printed at the selected Interval.
All: all stored tabular trends will be printed at the selected 
Interval.
30 min to 96 hrs: 30 min to 96 hrs of tabular trends before 
the selected Time will be printed at the selected Interval.

Interval Select the resolution of the tabular 
trends printed on a report.

NIBP, EWS, GCS: at an interval of acquiring the values of 
selected parameter (EWS and GCS are only available when 
the N1 is used with the independent external display).
Auto: using the Interval setting of the Tabular Trends 
review page.
5 sec to 3 hrs: the tabular trends will be printed at the 
interval of 5 sec to 3 hrs.

Report Format Select the printing principle. Parameter Oriented: print one page span of report with 
parameters listed by row and time listed by column when 
Interval is set to Auto.
Time Oriented: print one page span of report with time 
listed by row and parameter listed by column when Interval 
is set to Auto.
Note that Interval on Auto only limits the number of rows or 
columns for Time. The report may have multiple pages to 
accommodate the number of parameters. To limit the 
parameters, change the Trend Group.
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18.6.4 Configuring Graphic Trends Reports
To set graphic trends reports, follow this procedure:

1. Select the Main Menu quick key →from the Report column select Report Setup. 

2. Select the Graphic Trends Report tab. 

3. Set the desired options.

18.7 Viewing Printer Status
You can view the status of the most recent ten printing tasks in the Print Queue dialog. To view the status of 
printing tasks, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Print Queue.

2. View the status of printing tasks in the Print Queue dialog. 

Each printing task includes the following information:

■ Print time

■ Report title

■ Printer name (when using the printer server) or IP address (when using the network printer)

■ Printing status, for example, printing, failed, retrying, and waiting.

18.8 Printer Out of Paper
When the printer runs out of paper, the print request will remain incomplete. If there are too many print jobs that 
remain incomplete, then a printer error may occur. To resolve the error, install paper. Some print requests may be 
lost if the incomplete tasks overflow the printer buffer. Missing or lost reports must be recreated and printed.

To reduce risks of printer errors, maintain enough paper in the printer.

18.9 List of Reports
The monitor can output the following reports to the printer:

■ Realtime reports

◆ Realtime Report

◆ Freeze Report

◆ ECG Report (5-lead, 6-lead, 12-lead)

◆ 12-Lead Interpretation Report (realtime)

◆ Print on Alarm Report

◆ Alarm Limits Report

◆ Titration Table Report (only available when the N1 is used with the independent external display)

◆ Hemodynamic Calculation Report (only available when the N1 is used with the independent external 
display)

◆ Oxygenation Calculation Report (only available when the N1 is used with the independent external 
display)

◆ Ventilation Calculation Report (only available when the N1 is used with the independent external 
display)

◆ Renal Calculation Report (only available when the N1 is used with the independent external display)

◆ ST Report (Realtime)

Menu Item Function Description

Period Select the period during which a 
graphic trends report will be printed.

Auto: one page of a graphic trends before the current 
time will be printed.
All: all stored graphic rends will be printed..
30 min to 96 hrs: 30 min to 96 hrs of graphic trends 
before the selected Time will be printed.
BeneVision N1 Patient Monitor Operator’s Manual 18 - 5



◆ QT Report (Realtime)

◆ OxyCRG Report (only available when the N1 is used with the independent external display)

◆ PAWP Report (only available when the N1 is used with the independent external display)

■ History reports

◆ Tabular Trends Report

◆ Graphic Trends Report

◆ Event List Report

◆ Event Detail Report

◆ Full Disclosure Overview Report

◆ Full Disclosure Detail Report

◆ 12-Lead Review Interpretation Report (review)

◆ OxyCRG Report (review, only available when the N1 is used with the independent external display)

◆ OxyCRG review Report (review)

■ End Case Report

◆ End Case Report - Realtime Report

◆ End Case Report -ECG Report

◆ End Case Report - Tabular Trends Report

◆ End Case Report - Graphic Trends Report
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19 Using the On-Screen Timers

The monitor has a Timer function to notify you when a preset time period is expired or how much time has 
elapsed. You can simultaneously display up to four timers. 

19.1 Displaying Timers
To display a timer, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆ Select the Main Menu quick key → from the Display column select Tile Layout.

2. Click the numeric tile area where the timer is to be displayed, and then select a timer from the popup list.

19.2 Controlling the Timer
The timer provides the following controls, depending on the state and settings of the timer:

■ Start: starts the timer. 

■ Pause: pauses the timer.

■ Resume: resumes the timer.

■ Reset: clears the timer.

19.3 Setting the Timer
You can set each timer independently. To set the timer, follow this procedure:

1. Select the timer area to enter the Timer Setup dialog.

2. Set Timer Type:

◆ Normal: The timer has a single and defined run time, and stops with a notification beep when the run 
time is reached.

◆ Advanced: The timer has a single and defined run time. When the run time is reached, the timer 
makes a notification beep and continuously displays the time beyond the end of run time.

◆ Cycled: The timer has a single and defined run time. When the run time is reached, the timer makes a 
notification beep and restarts automatically. The number of elapsed cycles is also displayed on the 
left of the Timer tile. 

◆ Unlimited: The timer displays the time elapsed since the timer was started.

◆ Clock: The timer displays the system time.

3. Set Direction.

◆ Up: the timer counts up, from zero to Run Time.

◆ Down: the timer counts down, from Run Time to zero.

4. Set Run Time.

5. Set Reminder Volume. 

A progress bar is shown with the run time. When the remaining time is 10 seconds, the monitor issues a 
reminder tone and the timer flashes in red, prompting you that the run time is about to expire. 

NOTE
• You cannot change timer settings, other than Reminder Volume when a timer is running.

• You can set Direct, Run Time, and Reminder Volume only for normal, advanced, and cycled timers.
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20 Managing Configurations

20.1 Configuration Introduction
When performing continuous monitoring on a patient, the clinical professional often needs to adjust the 
monitor’s settings according to the patient’s condition. The collection of all these settings is called a 
configuration. The system configuration items can be classified as: parameter configuration items, conventional 
configuration items, and user maintenance items. Allowing you to configure the monitor more efficiently, the 
monitor provides different sets of configurations to accommodate the varying patient categories and 
departments. You can change some settings from a certain set of configuration and then save the changed 
configuration as a user configuration.

The default configurations provided for your monitor are department-oriented. You can choose either from:

■ General

■ OR

■ ICU

■ Neonatology

■ CCU

Each department has three different sets of configurations tailored for adult, pediatric and neonatal patients 
respectively.

WARNING

• The configuration management function is password protected. The configuration management 
tasks must be performed by clinical professionals.

20.2 Changing the Department
If the current department configuration is not the one you want to view, you can change the department by 
following this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → select .

2. Select Change Department.

3. Select a department.

4. Select Ok.

CAUTION

• Changing the department will delete all current user configurations.

20.3 Setting Default Patient Category
To set the default patient category when admitting a new patient, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → select .

2. Set Default Patient Category.

20.4 Setting Default Configuration
The monitor will load the pre-set default configuration in the following cases:
BeneVision N1 Patient Monitor Operator’s Manual 20 - 1



■ A patient is admitted.

■ A patient is discharged.

■ Patient category is changed.

To set the default configuration, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Select Default Config.

3. Select Load the Latest Config or Load Specified Config.

◆ When you select Load Specified Config, the restored configuration is subject to the patient category 
(adult, pediatric or neonate). This configuration can be either factory configuration or a saved user 
configuration. As an example, select Default Adult Config and then select Factory Default or user 
configuration(s).

◆ When you select Load the Latest Config, the latest configuration is loaded when the monitor is 
started or a patient is admitted. 

20.5 Saving Current Settings
Current settings can be saved as a user configuration. Up to 25 user configurations can be saved.

To save current settings, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Save Current Settings.

3. Input the configuration name.

4. Select Ok to save current settings as a user configuration.

20.6 Deleting a Configuration
To delete a configuration, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Delete Configuration. 

3. Select the configuration you want to delete:

◆ In the Delete Configuration dialog, selecting Local tab shows the existing user configurations on the 
monitor. 

◆ In the Delete Configuration dialog, selecting USB Drive tab shows the existing user configurations 
on the USB drive.

4. Select Delete.

5. Select Ok.

20.7 Transferring a Configuration
When installing several monitors with identical user configurations, it is not necessary to set each unit 
separately. Use a USB drive to transfer the configuration from monitor to monitor.

20.7.1 Exporting a Configuration
To export the current monitor’s configuration, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the USB drive to the Dock’s USB port.

3. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .
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4. Select Export Configuration.

5. Select the configurations and User Maintenance Settings to export.

6. Select Export. 

20.7.2 Importing a Configuration
To import the configuration from the USB drive to the monitor, follow this procedure:

1. Connect the N1 to the Dock.

2. Connect the USB drive to the Dock’s USB port.

3. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

4. Select Import Configuration.

5. Select the configurations and User Maintenance Settings to import. 

6. Select Import. 

20.7.3 Loading a Configuration
You may make changes to some settings during operation. However, these changes or the pre-selected 
configuration may not be appropriate for the newly admitted patient. Therefore, the monitor allows you to load 
a desired configuration to ensure that all the settings are appropriate for your patient.

To load a configuration, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Load.

2. Select the desired configuration.

◆ Select the configuration on this monitor in the Local page.

◆ Select the configuration on the USB drive in the USB Drive page.

3. Select Load.

NOTE

• The monitor may configure some settings by default when you load a configuration of different 
software version with the current configuration.

20.8 Printing Configurations
To print both factory configurations and user configurations, follow this procedure:

1. Select the Main Menu quick key →from the Configuration column select Manage → input the required 
password → select .

2. Select Print Configuration.

3. Select desired configurations.

4. Select Print.

20.9 Modifying Configuration Password
To modify the configuration password, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Modify Password.

3. Respectively input the old password and new password.

4. Select OK.
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21 Password-protected User Settings

This chapter describes the password-protected functions accessed in the Maintenance dialog.

21.1 Setting the Device Location

21.1.1 Setting Monitor Information
To set monitor information, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Device Location tab.

3. Input monitor name, facility name and department name.

21.1.2 Setting Monitor Location
If your monitor is installed at a fixed position, or you do not need clinicians to change the room number and bed 
number, you can set Monitor Location to Fixed. To set the monitor location, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Device Location tab.

3. Set Location.

◆ Fixed: the Patient Management dialog displays Bed No. and Room No., but you cannot change 
them.

◆ Unfixed: you can change Bed No. and Room No. from the Patient Management dialog.

4. Input the room number and bed number. 

NOTE

• If Location is set to Unfixed, Bed No. and Room No. are cleared from the Device Location tab each 
time you discharge a patient. 

21.1.3 Enabling the Auto Obtain Bed Number Function
If the monitor is connected to the wired network, the monitor can automatically set the patient’s bed number 
according to the bed number information bonded to the bedside network connector.

 To enable this function, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Device Location tab.

3. Select Unfixed.

4. Switch on Auto Obtain Bed No..

NOTE

• The Auto Obtain Bed Number function is available only when the switch connected to the monitor 
supports the LLDP or CDP protocol, and the corresponding protocol is enabled.
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21.2 Changing Patient Management Settings

21.2.1 Selecting Displayed Patient Information
You can define which items can be displayed and edited from the Patient Management tab. To do so, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab.

3. Select the fields you want to display in the Patient Management dialog.

4. If necessary, select the customized fields and input names for these fields.

NOTE

• If the monitor is connected with the CMS, the patient information items and customized fields are 
loaded from the CMS.

21.2.2 Auto Discharging a Patient after Monitor Power Off
You can let the monitor automatically discharge after the monitor has been switched off for a period of time.

To set the time period of discharging a patient, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab→ select the Discharge tab.

3. Select a time for Auto Discharge When Power Off. The monitor will automatically discharge the patient 
when it is turned off for the designated period of time. The default is Never. That is to say the monitor will 
not automatically discharge a patient, regardless of how long the monitor has been switched off.

21.2.3 Clearing All Patient Data

You can delete all patient information and data in the monitor. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab→ select the Discharge tab.

3. Select Clear All Patient Data. 

4. Select OK. Select OK again for confirmation until a message indicating you that all data is cleared.

CAUTION
 

• Clearing patient data will discharge the current patient. Make sure there is no patient is being 
monitored before you clear all data.

21.2.4 Selecting Query Criteria for Searching Patients in ADT Server
You can define which criteria can be used to search patients in the ADT server. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → ADT Query tab.

3. Select the query criteria as desired.

21.2.5 Setting Patient Location Options for the Discharge Screen
To set options for patient location, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Location tab.

3. Input or edit patient location options.

21.2.6 Hiding Patient Name
To hide patient name on specific screens, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Display tab.

3. Set the following switches as desired:

◆ Switch off Primary Screen Display Full Name: does not display patient name in the patient 
information area on the primary display.

◆ Switch off Secondary Screen Display Full Name: does not display patient name in the patient 
information area on the secondary display, if configured.

◆ Switch off Remote View Display Full Name: does not display patient name in the patient 
information area on the remote monitors when this monitor is viewed by other monitors.

◆ Switch off Remote View Bedlist Display Full Name: does not display patient name in bed list on the 
remote monitors when this monitor is viewed by other monitors.

21.2.7 Select Whether a Prompt is Required When Auto Deleting Discharged Patients
The monitor automatically delete earlier discharged patients when the memory is limited. You can select 
whether an alarm is issued when discharged patients are automatically deleted and the monitor memory is very 
low.

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Set the Review tab → Discharged Patients tab.

3. Configure the alarms as needed:

◆ Prompt on patient auto deleted: an alarm is issued when the monitor automatically deletes earlier 
discharged patients.

◆ Alarm on storage is nearly full: selects whether an alarm is issued when the monitor memory is very 
low and the priority of this alarm.

21.3 Changing the Alarm Settings

21.3.1 Setting Alarm Tone Properties

21.3.1.1 Setting the Minimum Alarm Volume

To set the minimum alarm volume, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Alarm tab → Audio tab.

3. Set Minimum Alarm Volume. 

21.3.1.2 Setting the Audible Alarm Tone Pattern

You can distinguishes the heart beat tone, pulse tone, and keystroke tone by frequency. You can choose any of 
the three tone patterns: ISO, Mode 1, and Mode 2. For more information, see 6.3.3 Alarm Indicators. 

To set the alarm tone pattern, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Audio tab.

3. Set Alarm Sound to ISO, Mode 1or Mode 2.

21.3.1.3 Setting the Interval between Alarm Sounds

If you choose the ISO pattern, you can change the interval between alarm tones. To change the interval between 
alarm tones, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Audio tab.

3. Set High Alarm Interval, Med Alarm Interval, and Low Alarm Interval.

21.3.1.4 Setting Alarm Volume Escalation

The monitor provides the function of automatically escalating the alarm tone volume. When this function is 
enabled, if an alarm is not reset within the designated delay time after the alarm occurs, the volume of the alarm 
tone increases automatically. 

To set the alarm volume escalation, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Audio tab.

3. Set Auto Increase Volume.

◆ 2 Steps: if an alarm is not reset within the designated delay time after the alarm occurs, the alarm 
volume automatically increases by two levels.

◆ 1 Step: if an alarm is not reset within the designated delay time after the alarm occurs, the alarm 
volume automatically increases by one level.

◆ Off: if an alarm is not reset within the designated delay time after the alarm occurs, the volume of the 
alarm tone does not change.

4. Select Increase Volume Delay to set the delay time of alarm volume escalation.

NOTE

• The alarm volume escalation function is not applied to the latched alarms.

21.3.2 Setting Alarm Pausing and Resetting Properties

21.3.3 Defining the Pause Function
You can either pause alarms or pause alarm tones. This depends on the pause setting. To set the pause function, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Pause to Alarm Pause or Audio Pause. 

21.3.3.1 Setting the Alarm Pause Time/Alarm Tone Pause Time

The alarm pause time or alarm tone pause time can be set to 1 min, 2 min, 3 min, or Permanent. The default 
audio pause time is two minutes. 

To set the alarm tone pause time, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Pause Time. 

21.3.3.2 Setting the Priority of Audio Paused Alarms

To select alarm of what priority can be paused or alarm sound of what priority can be paused, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Pause Priority.

◆ All: pressing the Alarm Pause quick key pauses all alarms.

◆ Med & Low: pressing the Alarm Pause quick key pauses alarms of medium and low priority. The high 
priority alarms will not be paused.

◆ Disable: the Alarm Pause quick key is disabled.

21.3.3.3 Disabling the Options of Prolonging Alarm Pause Time/Alarm Tone Pause Time 

To disable specific options for the clinician when prolonging alarm pause time or the alarm tone pause time, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Switch off Pause 5 min, Pause 10 min, or Pause 15 min.

21.3.3.4 Setting Alarm Light Status on Alarm Reset 

When the alarm system is reset, the monitor presents the alarm light by default , but you can switch off the alarm 
light. To change the alarm light setting, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Alarm Light.

◆ On When Reset: when the alarm system is reset, the alarm tones of the current alarms are switched 
off, but the alarm lamp remains flashing. 

◆ Off When Reset: when the alarm system is reset, both the alarm tone and alarm lamp of the current 
alarms are switched off. 

21.3.3.5 Setting the Reminder Tones

When the alarm volume is set to zero, or the alarm is reset or switched off, the monitor issues a periodical 
reminder tone. The reminder tone is enabled by default.

To set the reminder tone, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Alarm Reset Reminder and Alarm Off Reminder.

◆ On: the monitor issues reminder tones at a designated interval.
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◆ Re-alarm: if the alarm condition persists the alarms marked with “√” will be re-generated after the 
designated reminder tone interval.

◆ Off: the monitor does not issue reminder tones at a designated interval. The alarms marked with “√” 
will be silenced.

4. Set Reminder Interval to 10 min, 5 min, 3 min, 2 min, or 1 min.

21.3.4 Latching Physiological Alarms
To latch physiological alarms, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Latching tab.

3. Select how you want to latch the alarms.

Alarm latching rules are as follows:

■ You can separately latch visible alarm signals and audible alarm signals.

■ Latching audible alarm signals simultaneously latches the corresponding visible signals.

■ Selecting alarms of lower priority simultaneously latches higher priority alarms. 

■ Switching V-Tach Latching Lock off allows you to switch on or off V-Tach Latching.

■ When V-Tach Latching Lock is switched on, V-Tach latching follows the setting of Lethal alarm latching 
and you cannot control V-Tach Latching.

21.3.5 Changing Remote Alarm Settings

21.3.5.1 Resetting Alarms for Remote Devices

You can reset the alarms occurring on the remote devices that are viewed on the Remote View screen of the 
monitor. To enable this function, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Switch on Reset Remote Bed Alarms. Then the Alarm Reset button appears on the bottom left of the 
Remote View screen.

To reset any remote device alarms, the clinician may now select the Alarm Reset button at the bottom of the 
Remote View screen.

NOTE

• You can reset remote device alarms only if the Alarm Reset By Other Bed switch is on at the remote 
devices and alarms are occurring on the remote device.

21.3.5.2 Authorizing the Alarm Reset to Other Devices

Alarms on your monitor can be reset by remote devices if you enable this function. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Switch on Alarm Reset By Other Bed. 

21.3.5.3 Selecting the Alarm Reminder for Remote Devices

You can configure what alarm indicators are necessary for the remote devices. To do so, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Select Alarm Reminder:

◆ Visible + Audible: the monitor provides visual alarm indication, and continuous audible alarm 
indication if the alarm persists at the remote device.

◆ Visible + Single Tone: the monitor provides visual alarm indication, and a single tone when the alarm 
occurs at the remote device.

◆ Visible Only: the monitor only provides visual alarm indication.

21.3.5.4 Presenting Alarm Sound for Remote Devices as per Alarm Priority 

You can configure what priority of remote device alarms are presented for audible notification. To do so, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Select Alarm Priority:

◆ All: the monitor sounds if an alarm occurs.

◆ High & Med: the monitor sounds if a high or medium priority alarm occurs.

◆ High Only: the monitor sounds only if a high priority alarm occurs.

21.3.5.5 Setting the Tone Pattern for Alarms from Remote Devices

The monitor provides the same alarm tone pattern for the remote device alarms as those for your monitor 
alarms. For more information on alarm tone pattern, see 6.3.3 Alarm Indicators.

To set the alarm tone pattern for the remote device alarms, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → select the Remote View tab.

3. Set Alarm Sound to ISO, Mode 1 or Mode 2.

21.3.5.6 Switching Off the Remote Device Disconnection Alarm

The monitor can provide an alarm if remote devices, for example, a bedside monitor or a telemetry, are 
disconnected. By default, the function is enabled. To disable the alarm, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

Switch off Remote Disconnected Alarm. 

21.3.6 Changing Alarm Priority Settings

21.3.6.1 Setting the Priority of the ECG Lead Off Alarm

To set the priority of the ECG lead off alarm, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. Set the priority of ECG Lead Off. 
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21.3.6.2 Setting the Priority of the SpO2 Sensor Off Alarm

To set the priority of the SpO2 sensor off alarm, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. Set the priority of SpO2 Sensor Off. 

21.3.6.3 Setting the Priority of the IBP No Sensor Alarm

To set the priority of the IBP no sensor alarm, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. Set the priority of IBP No Sensor. 

21.3.6.4 Setting the Switch of the CMS and eGateway Disconnection Alarm

You can choose whether to issue an alarm when the monitor is not connected or disconnected from the CMS/
eGateway. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. In the Other block, switch on or off CMS/eGW Disconnected Alarm. If CMS/eGW Disconnected Alarm is 
switched off, the “Offline” alarm is not presented when the monitor is not connected or disconnected from 
the CMS/eGateway.

21.3.6.5 Setting the Priority of the CMS and eGateway Disconnection Alarm

To set the priority of the CMS and eGateway disconnection alarm, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set CMS/eGW Disconnected.

21.3.6.6 Setting the Switch of the SpO2 Desat Alarm Off

You can choose whether switching off the SpO2 Desat alarm is permissible or not. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → select the Other tab.

3. Set SpO2 Desat Alarm Off.

◆ Disable: the SpO2 Desat alarm is always on. You cannot switch it off.

◆ Enable: you can switch off the SpO2 Desat alarm. For more information, see 10.6.1 Changing the SpO2 

Alarm Settings.

WARNING

• If a clinician switches off the SpO2 Desat alarm, the monitor will not alarm when the patient’s SpO2 is 
extremely low. This may result in a hazard to the patient. 
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21.3.6.7 Setting the Switch of the Apnea Alarm Off

You can choose whether switching off the apnea alarm is permissible or not. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → select the Other tab.

3. Set Apnea Alarm Off.

◆ Disable: the apnea alarm is always on. The clinician cannot switch it off.

◆ Enable: the clinician can switch off the apnea alarm. For more information, see 9.5.1 Setting the Resp 
Alarm Properties.

WARNING

• If a clinician switches off the apnea alarm, the monitor will not issue the apnea alarm when that 
situation occurs. This may result in a hazard to the patient. Keep the patient under close 
surveillance. 

21.3.7 Changing Alarm Delay Settings

21.3.7.1 Setting the Alarm Delay Time

 For continuously measured parameters, you can set the alarm delay time. If the alarm condition is resolved 
within the delay time, the monitor does not present the alarm. 

To set the alarm delay time, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set Alarm Delay.

◆ Off: an alarm is presented as soon as the alarm condition occurs.

◆ 1 sec ~ 8sec: for continuously measured parameters, an alarm is not presented if the alarm condition 
is resolved within the designated delay time.

The setting of Alarm Delay is not applied to the apnea alarms and the ST alarms. You can set Apnea Delay and 
ST Alarm Delay separately. 

WARNING

• The alarm delay time can be set to a maximum of 8 seconds. Changing this setting to an 
inappropriate level could result in a hazard to the patient.

21.3.7.2 Setting the ST Alarm Delay Time
1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set ST Alarm Delay.

21.3.8 Adjusting the Alarm Light Brightness
To adjust the alarm light brightness, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .
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2. Select the Alarm tab → Other tab.

3. From the Alarm Light Brightness area, set Primary Screen (note that you may have to scroll up the dialog 
to see this option). If you set alarm light brightness to Auto, the monitor automatically adjusts the alarm 
light brightness according to the ambient light. The stronger the ambient light is, the brighter the alarm 
light is. 

21.3.9 Changing Other Alarm Settings

21.3.9.1 Setting the Lethal Arrhythmia Alarms Switch

To allow a clinician to disable the lethal arrhythmia alarms, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. From the Other block, set Lethal Arrh Alarms Off as follows.

◆ Lethal Arrh Alarms Off is set to Disable by default. In this case, a clinician cannot switch off lethal 
arrhythmia alarms. 

◆ If you set Lethal Arrh Alarms Off to enable, a clinician can switch off lethal arrhythmia alarms from 
the ECG dialog. For more information, see 7.6.4.1 Changing Arrhythmia Alarm Settings.

WARNING

• If any of lethal arrhythmia alarms are switched off, the ECG waveform area displays a message to 
indicate that corresponding alarms are off. 

• If a clinician switches off all arrhythmia alarms, the monitor will not present arrhythmia alarms. 
Always keep the patient under close surveillance.

21.3.9.2 Setting the Intubation Time

The default intubation time is 2 minutes. To change the intubation time, following this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set the Intubation Mode Period.

21.3.9.3 Setting Arrhythmia Alarm Timeout Period

The arrhythmia algorithm can disable alarm light and alarm tone for designated period of time when certain 
arrhythmia alarms are detected. 

To set the arrhythmia alarm timeout period, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. From the Other block, set Arrhy Shield Time.

NOTE
• For the following alarms, alarm light and alarm tone cannot be disabled: HR high, HR low, 

Tachycardia, Bradycardia, Afib End, Irr Rhythm End.

• The arrhythmia alarm timeout period is only applied to the medium priority chains and atrial 
fibrillation chain. For the alarms in the high priority chain, alarm tone and alarm light are presented 
as soon as the alarm condition is detected. Refer to 7.6.5.1 Arrhythmia Alarm Chains for more 
information on the arrhythmia alarm chain.
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• Alarm indication rules for alarms in the atrial fibrillation chain are the same with those for the 
medium priority chains. 

21.4 Changing CAA Settings (only available when the N1 is used with the 
independent external display)

21.4.1 Enabling Inputing the Clinician ID
To display the clinician ID on the EWS screen, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select the EWS tab.

3. Switch on Clinician ID.

4. Select Clinician ID Timeout to set how long the clinician ID will remain valid.

NOTE

• The EWS tab is only available if a license for EWS is installed in the monitor.

21.4.2 Selecting the Default Scoring Tool
To set the default scoring tool for different patient category, follow this procedure:

1.  Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select EWS tab.

3. From the Select Default Score area, set Default Adult Score, Default Ped Score, and Default Neo Score.

21.4.3 Managing the Scoring Tools
To manage the scoring tool, follow this procedure:

1.  Select the Main Menu quick key →from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select EWS tab.

3. Select the Manage Score button.

◆ Delete local scoring tools: from the Local page, delete any unnecessary scoring tools.

◆ Import the desired scoring tools to the monitor: from the USB drive page, select the scoring tools on 
the USB drive, and then select Import.

NOTE

• The monitor provides MEWS and NEWS by default. You cannot delete them.

21.4.4 Setting GCS Threshold for Each Consciousness Level
You can configure the threshold and color of each consciousness level. To do so, follow this procedure:

1.  Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select the GCS tab.

3. Set high limit, low limit for each level.
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21.5 Changing Module Settings

21.5.1 Selecting the ECG Standard
Select the ECG standard according to the leadwires you are using. To select the ECG standard, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → ECG tab.

3. Set ECG Standard to AHA or IEC.

21.5.2 Changing the QTc Formula
The monitor uses the Hodges correction formula by default to correct the QT interval for heart rate. To select the 
QTc formula, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → ECG tab.

3. Set QTc Formula.

◆ Hodges: 

◆ Bazett: 

◆ Fridericia: 

◆ Framingham: 

21.5.3 Setting the 12-Lead Order Switch
To set whether to send the order number of 12-lead interpretation report to the hospital information system 
while saving the report, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab.

3. Select the ECG tab.

4. Set 12-Lead Order.

21.5.4 Calibrating ECG
The ECG signal may be inaccurate due to hardware or software problems. As a result, the ECG waveform 
amplitude becomes greater or smaller. In that case, you need to calibrate the ECG module. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → ECG tab.

3. From the bottom left corner of the dialog select Calibrate.

21.5.5 Manually Zeroing the CO2 Module

To zero the CO2 module, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → CO2 tab.

3. From the bottom left corner of the dialog select Zero.

21.5.6 Hiding the Invalid Display after Zeroing the CO2 Module

After the zero calibration is completed, the CO2 module reacquires the CO2 readings. During the reacquisition 
period, “Zero Recovering” is displayed in the CO2 numeric area. Valid data will reappear 30 seconds after the 
zero calibration is started. 

To hide the display of the “Zero Recovering” message, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → CO2 tab.

3. Switch off Zero Recovery for 30s. 

Selecting Defaults from the bottom of the dialog can restore this setting to the factory default.

21.5.7 Setting Parameter Measurement Timeout
NIBP measurements become outline fonts after a preset time. This feature prevents older values being 
misinterpreted as current measurements. To adjust the timeout period for PAWP, C.O., and NIBP, follow this 
procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select . 

2. Select the Module tab → select the Other tab.

3. Set the timeout period for PAWP and NIBP.

21.5.8 Setting Flow Rate (For Sidestream CO2 Module Without O2)

When you are using the sidestream CO2 module without the O2 monitoring function to monitor a neonatal 
patient, you can select flow rate. To do so, follow this procedure:

1. Ensure that the sidestream module without O2 is inserted in the monitor.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Module tab → Other tab.

4. Set CO2 Flow Rate For Neo.

21.6 Hiding Undesired Review Tabs
If you do not need to review some items, you can hide them. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Review tab.

3. From the Tabs page, Event page or Arrh Mark page deselect those that do not need to be available to 
clinicians during review.

21.7 Setting the Printer

21.7.1 Setting the Printer Properties
To set a network printer, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab.

3. In the Printer tab, select Connection Type to choose whether you want to output patient reports via the 
print server or a network printer.

4. If you set Connection Type to Print Server, perform the following settings:

◆ Print Server Address: select  to input the print server name or IP address.

◆ Port: selects  to input the print server port. If the CMS is used as the print server, set Port to 6603.

◆ Set the report type in the Report Type area. For more information, see section 21.7.2 Setting the 
Report Type. 

5. If you set Connection Type to Printer, perform the following settings:

◆ Select Printer IP Address. Select  to input the IP address of the desired network printer.

◆ Select Paper Size.

◆ Select Resolution.

After finishing configurations, you can select the Print Test Page button to verify that the printer works properly.

21.7.2 Setting the Report Type
If the Connection Type is set to Print Server, you need to set the report type:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab.

3. Set Connection Type to Print Server.

4. Select the report you intend to set, for example, General Report.

5. Set the Print Action:

◆ Paper: outputs paper report.

◆ PDF: outputs the electronic report in PDF format.

◆ Paper And PDF: outputs both the paper report and the PDF report.

6. For paper report, respectively select Printer and Printer Resolution to set the default printer and the 
resolution for the default printer.

7. For PDF report, select the PDF Resolution to set the resolution.

NOTE

• General reports refer to the reports other than the end case report and realtime alarm report.

21.7.3 Setting the Report Layout

 To set the patient information you want to display on general reports, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Print tab. 

3. Select the Report Layout tab.

4. Select the desired items under Report Name. N/A indicates that this item is not displayed on a report.

21.7.4 Setting Patient Information on 12-lead ECG Reports
To set the patient information you want to display on 12-lead ECG reports, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .
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2. Select the Print tab.

3. select the ECG Report tab.

4. On the right of the ECG Report page, select the desired patient information items. Patient ID, Patient 
Name, Age, and Gender are displayed on an ECG report by default.

NOTE

• You can only set the patient information to display on the ECG report from the ECG Report page. 
Patient information configured in the Report Layout page is not applied to ECG reports.

21.7.5 Configuring the Name of PDF Files
If you use the print server to output patient reports, you can use the PDF printer to output PDF format reports. To 
configure the name of PDF files, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab → PDF File Name tab. 

3. Select the desired items and their sequence under PDF File Name. N/A refers to no information.

21.7.6 Showing the Second Mark
To set whether you want to show second marks on the report output by the printer, follow this procedure.

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab → Other tab.

3. Enable or disable Second Mark (Printer).

21.7.7 Setting Parameter Unit
To set parameter unit, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Set the Unit tab.

3. Set unit for each parameter.

21.8 Setting the Time

21.8.1 Setting the Time Synchronization
If the NTP Time Synchronization function is enabled, the monitor can automatically synchronize its time with a 
time server on which NTP (Network Time Protocol) is implemented. If there are many monitors connected within 
one network, you can enable the time synchronization to synchronize the time, and make it unnecessary to 
manually set the time for individual monitors.

21.8.1.1 Enabling NTP Time Synchronization

To enable the NTP Time Synchronization function, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Switch on Start NTP Time Sync.
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21.8.1.2 Setting the Time Server Address

To set the DNS name of the time server address, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Input the name or IP address of the time server.

After configuring the NTP time server, select Network Test to verify that the NTP server is properly connected.

21.8.1.3 Setting the Time Synchronization Interval

To set the time synchronization interval, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Set Interval.

21.8.2 Enabling Auto Daylight Savings Time
By default, daylight savings time is disabled. If this function is needed, you need to manually enable the daylight 
savings time. To auto start the daylight savings time, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Time tab → Daylight Savings Time tab..

3. Switch on Auto Daylight Savings Time.

4. Adjust daylight savings time settings as necessary.

NOTE

• If you enable Auto Daylight Savings Time you cannot manually switch it on or off from the System 
Time dialog. For more information, see 3.8.1 Setting the Date and Time.

21.9 Viewing Version Information
To view the system software version, module hardware and software version, and firmware version , follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Version tab.

You can also view the system software version by selecting the Main Menu quick key → from the System 
column select Version.

21.10 Checking Battery Information
To check the battery information, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Battery Information tab.

21.11 Changing Scanner Settings 
For the 2D barcode reader, you can change the scanner settings.
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21.11.1 Establish the Relationship between Patient Demographics and 2D Barcode 
Fields (for the Mindray Custom 2D Barcode Reader)
To configure 2D barcode reader, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → 2D Barcode tab.

3. Establish the relationship between the monitor data and hospital’s barcode data for selectable patient 
demographics. For example, the monitor has an option of Ped for patient category. In your hospital 
barcode, the text may read as Pediatric. So input Pediatric for the field Ped to establish their relationship. 

21.11.2 Setting the Barcode Reader Information 
To set the barcode reader information, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → Scanner Info. tab.

3. Set Scanner Type:

◆ 1D Scanner: select this option when using a 1D scanner or a 2D scanner other than the Mindray 
custom 2D scanner.

◆ 2D Scanner: select this option when using the Mindray custom scanner.

NOTE

• When you set Scanner Type to 2D Scanner, default settings are applied to Data Encoding Type and 
Data Parse Mode. You do not need to change these setting.

21.11.3 Identifying the Barcode Reader (for the non-Mindray Custom 2D Barcode 
Reader)
When you are using barcode readers other than the JADAK Flexpoint HS-1R or HS-1M, you should select the 
barcode reader from the USB device list, so that the monitor can identify the barcode reader. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → Identify Scanner tab.

3. From the USB device list, select the barcode reader you are using.

21.11.4 Selecting Patient Information Read by the Barcode Reader (for the Mindray 
Custom 2D Barcode Reader)
To select desired patient information that will be read by the barcode reader, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → Field tab.

3. Select the patient information. The selected information can be read by the barcode reader.

NOTE
• The patient information read by the barcode reader is dependent on the patient information 

encoded in the hospital's barcodes.
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21.12 Configuring the Network
You can connect the monitor to the central monitoring system (CMS), eGateway, and other monitors through 
wired LAN or wireless LAN.

21.12.1 Network Safety Information

CAUTION

• Wireless network designing, deploying, debugging, and maintenance should be executed by 
Mindray service personnel or authorized technicians.

• Always set the wireless network according to local wireless regulations.

• Keep network authentication information, for example passwords, safe, to protect the network from 
being accessed by unauthorized users.

• Do not connect non-medical devices to the monitor network.

• If wireless network signal is poor, there may be a risk of CMS-destined data loss.

• RF interference may result in wireless network disconnection. 

• Disconnecting from the network may result in CMS-destined data loss and function failure. Check 
the patient in case of network disconnection and solve the network problem as soon as possible.

• Ensure that the monitor IP address setting is correct. Changing the network settings may result in 
network disconnection. Contact your service personnel if there are any problems with the IP 
address.

21.12.2 Setting the Wireless Network
 To add and set the wireless network, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → WLAN tab.

3. Select Add WLAN. In the popup dialog, input network name, SSID, and password. Set Security.

4. Select the WLAN IP tab and select how to get the IP address and DNS address.

◆ Obtain IP Address Automatically: the monitor automatically gets the IP address.

◆ Use the Following Address: you need to input the IP address, Subnet Mask, and Gateway.

◆ Obtain DNS Address Automatically: the monitor automatically gets the DNS address.

◆ Use the following DNS Address: you need to input the IP address of Preferred DNS server and 
Alternate DNS server.

5. Select the WLAN Setup tab and set WLAN band and channels. The default is Auto, which means the 
monitor can automatically identify the WLAN band.

After configuring the wireless network, select Network Test to verify that the wireless network can be properly 
connected.

If you need to change network settings, select  beside the desired wireless network. Selecting  deletes 
the wireless network.

21.12.3 Managing Certifications
You can delete certifications from the monitor, or import certifications from the USB memory device. To do so, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → WLAN tab.

3. Select the Certificate Management button from the bottom left corner of the dialog.

◆ From the Local tab, select certifications you want to delete from the monitor, and then select Delete.
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◆ From the USB Drive tab, select certifications you want to import from the USB memory device, and 
then select Import.

21.12.4 Enabling Selecting a CMS
To enable selecting a CMS, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → Central Station Setup tab.

3. Switch on Select CMS.

21.12.5 Adding CMSs
You can add up to 30 central monitoring systems (CMS) for your monitor. To add CMSs, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → Central Station Setup tab.

3. Select Add Central Station, and then input the CMS name and IP address of this department.

21.12.6 Setting Multicast Parameters
Multicast helps device discovery between monitors and other devices on the network. Devices in the same 
multicast group can be mutually discovered.

To set multicast parameters, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→Device Discover tab.

3. Set Multicast TTL.

4. Set Multicast Address.

21.12.7 Setting the Master Server Address
To set the DNS name of the master server, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→ Device Discover tab.

3. Select Master Server Address to input the DNS name or IP address of the master server.

21.12.8 Setting the Network Service Quality Level
To set the quality of service (QoS), follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→QoS tab.

3. Select QoS Level For Realtime Monitoring to set the service quality of network connection for realtime 
monitoring, for example parameter measurements and waveforms, alarms, etc.

4. Select QoS Level For Others to set the service quality of network connection for non-realtime monitoring, 
for example history data, printing, etc.

21.12.9 Using the ADT Gateway
The ADT (admit-discharge-transfer) gateway is normally deployed in the eGateway. You can obtain patient 
information from the hospital ADT server through the ADT gateway.

To configure the ADT gateway, follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → ADT tab.

3. Select Server Address to input the host name or IP address of the ADT gateway.

4. Select Port to input the port of the ADT gateway.

ADT Query is switched off by default. You can load patient information to the monitor from the ADT server 
only when this function is enabled. 

After configuring the ADT gateway, select Network Test to verify that the ADT server is properly connected.

21.12.10 Sending Realtime Data, Waveforms and Alarms via HL7 Protocol
You can send the realtime data, waveforms, and alarms from the monitor to the hospital servers via HL7 
protocol. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → HL7 Configuration tab.

3. From the Data + Waveforms area, select Server Address to input the name or IP address for the server 
receiving the realtime data and waveform. Set Port.

4. Switch on Send Data and Send Waveform, as needed. Set Data Interval.

5. From the Alarms area, select Server Address to input the name or IP address for the server receiving the 
alarm data. Set Port.

6. Switch on Send Alarms as needed.

This page also displays the server connection status.

21.12.11 Selecting Data Encryption Type
To set data encryption type, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → Information Security tab.

3. Select Encryption Connection Type to set data encryption type when connecting devices:

◆ Only Private Encryption: Mindray private encryption is used to encrypt the transmitted data. You 
cannot connect devices supporting SSL (secure sockets layer) encryption.

◆ SSL Encryption Priority: for devices supporting SSL encryption, SSL encryption is used when 
connecting the devices. For devices not supporting SSL encryption, private encryption is used when 
connecting the devices.

21.12.12 Disabling the Broadcasting Patient Demographics Function
When viewing other patients, device location and patient information of remote devices are displayed in the 
remote device list by default. To protect patient privacy, you can disable the broadcasting of patient 
demographics function to prevent the monitor from sending patient information via broadcast. To do so, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select Network Setup tab → Information Security tab.

3. Switch off Broadcast Patient Demographics.

Thus, patient information will not display in the remote device list.

21.13 MLDAP
MLDAP refers to Mindray LDAP (Lightweight Directory Access Protocol). It is an independent process which can 
be installed on the eGateway or other application server (Windows). MLDAP provides user identity and 
authentication.
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The MLDAP server is connected with the hospital LDAP server. All monitoring devices are connected to the 
MLDAP server to implement identity and authentication for the following operations:

■ Changing alarm settings

■ Changing arrhythmia settings

■ Accessing the Maintenance dialog

21.13.1 Setting MLDAP
To access the MLDAP server, you should set your monitor as follows: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→ MLDAP tab.

3. Set Server address and port of the MLDAP server.

21.13.2 Testing MLDAP Server Connection
To test whether the monitor is properly connected with the MLDAP server, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→ MLDAP tab.

3. Select Network Test.

21.13.3 Selecting Password for User Authentication
You can select what password is used when changing alarm settings, arrhythmia settings, and accessing the 
Maintenance dialog. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Authorization Setup tab.

3. From the Maintenance area, set User Maintenance to select the password for accessing the monitor’s 
Maintenance dialog.

◆ Local Password: the monitor’s password for accessing the Maintenance dialog is required.

◆ User Password: the user name and password saved in the MLDAP server are required.

4. From the Others area, set Alarm Setup: select the password for changing alarm settings.

◆ No Password: changing alarm settings is not password protected.

◆ Local Password: changing alarm switch, alarm limit, and alarm priority is password protected. The 
monitor’s password for changing alarm settings is required.

◆ User Password: changing alarm switch, alarm limit, and alarm priority is password protected. The 
user name and password saved in the MLDAP server are required.

5. Set Arrhythmia: select the password for changing arrhythmia settings.

◆ No Password: changing arrhythmia settings is not password protected.

◆ Local Password: changing arrhythmia switch, alarm priority, and arrhythmia threshold is password 
protected. The monitor’s password for changing arrhythmia settings is required.

◆ User Password: changing arrhythmia switch, alarm priority, and arrhythmia threshold is password 
protected. The user name and password saved in the MLDAP server are required.

From the Maintenance area, selecting Modify Local Password can change the monitor’s password for 
accessing the Maintenance dialog.

From the Others area, selecting Modify Local Password can change the monitor’s password for accessing alarm 
settings and arrhythmia settings.
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21.13.4 Setting the Password Timeout Period
If you use the password saved in the MLDAP server to access the Maintenance dialog, alarm settings and 
arrhythmia settings, you can set the password timeout period. Once the timeout period is reached, you will need 
to re-enter the password. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Authorization Setup tab.

3. Set Retention Time.

21.14 Setting the Dock
After the N1 is transferred to the target location, connecting the N1 to a Dock enables N1 to use the settings of 
the Dock. All the settings in this section are stored in the Dock. When the N1 is disconnected from the Dock, the 
N1 uses its own settings and network. 

21.14.1 Setting the Work Mode
To set the work mode of the Dock, follow this procedure:

1. Connect the N1 to the Dock.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Dock Setup tab→ select the Setup tab.

4. Set the Work Mode. The default work mode is Dock Mode. 

◆ Dock Mode: the patient location settings (facility, department, room number, and bed number), 
printer settings, and authorization settings are from the N1. You can change these settings on Device 
Location, Print, or Authorization Setup page from the Maintenance menu.

◆ Host Mode: the patient location settings (facility, department, room number, and bed number), 
printer settings, and authorization settings are from the Dock. You can change these settings on 
Location, Printer, or Authorization Setup tab from the Dock Setup page.

21.14.2 Setting the Net Setting Type
To set the network setting type of the Dock, follow this procedure:

1. Connect the N1 to the Dock.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Dock Setup tab→ select the Setup tab.

4. Set the Net Setting Type. The default work mode is Use current N1 net setting. 

◆ Use current N1 net setting: the IP and WLAN settings are from the N1. You can change these settings 
on Network Setup page from the Maintenance menu.

◆ Use current Dock net setting: the IP and WLAN settings are from the Dock. You can change these 
settings on IP, or WLAN tab from the Dock Setup page.

21.14.3 Setting the Network of the Dock

21.14.3.1 Selecting a Network Type

To select network type, follow this procedure:

1. Connect the N1 to the Dock.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Dock Setup tab→ select the Setup tab.

4. Set the Work Mode to Host Mode.
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5. Select the IP tab.

6. Set Network Type to LAN1 IP, or WLAN according to your network type. 

21.14.3.2 Setting the Wired Network

Wired networking is available as long as N1 is connected to the Dock. To set the wired network, follow this 
procedure:

1. Connect the N1 to the Dock.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Dock Setup tab→ select the Setup tab.

4. Set the Work Mode to Host Mode.

5. Select the IP tab.

6. Set Network Type to LAN1 IP.

7. Select how to get the IP address of wired network.

◆ Obtain IP Address Automatically: the monitor automatically gets the IP address.

◆ Use the Following Address: you need to input the IP address, Subnet mask, and Gateway.

8. Select how to get the DNS address:

◆ Obtain DNS Address Automatically: the monitor automatically gets the DNS address.

◆ Use the following DNS Address: you need to input the IP address of Preferred DNS server and 
Alternate DNS server.

21.14.3.3 Setting the Wireless Network

To set the wireless network of the Dock, follow this procedure:

1. Connect the N1 to the Dock.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Dock Setup tab→ select the Setup tab.

4. Set the Work Mode to Host Mode.

5. Select the IP tab, and set Network Type to WLAN.

6. Select how to get the IP address of wireless network.

◆ Obtain IP Address Automatically: the monitor automatically gets the IP address.

◆ Use the Following Address: you need to input the IP address, Subnet Mask, and Gateway.

7. Select how to get the DNS address:

◆ Obtain DNS Address Automatically: the monitor automatically gets the DNS address.

◆ Use the following DNS Address: you need to input the IP address of Preferred DNS server and 
Alternate DNS server.

8. Select the WLAN tab and set SSID, Security, and Password. 

After configuring the wireless network, select Network Test to verify that the wireless network can be properly 
connected.

21.14.4 Setting the External Display
To set the external display, follow this procedure:

1. Connect the N1 to the Dock.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Dock Setup tab→ select the Setup tab.

4. Set the External Screen Contents.
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◆ Mirrored: the contents of the external display is exactly the same with the monitor. 

◆ Independent: separately configure the contents and layout of the monitor and external display. 

NOTE

• The N1’s screen and the independent external display’s screen cannot be viewed simultaneously. To 
switch the viewing location between the N1's screen and the independent external display, gently 
press the power switch of the N1, or double click on the screen to be viewed.

• In the situation that the External Screen Content is set to Independent and the viewing location is 
switched to the N1, if there is no operation on the monitor within one minute, the viewing location 
will automatically switch back to the external display. 

21.15 Defining Other Functions

21.15.1 Setting Notch Filter Frequency 
Set notch filter frequency according to the power line frequency of your country. To set notch filter frequency, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Set Notch Frequency to 50 Hz or 60 Hz according to the power line frequency.

21.15.2 Setting Mouse Sensitivity
The mouse sensitivity is adjustable. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Set Mouse Sensitivity.

21.15.3 Setting the SpO2 Tone Mode

The monitor adjusts the QRS tone (pitch tone) according to the SpO2 values. To set the SpO2 tone mode, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Other tab.

3. Set SpO2 Tone to Mode 1 or Mode 2. The pitch changes more rapidly in Mode 2 than in Mode 1, as 
saturation levels change.

The SpO2 tone mode chart for SpO2 between 40% to 100% is as follows:
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CAUTION

• It is highly recommended to use the same SpO2 tone mode for the same monitors in a single area to 
prevent issues arising from inconsistent operation.

21.15.4 Selecting the Language
To set the user interface (UI) language, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab

3. Set Language.

21.15.5 Switching On or Off a Parameter
 If there is no Parameters On/Off tab in the Screen Setup dialog then setting parameter switches is password 
protected. Follow this procedure to set parameter switches:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Select Parameters On/Off.

4. Enable or disable desired parameters.

When a parameter is switched off, the monitor stops data acquisition and alarming for this measurement. 

NOTE

• When a parameter is manually switched off and the corresponding parameter module is plugged in, 
you cannot monitor this parameter.

21.15.6 Setting If Setting Parameter Switches is Protected
You can set whether setting parameter switches is password protected. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Switch on or off Parameters On/Off Protected.
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21.15.7 Setting If Parameter Switch is Influenced by Configuration
You can set if the settings of parameter switches are influenced by loading a configuration. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Switch on or off Parameters On/Off Config Influenced.

21.15.8 Setting the Outdoor Mode
To set the way of entering the outdoor mode, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Set Enter Outdoor Mode to Manual or Auto.

◆ Manual: The monitor enters the outdoor mode by manually selecting the Main Menu quick key → 
from the Display column select Enter Outdoor Mode.

◆ Auto: The monitor enters the outdoor mode automatically if the strength of ambient light is greater 
than the threshold.
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22 Battery

22.1 Battery Introduction
This monitor is designed to run on rechargeable Lithium-ion battery power when the external power is not 
available. The monitor can switch between battery power and the external power without interrupting patient 
monitoring. If both the external power and the battery power are available, the monitor uses the external power 
in preference to the battery power. 

This monitor is designed to operate on battery power when the mains power is not available. The monitor uses 
mains power as primary power source. In case of mains power failure, the monitor automatically runs on the 
battery power. 

22.2 Battery Safety Information
   

WARNING

• Keep batteries out of the reach of children. 

• Use only Mindray specified batteries. Use of a different battery may present a risk of fire or 
explosion.

• Keep the batteries in their original package until you are ready to use them. 

• Do not expose batteries to liquid.

• Do not crush, drop or puncture the battery. Mechanical abuse can lead to internal damage and 
internal short circuits. If a battery has been dropped or banged against a hard surface, whether 
damage is externally visible or not, remove the battery from use and dispose of it properly.

• If the battery shows signs of damage or signs of leakage, replace it immediately. Use caution in 
removing the battery. Avoid contacting the leakage. 

• Batteries should be charged only in this monitor.

• Extremely high ambient temperature may cause battery overheat protection, resulting in monitor 
shutdown.

• The lithium-ion battery has a service life. Replace the battery when it reaches the end of its service 
life. Failure to replace the battery may cause serious damage to the equipment from battery 
overheating.

• Do not open batteries, heat batteries above 60 °C, incinerate batteries, or short battery terminals. 
They may ignite, explode, leak or heat up, causing personal injury.

CAUTION

• Remove the battery if it will not be used for an extended period of time.

22.3  Installing the Battery
The battery must only be installed by service personnel trained and authorized by Mindray. To install the battery, 
contact your service personnel. The battery is installed when the monitor leaves the factory. 

22.4 Battery Indications
The battery LED, on-screen battery symbol, battery power indicator, and related alarm messages indicate the 
battery status.
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22.4.1 Battery LED
The battery LED lies on the lower right corner of the monitor front panel.

The battery LED indications are as follows:

■ Green: the battery is fully charged.

■ Yellow: the battery is being charged.

■ Flashing green: the monitor is running on battery power.

■ Flashing yellow: the battery is malfunctioning.

■ Off: no battery is installed, or the monitor is powered off and no external power is connected.

22.4.2 Battery symbols
The on-screen battery symbols indicate the battery status as follows:

■  indicates that the battery is working correctly. The green portion represents the remaining 
charge.

■  indicates that the battery power is low and needs to be charged.

■  indicates that the battery is almost depleted and needs to be charged immediately. Otherwise, 
the monitor will automatically shut down soon.

■  indicates that the battery is being charged.

■  indicates that no battery is installed.

■  indicates a battery fault, battery communication fault, or battery charging fault. Contact service 
personnel for help.

22.4.3 Battery Power Indicator
Battery power indicator displays the remaining battery power.

22.4.4 Battery-related Alarms
The capacity of the battery is limited. When the battery level is low, the monitor presents the Low Battery alarm, 
the alarm lamp flashes, and the monitor produces an alarm sound. 

If the battery is almost depleted, the monitor presents the Critically Low Battery alarm. In this case, 
immediately connect the external power to  the monitor and charge the battery. Otherwise, the monitor will 
automatically shut down soon. 

BeneVision N1
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If the battery has been used for a prolonged period of time, the battery will be aged and its runtime may be 
significantly less than the specification. If the battery is aged, the Battery Service Required alarm is presented 
each time the monitor is turned on, indicating that the battery has reached its end of life. 

For more information on battery-related alarms, see Appendix D Alarm Messages.   

22.5 Charging the Battery
To optimize performance, a fully (or nearly fully) discharged battery should be charged as soon as possible. The 
battery can be charged in any of the following methods:

■ Method 1: the monitor is connected to the AC adapter or Dock.

■ Method 2: the monitor is in use with a host monitor.

■ Method 3: the monitor is in use with the Transport Dock.

For method 1 and method 3, the battery is charged regardless of whether or not the monitor is currently turned 
on. For method 2, the host monitor must be powered on for the N1 monitor's battery to charge.

22.6 Maintaining the Battery

22.6.1 Conditioning the Battery
The performance of the battery deteriorates over time. You should condition the battery every three months. If 
the battery is not conditioned for a prolonged time, its charge indication may not be accurate and you may 
wrongly evaluate the remaining battery runtime. 

To condition a battery, follow this procedure:

1. Disconnect the monitor from the patient and stop all monitoring and measuring procedures.

2. Turn off the monitor, and connect the monitor to the external power source.

3. Allow the battery to be charged uninterruptedly until it is fully charged.

4. Disconnect the monitor from the external power source, and turn on the monitor.

5. Allow the monitor to run on the battery until the battery is completely depleted and the monitor automat-
ically shuts down.

6. Fully charge the battery again for use or charge it to 40 - 60% for storage.

NOTE
• Do not use the monitor to monitor a patient during battery conditioning.

• Do not interrupt battery conditioning. Interrupting battery conditioning to use the monitor will 
prevent completion of the conditioning cycle and require repeating the conditioning process 
completely to properly condition the battery.

22.6.2 Checking Battery Performance
Life expectancy of a battery depends on how frequent and how long it is used. When properly used, the lithium-
ion battery has a useful life of approximately two years. If improperly used, its life expectancy can be shorter. We 
recommend replacing the lithium-ion battery every two years. 

The performance of a rechargeable battery deteriorates over time. You should check the battery performance 
every two months or if you question it is meeting the product specifications. 

See steps 1 to 5 of 22.6.1 Conditioning the Battery to check battery performance. The operating time of the 
batteries reflects their performance directly. If the operating time of a battery is noticeably shorter than that 
stated in the specifications, the battery may have reached its service life or be malfunctioning. If the battery 
performance meets the requirement, fully charge the battery again for use or charge it to 40 - 60% for storage.

NOTE

• Battery operating time depends on equipment configuration and operation. For example, high 
display brightness or measuring NIBP repeatedly will shorten the battery operating time.
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22.7 Storing Batteries
When storing batteries, make sure that the battery terminals do not come into contact with metallic objects. If 
batteries are stored for an extended period of time, place the batteries in a cool place with a partial charge of 
40% to 60% capacity. 

Condition the stored batteries every three months. For more information, see 22.6.1 Conditioning the Battery. 

NOTE

• Remove the battery from the equipment if the equipment is not used for a prolonged time (for 
example, several weeks). Otherwise the battery may overdischarge.

• Storing batteries at high temperature for an extended period of time will significantly shorten their 
life expectancy.

• Storing batteries in a cool place can slow the aging process. Ideally the batteries should be stored at 
15 °C. 

22.8 Recycling Batteries
Discard a battery in the following situations: 

■ The battery has visual signs of damage.

■  The battery fails.

■  The battery is aged and its runtime significantly less than the specification.

■  The battery has been used for more than it service time.

Properly dispose of batteries according to local regulations. 

WARNING

• Do not open batteries, heat batteries above 60 °C, incinerate batteries, or short the battery 
terminals. They may ignite, explode, leak or heat up, causing personal injury.
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23 Care and Cleaning

23.1 Care and Cleaning Introduction
In this chapter we only describe cleaning and disinfection of the main unit, parameter modules, mounting kits, 
and certain parameter accessories. For the cleaning and disinfection of the Transport Dock and other reusable 
accessories, refer to their instructions for use of the corresponding accessories.

Keep your equipment and accessories clean. To avoid damage to the equipment, follow these guidelines:

■ Always follow the manufacturer’s instructions for each cleaning / disinfecting agent.

■ Do not immerse any part of the equipment or accessories into liquid.

■ Do not pour liquid onto the equipment or accessories.

■ Do not allow liquid to enter the case.

■ Never use abrasive materials (such as steel wool or silver polish), or erosive cleaners (such as acetone or 
acetone-based cleaners).

23.2 Care and Cleaning Safety Information

WARNING

• Be sure to turn off the system and disconnect all power cables from the outlets before cleaning the 
equipment.

CAUTION

• If you spill liquid on the equipment or accessories, contact Mindray or your service personnel.

• Avoid wetting the pins and metal parts of the equipment, mounting kits or accessories during 
cleaning and disinfection.

• Use only Mindray approved cleaners and disinfectants and methods listed in this chapter to clean or 
disinfect your equipment. Warranty does not cover damage caused by unapproved substances or 
methods.

• We make no claims regarding the efficacy of the listed chemicals or methods as a means for 
controlling infection. For the method to control infection, consult your hospital’s Infection Control 
Officer or Epidemiologist.

• The responsible hospital or institution shall carry out all cleaning and disinfection procedures 
specified in this chapter.

• Refer to the respective instructions for use of the cleaning agents and disinfectants.

• Do not mix disinfecting solutions (such as bleach and ammonia) as hazardous gases may result.

NOTE

• To clean or disinfect reusable accessories, refer to the instructions delivered with the accessories.
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23.3 Cleaning and Disinfecting the Equipment and Mounting Kits
Use approved cleaning and disinfecting agents for cleaning or disinfecting the main unit, parameter modules, 
Modular Rack, Dock, folding hook, monitor handle, and bedrail hook.

23.3.1  Approved Cleaning and Disinfecting Agents
The following table lists approved cleaning and disinfecting agents:
:

Product Name Product Type Active Ingredients

Sodium hypochlorite bleach Liquid Sodium hypochlorite bleach 0.5%

Hydrogen peroxide Hydrogen peroxide 3%

Isopropanol Isopropanol 70%

1-Propanol 1-Propanol 50%

Metrex CaviCide1™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

 Virex® II 256 (1:256) Didecyl dimethyl ammonium chloride 8.704%, 
n-Alkydimethyl benzyl ammonium chloride 8.190%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® High Level 
Surface Disinfectant

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),

Contains dipotassium peroxodisulphate.

Alpet® D2 Surface Sanitizing 
Wipes

Wipes Isopropyl Alcohol 58.6000%,
Octyl Decyl Dimethyl Ammonium chloride 0.0075%,
Dioctyl Dimethyl Ammonium Chloride 0.0030%

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Sodium Hypochlorite 0.65%

Clorox Healthcare® Bleach 
Germicidal Wipes

Sodium Hypochlorite 0.55%

Clorox Healthcare® Hydrogen 
Peroxide Cleaner Disinfectant 
Wipes

Hydrogen Peroxide 1.4%

Diversey Oxivir® TB Wipes Hydrogen Peroxide 0.5%

Metrex CaviWipes™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

PDI Sani-Cloth® AF3 Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.14%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.14%

PDI Sani-Cloth® Bleach 
Germicidal Disposable Wipe

Sodium Hypochlorite 0.63%,other ingredients 99.37%

PDI Sani-Cloth® HB Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.07%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.07%

PDI Sani-Cloth® Plus Germicidal 
Disposable Cloth

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.125%,
n-Alky dimethyl benzyl ammonium chlorides 0.125%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%
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NOTE

• For equipment with the symbol , all the listed cleaning and disinfecting agents are available for 
use. 

23.3.2 Cleaning the Equipment and Mounting Kits
The main unit, parameter modules, Modular Rack, Dock, folding hooks, monitor handle, and bedrail hooks 
should be cleaned on a regular basis. Before cleaning the equipment and mounting kits, consult your hospital’s 
regulations for cleaning the equipment. 

To clean your equipment, follow this procedure:

1. Shut down the monitor and disconnect it from the AC power.

2. Clean the display screen with wipes or a soft cloth moistened with one of the cleaning agents listed in 
23.3.1 Approved Cleaning and Disinfecting Agents only.

3. Clean the exterior surface of the equipment and mounting kits with wipes or a soft cloth moistened with 
one of the cleaning agents listed in 23.3.1 Approved Cleaning and Disinfecting Agents only.

4. Wipe off all the cleaning agent residue with a dry cloth.

5. Dry your equipment in a ventilated, cool place.

23.3.3 Disinfecting the Equipment and Mounting Kits
Disinfect the main unit, parameter modules, Modular Rack, Dock, folding hook, monitor handle, and bedrail 
hook as required in your hospital’s servicing schedule using the disinfecting agents listed in the table above. 
Cleaning equipment and mounting kits before disinfecting is recommended.

CAUTION

• Never use EtO or formaldehyde for disinfection.

23.4 Cleaning and Disinfecting the Accessories
For the NIBP air hose and SpO2 cable, you should clean and disinfect them using the cleaners and disinfectants 
and methods listed in this section. For other accessories, you should consult the instructions delivered with the 
accessories.

CAUTION

• Fluids entering the NIBP air hose can damage the equipment. When cleaning and/or disinfecting the 
NIBP air hose, prevent liquid from entering the hose.

• Periodically inspect the NIBP air hose and connector for signs of wear or deterioration. Replace the 
NIBP air hose if you detect a leak. Dispose of damaged NIBP air hose according to local laws for 
disposal of hospital waste.

• Never immerse or soak the accessories in any liquid.

• Never clean or disinfect the metalic connectors at either end of the accessories.

• Use only Mindray approved cleaners and disinfectants and methods listed in this section to clean or 
disinfect the accessories. Warranty does not cover damage caused by unapproved substances or 
methods.

• To avoid long term damage, the accessories should be disinfected only when necessary as 
determined by your hospital’s policy.

VIRAGUARD Hospital Surface 
Disinfectant Towelettle

Wipes Isopropanol 70%,
Other ingredients 30%

Product Name Product Type Active Ingredients
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23.4.1 Approved Accessories Cleaning and Disinfecting Agents
The following table lists approved NIBP air hose cleaning and disinfecting agents:
:

The following table lists approved Masimo SpO2 cable cleaning and disinfecting agents:
:

Product Name Product Type Active Ingredients

Isopropanol Liquid Isopropanol 70%

1-Propanol 1-Propanol 50%

Metrex CaviCide1™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® High Level 
Surface Disinfectant 

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),
Contains dipotassium peroxodisulphate.

Alpet® D2 Surface Sanitizing 
Wipes

Wipes Isopropyl Alcohol 58.6000%,
Octyl Decyl Dimethyl Ammonium chloride 0.0075%,
Dioctyl Dimethyl Ammonium Chloride 0.0030%

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Sodium Hypochlorite 0.65%

Metrex CaviWipes™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

PDI Sani-Cloth® AF3 Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.14%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.14%

PDI Sani-Cloth® Plus Germicidal 
Disposable Cloth

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.125%,
n-Alky dimethyl benzyl ammonium chlorides 0.125%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%

VIRAGUARD Hospital Surface 
Disinfectant Towelettle

Isopropanol 70%,
Other ingredients 30%

Product Name Product Type Active Ingredients

Isopropanol Liquid Isopropanol 70%
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The following table lists approved Nellcor SpO2 cable cleaning and disinfecting agents:
:

23.4.2 Cleaning the Accessories
You should clean the accessories (NIBP air hose and SpO2 cable) on a regular basis. Before cleaning the 
accessories, consult your hospital’s regulations for cleaning the accessories.

To clean the accessories, follow this procedure:

1. Clean the accessories with wipes or a soft cloth moistened with one of the cleaning agents listed in 
23.4.1 Approved Accessories Cleaning and Disinfecting Agents only.

2. Wipe off all the cleaning agent residue with a dry cloth.

3. Allow the accessories to air dry.

23.4.3 Disinfecting the Accessories
We recommend that the accessories (NIBP air hose and SpO2 cables) should be disinfected only when necessary 
as determined by your hospital’s policy, to avoid long term damage to the accessories. Cleaning the accessories 
before disinfecting is recommended.

23.5 Sterilization
Sterilization is not recommended for this equipment, related products, accessories, or supplies unless otherwise 
indicated in the Instructions for Use that accompany the products, accessories or supplies.

Product Name Product Type Active Ingredients

Sodium hypochlorite bleach Liquid Sodium hypochlorite bleach 0.5%

Isopropanol Isopropanol 70%

1-Propanol 1-Propanol 50%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® High Level 
Surface Disinfectant 

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),
Contains dipotassium peroxodisulphate.

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Wipes Sodium Hypochlorite 0.65%

Clorox Healthcare® Bleach 
Germicidal Wipes

Sodium Hypochlorite 0.55%

Clorox Healthcare® Hydrogen 
Peroxide Cleaner Disinfectant 
Wipes

Hydrogen Peroxide 1.4%

Diversey Oxivir® TB Wipes Hydrogen Peroxide 0.5%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%

VIRAGUARD Hospital Surface 
Disinfectant Towelettle

Isopropanol 70%,
Other ingredients 30%
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24 Maintenance

24.1 Maintenance Introduction
Regular maintenance is essential to ensure that the equipment continues to function properly. This chapter 
contains information on periodic testing and maintenance. 

24.2 Maintenance Safety Information

WARNING

• To avoid electric shock, stop using the equipment if you find the housing is damaged, and contact 
the service personnel.

• Failure on the part of the responsible individual hospital or institution using this equipment to 
implement a recommended maintenance schedule may cause undue equipment failure and 
possible health hazards.

• No modification of this equipment is allowed.

• This equipment contains no user serviceable parts. 

• The safety checks or maintenance involving any disassembly of the equipment should be performed 
by professional service personnel. Otherwise, undue equipment failure and possible health hazards 
could result. 

• Do not open batteries, heat batteries to above 60 °C, incinerate batteries, or short the battery 
terminals. Batteries may ignite, explode, leak or heat up, causing personal injury.

• The service personnel must be properly qualified and thoroughly familiar with the operation of the 
equipment.

CAUTION

• The equipment and accessories shall not be serviced or maintained while in use on a patient. 

• If you discover a problem with any of the equipment, contact your service personnel or Mindray.

• Use and store the equipment within the specified temperature, humidity, and altitude ranges.

• When disposing of the packaging material, be sure to observe the applicable waste control 
regulations and keep it out of the reach of children.

• At the end of its service life, the equipment, as well as its accessories, must be disposed of in 
compliance with the guidelines regulating the disposal of such products. If you have any questions 
concerning disposal of the equipment, please contact Mindray.
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24.3 Maintenance and Testing Schedule
Follow the maintenance and testing schedule or local regulations to perform testing and maintenance such as 
defined in section 24.5 Testing Methods and Procedures. Follow your hospital policy on cleaning and disinfecting 
the equipment before testing and maintenance.

The following table lists the maintenance and testing schedule:

24.4 Checking System Software Version 
To view system software version information, select the Main Menu quick key → from the System column select 
Version.

You can check the detailed system software version, module hardware and software version, and firmware 
version only from the Maintenance dialog.

24.5 Testing Methods and Procedures
Except for the following maintenance tasks, all other test and maintenance tasks should be performed by 
Mindray-qualified service personnel only. 

■ Regular checks, including visual inspection and power-on test

■ Printer tests

■ Battery check

If your monitor needs a safety test and performance test, contact the service personnel.

24.5.1 Performing Visual Inspection
Visually inspect the equipment before its first use every day. If you find any signs of damage, remove the monitor 
from use and contact the service personnel.

Test/Maintenance Item Recommended Frequency 

Performance Tests 

Visual inspection Every day, before first use.

Measurement module performance test and 
calibration

1. If you suspect that the measurement values are incorrect. 
2. Follow any repairs or replacement of relevant module.
3. Once a year for CO2 tests. 
4. Once every two years for other parameter module performance 
tests. 

Analog output test If you suspect that the analog output function does not work 
properly.

Defibrillation synchronization test If you suspect that the defibrillation synchronization function does 
not work properly.

Electrical Safety Tests

Electrical safety tests Once every two years. 

Other Tests

Power-on test Before use

Network printer tests 1. When first installed.
2.Follow any repair or replacement of the printer. 

Battery check Functionality test 1. When first installed. 
2. When battery is replaced. 

Performance test Every three months or if the battery runtime is reduced significantly. 
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Verify that the equipment meets the following requirements:

■ Environment and power supply specifications are met.

■ The monitor housing and display screen are free from cracks or other damage.

■ The power cord is not damaged and the insulation is in good condition.

■ Connectors, plugs, and cables are not damaged or kinked. 

■ Power cord and patient cables are securely connected to the equipment and modules.

24.5.2 Performing Power-on Test
The monitor automatically performs a power-on test at startup. Verify the following items for the power-on test:

■ The equipment powers on properly.

■ The alarm system works properly, denoted by alarm sounds and display of all 3 alarm light colors.

■ The monitor displays properly.

24.5.3  Testing the Network Printer
To check the printer, follow this procedure:

1. Start a printing task to print waveforms and reports.

2. Check that the printer is properly connected and functions correctly. 

3. Check that the printout is clear with no missing information.

24.5.4 Checking the Battery
For information on battery check, see 22.6.2 Checking Battery Performance. 

24.6 NIBP Maintenance

24.6.1 NIBP Leakage Test
The NIBP leakage test checks the integrity of the system and of the valve. The NIBP leakage test should be 
performed once every two years or when you doubt the NIBP measurements. The NIBP leakage test should be 
performed by Mindray-qualified service personnel only. 

24.6.2 NIBP Accuracy Test
The NIBP accuracy test should be performed once every two years or when you doubt the NIBP measurements. 
The NIBP accuracy test should be performed by Mindray-qualified service personnel only. 

24.7 Disposing of the Monitor
Dispose of the monitor and its accessories when its service life is reached. Follow local regulations regarding the 
disposal of such product.

WARNING

• For disposal of parts and accessories, where not otherwise specified, follow local regulations 
regarding disposal of hospital waste.
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25 Accessories

The accessories listed in this chapter comply with the requirements of IEC 60601-1-2 when in use with the 
patient monitor. The accessory material that contacts the patients has undertaken the bio-compatibility test and 
is verified to be in compliance with ISO 10993-1. For details about the accessories, refer to the instructions for use 
provided with the accessory.

WARNING

• Use accessories specified in this chapter. Using other accessories may cause damage to the patient 
monitor or not meet the claimed specifications.

• Single-use accessories are not designed to be reused. Reuse may cause a risk of contamination and 
affect the measurement accuracy.

CAUTION
 

• The accessories may not meet the performance specifications if stored or used outside the specified 
temperature and humidity ranges. If accessory performance is degraded due to aging or 
environmental conditions, contact your service personnel.

• Check the accessories and their packages for any sign of damage. Do not use them if any damage is 
detected.

• Use the accessories before the expiration date if an expiration date is indicated.

• Discard disposable accessories according to hospital regulations.

NOTE

• This manual describes all the accessories that are validated for use. Not all accessories are available 
in every market. 

25.1 ECG Accessories

25.1.1  ECG Electrodes Available for Purchase

Model Part No. Description Usage Applicable patient

31499224 0010-10-12304 Electrode, Kendall, pkg of 10 Disposable Adult

2245-50 9000-10-07469 ECG electrode, 3M, pkg of 50 Disposable Pediatric

1050NPSMKittycat 0681-00-0098-01 NEO pre-wired electrode radio 
Opaque, pkg of 100

Disposable Neonate

1051NPSMKittycat 0681-00-0098-02 NEO pre-wired electrode radio 
Translucent, pkg of 100

Disposable Neonate

H124SG 900E-10-04880 ECG electrode, Kendall, 10 pcs/
package

Disposable Neonate
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25.1.2 12-Pin Trunk Cables Available for Purchase

25.1.3 12-Pin Trunk Cables Also Compatible

25.1.4 3-lead ECG Leadwires Available for Purchase
 

Model Part No. Description Usage Applicable patient

EV6206 009-005266-00 ECG cable, 10' (3.1 m), 
defibrillation-proof, for N/T

Reusable Adult/Pediatric

EV6207 009-005267-00 ECG cable, 20' (6.2 m), 
defibrillation-proof, for N/T

Reusable Adult/Pediatric

EV6216 009-005268-00 ECG cable, 10' (3.1 m), ESU-proof, 
for N/T

Reusable Adult/Pediatric

EV6217 009-005269-00 ECG cable, 20' (6.2 m), ESU-Proof, 
for N/T

Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EV6201 0010-30-42719 12Pin 3/5-Lead ECG trunk cable, 
defibrillation-proof

Reusable Adult/Pediatric

EV6202 0010-30-42720 12Pin 3-Lead ECG trunk cable, 
defibrillation-proof

Reusable Pediatric/Neonate

EV6203 0010-30-42721 12Pin 12-Lead trunk cable, 
defibrillation-proof

Reusable Adult/Pediatric

EV6211 0010-30-42723 12Pin 3/5-Lead ECG trunk cable, 
ESU-proof

Reusable Adult/Pediatric

EV6212 0010-30-42724 12Pin 3-Lead ECG trunk cable, ESU-
proof

Reusable Pediatric/Neonate

EV6222 040-000754-00 12Pin 3-Lead trunk cable, 
defibrillation-proof, DIN Conn

Reusable Pediatric/Neonate

Model Part No. Description Usage Applicable patient

EY6316B 009-004765-00 3-Lead, N/T, AHA, snap, 24’’ Reusable Adult/Pediatric

EY6305B 009-004766-00 3-Lead, N/T, AHA, snap, 36’’ Reusable Adult/Pediatric

EY6316A 009-004771-00 3-Lead, N/T, AHA, clip, 24’’ Reusable Adult/Pediatric

EY6305A 009-004772-00 3-Lead, N/T, AHA, clip, 36’’ Reusable Adult/Pediatric

EY6310B 009-004777-00 3-Lead,  N/T,  AHA, snap, 24’’ Disposable Adult/Pediatric
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25.1.5 3-lead ECG Leadwires Also Compatible

25.1.6 5-lead ECG Leadwires Available for Purchase

25.1.7 5-lead ECG Leadwires Also Compatible

25.1.8 6-lead ECG Leadwires Available for Purchase

25.1.9 12-lead ECG Chest Leadwires Available for Purchase

25.1.10 12-lead ECG Leadwires Also Compatible

Model Part No. Description Usage Applicable patient

EL6305A 0010-30-42896 3-Lead leadset, AHA, clip Reusable Neonate

EL6303A 0010-30-42731 3-Lead leadset, AHA, clip, Long Reusable Adult/Pediatric

EL6301B 0010-30-42734 3-Lead leadset, AHA, snap Reusable Adult/Pediatric

EL6311B 040-000146-00 3-Lead leadset, AHA, snap Disposable Pediatric/Neonate

EL6311A 040-000148-00 3-Lead leadset, AHA, clip Disposable Pediatric/Neonate

Model Part No. Description Usage Applicable patient

EY6511B 009-004782-00 5-Lead, N/T, AHA, snap, 24’’ Reusable Adult/Pediatric

EY6512B 009-004783-00 5-Lead, N/T, AHA, snap, 36’’ Reusable Adult/Pediatric

EY6511A 009-004786-00 5-Lead, N/T, AHA, pinch, 24’’ Reusable Adult/Pediatric

EY6512A 009-004787-00 5-Lead, N/T, AHA, pinch, 36’’ Reusable Adult/Pediatric

EY6507B 009-004790-00 5-Lead,  N/T,  AHA, snap, 24’’ Disposable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EL6503A 0010-30-42729 5-Lead leadset, AHA, clip, Long Reusable Adult/Pediatric

EL6501B 0010-30-42735 5-Lead leadset, AHA, snap Reusable Adult/Pediatric

EL6501A 0010-30-42727 5-Lead leadset, AHA, clip Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EY6601B 009-004794-00 6-Lead, N/T, AHA, snap, 24’’ Reusable Adult/Pediatric

EY6602B 009-004795-00 6-Lead, N/T, AHA, snap, 36’’ Reusable Adult/Pediatric

EY6601A 009-004798-00 6-Lead, N/T, AHA, pinch, 24’’ Reusable Adult/Pediatric

EY6602A 009-004799-00 6-Lead, N/T, AHA, pinch, 36’’ Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EL6803A 0010-30-42904 12-Lead leadset, chest, AHA, clip Reusable Adult/Pediatric

EL6803B 0010-30-42908 12-Lead leadset, chest, AHA, snap Reusable Adult/Pediatric
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25.2 SpO2 Accessories

Wavelength emitted by the sensors is between 600 nm and 1000 nm. The maximum photic output consumption 
of the sensor is less than 18 mW.

The information about the wavelength range and maximum photic output consumption can be especially 
useful to clinicians, for example, when photodynamic therapy is performed.

25.2.1 Extension Cables and Adapter Cables Available for Purchase

25.2.2 Extension Cables and Adapter Cables Also Compatible

25.2.3  Masimo SpO2 RD Set Sensors Available for Purchase

Model Part No. Description Usage Applicable patient

EL6801A 0010-30-42902 12-Lead leadset, limb, AHA, clip Reusable Adult/Pediatric

EL6801B 0010-30-42906 12-Lead leadset, limb, AHA, snap Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

572A 0010-20-42712 8-pin SpO2 extension cable, Nellcor Reusable /

4089 040-003381-00 RD to LNC Adapter Cable /

4092 040-003426-00 LNCS to RD Adapter /

583A 040-003310-00 8pin masimo Cable (RD SET) /

Model Part No. Description Usage Applicable patient

582A 115-020768-00 8-pin SpO2 extension cable, Masimo Reusable /

Model Part No. Description Usage Applicable patient

4050 040-003376-00 SpO2 sensor, RD SET DCI Reusable Adult (> 30 kg)

4051 040-003377-00 SpO2 sensor, RD SET DCI Reusable Pediatric (10-50 kg)

4053 040-003380-00 SpO2 sensor, RD Set TC-I, tip-clip ear 
sensor, 3ft

Reusable Adult (> 30 kg)

4000 040-003382-00 SpO2 sensor, RD SET Adt, adhesive, 
pkg of 20

Disposable Adult (> 30 kg)

4001 040-003383-00 SpO2 sensor, RD SET PDT, adhesive, 
pkg of 20

Disposable Pediatric (10 to 50 
kg)

4002 040-003384-00 SpO2 sensor, RD Set Inf, adhesive, 
pkg of 20

Disposable Infant (3 to 20 kg)

4003 040-003385-00 SpO2 sensor, RD Set Neo, adhesive, 
pkg of 20

Disposable Neonatal /Adult 
(<3Kg or >40Kg)

4004 040-003386-00 SpO2 sensor, RD Set NeoPt, adhesive, 
pkg of 20

Disposable Neonate (<1 kg)

4005 040-003387-00 SpO2 sensor, RD Set NeoPt-500, non-
adhesive, pkg of 20

Disposable Neonate (<1 kg)
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25.2.4 Masimo SpO2 LNCS Sensors Also Compatible
 

25.2.5 Nellcor SpO2 Sensors Also Compatible

25.3  Temp Accessories

25.3.1 Temp Cable Available for Purchase

Model Part No. Description Usage Applicable patient

LNCS DCI 0010-10-42600 SpO2 sensor, finger-clip Reusable Adult (>30 kg) 

LNCS DCIP 0010-10-42634 SpO2 sensor, finger-clip Reusable Pediatric (10-50 kg) 

LNCS YI 0010-10-43016 SpO2 sensor, multisite Reusable Adult/Pediatric/
Neonate

LNCS NeoPt-L 0010-10-42626 SpO2 sensor Disposable Neonate (<1 kg)

LNCS Neo-L 0010-10-42627 SpO2 sensor Disposable Neonate /Adult 
(<3 kg or>40 kg)

LNCS Inf-L 0010-10-42628 SpO2 sensor Disposable Infant (3-20 kg)

LNCS Pdtx 0010-10-42629 SpO2 sensor Disposable Pediatric (10-50 kg) 

LNCS Adtx 0010-10-42630 SpO2 sensor Disposable Adult (>30 kg)

LNCS Adtx 0600-00-0121 SpO2 sensor, finger-clip, 20 pcs/box Disposable Adult (>30 kg)

LNCS Pdtx 0600-00-0122 SpO2 sensor, finger-clip, 20 pcs/box Disposable Pediatric (10-50 kg)

LNCS DCI 0600-00-0126 SpO2 sensor, finger-clip Reusable Adult (>30 kg)

LNCS DCIP 0600-00-0127 SpO2 sensor, finger-clip Reusable Pediatric (10-50 kg)

LNCS NeoPt 0600-00-0156 SpO2 sensor, finger-clip Disposable Neonate (<1Kg)

LNCS Neo-L 0600-00-0157 SpO2 sensor, 20 pcs/box Disposable Neonate /Adult 
(<3 kg or > 40 kg)

LNCS Inf 0600-00-0158 SpO2 sensor, 20 pcs/box Disposable Infant (3-20 kg)

Model Part No. Description Usage Applicable patient

DS-100A 9000-10-05161 SpO2 sensor, finger-clip Reusable Adult

D-YS 0010-10-12476  SpO2 sensor, with wraps Reusable /

OXI-P/I 9000-10-07308 SpO2 sensor, finger, band Reusable Pediatric/Infant

OXI-A/N 9000-10-07336 SpO2 sensor, finger/foot, band Reusable Adult/Neonate 

MAX-AI 0010-10-12202 SpO2 sensor, 24 pcs/box Disposable Adult (>30 kg)

MAX-PI 0010-10-12203 SpO2 sensor, 24 pcs/box Disposable Pediatric (10-50 Kg)

MAX-II 0010-10-12204 SpO2 sensor, 24 pcs/box Disposable Infant (3-20 kg)

MAX-NI 0010-10-12205 SpO2 sensor, 24 pcs/box Disposable Adult/Neonate
(<3 kg or >40 kg)

Model Part No. Description Usage Applicable patient

MR420B 040-001235-00 2-pin Temperature adapter cable Reusable /
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25.3.2 Temp Probes Available for Purchase

25.4 NIBP Accessories

25.4.1 NIBP Hoses Available for Purchase
  

25.4.2 Cuffs Available for Purchase

Model Part No. Description Usage Applicable patient

MR401B 0011-30-37392 Temperature probe, endocavity Reusable Adult

MR402B 0011-30-37394 Temperature probe, endocavity Reusable Pediatric/Infant

MR403B 0011-30-37393 Temperature probe, skin surface Reusable Adult

MR404B 0011-30-37395 Temperature probe, skin surface Reusable Pediatric/Infant

MR411 040-003292-00 Temperature probe, esophageal/
rectal, 9FR

Disposable Adult/Pediatric

MR412 040-003293-00 Temp probe, skin surface Disposable All

ES400-12 0206-03-0112-02 PROBE,D TEMP,ES400-12 (box of 20) Disposable Adult

ES400-18 0206-03-0118-02 PROBE,D TEMP,ES400-18 (box of 20) Disposable Adult

ER400-9 0206-03-0209-02 PROBE,D TEMP,ER 400-9 (box of 20) Disposable Adult

ER400-12 0206-03-0212-02 PROBE,D TEMP,ER400-12 (box of 20) Disposable Adult

STS-400 0206-03-0300-02 PROBE,D TEMP,STS-400 (box of 20) Disposable Adult

Model Part No. Description Usage Applicable patient

CM1903 6200-30-09688 NIBP hose, inbuilt connector, 3m Reusable Adult/Pediatric

CM1901 6200-30-11560 NIBP hose, inbuilt connector, 3m Reusable Neonate

Model Part No. Description Usage Applicable patient

CM1200 115-002480-00 Cuff, 7-13 cm Reusable Small Infant

CM1201 0010-30-12157 Cuff, 10-19 cm Reusable Infant

CM1202 0010-30-12158 Cuff, 18-26 cm Reusable Pediatric

CM1203 0010-30-12159 Cuff, 25-35 cm Reusable Adult

CM1204 0010-30-12160 Cuff, 33-47 cm Reusable Adult

CM1205 0010-30-12161 Cuff, 46-66 cm Reusable Adult thigh

CM1301 115-027713-00 Cuff, 10-19 cm, bladderless Reusable Infant

CM1302 115-027714-00 Cuff, 18-26 cm, bladderless Reusable Small Adult

CM1303 115-027715-00 Cuff, 25-35 cm, bladderless Reusable Adult

CM1304 115-027716-00 Cuff, 33-47 cm, bladderless Reusable Adult

CM1305 115-027717-00 Cuff, 46-66 cm, bladderless Reusable Adult thigh

CM1306 115-027718-00 Cuff, 24-35 cm, bladderless Reusable Adult

CM1307 115-027719-00 Cuff, 33-47 cm, bladderless Reusable Adult

CM1501 115-027556-00 Cuff, 10-19 cm, bladderless Disposable Child
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25.5 IBP Accessories

25.5.1 IBP Accessories Available for Purchase

25.5.2 IBP Accessories Also Compatible

25.5.3 ICP Accessories Available for Purchase

CM1502 115-027557-00 Cuff, 18-26 cm, bladderless Disposable Small adult

CM1503 115-027558-00 Cuff, 25-35 cm, bladderless Disposable Adult

CM1504 115-027559-00 Cuff, 33-47 cm, bladderless Disposable Large adult

CM1505 115-027560-00 Cuff, 46-66 cm, bladderless Disposable Adult thigh

CM1506 115-027561-00 Cuff, 25-35 cm, bladderless, long Disposable Adult

CM1507 115-027562-00 Cuff, 33-47 cm, bladderless, long Disposable Large adult

CM1500A 001B-30-70677 Cuff, 3.1-5.7 cm Disposable Neonate

CM1500B 001B-30-70678 Cuff, 4.3-8.0 cm Disposable Neonate

CM1500C 001B-30-70679 Cuff, 5.8-10.9 cm  Disposable Neonate

CM1500D 001B-30-70680 Cuff, 7.1-13.1 cm Disposable Neonate

CM1500E 001B-30-70681 Cuff, 5# Disposable Neonate

Model Part No. Description Usage Applicable patient

Model Part No. Description Usage Applicable patient

IM2204 040-001029-00 IBP extended cable with dual-
receptacle

Reusable /

IM2202 001C-30-70757 12 Pin IBP cable, Argon Reusable /

IM2201 001C-30-70759 12 Pin IBP cable, ICU Medical Reusable /

IM2211 0010-21-12179 12 Pin IBP cable, Edwards Reusable /

Model Part No. Description Usage Applicable patient

DT-4812 6000-10-02107 Disposable transducer kit, Argon Disposable /

682275 0010-10-12156 Mounting background and 
accessory for IBP transducer, Argon

Reusable /

42584 0010-10-42638 IBP transducer, ICU Medical Disposable /

42602 M90-000133--- Mounting background and 
accessory for IBP transducer, ICU 
Medical

Reusable / 

42394 M90-000134--- Mounting clamp for IBP transducer 
(send with the cable), ICU Medical

Reusable /

Model Part No. Description Usage Applicable patient

CP12601 009-005460-00 12 Pin ICP Cable / /
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25.6 CO2 Accessories

25.6.1 Sidestream CO2 Accessories Available for Purchase

25.6.2 Microstream CO2 Accessories Also Compatible

82-6653 040-002336-00 Codman ICP sensor kit, Johnson & 
Johnson, pkg of 1

Disposable /

Model Part No. Description Usage Applicable patient

Model Part No. Description Usage Applicable patient

4000 M02A-10-25937 CO2 Nasal sample cannula, 7'’ line Disposable Adult

4100 M02A-10-25938 CO2 Nasal sample cannula, 7'’ line Disposable Pediatric

4200 M02B-10-64509 CO2 Nasal sample cannula, 7'’ line Disposable Neonatal

60-15200-00 9200-10-10533 Sampling line, 2.5 m Disposable Adult/Pediatric

60-15300-00 9200-10-10555 Sampling line, 2.5 m Disposable Neonatal

60-14100-00 9000-10-07486 Dryline airway adapter, straight Disposable Adu/Ped

040-001187-00 040-001187-00 Airway Adapter Disposable Neonatal

60-14200-00 9000-10-07487 Dryline airway adapter, elbow Disposable /

100-000080-00 100-000080-00 Watertrap, DRYLINE II, pkg of 10 Reusable Adult/Pediatric

100-000081-00 100-000081-00 Watertrap, DRYLINE II, pkg of 10 Reusable Neonatal

Model Part No. Description Usage Applicable patient

MVAI 0010-10-42560 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVAIH 0010-10-42561 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVIIH 0010-10-42562 Neonatal-Infant Intubated CO2 FilterLine Disposable Neonate

MVAIL 0010-10-42563 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVAIHL 0010-10-42564 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVIIHL 0010-10-42565 Neonatal-Infant Intubated CO2 FilterLine Disposable Neonate

MVA 0010-10-42566 Adt Oral-Nasal CO2 FilterLine Disposable Adult

MVP 0010-10-42567 Ped Oral‐Nasal CO2 FilterLine Disposable Pediatric

MVAO 0010-10-42568 Adt Oral‐Nasal CO2 FilterLine w/O2 Disposable Adult

MVPO 0010-10-42569 Ped Oral‐Nasal CO2 FilterLine w/O2 Disposable Pediatric

MVAOL 0010-10-42570 Adt Oral-Nasal CO2 FilterLine w/O2 L Disposable Adult

MVPOL 0010-10-42571 Ped Oral‐Nasal CO2 FilterLine w/O2 L Disposable Pediatric

MVANH 0010-10-42572 Adult Nasal CO2 FilterLine Disposable Adult

MVINH 0010-10-42574 Neo-Inf Nasal CO2 FilterLine H Disposable Neonate

MVANOH 0010-10-42575 Adt Nasal CO2 FilterLine w/O2 H Disposable Adult

MVPNOH 0010-10-42576 Ped Nasal CO2 FilterLine w/O2 H Disposable Pediatric

MVAN 0010-10-42577 Adult Nasal CO2 FilterLine Disposable Adult

MVPN 0010-10-42578 Pediatric Nasal CO2 FilterLine Disposable Pediatric
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25.7 External Modules

25.8 Mount and Mounting Accessories

25.9 Miscellaneous Accessories

Part No. Description

115-047274-00 IBP module

115-053711-00 Sidestream CO2 module, with neonatal accessories

115-049134-00 Sidestream CO2 module, with adult and pediatric accessories

115-049136-00 Sidestream CO2 module, integrating O2 (paramagnetic) monitoring, with adult and 
pediatric accessories

115-053712-00 Sidestream CO2 module, integrating O2 (paramagnetic) monitoring, with neonatal 
accessories

6800-30-50820 Microstream CO2 module, with accessories

Part No. Description

115-028320-00 Monitor handle

115-048378-00 Modular Rack kit

115-054849-00 Dock and pole mount kit

115-054851-00 Modular Rack and folding hook kit 

115-048990-00 Bedrail hook kit

045-001229-00 LCD wall-mount bracket

045-001230-00 Pole mounting kit

045-002198-00 Dock wall mount bracket

045-000931-00 GCX M series wall mount with quick release

045-001228-00 N1/T1 docking station wall-mount (for LCD)

034-000454-00 GCX M series arm, 16", with 6” riser

034-000457-00 GCX M series 12” pivot arm

034-000456-00 GCX VHM variable height arm

045-000934-00 Keyboard wall-mount bracket

045-000924-00 Rolling stand with quick release mount

115-050757-00 Hook kit

Part No. Description

009-009766-00 N Series to N1/T1 docking station cable, 20 m

009-006594-00 N Series to N1/T1 docking station cable, 10 m

009-005123-00 N Series to N1/T1 docking station cable, 4 m

009-006593-00 N Series to N1/T1 docking station cable, 2 m

115-048379-00 Dock, with power cord
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115-048384-00 Transport Dock

009-005391-00 MPM analog output and defib sync cable

023-001788-00 External display, 21.5”

023-001566-00 HP LaserJet Enterprise M608n, black and white

115-048139-00 AC adapter kit

115-049427-00 Lithium battery kit

DA8K-10-14452 Power cord

023-000524-00 Wireless keyboard and mouse set

023-000525-00 Wired keyboard and mouse set

023-000247-00 Keyboard, wired USB connector, black

023-000248-00 Mouse, wired USB connector, black

115-039575-00 2D Barcode reader, HS-1M, JADAK

115-039635-00 2D Barcode reader, HS-1R, JADAK

Part No. Description
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A Product Specifications

A.1 Monitor Safety Specifications
The monitor is classified, according to IEC 60601-1: 2005:

A.2 Physical Specifications

A.3 Environmental Specifications

WARNING

• The monitor may not meet the performance specifications if stored or used outside the specified 
temperature and humidity ranges. If the performance of the equipment is degraded due to aging or 
environmental conditions, contact your service personnel.

• The monitor cannot be transported in the temperature lower than -30ºC.

Degree of protection against electrical 
shock

Type CF defibrillation proof for ECG, Resp, TEMP, IBP, SpO2,and NIBP
Type BF defibrillation proof for CO2

Type of protection against electrical 
shock

Class I

Degree of protection against harmful 
ingress of water

N1 monitor: IP44 (protected against ingress of foreign objects no less than 1.0 
mm, and against access to hazardous parts with wire; protect against harmful 
effects of splashing water)
Dock/Modular Rack/AC Adapter: IPX1 (protected against harmful effects of 
vertically falling water drops)
Transport Dock: IP22 (protected against ingress of foreign objects no less than 
12.5 mm and against access to hazardous parts with finger; protected against 
harmful effects of vertically falling water drops with the device tilted at any 
angle up to 15°)

Degree of safety of application in the 
presence of flammable anesthetic 
mixture with air or with oxygen or 
nitrous oxide

The equipment is not suitable for use in the presence of a flammable 
anesthetic mixture with air or with oxygen or nitrous oxide

Mode of operation Continuous

Item Maximum 
Weight (kg)

W × H × D (mm) Comments

N1 main unit 0.95 148.5 × 103 × 81 without internal CO2 module

N1 main unit 1.17 148.5 × 103 × 81 with internal CO2 module

Modular Rack 0.60 165 ×130×168 /

Dock 0.97 190×125×155 /

Transport Dock 2.51 162.4×253×195.5 with cable box

Transport Dock 1.80 162.4×113×195.5 without cable box

Microstream CO2 module 0.40 136.5 × 40 × 102 /

Sidestream CO2 module 0.52 136.5 × 40 × 102 without O2

IBP module 0.26 136.5 × 40 × 102 /
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• When the monitor and related products have differing environmental specifications, the effective 
range for the combined products is that range which is common to the specifications for all 
products.

NOTE
• The environmental specification of unspecified parameter modules are the same as those of the 

main unit.

Transient operating conditions

The monitor is operated in normal use for a period not less than 20 minutes when moved from room 
temperature (20°C ± 2°C) to an environment of a temperature range from - 20 °C to 50 °C, and relative humidity 
range from 15% to 95% (non-condensing). 

The monitor is operated in normal use for a period not less than 20 minutes when moved from storage 
temperature (range from - 30 °C to 70 °C) to room temperature (20°C ± 2°C), and started up within 10 minutes 
after the movement.

A.4 Power Supply Specifications

A.4.1 External Power Supply Specifications

Components Property (unit) Operating Condition Storage Condition

Main Unit/ 
Transport Dock/
AC Adapter

Temperature (°C) 0 to 40 -30 to 70

Relative humidity 
(noncondensing) (%)

5 to 95 5 to 95

Barometric (mmHg) 427.5 to 805.5 375 to 805.5 (with CO2)
120 to 805.5 (without CO2)

Modular Rack/
Dock

Temperature (°C) 0 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 427.5 to 805.5 120 to 805.5

Microstream CO2 
module

Temperature (°C) 0 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 430 to 790 430 to 790

Sidestream CO2 
module

Temperature (°C) 5 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 430 to 790 375 to 805.5

N1 main unit

Input voltage 12VDC (±10%)

Input current 2 A

AC Adapter

Input 100 to 240 VAC (-15%, +10%), 50/60 Hz (±3 Hz), 1.0A to 0.6A

Output 12VDC (±10%), 2.5A

Dock

Input voltage 100 to 240VAC (±10%)
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A.4.2 Battery Specifications

A.5 Display Specifications

A.6 Touchscreen Specifications

Input current 0.65A to 0.35A

Frequency 50/60Hz (±3Hz)

Transport Dock

Input 100 to 240 VAC (-15%, +10%), 50/60 Hz (±3 Hz), 1.0A to 0.6A
AC waveform: sine

Output 12VDC (±10%), 2.5A

Battery type Rechargeable lithium-Ion battery

Voltage 7.2 VDC

Capacity 2500 mAh 

Run time At least 8 hours when the monitor without internal CO2 module is powered by 
two new fully-charged batteries at 25°C ± 5°C with factory default screen 
brightness, Wi-Fi disabled, ECG and SpO2 cable connected, and auto NIBP 
measurements at an interval of 15 minutes.

At least 3 hours when the monitor with internal CO2 module is powered by 
one new fully-charged battery at 25°C ± 5°C with factory default screen 
brightness, Wi-Fi enabled, CO2 sampling line connected, Temp, IBP, ECG and 
SpO2 cable connected, and auto NIBP measurements at an interval of 15 
minutes.

Shutdown delay: at least 15 minutes after the low battery alarm first occurs.

Charge time For the monitor without internal CO2 module:
no more than 6 hours to 90% when the monitor is off.
no more than 10 hours to 90% when the monitor is on.

For the monitor with internal CO2 module:
no more than 3 hours to 90% when the monitor is off.
no more than 5 hours to 90% when the monitor is on.

N1 main unit

Screen type Color TFT LCD

Screen Size (diagonal) 5.5 inches

Resolution 1280 x 720 pixels

Pixel per inch (PPI) 269

External display

Screen type Medical-grade color TFT LCD

Screen Size (diagonal) 22 inches

Resolution 1280 x 720 pixels

Screen type Capacitive, multi-point touch
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A.7 LEDs

A.7.1 Main Unit

A.7.2 Dock

A.7.3 Transport Dock

A.7.4 AC Adapter

A.8 Audio Indicator

A.9 Monitor Interface Specifications

A.9.1 Interface Specifications of the Main Unit

Alarm lamp 1 (three color-coded: red, yellow, and cyan)

Power-on LED 1 (green)

External power LED 1 (green)

Battery LED 1 (two color-coded: yellow and green)

Connection status LED 1 (green)

External power supply LED 1 (green)

Power-on LED 1 (green)

Power-on LED 1 (green)

Speaker Give alarm tones (45 to 85 dB), reminder tones, key tones, QRS tones; support 
PITCH TONE and multi-level tone modulation; alarm tones comply with IEC 
60601-1-8:2012.

DC power input connector 1

Multifunctional connector 1

Multi-pin connector 1

Communication interface 4

Infrared filter 1

Contact 2

Power switch 1

Sample line connector of the Sidestream 
CO2

1

Gas outlet 1

ECG cable connector 1

SpO2 sensor connector 1
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A.9.2 Interface Specifications of the Modular Rack

A.9.3 Interface Specifications of the Dock

A.10 Signal Outputs Specifications

NIBP cuff connector 1

IBP cable connector 1

Temperature probe connector 2

Multi-pin connector 2

Infrared filter 1

Pogo pin 3

Contact 2

Network connector 1

Equipotential grounding terminal 1

AC power input connector 1

VGA connector 1

Host monitor connector 1

USB connector 2

Multi-pin connector 1

ECG Analog Output

Bandwidth
(-3dB; reference frequency: 10Hz)

Diagnostic mode: 0.05 to 150 Hz
Monitor mode: 0.5 to 40 Hz
Surgical mode: 1 to 20 Hz
ST mode: 0.05 to 40 Hz

Maximum QRS delay 25 ms (in diagnostic mode, and non-paced)

Gain (reference frequency 10Hz) 1V/mV (±5%)

Pace enhancement Signal amplitude: Voh≥2.5V
Pulse width: 10ms±5%
Signal rise and fall time: ≤100μs

IBP Analog Output

Bandwidth (-3dB; reference 
frequency:1Hz)

0 to 40 Hz 

Maximum transmission delay 30 ms

Gain (reference frequency 1 Hz) 1 V/100 mmHg, ±5%

Defib Sync Pulse

Output impedance ≤100 Ω

Maximum time delay 35 ms (R-wave peak to leading edge of pulse)

Amplitude High level: 3.5 to 5 V, ±5%, providing a maximum of 10 mA output current;
Low level: < 0.5 V, receiving a maximum of 5 mA input current.

Pulse width 100 ms ±10%
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A.11 Data Storage

A.12 Out-Of-Hospital Transport - Standards Compliance
■ Shock Tests according to IEC TR 60721-4-7, Class 7M3. Test procedure according to IEC/EN60068-2-27 

(peak acceleration up to 100g).

■ Random Vibration according to IEC TR 60721-4-7, Class 7M3. Test procedure according to IEC/EN 60068-2-
64 (RMS acceleration 5g).

■ Sinusoidal Vibration according to IEC TR 60721-4-7, Class 7M3. Test procedure according to IEC/EN 60068-
2-6 (acceleration up to amplitude 2g).

■ Bump Test according to IEC/EN60068-2-29 (peak acceleration 15 g, 1000 bumps).

■ Free Fall Test according to EN 60068-2-32 (height 1.2 m).

■ EN 1789:2007+A2:2014 Medical vehicles and their equipment - Road ambulances. 

■ EN 13718-1:2008 Medical vehicles and their equipment-Air ambulances-Part 1: Requirements for medical 
devices used in air ambulances.

■ IEC 60601-1-12:2014 Medical electrical equipment -Part 1-12: General requirements for basic safety and 
essential performance -Collateral Standard: Requirements for medical electrical equipment and medical 
electrical systems intended for use in the emergency medical services environment.

■ RTCA DO-160G Environmental Conditions and Test Procedures for Airborne Equipment.

◆ Section 7 Operational Shocks and Crash Safety

◆ Section 8 Vibration (Category S for fixed wing and Category U2 for rotary wing)

■ MIL-STD-810G Environmental engineering considerations and laboratory tests 

◆ Method 514.6 Category 13 - Fixed Wing Propeller Aircraft

◆ Method 514.6 Category 14 Category 14 Helicopter, General, UH-60

◆ Method 514.6 Category 20 - Ground vehicles - ground mobile

◆ Method 514.6 Category 24 - Helicopter minimum integrity test

■ Radiated susceptibility 20 V/m according to IEC 80601-2-30: 2018 (NIBP), ISO80601-2-55: 2018 (CO2), 
ISO80601-2-56: 2017 (TEMP), ISO 80601-2-61: 2017 (SpO2).

■ Extended radiated susceptibility tests

◆ TETRA 400: 27V/m

◆ GMRS 460; FRS 460; GSM 800/900; TETRA 800; iDEN 820; CDMA 850; LTE Band 5; GSM 1800; CDMA 
1900; GSM 1900; DECT; LTE Band 1, 3, 4, 25; UMTS; Bluetooth; WLAN; 802.11 b/g/n; RFID 2450; LTE 
Band 7: 28V/m

Video Output

Video signals VGA signal

Alarm output

Alarm delay time from the monitor to 
remote equipment 

The alarm delay time from the monitor to remote equipment is ≤2 seconds, 
measured at the monitor signal output connector. 

Alarm signal sound pressure level range 45 dB(A) to 85 dB(A) within a range of one meter

Trends A minimum of 120 hours of trend data for trend interval as low as 1 minute.

Events 1000 events

NIBP measurements 1000 sets

Interpretation of resting 12-lead ECG 
results

20 sets

Full-disclosure waveforms 48 hours at maximum. The specific storage time depends on the waveforms 
stored and the number of stored waveforms.

OxyCRG view A maximum of 48 hours of oxyCRG events
A - 6  BeneVision N1 Patient Monitor Operator’s Manual



◆ LTE Band 13, 17; WLAN 802.11 a/n: 9V/m

■ Magnetic Field emission according to MIL STD 461F, Chapter RE101: Radiated emissions, magnetic field, 
30Hz to 100KHz. Limit class: Army.

■ Magnetic Field susceptibility: Radiated susceptibility, magnetic field, 50 and 60 Hz, 30 A/m.

A.13 Wi-Fi Specifications

A.13.1 Wi-Fi Technical Specifications (MSD45N)

A.13.2 Wi-Fi Performance Specifications

WARNING

• All network functions of data communication are designed to operate on a private network.

A.13.2.1 System Capacity

Number of the monitors supported by a single AP: ≤ 16

Testing conditions are as follows:

■ Each monitor can communicate with the CMS. 

■ Two monitors are used to view other monitors.

■ Only one monitor can transmit history data. 

■ The weakest strength of the AP signal where the monitor is located cannot be less than -65 dBm.

A.13.2.2 Resistance to Wireless Interference

The distance between the interfering devices and the monitor is greater than 20 cm. A Wi-Fi interference (no 
greater than -85 dBm) in the same channel and a Wi-Fi interference (no greater than -50 dBm) in an adjacent-
channel are presented synchronously. The interfering devices include, but are not limited to, 2.4 GHz wireless 
devices, cellular mobile networks, microwave ovens, intercoms, cordless phones, and ESU equipment. The 
interfering devices do not include Wi-Fi devices.

The monitoring network must support the following requirements:

Protocol IEEE 802.11a/b/g/n

Modulation mode BPSK, QPSK, 16QAM, 64QAM

Operating frequency 2.4 GHz to 2.495 GHz.
5.15 GHz to 5.25 GHz, 5.725 GHz to 5.85 GHz

Channel spacing IEEE 802.11b/g: 5 MHz 
IEEE 802.11n (at 2.4 GHz): 5 MHz 
IEEE802.11a: 20 MHz
IEEE802.11n (at 5 GHz): 20 MHz

Wireless data rate IEEE 802.11b: 1 Mbps to 11 Mbps
IEEE 802.11g: 6 Mbps to 54 Mbps
IEEE 802.11n: 6.5 Mbps to 72.2 Mbps (MCS0-MCS7)
IEEE 802.11a: 6 Mbps to 54 Mbps

Output power <20 dBm (CE requirements, detection mode: RMS)
<30 dBm (FCC requirements, detection mode: peak power)

Operating mode As station, access AP for data transmission

Data security Standards: WPA-PSK, WPA2-PSK, WPA-Enterprise, WPA2-Enterprise, WPA CCKM, WPA2 
CCKM
EAP method: EAP-FAST, EAP-TLS, EAP-TTLS, PEAP-GTC, PEAP-MSCHAPv2, PEAP-TLS, LEAP
Encryption: AES
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■ All the monitors do not encounter communication loss.
■ The total delay of data transmission from the monitor to the CMS: ≤ 2 seconds.
■ The delay for monitor-related settings configured at the CMS to be effective: ≤ 2 seconds.
■ The total delay of data transmission from one monitor to the other: ≤ 2 seconds.
■ The delay for the monitor to reset alarms of another to be effective: ≤ 2 seconds.

A.13.2.3 Wi-Fi Network Stability

The ratio of the communication data loss on the CMS from any monitor does not exceed 0.1% over a 24-hour 
period (12 of the 16 monitors connected to the network roam for 30 times).

Testing conditions are as follows:

■ Number of the monitors supported by a single AP: ≤ 16.

■ Each monitor can communicate with the CMS. 

■ Two monitors are used to view other monitors.

■ Only one monitor can transmit history data. 

■ The weakest strength of the AP signal where the monitor is located cannot be less than -65 dBm.

A.13.2.4 Line of Sight Distance

The line of sight distance between the monitor and the AP is no less than 50 meters.

A.14 Measurement Specifications
The adjustable range of alarm limits is the same with the measurement range of signals unless otherwise 
specified. 

A.14.1 ECG Specifications

ECG

Standards Meets the requirements of IEC 60601-2-27: 2011 and IEC 60601-2-25: 2011

Lead set 3-lead: I, II, III

5-lead: I, II, III, aVR, aVL, aVF, V

6-lead: I, II, III, aVR, aVL, aVF, Va, Vb

12-lead: I, II, III, aVR, aVL, aVF, V1 to V6

ECG standard AHA, IEC

Display sensitivity 1.25 mm/mV (×0.125), 2.5 mm/mV (×0.25), 5 mm/mV (×0.5), 10 mm/mV (×1), 
20 mm/mV (×2), 40 mm/mV (×4), Auto, less than 5% error

Sweep speed 6.25 mm/s, 12.5 mm/s, 25 mm/s, 50 mm/s, less than 5% error

Bandwidth (-3dB) Diagnostic mode:

Monitor mode: 

Surgery mode: 

ST mode:

High frequency cut-off (for 12-
lead ECG analysis):

0.05 to 150 Hz

0.5 to 40 Hz

1 to 20 Hz

0.05 to 40 Hz

350 Hz (0.05 to 350 Hz), 150 Hz (0.05 to 150 
Hz), 35 Hz (0.05 to 35 Hz), 20 Hz (0.05 to 20 
Hz) selectable

Common mode rejection ratio Diagnostic mode, monitor mode, surgery mode, ST mode, High Freq Cut-off: 
>90 dB (with notch filter off )

Monitor mode, surgery mode, ST mode: >105 dB (with notch filter on)

Notch filter 50/60 Hz, Monitor, surgical, and ST mode: notch filter turns on automatically

Diagnostic mode and High Freq Cut-off: notch filter is turned on/off manually

Differential input impedance ≥5 MΩ

Input signal range ±8 mV (peak-to-peak value)
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Accuracy of signal reproduction Use A and D methods based on IEC 60601-2-25: 2011 to determine frequency 
response.

Electrode offset potential tolerance ±500 mV

Lead-off detection current Measuring electrode: <0.1 μA
Drive electrode: <1 μA

Input offset current ≤0.1 μA, (drive lead≤1μA)

Defibrillation protection Withstands 5000V (360 J) charge without data loss or corruption
Baseline recovery time: <5 s
Polarization recovery time: <10 s
Defibrillation energy absorption: ≤10% (100 Ω load)

Patient leakage current <10 uA

Calibration signal 1mV (peak-to-peak value) ±5%

ESU protection Cut mode: 300 W
Coagulate mode: 100 W
Recovery time: ≤10 s
In compliance with the requirements in clause 202.6.2.101 of IEC 60601-2-27: 
2011

Pace Pulse

Pace pulse markers Pace pulses meeting the following conditions are labelled with a PACE marker:

Amplitude:
Width:
Rise time: 
No overshoot

±2 mV to ±700 mV
0.1 ms to 2 ms
10 μs to 100 μs (< 10% of pulse width)

Pace pulse rejection When tested in accordance with the IEC 60601-2-27: 2011: 201.12.1.101.13, 
the heart rate meter rejects all pulses meeting the following conditions. 

Amplitude:
Width:
Rise time: 
No overshoot

±2 mV to ±700 mV
0.1 ms to 2 ms
10 μs to 100 μs (< 10% of pulse width)

HR

Measurement range Neonate: 15 to 350 bpm
Pediatric: 15 to 350 bpm
Adult: 15 to 300 bpm

Resolution 1 bpm

Accuracy ±1 bpm or ±1%, whichever is greater.

Sensitivity 200 μV (lead II)

Minimum QRS detection threshold Adult and pediatric: 0.16 – 0.48 mV
Neonate: 0.12 – 0.40 mV

HR averaging method In compliance with the requirements in Clause 201.7.9.2.9.101 b) 3) of IEC 
60601-2-27: 2011, the following method is used:
If the last 3 consecutive RR intervals are greater than 1200 ms, the 4 most 
recent RR intervals are averaged to compute the HR. Otherwise, heart rate is 
computed by subtracting the maximum and minimum ones from the most 
recent 12 RR intervals and then averaging the remaining 10 RR intervals.
The HR value displayed on the monitor screen is updated no more than one 
second.
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Response to irregular rhythm In compliance with the requirements in Clause 201.7.9.2.9.101 b) 4) of IEC 
60601-2-27: 2011, the heart rates for the specified test signals after 20 seconds 
of stabilization are:
Ventricular bigeminy (waveform A1): 80±1 bpm
Slow alternating ventricular bigeminy (waveform A2): 60±1 bpm
Rapid alternating ventricular bigeminy (waveform A3): 120±1 bpm
Bidirectional systoles (waveform A4): 90±2 bpm

Response time to heart rate change Meets the requirements of IEC 60601-2-27: 2011: Clause 201.7.9.2.9.101 b) 5).
From 80 to 120 bpm: less than 11 s
From 80 to 40 bpm: less than 11 s 

Time to alarm for tachycardia Meets the requirements in Clause 201.7.9.2.9.101 b) 6) of IEC 60601-2-27: 2011.

Waveform
B1h-range:
B1-range:
B1d-range:
B2h-range:
B2-range:
B2d-range:

<11 s
<11 s
<11 s
<11 s
<11 s
<11 s

Tall T-wave rejection capability When the test is performed based on Clause 201.12.1.101.17 of IEC 60601-2-27: 
2011, the heart rate calculation is not affected for QRS of 1 mV amplitude and 
100 ms duration, T-wave duration of 180 ms and amplitude lower than 1.2 mV, 
and QT interval of 350 ms. 

Arrhythmia Analysis Classifications Asystole, V-Fib/V-Tach, V-Tach, Vent Brady, Extreme Tachy, Extreme Brady, Vent 
Rhythm, PVCs/min, Pauses/min, Couplet, Bigeminy, Trigeminy, R on T, Run 
PVCs, PVC, Tachy, Brady, Missed Beats, Pacer Not Pacing, Pacer Not Capture, 
Multiform PVC, Nonsus V-Tach, Pause, Irr Rhythm, A-Fib

ST Segment Analysis 

Measurement range -2.0 mV to +2.0 mV RTI

Accuracy -0.8 mV to +0.8 mV: ±0.02 mV or ±10%, whichever is greater
Beyond this range: not specified

Resolution 0.01mV

QT/QTc Analysis

Measurement range QT: 200 to 800 ms
QTc: 200 to800 ms
QT-HR: 15 bpm to 150 bpm for adult, 15 bpm to 180 bpm for pediatric and 
neonate

Accuracy QT: ±30 ms

Resolution QT: 4 ms
QTc: 1 ms

12-lead ECG Interpretation

Sampling rate 1000 samples/s (waveform) 
500 samples/s (ECG algorithm)

Amplitude quantisation 24 bits

Alarm limit Range Step
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A.14.2 Resp Specifications

A.14.3 SpO2 Specifications

Refer to Appendix F SpO2 Sensor Accuracy for the clinical study results of SpO2 sensor accuracy.

HR High HR≤40bpm: (low limit + 2 bpm) to 40 bpm
HR > 40 bpm: (low limit + 5 bpm) to 295 bpm (Adult/Pediatric)
                     (low limit + 5 bpm) to 300 bpm (Neonate)

HR≤40bpm: 1 bpm
HR > 40 bpm: 5 bpm

HR Low HR≤40bpm: 16 bpm to (high limit - 2 bpm) (Adult/Pediatric)
                         15 bpm to (high limit - 2 bpm) (Neonate)
HR > 40 bpm: 40 bpm to (high limit - 5 bpm)

ST High (low limit + 0.2 mV) to 2.0 mV (ST alarm mode: Absolute)
0 mV to 2.0 mV (ST alarm mode: Relative)

0.05 mV

ST Low -2.0 mV to (high limit - 0.2 mV) (ST alarm mode: Absolute)
-2.0 mV to 0 mV (ST alarm mode: Relative)

QTc High 200 ms to 800 ms 10 ms

ΔQTc High 30 ms to 200 ms

Technique Trans-thoracic impedance

Lead Options are lead I, II, and Auto. 

Respiration excitation waveform <300 μA RMS, 62.8 kHz (±10%)

Minimum respiration impedance 
threshold

0.3Ω

Baseline impedance range 200 to 2500 Ω (using an ECG cable with 1kΩ resistance)

Bandwidth 0.2 to 2.5 Hz (-3 dB)

Sweep speed 3mm/s, 6.25 mm/s, 12.5 mm/s, 25 mm/s or 50 mm/s, less than 10% error

Respiration Rate

Measurement range Adult: 0 to 120 rpm
Pediatric, neonate: 0 to 150 rpm

Resolution 1 rpm

Accuracy 7 to 150 rpm: ±2 rpm or ±2%, whichever is greater
0 to 6 rpm: not specified

Apnea alarm delay 10 s, 15 s, 20 s, 25 s, 30 s, 35 s, 40 s

Alarm limit Range (rpm) Step (rpm)

RR High Adult, pediatric:
RR≤20
RR>20
Neonate: 
RR≤20
RR>20

(low limit + 2) to 20
(low limit + 5) to 100

(low limit + 2) to 20
(low limit + 5) to 150

RR≤20: 1
RR>20: 5

RR Low RR≤20:
RR>20:

0 to (high limit - 2)
20 to (high limit - 5)

Alarm limit Range (%) Step (%)

SpO2 High (low limit + 2) to 100 1
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Masimo SpO2 Module

Nellcor SpO2 Module

SpO2 Low Masimo: (Desat+1) to (high limit - 2) 
Nellcor: (Desat+1) or 20 (whichever is greater) 
to (high limit - 2)

SpO2 Desat Low 0 to (SpO2 low limit - 1)

Standards Meets the requirements of ISO 80601-2-61: 2017

Measurement range 1 to 100%

Resolution 1%

Response time ≤20 s (normal perfusion, no disturbance, SpO2 value sudden change from 70% 
to 100%)

Accuracy1 70 to 100%: ±2%ABS (adult/pediatric, without motion) 
70 to 100%: ±3%ABS (adult/pediatric, with motion) 
70 to 100%: ±3%ABS (neonate) 
1% to 69%: Not specified. 

Refresh rate ≤ 1 s 

SpO2 averaging time 2-4 s, 4-6 s, 8 s, 10 s, 12 s, 14 s, 16 s 

Low perfusion conditions Pulse amplitude: >0.02% 
Light penetration: >5%

Low perfusion SpO2 accuracy2 ±2%

PI measurement range 0.02 to 20% 

1 The Masimo pulse oximeter with sensors have been validated for no motion accuracy in human blood studies on healthy 
adult volunteers in induced hypoxia studies in the range of 70% to 100% SpO2 against a laboratory co-oximeter and ECG 
monitor. This variation equals plus or minus one standard deviation. Plus or minus one standard deviation encompasses 
68% of the population. One percent was added to the accuracies for neonatal sensors to account for accuracy variation due 
to properties of fetal hemoglobin.
 The Masimo pulse oximeter with sensors has been validated for motion accuracy in human blood studies on healthy adult 
volunteers in induced hypoxia studies while performing rubbing and tapping motions at 2 to 4 Hz. At an amplitude of 1 to 
2 cm and non-repetitive motion between 1 to 5 Hz. At an amplitude of 2 to 3 cm in induced hypoxia studies in the range of 
70% to 100% SpO2 against a laboratory co-oximeter and ECG monitor. This variation equals plus or minus one standard 
deviation. Plus or minus one standard deviation encompasses 68% of the population. 
2 The Masimo pulse oximeter has been validated for low perfusion accuracy in bench top testing against a Biotek Index 2 
simulator and Masimo's simulator with signal strengths of greater than 0.02% and a % transmission of greater than 5% for 
saturations ranging from 70 to 100%. This variation equals plus or minus one standard deviation. Plus or minus one 
standard deviation encompasses 68% of the population. 

Standard Meet the requirements of ISO 80601-2-61 2017

Measurement range 0 to 100%

Resolution 1%

Refresh rate ≤1 s

Response time ≤30 s (normal perfusion, no disturbance, SpO2 value sudden changes from 
70% to 100%)

Accuracy 70 to 100%: ±2%ABS (adult/pediatric)
70 to 100%: ±3%ABS (neonate)
0 to 69%: Not specified.

When the SpO2 sensor is applied for neonatal patients as indicated, the specified accuracy range is increased by ±1%, to 
compensate for the theoretical effect on oximeter measurements of fetal hemoglobin in neonatal blood.
A - 12  BeneVision N1 Patient Monitor Operator’s Manual



A.14.4 PR Specifications

PR from Masimo SpO2

PR from Nellcor SpO2

 

PR from NIBP

PR from IBP

A.14.5 Temp Specifications

Alarm limit Range (bpm) Step (bpm)

PR High PR≤40: (low limit + 2) to 40
PR > 40: (low limit + 5) to 295 (Adult/Pediatric), 
(low limit + 5) to 300 (Neonate)

PR≤40: 1
PR>40: 5

PR Low PR≤40: 16 to (high limit - 2) (Adult/Pediatric), 
15 to (high limit - 2) (Neonate)
PR > 40: 40 to (high limit - 5)

Measurement range 25 to 240 bpm

Resolution 1 bpm

Response time ≤20 s (with normal perfusion, no disturbance, and a PR value transition from 
25 to 220 bpm)

Accuracy ±3 bpm (without motion) 
±5 bpm (with motion) 

Refresh rate ≤1 s

Measurement range 20 to 300 bpm

Resolution 1 bpm

Response time ≤30 s (with normal perfusion, no disturbance, and a PR value transition from 
25 to 250 bpm)

Accuracy 20 to 250 bpm: ±3 bpm
251 to 300 bpm: not specified

Refresh rate ≤1 s

Measurement range 30 to 300 bpm

Resolution 1 bpm

Accuracy ±3 bpm or ±3%, whichever is greater

Measurement range 25 to 350 bpm

Resolution 1 bpm

Accuracy ±1 bpm or ±1%, whichever is greater

Standard Meets the requirements of ISO 80601-2-56: 2017

Technique Thermal resistance

Operating mode Direct mode

Measurement range 0 to 50 °C (32 to 122 °F)

Resolution 0.1°C

Accuracy ±0.1 °C or ±0.2 °F (excluding probe error)
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A.14.6 NIBP Specifications

Minimum time for accurate 
measurement

Body surface: <100 s
Body cavity: <80 s

Alarm limit Range Step

Txx High (xx refers to temperature site) (low limit +1.0) to 50.0 °C
(low limit +2.0) to 122.0 °F

0.1 °C
0.1 °F

Txx Low (xx refers to temperature site) 0.1 to (high limit - 1.0) °C
32.2 to (high limit - 2.0) °F

ΔT High 0.1 to 50.0 °C
0.2 to 90.0 °F

Standard Meets the requirements of IEC 80601-2-30: 2018

Technique Oscillometry

Mode of operation Manual, Auto, STAT, Sequence

Auto mode repetition intervals 1, 2, 2.5, 3, 5, 10, 15, 20, 30, 60, 90, 120, 180, 240 or 480 min

STAT mode cycle time 5 min

Max measurement time Adult, pediatric: 180 s
Neonate: 90 s

Heart rate range 30 to 300 bpm

Measurement ranges
(mmHg)

Adult Pediatric Neonate

Systolic: 25 to 290 25 to 240 25 to 140

Diastolic: 10 to 250 10 to 200 10 to 115

Mean: 15 to 260 15 to 215 15 to 125

Accuracy Max mean error: ±5 mmHg
Max standard deviation: 8 mmHg

Resolution 1mmHg

Initial cuff inflation pressure range 
(mmHg)

Adult: 80 to 280
Pediatric: 80 to 210
Neonate: 60 to 140

Default initial cuff inflation pressure 
(mmHg)

Adult: 160
Pediatric: 140
Neonate: 90

Software overpressure protection Adult: 297±3 mmHg
Pediatric: 297±3 mmHg
Neonate: 147±3 mmHg

Static pressure measurement range 0 mmHg to 300 mmHg

Static pressure measurement accuracy ±3 mmHg

Alarm limit Range (mmHg) Step (mmHg)
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NIBP-S High Adult: (low limit + 5) to 285
Pediatric: (low limit + 5) to 235
Neonate: (low limit + 5) to 135

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-S Low 26 to (high limit - 5)

NIBP-M High Adult: (low limit + 5) to 255
Pediatric: (low limit + 5) to 210
Neonate: (low limit + 5) to 120

NIBP-M Low 16 to (high limit - 5)

NIBP-D High Adult: (low limit + 5) to 245
Pediatric: (low limit + 5) to 195
Neonate: (low limit + 5) to 110

NIBP-D Low 11 to (high limit - 5)

NIBP-S Extreme High NIBP-S high limit < 50
Adult: (NIBP-S high limit + 1) to 290
Pediatric: (NIBP-S high limit + 1) to 240
Neonate: (NIBP-S high limit + 1) to 140

NIBP-S high limit ≥ 50
Adult: (NIBP-S high limit + 5) to 290
Pediatric: (NIBP-S high limit +5) to 240
Neonate: (NIBP-S high limit +5) to 140

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-S Extreme Low NIBP-S low limit ≤ 50
25 to (NIBP-S low limit - 1)

NIBP-S low limit > 50

25 to (NIBP-S low limit - 5)

NIBP-M Extreme High NIBP-M high limit < 50
Adult: (NIBP-M high limit + 1) to 260
Pediatric: (NIBP-M high limit + 1) to 215
Neonate: (NIBP-M high limit + 1) to 125

NIBP-M high limit ≥ 50
Adult: (NIBP-M high limit + 5) to 260
Pediatric: (NIBP-M high limit + 5) to 215
Neonate: (NIBP-M high limit + 5) to 125

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-M Extreme Low NIBP-M low limit ≤ 50
15 to (NIBP-M low limit - 1)

NIBP-M low limit > 50
15 to (NIBP-M low limit - 5)

NIBP-D Extreme High NIBP-D high limit < 50
Adult: (NIBP-D high limit + 1) to 250
Pediatric: (NIBP-D high limit + 1) to 200
Neonate: (NIBP-D high limit + 1) to 115

NIBP-D high limit ≥ 50
Adult: (NIBP-D high limit + 5) to 250
Pediatric: (NIBP-D high limit + 5) to 200
Neonate: (NIBP-D high limit + 5) to 115

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-D Extreme Low NIBP-D low limit ≤ 50
10 to (NIBP-D low limit - 1)

NIBP-D low limit > 50
10 to (NIBP-D low limit - 5)
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*Measurement accuracy verification: In adult and pediatric modes, the blood pressure measurements measured 
with this device are in compliance with the Standard for Non-invasive sphygmomanometers (ISO 81060-2: 2013) 
in terms of mean error and standard deviation by comparing with intra-arterial or auscultatory measurements 
(depending on the configuration) in a typical patient population. For auscultatory reference, the 5th Korotkoff 
sound was used to determine the diastolic pressure.

In neonatal mode, the blood pressure measurements measured with this device are in compliance with the 
American National Standard for Non-invasive sphygmomanometers (ISO 81060-2) in terms of mean error and 
standard deviation by comparing with intra-arterial measurements (depending on the configuration) in a typical 
patient population.

A.14.7 IBP Specifications

A.14.8 CO2 Specifications

Standard Meets the requirements of IEC 60601-2-34: 2011

Technique Direct invasive measurement

IBP

Measurement range -50 to 300 mmHg

Resolution 1 mmHg

Accuracy ±2% or ±1 mmHg, whichever is greater (excluding sensor error)

PPV

Measurement range 0% ~ 50%

Pressure transducer

Excitement voltage 5 VDC, ±2%

Sensitivity 5 μV/V/mmHg

Zero adjustment range ±200 mmHg

Impedance range 300 to 3000Ω

Volume displacement <0.04 mm3 /100 mmHg

Alarm limit Range (mmHg) Step (mmHg)

Sys High IBP ≤ 50: (low limit + 2) to 50
IBP > 50: (low limit + 5) to 295

IBP ≤ 50: 1
IBP > 50: 5

Mean High

Dia High

Sys Low IBP ≤ 50: -49 to (high limit - 2)
IBP > 50: 50 to (high limit - 5)

Mean Low

Dia Low

Art-S Extreme High High limit < 50: (High limit+ 1) to 300
High limit ≥ 50: (High limit+ 5) to 300

IBP ≤ 50: 1
IBP > 50: 5

Art-M Extreme High

Art-D Extreme High

Art-S Extreme Low low limit ≤ 50: -50 to (low limit- 1)
low limit > 50: -50 to (low limit- 5)

Art-M Extreme Low

Art-D Extreme Low

Measurement mode Sidestream, microstream

Technique Infrared absorption
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Sidestream CO2 Module

Apnea delay 10 s, 15 s, 20 s, 25 s, 30 s, 35 s, 40 s

Alarm limit Range Step

EtCO2 High (low limit + 2) to 99 mmHg 1 mmHg

EtCO2 Low 1 to (high limit - 2) mmHg

FiCO2 High 1 to 99 mmHg

Standard Meets the requirements of ISO 80601-2-55: 2018

CO2 Measurement range 0 to 150 mmHg

CO2 absolute accuracy* Full accuracy mode:
0 - 40 mmHg: ±2mmHg
41 - 76 mmHg: ±5% of reading
77 - 99 mmHg: ±10% of reading
100 - 150mmHg: ±(3mmHg + 8% of reading
ISO accuracy mode: Add ±2mmHg to the full accuracy mode

Accuracy specifications are affected by the breath rate and I:E. The EtCO2 accuracy is within specification for breath rate ≤ 
60 rpm and I/E ratio ≤ 1:1, or breath rate ≤ 30 rpm and I/E ratio ≤ 2:1. 

CO2 resolution 1 mmHg

O2 measurement range 0 to 100%

O2 absolute accuracy 0≤O2 concentration≤25%:
25<O2 concentration≤80%:
80<O2 concentration≤100%:

±1%
±2%
±3%

O2 resolution 1%

Accuracy drift Meets the requirements for measurement accuracy within 6 hours

Sample flowrate Using internal CO2 module: 50 ml/min
Using external CO2 module with O2 sensor:
Adult, pediatric: 120 ml/min
Neonatal: 90 ml/min
Using the external CO2 module without O2 sensor: 
Adult, pediatric: 120 ml/min
Neonatal: 70 ml/min, 90 ml/min

Sample flowrate tolerance ±15% or ±15 ml/min, whichever is greater.

Start-up time Maximum: 90 s
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Rise time For CO2 measurements (using external CO2 module without O2 sensor):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤250 ms@70 ml/min.
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤250 ms@90 ml/min.
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤300 ms@120 ml/min 

For CO2 measurements (using external CO2 module with O2 sensor):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤250 ms@90 ml/min.
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤300 ms@120 ml/min 
For CO2 measurements (using internal CO2 module):
Measured with a standard Oridion sampling line:
≤250 ms@50 ml/min 
Measured with a prolonged Oridion sampling line:
≤280 ms@50 ml/min 
For O2 measurements:
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤800 ms@90 ml/min.
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤750 ms@120 ml/min

Response time For CO2 measurements (using external CO2 module without O2 sensor):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤5.0 s @ 70 ml/min 
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤4.5 s @ 90 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤5.0 s @ 120 ml/min
For CO2 measurements (using external CO2 module with O2 sensor):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤4.5 s @ 90 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤5.0 s @ 120 ml/min

For CO2 measurements (using internal CO2 module):
Measured with a standard Oridion sampling line:
≤5.0 s@50 ml/min 
Measured with a prolonged Oridion sampling line:
<6.5 s@50 ml/min

For O2 measurements:
Measured with a DRYLINE II neoonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤4.5 s @ 90 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤5.0 s @ 120 ml/min

awRR measurement range 0 to 150 rpm

awRR measurement precision <60 rpm: ±1 rpm
60 to 150 rpm: ±2 rpm

awRR resolution 1 rpm
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Microstream CO2 Module

Data sample rate 50 Hz

Effect of interference gases on CO2 measurements

Gas Concentration (%) Quantitative effect*

N2O ≤60 ±1 mmHg

Hal ≤4

Sev ≤5

Iso ≤5

Enf ≤5

Des ≤15 ±2 mmHg

*: means an extra error should be added in case of gas interference when CO2 measurements are performed between 0 to 
40mmHg. 

Standard Meets the requirements of ISO 80601-2-55: 2018

CO2 Measurement range 0 to 99 mmHg

Accuracy* 0 to 38 mmHg: 

39 to 99 mmHg:

±2 mmHg

±5% of the reading (0.08% of the reading 
increased in error for every 1 mmHg if the 
reading is more than 38 mmHg)

Accuracy drift Meets the requirements for measurement accuracy within 6 hours

* Accuracy applies for respiration rate up to 80 rpm. For respiration rate above 80 rpm and EtCO2 exceeding 18 mmHg, the 
accuracy is 4 mmHg or ±12% of the reading, whichever is greater. For respiration rate above 60 rpm, the above accuracy 
can be achieved by using the FilterLine H Set for Infant/Neonatal. In the presence of interfering gases, the above accuracy 
is maintained to within 4%.

Resolution 1 mmHg

Sample flow rate 50 (- 7.5/+15) ml/min

Initialization time Maximum 180 s

Response time 4.3 s (with any 2-meter FilterLine)

5.5 s (with any 4-meter FilterLine)

Rise time 190 msec (with any 2-meter FilterLine)

210 msec (with any 4-meter FilterLine)

awRR measurement range 0 to 150 rpm

awRR measurement accuracy 0 to 70 rpm: 

71 to 120 rpm: 

121 to 150 rpm: 

±1 rpm

±2 rpm

±3 rpm

awRR resolution 1 rpm

Data sample rate 40 Hz
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B EMC and Radio Regulatory Compliance

B.1 EMC
The device meets the requirements of IEC 60601-1-2: 2014. 

WARNING

• Use of accessories, transducers and cables other than those specified or provided by the 
manufacturer of this equipment could result in increased electromagnetic emissions or decreased 
electromagnetic immunity of this equipment and result in improper operation.

• The non-ME EQUIPMENT (e.g. information technology equipment (ITE)) that is a part of an ME 
SYSTEM may be disrupted by the electromagnetic interference of nearby equipment. It may be 
necessary to take mitigation measures, such as re-orienting or relocating the non-ME EQUIPMENT or 
shielding the location. 

• Use of this equipment adjacent to, or stacked with, other equipment should be avoided because it 
could result in improper operation. If such use is necessary, this equipment and the other equipment 
should be observed to verify that they are operating normally.

• This equipment is intended for use in professional healthcare facility EMC environment and home 
healthcare EMC environment. If it is used in a special environment, such as a magnetic resonance 
imaging environment, the equipment/system may be disrupted by the operation of nearby 
equipment.

• Portable RF communications equipment (including peripherals such as antenna cables and external 
antennas) should be used no closer than 30 cm (12 inches) to any part of the this device, including 
cables specified by the manufacturer. Otherwise, degradation of the performance of this equipment 
could result.

If the system is operated within the electromagnetic environment listed in Table Guidance and Declaration -
Electromagnetic Immunity, the system will remain safe and provide the following essential performance:

■ Operating mode

Guidance and Declaration - Electromagnetic Emissions

The device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment.

Emission tests Compliance Electromagnetic environment - guidance

Conducted and radiated RF 
EMISSIONS CISPR 11

Group 1 The device uses RF energy only for its internal function. 
Therefore, its RF emissions are very low and are not likely to 
cause any interference in nearby electronic equipment.

Conducted and radiated RF 
EMISSIONS
CISPR 11

Class B The device is suitable for use in all establishments, including 
domestic establishments and those directly connected to the 
public low-voltage power supply network that supplies 
buildings used for domestic purposes.

Conducted and radiated RF 
EMISSIONS
CISPR 11

Class A 
(Used with Dock)

The device is suitable for use in all establishments other than 
domestic and those directly connected to the public low-voltage 
power supply network that supplies buildings used for domestic 
purposes.

Harmonic distortion
IEC 61000-3-2: 2014

Class A The device is suitable for use in all establishments, including 
domestic establishments and those directly connected to the 
public low-voltage power supply network that supplies 
buildings used for domestic purposes.Voltage fluctuations and 

flicker
IEC 61000-3-3: 2013

Complies
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■ Accuracy

■ Function

■ Accessories identification

■ Data stored

■ Alarm

■ Detect for connection

NOTE

• If the essential performance is lost or degraded, it may be necessary to take mitigation measures, 
such as re-orienting or relocating the ME EQUIPMENT or ME SYSTEM or shielding the location. 
During this time, the user should stop using the monitor and contact the service personnel.

• The device needs special precautions regarding EMC and needs to be installed and put into service 
according to the EMC information provided below. 

• Other devices may interfere with this device even though they meet the requirements of CISPR.

• When an input signal is below the minimum amplitude provided in technical specifications, 
erroneous measurements could result.

• The EMISSIONS characteristics of this device make it suitable for use in industrial areas and hospitals 
(CISPR 11 class A). If it is used in a residential environment (for which CISPR 11 class B is normally 
required) this device might not offer adequate protection to radio-frequency communication 
services. The user might need to take mitigation measures, such as relocating or re-orienting the 
device.

Guidance and Declaration - Electromagnetic Immunity 

The device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment. 

Immunity test IEC60601test level Compliance level Electromagnetic environment - guidance

Electrostatic 
discharge (ESD) IEC 
61000-4-2: 2008

±8 kV contact
±15 kV air

±8 kV contact
±15 kV air

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%.

Electrical fast 
transient/burst IEC 
61000-4-4: 2012

±2 kV for power 
supply lines
±1 kV for input/
output lines
(length greater than 3 
m)

±2 kV for power 
supply lines
±1 kV for input/
output lines
(length greater than 3 
m)

Mains power quality should be that of a 
typical commercial or hospital environment.

Surge IEC 61000-4-5: 
2014

±1 kV line(s) to line(s)
±2 kV line(s) to earth

±1 kV line(s) to line(s)
±2 kV line(s) to earth

Voltage dips and 
voltage interruptions
IEC 61000-4-11: 2004

0 % UT for 0.5 cycle: at 
0°, 45°, 90°, 135°, 180°, 
225°, 270° and 315°

0 % UT for 1 cycle and 
70 % UT for 25/30 
cycles: at 0°

0 % UT for 250/300 
cycle

0 % UT for 0.5 cycle: at 
0°, 45°, 90°, 135°, 180°, 
225°, 270° and 315°

0 % UT for 1 cycle and 
70 % UT for 25/30 
cycles: at 0°

0 % UT for 250/300 
cycle

Mains power quality should be that of a 
typical commercial or hospital environment. If 
the user of our product requires continued 
operation during power mains interruptions, 
it is recommended that our product be 
powered from an uninterruptible power 
supply or a battery.

RATED power 
frequency magnetic 
fields
IEC 61000-4-8: 2009

30 A/m
50 Hz/60 Hz

30 A/m
50 Hz/60 Hz

Power frequency magnetic fields should be at 
levels characteristic of a typical location in a 
typical commercial or hospital environment.

Note: UT is the AC mains voltage prior to application of the test level.
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Guidance and Declaration - Electromagnetic Immunity

The device is intended for use in the specified electromagnetic environment. The customer or the user of the device should 
assure that it is used in such an environment as described below.

Immunity test IEC60601 test level Compliance level Electromagnetic environment - guidance

Conducted 
disturbances induced 
by RF fields
IEC61000-4-6: 2013

3 Vrms
150 kHz to 80 MHz

3Vrms Portable and mobile RF communications 
equipment should be used no closer to any 
part of the system, including cables, than the 
recommended separation distance calculated 
from the equation appropriate for the 
frequency of the transmitter. Recommended 
separation distances:

 

6 Vrms
in ISM bands and 
amateur radio bandsa 
between 0.15 MHz 
and 80 MHz

6 Vrms

Radiated RF EM fields
IEC61000-4-3

10 V/m
80 MHz to 2.7 GHz

10 V/m Recommended separation distances:
80 MHz to 800 MHz: 
800MHz - 2.7GHz:  
Where, P is the maximum output power rating 
of the transmitter in watts (W) according to 
the transmitter manufacturer and d is the 
recommended separation distance in meters 
(m)b.
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site 
surveya should be less than the compliance 
level in each frequency rangeb.
Interference may occur in the 
vicinity of equipment marked with 
the following symbol: 

20V/m
80 MHz to 2.5 GHz
(IEC80601-2-30: 2018, 
ISO 80601-2-55: 2018, 
ISO 80601-2-56: 2017, 
ISO 80601-2-61: 2017)

20V/m

Proximity fields from 
RF wireless 
communications 
equipment
IEC61000-4-3: 
2006+A1:2007+A2:20
10

27 V/m
380 - 390 MHz

27 V/m /

28 V/m
430 - 470 MHz,
800 - 960 MHz
1700 - 1900 MHz,
2400 - 2570 MHz

28 V/m

9 V/m
704 - 787 MHz,
5100 - 5800 MHz

9 V/m

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people.

a The ISM (industrial, scientific, and medical) bands between 150 kHz and 80 MHz are 6.765 MHz to 6.795 MHz; 13.553 MHz 
to 13.567 MHz; 26.957 MHz to 27.283 MHz; and 40.66 MHz to 40.70 MHz. The amateur radio bands between 0,15 MHz and 
80 MHz are 1,8 MHz to 2,0 MHz, 3,5 MHz to 4,0 MHz, 5,3 MHz to 5,4 MHz, 7 MHz to 7,3 MHz, 10,1 MHz to 10,15 MHz, 14 MHz 
to 14,2 MHz, 18,07 MHz to 18,17 MHz, 21,0 MHz to 21,4 MHz, 24,89 MHz to 24,99 MHz, 28,0 MHz to 29,7 MHz and 50,0 MHz 
to 54,0 MHz.
b: Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To 
assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. 
If the measured field strength in the location in which the ME EQUIPMENT or ME SYSTEM is used exceeds the applicable 
RF compliance level above, the ME EQUIPMENT or ME SYSTEM should be observed to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as re-orienting or relocating the ME EQUIPMENT or 
ME SYSTEM.
c: Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3V/m. 

d 1.2 P=

d 1.2 P=
d 2.3 P=
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WARNING

• The device is configured with a wireless network connector to receive wireless signal. Other devices 
may interfere with this device even though they meet the requirements of CISPR.

B.2 Radio Regulatory Compliance
This device complies with Part 15 of the FCC Rules and RSS-210 of Industry Canada. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Any changes or modifications to this equipment not expressly approved by Mindray may cause harmful radio 
frequency interference and void your authority to operate this equipment.

The maximum antenna gain permitted complies with the e.i.r.p. limits as stated in RSS-210.

The maximum antenna gain permitted complies with the e.i.r.p. limits specified for point-to-point operation, as 
stated in RSS-210.

WARNING

• Changes or modifications not expressly approved by the party responsible compliance could void 
the user’s authority to operate the equipment.

Recommended separation distances between portable and mobile RF communications equipment and the device

The device is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The 
customer or the user of the device can help prevent electromagnetic interference by maintaining a minimum distance 
between portable and mobile RF communications equipment (transmitters) and the device as recommended below, 
according to the maximum output power of the communications equipment.

Rated maximum 
output power of 
transmitter (W)

Separation distance in meters (m) according to frequency of the transmitter

150 kHz to 80 MHz
 

80 MHz to 800 MHz
 

800 MHz to 2.7 GHz
 

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.20 1.20 2.30

10 3.80 3.80 7.30

100 12.00 12.00 23.00

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres 
(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output 
power rating of the transmitter in Watts (W) according to the transmitter manufacturer.
Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people.

d 1.2 P= d 1.2 P= d 2.3 P=
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C Default Settings

C.1 ECG, Arrhythmia, ST and QT Default Settings

C.1.1 ECG Default Settings

Item Default Setting

HR Alarm switch On

High limit Adult: 120 bpm
Pediatric: 160 bpm
Neonate: 200 bpm

Low limit Adult: 50 bpm
Pediatric: 75 bpm
Neonate: 100 bpm

Priority Med

Alarm Outputs Off

Alarm Source Auto

ECG1 II

ECG2 (5-lead, 6-lead, 12-lead) V (for 5-lead).Va (for 6-lead), V1 (for 12-lead)

Va (for 6-lead only) Va

Vb(for 6-lead only) Vb

ECG Gain ×1

Speed 25 mm/sec

Filter OR: Surgery
CCU: Diagnostic
Other departments: Monitor

Notch Filter On

Lead Set Auto

Smart Lead On

QRS Volume General and OR: 2
Other departments: 0

Baseline Drift Removal (for 12-lead only) On

Waveform Layout (for 12-lead only) Standard

QRS Threshold 0.16 mV

Paced Adult: Unspecified
Pediatric/neonate: No

Pacer Reject Off
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C.1.2 Arrhythmia Default Settings

C.1.2.1 Arrhythmia Alarm Default Settings

Item Alarm Switch Priority Alarm Outputs

Asystole On High, unadjustable Off

V-Fib/V-Tach On High, unadjustable Off

V-Tach On High, unadjustable Off

Vent Brady On High, unadjustable Off

Extreme Tachy On High, unadjustable Off

Extreme Brady On High, unadjustable Off

R on T CCU: On
Other departments: Off

Med Off

Run PVCs Off Low Off

Couplet Off Prompt Off

Multiform PVC Off Med Off

PVC Off Prompt Off

Bigeminy CCU: On
Other departments: Off

Med Off

Trigeminy CCU: On
Other departments: Off

Med Off

Tachy Off Med Off

Brady Off Med Off

Pacer Not Capture Off Prompt Off

Pacer Not Pacing Off Prompt Off

Missed Beat Off Prompt Off

Nonsus V-Tach CCU: On
Other departments: Off

Med Off

Vent Rhythm CCU: On
Other departments: Off

Med Off

Pause Off Low Off

Irr Rhythm Off Prompt Off

A-Fib Off Prompt Off

PVCs/min CCU: On
Other departments: Off

Med Off

Pauses/min CCU: On
Other departments: Off

Med Off
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C.1.2.2 Arrhythmia Threshold Default Settings 

C.1.3 ST Default Settings

Item Default Setting

Adult Pediatric

Asystole Delay 5 sec 5 sec

Tachy 120 bpm 160 bpm

Brady 50 bpm 75 bpm 

Extreme Tachy 160 bpm 180 bpm

Extreme Brady 35 bpm 50 bpm

Multif PVCs Window 15 beats 15 beats

PVCs/min 10 10

Pauses/min 8 8

Pause Threshold 2.0 sec 2.0 sec

AF/Irr Rhy End Time 2 min 2 min

V-Tach Rate 130 bpm 130 bpm

V-Brady Rate 40 bpm 40 bpm

V-Tach PVCs 6 6

V-Brady PVCs 5 5

Item Default Setting

ST Alarm Mode Absolute

ST Alarm Mode set to Absolute:
ST-I, ST-II, ST-III, ST-aVR, ST-aVL, ST-aVF, ST-V1, ST-
V2, ST-V3, ST-V4, ST-V5,ST-V6, ST-Va, ST-Vb

Alarm switch Off

High limit 0.2 mV

Low limit -0.2 mV

Priority Med

Alarm Outputs Off

ST Alarm Mode set to Relative:
ST Single,
ST Dual

Alarm switch Off

High limit 0.1 mV

Low limit -0.1 mV

Priority Med

Alarm Outputs Off

ST Analysis Off

ST Segment Auto

Show Marker Off

ST Point J+60

Auto Adjust On

J 48

ISO -80
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C.1.4 QT Default Settings

C.1.5 Glasgow 12-lead ECG Algorithm Default Settings

C.2 Respiration Default Settings

Item Default Setting

QTc Alarm switch Off

High limit Adult: 500
Pediatric: 480
Neonate: 460

Priority Med

Alarm Outputs Off

ΔQTc Alarm switch Off

High limit 60

Priority Med

Alarm Outputs Off

QT Analysis Off

QT Lead All

Item Default Setting

High Freq Cut-off 35 Hz

Baseline Drift Removal On

Tachy 100

Brady 50

Waveform Layout Standard

Median Complex Off

Measurements On

Interpretation On

Interpretation Summary On

Item Default Setting

RR Alarm switch On

High limit Adult: 30
Pediatric: 30
Neonate: 100 

Low limit Adult: 8
Pediatric: 8
Neonate: 30 

Priority Med

Alarm Outputs Off

Apnea Alarm switch On

Priority High, unadjustable

Alarm Outputs Off
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C.3 SpO2 Default Settings

Apnea Delay Adult: 20 sec
Pediatric: 20 sec
Neonate: 15 sec

RR Source Auto

Resp Lead Adult: Auto
Pediatric: Auto
Neonate: II

Gain ×2

Speed 6.25 mm/s

Auto Threshold Detection On

Item Default Setting

Item Default Setting

SpO2 Alarm switch On

High limit Adult: 100%
Pediatric: 100%
Neonate: 95%

Low limit 90%

Priority Med

Alarm Outputs Off

SpO2 Desat Alarm switch On

Low limit 80%

Priority High

Alarm Outputs Off

Satsecond (for Nellcor SpO2) Off

NIBP Simul Off

FastSAT (for Masimo SpO2) Off

Display SIQ (for Masimo SpO2) Off

Display PI (for Masimo SpO2) On

Speed 25 mm/s
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C.4 Temperature Default Settings

C.5 NIBP Default Settings

PR Alarm switch On

High limit Adult: 120
Pediatric: 160 
Neonate: 200

Low limit Adult: 50
Pediatric: 75  
Neonate: 100

Priority Med

Alarm Outputs Off

Alarm Source Auto

PR Source Auto

Display PR On

QRS Volume General, OR: 2
Other departments: 0

Item Default Setting

Item Default Setting

Txx
(xx refers to 
temperature site)

Alarm switch On

High limit 38.0 °C

Low limit 35.0 °C

Priority Med

Alarm Outputs Off

ΔT Alarm switch On

High limit 2.0 °C

Priority Med

Alarm Outputs Off

Item Default Setting

NIBP-S Alarm switch On

High limit Adult: 160 mmHg 
Pediatric: 120 mmHg
Neonate: 90 mmHg

Low limit Adult: 90 mmHg 
Pediatric: 70 mmHg
Neonate: 40 mmHg

Priority Med

Alarm Outputs Off
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NIBP-D Alarm switch On

High limit Adult: 90 mmHg 
Pediatric: 70 mmHg
Neonate: 60 mmHg

Low limit Adult: 50 mmHg 
Pediatric: 40 mmHg
Neonate: 20 mmHg

Priority Med

Alarm Outputs Off

NIBP-M Alarm switch On

High limit Adult: 110 mmHg 
Pediatric: 90 mmHg
Neonate: 70 mmHg

Low limit Adult: 60 mmHg 
Pediatric: 50 mmHg
Neonate: 25 mmHg

Priority Med

Alarm Outputs Off

NIBP-S Extreme Alarm switch Off

High limit Adult: 175 mmHg 
Pediatric: 130 mmHg
Neonate: 95 mmHg

Low limit Adult: 75 mmHg 
Pediatric: 60 mmHg
Neonate: 35 mmHg

Priority High

Alarm Outputs Off

NIBP-D Extreme Alarm switch Off

High limit Adult: 105 mmHg 
Pediatric: 80 mmHg
Neonate: 65 mmHg

Low limit Adult: 35 mmHg 
Pediatric: 30 mmHg
Neonate: 15 mmHg

Priority High

Alarm Outputs Off

NIBP-M Extreme Alarm switch Off

High limit Adult: 125 mmHg 
Pediatric: 100 mmHg
Neonate: 75 mmHg

Low limit Adult: 45 mmHg 
Pediatric: 40 mmHg
Neonate: 20 mmHg

Priority High

Alarm Outputs Off

Item Default Setting
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C.6 IBP Default Settings
 

Initial Pressure Adult: 160 mmHg 
Pediatric: 140 mmHg
Neonate: 90 mmHg

Interval OR: 5 min
Neonatology: 30 min
Other departments: 15 min

Start Mode Clock

NIBP End Tone Off

Venipuncture Pressure Auto

Display Format Sys/Dia (Mean)

Display Alarm Limits Off

Display PR Off

Item Default Setting

Item Default Setting

IBP-S Alarm switch On

High limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

           Adult: 160 mmHg 
            Pediatric: 120 mmHg 

            Neonate: 90 mmHg 

■ PA

            Adult: 35 mmHg 
             Pediatric and neonate: 60 mmHg 

Low limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 90 mmHg 
            Pediatric: 70 mmHg 
            Neonate: 55 mmHg 
■ PA

            Adult: 10 mmHg 
            Pediatric and neonate: 24 mmHg 

Priority Med

Alarm Outputs Off
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IBP-D Alarm switch On

High limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 90 mmHg 
            Pediatric: 70 mmHg 
            Neonate: 60 mmHg 
■ PA

            Adult: 16 mmHg 
            Pediatric and neonate: 4 mmHg 

Low limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 50 mmHg 
            Pediatric: 40 mmHg 
            Neonate: 20 mmHg 
■ PA

            Adult: 0 mmHg 
            Pediatric and neonate: -4 mmHg 

Priority Med

Alarm Outputs Off

IBP-M Alarm switch On

High limit ■ Art/pArt/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 110 mmHg 
            Pediatric: 90 mmHg 
            Neonate: 70 mmHg 
■ PA

            Adult: 20 mmHg 
            Pediatric and neonate: 26 mmHg 
■ CVP

            Adult: 14 cmH2O 
            Pediatric and neonate: 5 cmH2O 
■ ICP/RAP/LAP/UVP/P3-P4 venous pressure

            Adult: 10 mmHg 
            Pediatric and neonate: 4 mmHg 

Low limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 70 mmHg 
            Pediatric: 50 mmHg 
            Neonate: 35 mmHg 
■ PA

            Adult: 0 mmHg 
            Pediatric and neonate: 12 mmHg 
■ CVP

            Adult: 0 cmH2O
            Pediatric and neonate: 0 cmH2O
■ ICP/RAP/LAP/UVP/P3-P4 venous pressure

            Adult: 0 mmHg 
            Pediatric and neonate: 0 mmHg 

Priority Med

Alarm Outputs Off

Item Default Setting
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Art-S Extreme Alarm switch Off

High limit Adult: 175 mmHg 
Pediatric: 130 mmHg 
Neonate: 95 mmHg 

Low limit Adult: 75 mmHg 
Pediatric: 60 mmHg 
Neonate: 50 mmHg 

Priority High

Alarm Outputs Off

Art-D Extreme Alarm switch Off

High limit Adult: 105 mmHg 
Pediatric: 80 mmHg 
Neonate: 65 mmHg

Low limit Adult: 35mmHg 
Pediatric: 30 mmHg 
Neonate: 15 mmHg 

Priority High

Alarm Outputs Off

Art-M Extreme Alarm switch Off

High limit Adult: 125 mmHg 
Pediatric: 100 mmHg 
Neonate: 75 mmHg

Low limit Adult: 55 mmHg 
Pediatric: 40 mmHg 
Neonate: 30 mmHg 

Priority High

Alarm Outputs Off

CPP Alarm switch On

High limit Adult: 130 mmHg 
Pediatric: 100 mmHg 

Neonate: 90 mmHg 

Low limit Adult: 50 mmHg 
Pediatric: 40 mmHg 
Neonate: 30 mmHg 

Priority Med

Alarm Outputs Off

Measure (for P1, P2) All

Measure (for P3, P4) Mean Only

Sensitivity Med

Speed 25 mm/sec

Item Default Setting
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C.7 CO2 Default Settings

C.7.1 General Settings

Scale ICP/RAP/LAP/UVP 
venous pressure

0- 20 mmHg

Art/Ao/BAP/FAP/LV/P1/
P2 arterial pressure 

0-160 mmHg

UAP/P3/P4 venous 
pressure

0-80 mmHg

CVP/PA CVP: 0-30 cmH2O
PA: 0 - 30 mmHg

Display Format Sys/Dia (Mean)

Display Alarm Limits Off

Use PA-D as PAWP (only available for 
independent external display)

Off

PPV Measure Off

PPV Source Auto

PAWP Reference Waveform 1 II

Reference Waveform 2 Resp

Speed 12.5 mm/sec

PA Scale 0-30 mmHg

Overlapping 
Waveform Setup

Left Scale 0-160 mmHg

Right Scale 0-20 mmHg

CVP Scale 0-30 cmH2O

ICP Scale 0-20 mmHg

PA Scale 0-30 mmHg

Speed 25 mm/sec

Gridlines Off

Item Default Setting

Item Default Setting

EtCO2 Alarm switch On

High limit Adult and pediatric: 50 mmHg
Neonate: 45 mmHg

Low limit Adult and pediatric: 25mmHg
Neonate: 30mmHg 

Priority Med

Alarm Outputs Off
BeneVision N1 Patient Monitor Operator’s Manual C - 11



C.7.2 Sidestream CO2 Default Settings

C.7.3 Microstream CO2 Default Settings

FiCO2 Alarm switch On

High limit 4 mmHg

Priority Med

Alarm Outputs Off

Apnea Delay Adult and pediatric: 20 s 
Neonate: 15 s 

RR Source Auto

Speed 6.25 mm/s

Scale 50 mmHg

Waveform Type Draw

Item Default Setting

Item Default Setting

EtO2 Alarm switch On

High limit 88%

Low limit 18%

Priority Med

Alarm Outputs Off

FiO2 Alarm switch On

High limit Adult and pediatric: 100% 
Neonate: 90% 

Low limit 18%

Priority Med

Alarm Outputs Off

BTPS Compensation Off

O2 Compensation (for CO2 module without 
O2 measurement)

OR: 100%
Other departments: 21% 

N2O Compenation 0%

AG Compenation 0%

Auto Standby 60 min

Operating Mode Measure

Item Default Setting

BTPS Compen Off

Maximum Hold 20 sec

Auto Standby Off

Operating Mode Measure
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C.8 Alarm Default Settings

C.9 Display Default Settings

Item Default Setting

Alarm Volume 2

High Alarm Volume Alarm Volume + 2

Reminder Volume 2

Apnea Delay Adult/Pediatric: 20 sec
Neonate: 15 sec

Printing Duration on Alarm 20 sec

Auto Limits for New Patient On

Item Default Setting

Choose Screen Normal Screen

Display Screen Lock Duration 
(Only Available for the 
Independent External 
Display)

General: Permanent
CCU: Permanent
Other departments: 10 sec

Brightness 5

Key Volume 2

Night Mode Brightness 1

Alarm Volume 2

QRS Volume 1

Key Volume 0

NIBP End Tone Off

Stop NIBP Off
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D Alarm Messages

This chapter lists only the physiological and technical alarm messages. Some messages appearing on your 
monitor may not be included. In the “Cause and solution” column, corresponding solutions are given instructing 
you to troubleshoot problems. If the problem persists, contact your service personnel.

D.1 Physiological Alarm Messages 

D.1.1 General Physiological Alarm Messages

Note: XX represents a measurement or parameter label, such as HR, NIBP, PVCs, RR, SpO2, PR, etc.

D.1.2 Arrhythmia Alarm Messages

Alarm messages Default priority Cause and solution

XX High Med XX value has risen above the high alarm limit or fallen below the low 
alarm limit. Check the patient’s condition and check if the patient 
category and alarm limit settings are correct.XX Low Med

Alarm message Default priority

Asystole High

V-Fib/V-Tach High

V-Tach High

Vent Brady High

Extreme Tachy High

Extreme Brady High

R on T Med

Run PVCs Low

Couplet Prompt

Multiform PVC Med

PVC Prompt

Bigeminy Med

Trigeminy Med

Tachy Med

Brady Med

Pacer Not Pacing Prompt

Pacer Not Capture Prompt

Missed Beats Prompt

Nonsus. Vtac Med

Vent Rhythm Med

Pause Low
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Note: When arrhythmia alarms occur, check the patient’s condition and the ECG connections.

D.1.3 Resp Physiological Alarm Messages

D.1.4 SpO2 Physiological Alarm Messages

D.1.5 PR Physiological Alarm Messages

D.1.6 NIBP Physiological Alarm Messages

D.1.7 IBP Physiological Alarm Messages

Irr Rhythm Prompt

PVCs/min Med

Pauses/min Med

A-Fib Prompt

Alarm message Default priority

Alarm message Default priority Cause and solution

Resp Artifact High The patient’s heartbeat has interfered with the impedance respiration 
measurement. Check the patient’s condition and the ECG connections.

Apnea High The respiration signal is so weak that the monitor cannot perform 
respiration analysis. Check the patient’s condition, module and patient 
connections.

Alarm message Default priority Cause and solution

SpO2 Desat High The SpO2 value falls below the desaturation alarm limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

Alarm message Default priority Cause and solution

No Pulse High The pulse signal is so weak that the monitor cannot perform pulse 
analysis. Check the patient’s condition and the source of the PR, such as 
IBP or SpO2 sensor, and measurement site. 

Alarm message Default priority Cause and solution

NIBP-S Extremely 
High/NIBP-D 
Extremely High/NIBP-
M Extremely High

High The NIBP value is higher than the NIBP Extreme alarm high limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

NIBP-S Extremely 
High/NIBP-D 
Extremely High/NIBP-
M Extremely Low

High The NIBP value is lower than the NIBP Extreme alarm low limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

Alarm message Default priority Cause and solution

Art-S/Art-D/Art-M 
Extremely High

High The Art value is higher than the Art Extreme alarm high limit. Check the 
patient’s condition and check if the alarm limit settings are correct.
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D.1.8 CO2 Physiological Alarm Messages

D.2 Technical Alarm Messages
This section lists technical alarms, their default priority, responses on alarm reset, and the actions that can be 
taken when an alarm occurs. Some of alarms may not be included.

Various technical alarms respond differently when the alarm system is reset. For easy clarification, in this section 
the technical alarms are classified into three categories of response when the alarm system is reset:

■ A: technical alarms are cleared. The monitor gives no alarm indications.

■ B: technical alarms are changed to the prompt messages.

■ C: the alarm is silenced and a √ appears before the alarm message. 

In the following tables A, B, and C are used to refer to the responses on alarm reset.

D.2.1 General Technical Alarm Messages

Note: XX represents a measurement or parameter label, such as HR, RR, SpO2, or EtCO2, etc.

D.2.2 ECG Technical Alarm Messages

Art-S/Art-D/Art-M 
Extremely Low

High The Art value is lower than the Art Extreme alarm low limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

Alarm message Default priority Cause and solution

Alarm message Default priority Cause and solution

FiO2 Shortage High FiO2 concentration is less than 18%. Check the patient’s condition, the 
ventilated O2 content and the airway connection.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

XX Module Error High C XX module does not work properly. Reinsert the 
module, if the alarm persists, contact your service 
personnel.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

ECG Noisy Low/Prompt A The ECG signal is noisy. Check for any possible 
sources of signal noise around the cable and 
electrode, and check the patient for excessive 
motion.

ECG Amplitude Too Small Low C The ECG amplitude does not reach the detected 
threshold. Check for any possible source of 
interference around the cable and electrode.

ECG (XX) Lead Off Low B The electrode has become detached from the 
patient or the lead wire has become 
disconnected from the adapter cable. Check the 
connections of the electrodes and leadwires.

ECG Signal Invalid Low A Patient skin impedance is too high. Check ECG 
electrode application. 

ECG Learning Prompt / ECG learning is manually or automatically 
triggered.
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Note: XX represents ECG lead name, for example RL, LL, V, Va, Vb, etc.

D.2.3 Resp Technical Alarm Messages

D.2.4 SpO2 Technical Alarm Messages

Cannot Analyze QT Prompt / /

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Resp Interference Prompt / The respiration circuit is disturbed. Check for any 
possible sources of signal noise.

Electrode Poor Contact Prompt / Check the electrode application. Reposition or 
replace the electrodes if necessary.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

SpO2 Sensor Off Sensor 
Off

Low B The SpO2 sensor has become detached from the 
patient or the module. Check the sensor 
connection. If the alarm persists, replace the 
sensor.

SpO2 No Sensor No 
Sensor

Low A The SpO2 extension cable is detached from the 
SpO2 module, or the SpO2 sensor is detached 
from the SpO2 extension cable. Check the SpO2 
cable and the sensor connection. If the alarm 
persists, replace the sensor.

SpO2 Excess Light Low C Ambient light is too strong. Move the sensor to a 
place with lower level of ambient light or cover 
the sensor to minimize the ambient light.

SpO2 No Pulse Low C The SpO2 sensor failed to obtain pulse signal. 
Check the patient’s condition and replace the 
sensor application site. If the alarm persists, 
replace the sensor.

SpO2 Sensor 
Incompatible

Low C Incompatible or an unspecified SpO2 sensor is 
used. Use specified sensors.

SpO2 Low Signal Quality Low C 1. Check the sensor and sensor position.
2. Make sure the patient is not shivering or 
moving.
3. The patient’s pulse may be too low to be 
measured.

SpO2 Interference Low C The SpO2 signal has interference. Check for any 
possible sources of signal noise and check the 
patient for excessive motion.

SpO2 Sensor Error Low C Replace the sensor and measure again.

SpO2 Searching Pulse Prompt / SpO2 is searching for pulse.

SpO2 Low Perfusion Prompt / The SpO2 sensor is not properly placed or the 
patient’s perfusion index is too low.
1. Check the sensor and sensor position.
2. Reposition the sensor if necessary.
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D.2.5 Temp Technical Alarm Messages

D.2.6 NIBP Technical Alarm Messages

D.2.7 IBP Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

T1/T2 Sensor Off Low A Check the sensor connection and reconnect the 
sensor.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

NIBP Loose Cuff Low A There is a leak in the cuff or air tubing. Use a cuff 
of correct type based on the patient size. Apply 
the cuff and connect the air tubing as instructed 
in the manual.

NIBP Air Leak Low A Check the NIBP cuff and pump for leakages.

NIBP Airway Error Low A The air tubing may be occluded. Check the air 
tubing for an occlusion or kinking. If the alarm 
persists, contact your service personnel.

NIBP Weak Signal Low A The patient’s pulse is weak or the cuff is loose. 
Check the patient’s condition and replace the cuff 
application site. 

NIBP Overrange Low A The measured NIBP value exceeds the module 
measurement range. Check the patient’s 
condition.

NIBP Excessive Motion Low A Check the patient’s condition and reduce patient 
motion.

NIBP Cuff Overpress Low A The NIBP airway may be occluded. Check the 
airway and measure again. If the alarm persists, 
contact your service personnel.

NIBP Timeout Low A The measurement time exceeds 120 seconds in 
the adult or pediatric mode, or exceeds 90 
seconds in the neonatal mode, and the BP value 
cannot be obtained. Check the patient’s 
condition and NIBP connections, or replace the 
cuff and measure again.

NIBP Cuff and Patient 
Mismatch

Low A The cuff type mismatches the patient category. 
Verify the patient category or replace the cuff if 
necessary. If patient category is correct, check 
that the tubing is not bent and the airway is not 
occluded.

NIBP Airway Leak Low A Airway leakage is found during the NIBP leakage 
test. Check the NIBP cuff and pump for leakages.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

XX Sensor Error Med C The IBP sensor fails. Replace the sensor.

XX No Sensor Med A The IBP patient cable and/or corresponding IBP 
sensor is not connected or detached. Check the 
cable and sensor connection.
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Note: XX represents an IBP label, for example PA, CVP, FAP, P1, etc.

D.2.8 CO2 Technical Alarm Messages

XX No Pulse Low A The catheter may be occluded. Please flush the 
catheter.

XX Disconnected High C The tubing is disconnected from the patient, or 
the three-way valve is open to the air. Check the 
connection of the tubing, or check the valve is 
open to the patient. If the alarm persists, contact 
your service personnel.

Host Monitor Version Low Low A The N Series system software version is too low. 
In order for the N Series monitor to connect to 
the N1 which connects to the external IBP 
module and perform IBP monitoring, the system 
software of N 1 and N series monitor should be 
V01.62.00 and above.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

CO2 Module High Temp Low C Ambient temperature is too high or there is a 
module failure.
1. Lower the operating temperature.
2. Reinsert the module.
3. If the alarm persists, the CO2 module may have
failed, contact your service personnel.

CO2 Module Low Temp Low C Ambient temperature is too low or there is a 
module failure.
1. Raise the operating temperature.
2. Reinsert the module.
3. If the alarm persists, the CO2 module may have
failed, contact your service personnel.

CO2 Zero Failed Low C Reinsert the module. If the alarm persists, contact 
your service personnel.

CO2 No Watertrap Low B Check the watertrap connections.

CO2 No Adaptor Low B Check the adaptor connections.

CO2 High Airway Press. Low C 1. Check the airway pressure settings of the 
ventilator/anesthesia machine.
2. Disconnect the module from the ventilator/
anesthesia machine.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

CO2 Low Airway Press. Low C 1. Check the airway pressure settings of the 
ventilator/anesthesia machine.
2. Disconnect the module from the ventilator/
anesthesia machine.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.
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D.2.9 Power Supply Technical Alarm Messages

High Barometric Low C The ambient pressure exceeds the operating 
pressure range or CO2 module fails.
1. Make sure that the ambient pressure meets the 
specifications, and check for sources that affect 
the ambient pressure.
2. Reinsert the module. If the alarm persists, 
contact your service personnel.

Low Barometric Low C The ambient pressure exceeds the operating 
pressure range or CO2 module fails.
1. Make sure that the ambient pressure meets the 
specifications, and check for sources that affect 
the ambient pressure.
2. Reinsert the module. If the alarm persists, 
contact your service personnel.

CO2 Airway Occluded Low C 1. Check if the sample line is kinked or occluded.
2. Replace the sample line.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

CO2 No Filterline Low A Make sure that the filterline is connected.

CO2 Calibration Required Low C Perform a calibration.

CO2 Airway Error Low C 1. Check if the sample line is kinked or occluded.
2. Replace the sample line.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

CO2 Adapter Error Low A Check, clean or replace the airway adapter. 
Perform a zero calibration.

CO2 No Sensor Low A Make sure that the CO2 transducer is connected.

CO2: Change Watertrap Low C Replace the watertrap.

CO2 Watertrap Mismatch Low C Check the patient category and use a correct 
watertrap.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Low Battery Med C Connect the monitor to an AC power source and 
allow the batteries to charge.

Critically Low Battery High C Connect the monitor to an AC power source and 
allow the batteries to charge.

Battery Service Required Low B The battery has reached its lifetime. Contact the 
service personnel.

Power Board Comm Error High C Shutdown and restart the monitor. If the alarm 
persists, contact your service personnel.

Battery Err High C The battery may have failed. Contact your service 
personnel.

Battery Charging Error High C The charging circuit fails or the battery fails. 
Contact your service personnel.
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Note: XX represents 2.5, 3.3, 5, or 12.

D.2.10 Printer Technical Alarm Messages

D.2.11 Technical Alarm Messages Related to Networked Monitoring

Battery Temperature Too 
High

High C Stop using the monitor after this alarm appears, 
and contact your service personnel.

Battery Off High C Shutdown and restart the monitor. If the alarm 
persists, contact your service personnel.

RT Clock Need Reset High C Contact your service personnel.

RT Clock Not Exist High C Contact your service personnel.

XX V Too High High C There is a problem with the system power supply. 
Shutdown and restart the monitor.

XX V Too Low High C

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Printer Buffer Full Prompt / The printer buffer is full. Wait until the printer 
finishes the printing task.

Printing Failed Prompt / The printer ran out of paper or cannot be found 
on the network. Check the printer.

Printing Stopped Prompt / Printing was manually stopped.

Printer Unavailable Prompt / The printer may have failed. Check the printer.

PDF storage space is 
nearly full

Prompt / Delete the files saved under the PDF file path to 
release storage space. Otherwise you cannot save 
new PDF files.

Error storing PDF file Prompt / The PDF file path settings on the print server and 
the PDF Creator are not consistent or the PDF 
storage space is full. Check the PDF file path 
settings for consistency, or delete the files saved 
under the PDF file path to release storage space. 

Change the print server 
language to be consistent 
with this monitor

Prompt / Verify that the language settings of the print 
server and the monitor are consistent, Otherwise 
you cannot perform printing.

Print Server Disconnected Prompt / Check that the monitor is properly connected 
with the print server.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

CMS/eGW Disconnected Low B The monitor is disconnected from the CMS. 
Check the network connection.

View Bed XX YY-ZZ, 
Network Disconnected.

Low A The network is interrupted when the monitor is 
viewing the remote device. Check the network 
connection.

Viewed by Bed XX YY-ZZ, 
Network Disconnected.

Low A The network is interrupted when the monitor is 
viewed by another remote device. Check the 
network connection.

WLAN IP Address Conflict Low C There is a wireless network IP address conflicts. 
Check the network settings.
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Note: XX refers to the department name, YY refers to the room number, and ZZ refers to the bed number.

D.2.12 Other System Technical Alarm Messages

LAN1 IP Address Conflict Low C There is a wired network IP address conflicts. 
Check the network settings.

Fail To Get WLAN IP 
Address

Low C Unable to automatically obtain the wireless 
network IP address. Check the network settings.

Fail To Get LAN1 IP 
Address

Low C Unable to automatically obtain the wired 
network IP address. Check the network settings.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Storage Error High C The storage card failed or files are damaged. 
Shutdown and restart the monitor.  Format the 
storage card (CAUTION: this will clear all patient 
data stored on this monitor). If the alarm persists, 
contact your service personnel.

Loading Default Config 
Failed

Low A The default configuration was not correctly 
loaded. The monitor will restore to the factory 
default configuration for the current patient 
category.

Read dock E2PROM error! High C 1. Check if you’re using the specified external 
display.

• If you’re using the specified external display, 
remove the N1 from the Dock, and reconnect 
the N1 and the Dock.

• If you’re not using the specified external 
display, replace current external display with 
the specified external display. Then remove 
the N1 from the Dock, and reconnect the N1 
and the Dock.

2. If the alarm persists, contact your service 
personnel.

XX Conflicts
(XX refers to the module 
label)

Prompt / The same type of corresponding module being 
used exceeds the supported number. Remove 
the conflict module. 

XX Measurement has 
been closed
(XX refers to the module 
label)

Prompt / The parameter module is disabled. Switch on the 
module if you want to use it. For more 
information, see 3.9.1 Switching On or Off a 
Parameter.

The display setup for XX is 
disabled.
(XX refers to the 
parameter label)

Prompt / The parameter of the newly inserted module is 
not displayed on the screen. Select a desired area 
to display the parameter numerics and 
waveforms. For more information, see 
3.9.2 Displaying Parameter Numerics and 
Waveforms.

The patient data storage 
space is nearly full. Please 
delete some discharged 
patients.

Med B The storage space of the monitor is full. Delete 
unnecessary discharged patients.
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E SpO2 Sensor Accuracy

E.1 The Accuracy of Masimo SpO2 Sensors

Table information for the plots below show ARMS values measured with Masimo SET Oximetry Technology in a 
clinical study.

Adtx/Pdtx/4000/4001

Inf/Neo/NeoPt/4002/4003/4004/4005
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DCI/DCIP/4050/4051

LNCS YI

4053
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E.2 The Accuracy of Nellcor SpO2 Sensors

SpO2 Accuracy for Nellcor Sensors vs. Co-Oximeters (Arms)

Modified Bland-Altman for SpO2 - MAXAI, MAXPI, MAXII, MAXNI Sensors: (SpO2 - SaO2) 
vs.SaO2

Modified Bland-Altman for SpO2 - DS-100A Sensors: (SpO2 - SaO2) vs.SaO2

SpO2 Range 100% to 70% 100% to 90% 90% to 80% 80% to 70%

DS-100A 1.64% 1.16% 1.67% 2.25%

D-YS, OXI-P/I, OXI-A/N 2.41% 1.38% 2.50% 3.60%

MAXAI, MAXPI, MAXII 1.62% 1.49% 1.57% 2.50%

MAXNI 1.85% 1.71% 1.51% 1.59%
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Modified Bland-Altman for SpO2 - D-YS, OXI-A/N, OXI-P/I Sensors: (SpO2 - SaO2) vs.SaO2
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F Units, Symbols and Abbreviations

F.1 Units 

Abbreviation In Full

μA microampere

μV microvolt

μs microsecond

A Ampere

Ah Ampere hour

bpm beat per minute

bps bits per second

°C Celsius

cc cubic centimeter

cm centimeter

dB decibel

DS dyne second

°F Fahrenheit

g gram

GHz gigahertz

GTT gutta

h hour

Hz hertz

in inch

k kilo

kg kilogram

kPa kilopascal

L litre

lb pound

m meter

mAh milliampere hour

Mb mega byte

mcg microgram

mEq milli-equivalents

mg milligram

min minute

ml milliliter

mm millimeter
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F.2 Symbols

mmHg millimeters of mercury

cmH2O centimeters of water

ms millisecond

mV millivolt

mW milliwatt

MΩ megaohm

nm nanometer

rpm breaths per minute

s second

V volt

VA volt ampere

Ω ohm

W watt

Abbreviation In Full

Symbol Explanation

– negative, minus

% percent

/ per; divide; or

～ to

＋ plus

＝ equal to

＜ less than

＞ greater than

≤ less than or equal to

≥ greater than or equal to

± plus or minus

× multiply

© copyright
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F.3 Abbreviations

Abbreviation In Full

AaDO2 alveolar-arterial oxygen gradient

AC alternating current

Adu adult

AG anaesthesia gas

AHA American Heart Association

Ao aortic pressure

Art arterial

ATMP barometric pressure

aVF left foot augmented lead

aVL left arm augmented lead

aVR right arm augmented lead

awRR airway respiratory rate

BAP brachial arterial pressure

BSA body surface area

BT blood temperature

BTPS body temperature and pressure, saturated

CAA Clinical Assistive Application

CaO2 arterial oxygen content

CCI continuous cardiac index

CCO continuous cardiac output

CCU cardiac (coronary) care unit

CE Conformité Européenne

CFI cardiac function index

C.I. cardiac index

CIS clinical information system

CISPR International Special Committee on Radio Interference

CMOS complementary metal oxide semiconductor

CMS central monitoring system

C.O. cardiac output

CO2 carbon dioxide

COHb carboxyhemoglobin

Compl compliance

CPI cardiac power index

CPO cardiac power output

CVP central venous pressure

DC direct current

Des desflurane
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Dia diastolic

dpi dot per inch

dPmx left ventricular contractility

DVI digital video interface

DO2 oxygen delivery

DO2I oxygen delivery index

ECG electrocardiograph

EDV end-diastolic volume

EEC European Economic Community 

EEG electroencephalogram

EMC electromagnetic compatibility

EMG electromyograph

EMI electromagnetic interference

Enf enflurane

ESV end systolic volume

ESVI end systolic volume index

ESU electrosurgical unit

Et end-tidal

EtAA end-tidal anesthetic agent

EtDes end-tidal anesthetic agent

EtEnf

EtHal 

EtIso

EtSev

EtCO2 end-tidal carbon dioxide

EtN2O end-tidal nitrous oxide

EtO ethylene oxide

EtO2 end-tidal oxygen

EVLW extravascular lung water

ELWI extravascular lung water index

EWS Early Warning Score

FAP femoral arterial pressure

FCC Federal Communication Commission

FDA Food and Drug Administration

Fi fraction of inspired

FiAA inspired anesthetic agent

Abbreviation In Full
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FiDes inspired anesthetic agent

FiEnf

FiHal 

FiIso

FiSev

FiCO2 fraction of inspired carbon oxygen

FiN2O fraction of inspired nitrous oxide

FiO2 fraction of inspired oxygen

FPGA field programmable gate array

FV flow-volume

GCS Glasgow Coma Scale

GEDV global end diastolic volume

GEDI global end diastolic volume index

GEF global ejection fraction

Hal halothane

Hb hemoglobin

Hct haematocrit

HIS hospital information system

HR heart rate

IBP invasive blood pressure

IBW ideal body weight

ICP intracranial pressure

ICT/B intracranial catheter tip pressure transducer

ICU intensive care unit

ID identification

I:E inspiratory time: expiratory time ratio

IEC International Electrotechnical Commission 

IEEE Institute of Electrical and Electronic Engineers

IP internet protocol

Iso isoflurane

ITBI intrathoracic blood volume index

ITBV intrathoracic blood volume

LA left arm

LAP left atrial pressure

LCD liquid crystal display

LCW left cardiac work

LCWI left cardiac work index

LDAP Lightweight Directory Access Protocol

LED light emitting diode

Abbreviation In Full
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LL left leg

LVET left ventricular ejection time

LVSW left ventricular stroke work

LVSWI left ventricular stroke work index

MAC minimum alveolar concentration

MAP mean arterial pressure

Mb myoglobin

MetHb methemoglobin

MEWS Modified Early Warning Score

MLDAP Mindray LDAP, Mindray lightweight directory access protocol

MRI magnetic resonance imaging

MV minute volume

MVe expiratory minute volume

MVi inspiratory minute volume

N/A not applied

N2 nitrogen

N2O nitrous oxide

Neo neonate

NEWS National Early Warning Score

NIBP noninvasive blood pressure

NIF negative inspiratory force

O2 oxygen

O2% oxygen concentration

OR operating room

OxyCRG oxygen cardio-respirogram

PA pulmonary artery

Paw airway pressure

PAWP pulmonary artery wedge pressure

Ped pediatric

PEEP positive end expiratory pressure

PEF peak expiratory flow

PEP pre-ejection period

PIF peak inspiratory flow

PIP peak inspiratory pressure

Pleth plethysmogram

Pmean mean pressure

PO2 oxygen supply pressure

Pplat plateau pressure

PPV pulse pressure variation

Abbreviation In Full
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PR pulse rate

PVC premature ventricular contraction

PVPI pulmonary vascular permeability index

PVR pulmonary vascular resistance

PVRI pulmonary vascular resistance index

qSOFA quick Sepsis-Related Organ Failure Assessment

RA right arm

RAP right atrial pressure

Raw airway resistance

Rec record, recording

Resp respiration

RL right leg

RR respiration rate

RSBI rapid shallow breathing index

RVEF right ventricular ejection fraction

SOFA Sepsis-Related Organ Failure Assessment

SpO2 arterial oxygen saturation from pulse oximetry

SQI signal quality index

SR suppression ratio

SSC Surviving Sepsis Campaign

SSI signal strength index

STR systolic time ratio

SV stroke volume

SVI stroke volume index

SVR systemic vascular resistance

SVRI systemic vascular resistance index

SVV stroke volume variation

SvO2 venous oxygen saturation

Sync synchronization

Sys systolic pressure

TB blood temperature

TD temperature difference

Temp temperature

TFT thin-film technology

TI injectate temperature

TRC tube resistance compensation

UAP umbilical arterial pressure

UPS uninterruptible power supply

USB universal serial bus

Abbreviation In Full
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UVP umbilical venous pressure

VAC volts alternating current

VEPT volume of electrically participating tissue

VPB ventricular premature beat per minute

Abbreviation In Full
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